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About Analytica



In this Introduction

This introduction tells you how to:

• Use this manual

• Install Analytica

• Access Analytica examples

• Use the online help system

It also reviews the features that are new to the 
Analytica 2.0 release.
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Welcome

Welcome to the Analytica User Guide. This document describes how 
to use Analytica 2.0 for Windows. Use the Analytica Tutorial for a 
hands-on introduction to the basics of Analytica, then refer to this 
guide when you need more detailed information.

If you don’t read manuals

You may find that you can successfully use many of Analytica’s 
features without reading this User Guide, especially after going 
through the Analytica Tutorial. If so, you can use this User Guide 
mainly as a reference when you need more help. You may still find
valuable to look at a few sections because they give valuable tips 
techniques. In particular, we recommend Chapters 5, 6, 11, and 1

Chapter 5 provides general tips on the process of building a mode
distilled from the experience of master modelers (including Newto
and Einstein). It suggests guidelines for building effective models 
that are clear, comprehensible, and reliable, and that focus on wh
really matters—the decisions, objectives, and key uncertainties. 
These tips are helpful with any modeling software, but we have 
designed Analytica to make them especially easy to adopt. For 
example, you can use Analytica’s hierarchical influence diagrams
organize a complex model.

Chapter 6 explains how to create diagrams that are truly lucid—an
how to avoid creating spaghetti diagrams.

Chapter 11 provides an overview of Analytica’s Intelligent Arrays™
With intelligent arrays you can create and analyze large 
multidimensional models with surprising power and ease. Howeve
there are some subtleties to the effective use of arrays. Prior 
experience with spreadsheets or arrays in programming language
may actually mislead you about how to use arrays in Analytica. W
suggest that you look at Chapter 11 if you plan to create models w
extensive use of arrays.

Chapter 13 discusses how to select an appropriate probability 
distribution to express the uncertainty in a quantity. It also provide
an overview of how Analytica computes probability distributions 
using Monte Carlo and other random sampling methods, and your
options for controlling and displaying probabilistic values.
Analytica User Guide 3
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Requirements

To use Analytica, you need the following configuration:

• 486-66Mhz (Pentium 90Mhz+ recommended)

• 5MB disk space

• 16MB RAM (24MB+ recommended)

• 8-bit color display

• Windows 95, 98 or NT 4 operating system

Installing Analytica

Follow these steps to install the Analytica application and associa
model files on your hard disk:

1. Start Windows.

2. Insert the Analytica CD in your computer’s CD-ROM drive.

3. Click on the Start button on the Windows taskbar.

4. Select Run from the popup menu.

5. In the Run dialog box, specify the program SETUP.EXE on 
your CD-ROM drive (usually either the D: or E: drive).

6. Click on OK.

The setup program requires some responses from you. For example, 
you will be asked to verify the directory name in which Analytica will 
be installed. Most users can accept the defaults provided by the setup 
program. The default installation location for Analytica is C:\Program 
Files\Analytica2.

What’s new in Analytica 2.0

Analytica 2.0 for Windows introduces a wealth of new functionality 
relative to the previous Analytica 1.2 for Windows release.
4 Analytica User Guide
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OLE Linking

Integrate your Analytica models with external spreadsheets. Link data 
from external OLE-compliant applications into your Analytica 
models. Link results in your Analytica models to external 
applications. When values change, the changes are immediately 
reflected in the other applications, eliminating the need to repeat copy-
paste operations between applications. 

See “Linking Analytica results to other applications” on page 366 a
“Linking data from other applications into Analytica” on page 371.

Some example uses:

When preparing a report in Microsoft Word, you can link an Analytic
result directly into your document. If your model or input data is lat
refined, the new results are automatically propagated to your repo
saving you from having to re-edit the document.

By linking an Analytica result to an Excel spreadsheet, you can us
Excel’s extensive formatting capabilities to add specialized formatti
to your final presentation.

You wish to use Analytica to analyze some stock market data, 
currently contained within a spreadsheet. You update your spreads
periodically, and therefore do not want to have to copy-and-paste 
data into your Analytica model each time the data is updated. You 
link the data into an Analytica edit table. When your data changes
your Analytica model automatically receives the new data.

You wish to implement parts of your model in a spreadsheet, and o
parts in Analytica. By OLE-linking between the two applications, th
separate pieces of the model are easily integrated.

Integration with Excel Graph

You can now (optionally) use Microsoft Excel’s graphing engine to
plot your results. Take advantage of Excel’s extensive library of 
different chart types and control of formatting. Use of this feature 
requires Microsoft Excel 8 (Excel 97) or later to be installed on yo
computer. Excel is not included with Analytica.

See “Using Excel Graph with Analytica” on page 130.
Analytica User Guide 5
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Language Extensions

New Functions

Over 50 new built-in functions have been added, falling into several 
categories:

Financial (page 253): CumIPmt, CumPrinc, Fv, IPmt, Irr, Nper, Npv, 
Pmt, PPmt, Pv, Rate, XIrr, XNpv.

Math (page 213): Ceil, Degrees, Floor, Mod, Radians, Tan.

Advanced Math (page 260): Arccos, Arcsin, Arctan2, BetaFn, BetaI, 
Combinations, Cosh, CumNormal, 
CumNormalInv, Erf, ErfInv, GammaFn, GammaI, 
GammaIInv, Lgamma, Permutations, Regression, 
Sinh, Tanh.

Of special note: Regression provides a generalized linear regression 
capability, providing a very powerful, general, and robust curve-
fitting capability (page 264).

Array (page 249, 245): MdArrayToTable, MdTable, Unique.

Distributions (page 298): Gamma.

String Functions (page 252): Join, Split, Stringlength, Stringreplace, 
Substring.

Special Functions (page 243, 266, 339): IndexNames, IsNaN, 
IsNumber, IsText, IsUndef, WhatIfAll.

Database Functions (Enterprise version only, page 427): DbLabels, 
DbQuery, DbTable, DbTableNames, DbWrite, 
SqlDriverInfo.

Partial Name-Space Scoping

Legacy models that define variables or user-defined functions with 
names that conflict with new built-in functions will continue to work 
as before without a name-space conflict. A new :: operator provides a 
way to disambiguate between legacy names and new built-in 
functions.

See “Scoping operator (::)” on page 168.
6 Analytica User Guide
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Changes to Existing Functions
• Uncumulate (page 233): The uncumulate function is now an exact 

inverse of cumulate. The first element of the result of 
Uncumulate(A,I) is now, by default, the first element of A, rather 
than zero. A third optional parameter has also been added that 
explicitly specifies the value for the first element. 
Uncumulate(A,I,0) is equivalent to Uncumulate(A,I) in prior 
versions of Analytica.

• If B Then U Else V (page 201): There are now three versions of 
conditional operators: If, Ifall, and Ifonly. The new Ifonly operator 
is identical to If in previous versions, and removes (collapses) th
dimensions of B from the result if B is constant. If has been changed
so that it no longer collapses the result when B is constant. Ifall 
includes all the dimensions of B, U, and V in the result.

• The first parameter of array functions (Sum, Average, Min, Max, 
Cumulate, Uncumulate, Product, Cumproduct) does not have to be 
indexed explicitly by the indicated index. When it is not indexed
the array is treated as if it were constant across the indicated in
For example, Cumulate(1,J) returns the an array of the positions o
the elements of J.

• Beta (page 295): A new algorithm for generating samples from th
Beta distribution replaces the previous algorithm. The new 
algorithm is more accurate, especially in extreme cases.

• Choice (page 234): A third optional parameter to Choice now 
controls whether the ALL option displays on a pull-down.

• Matrix operations (Determinant, Inverse, Transpose, Decompose, 
page 246) now array abstract. For example, if A is indexed by I,J,K 
(where I and J are the same length), then Determinant(A,I,J) will 
evaluate and return an array of determinants indexed by K.

Presentation Enhancements

Improved Printing and Print Previewing

See “Printing” on page 31.

• You can now preview page breaks for all windows (diagram, 
object, outline, and result windows).

• Printer output can now be scaled, either magnified or shrunk by
given percent, or scaled to fit on a specified number of pages.
Analytica User Guide 7
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• Print settings for each view are now stored and retained betwee
print jobs.

Result View Enhancements
• Result views allow totals to be displayed across rows, columns,

slices. (page 39)

• Reports can use separate number formatting for each column o
row. (page 129)

• Two new bar graph parameters have been added to the Graph 
Settings: Origin and Offset. These make it possible to achieve 
several graphing effects, including “tornado-style” graphs. 
(page 126)

Influence Diagram Enhancements
• A text node button has been added to the toolbar. (page 160)

• You can now control the Z-order of diagram objects using Send to 
Back and Bring to Front. (page 68)

• Form controls within nodes (Choice pull-downs, edit boxes, and
buttons) can now be resized. (page 155)

Internal Engine Improvements

Extensive improvements to Analytica’s internal memory managem
have been incorporated into Analytica 2.0 for Windows. These 
changes are transparent from the point of view of functionality, bu
result in substantial speed improvements in some models. The cha
also fix some known memory leaks and greatly reduce the chance
there being an as-yet-undiscovered memory leak. Furthermore, th
changes substantially improve the responsiveness of CTRL-DOT 
abort an in-process computation. Among the enhancements are th
ability to share array memory between results when the array conte
are identical, support for sparse arrays in certain cases when port
of arrays are constant, and the optimization of dot-product evaluati
Speed improvements from 30% to 1600% have been reported for
previously existing models. The level of speed-up on any given mo
will depend on the degree to which the enhancements can levera
features such as sparse-arrays and memory sharing.
8 Analytica User Guide
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Enterprise version

An Enterprise version of Analytica is now available. In addition to the 
features found in Analytica 2.0, Analytica Enterprise 2.0 also provides 
features for protecting your intellectual property when you distribute 
your models to others, and functions for accessing external databases 
using ODBC and SQL. See Chapter 21 beginning on page 413.

New Installer

Analytica now has a new installer and de-installer. The new installer 
respects NT user/administration distinctions, and performs a clean de-
installation. (page 4)

Miscellaneous
• Default Directory: In compliance with Windows standards, 

Analytica now starts up by default in the user’s personal directo

• Links to Web Sites: The help menu now contains links to the 
Analytica and ADE web pages. (page 456)

• Definition Editing: New key-combinations provide additional 
convenience when editing Analytica expressions and variable 
definitions. Double clicking a mouse selects a word or identifier,
CTRL-arrows move a full word at a time, and ALT-CTRL-arrows
move to matching parentheses. Holding SHIFT down selects tex
the caret is moved. (page 137)
Analytica User Guide 9
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Conventions used in this guide

This guide uses the following conventions: 

Typographic conventions

Terminological conventions

Analytica Note:  Notes tell you useful or important information.

Using Online Help

At any point, you can access Analytica’s online help system by 
pressing the F1 key or by using the pull-down Help menu.

Example Meaning

behavior analysis Analytica terms when introduced. Most of these terms are 
included in the Glossary

Diagram menus and menu commands

Sequence()
Price - DownPmt

functions
expressions, definitions

Enter key on keyboard

Foxes at end title or identifier of a variable or other Analytica object

Term Meaning

click press and release the mouse button one time

double-click press and release the mouse button two times in quick succession

drag press and hold down the mouse button, move the cursor to a new 
location on the screen, and then release the mouse button

press press and hold down the mouse button 

select click on an interface object, such as a node in a diagram or a cell in a 
table; selected objects appear highlighted
10 Analytica User Guide



User Guide Examples Folder
User Guide Examples Folder

In the Examples folder distributed with Analytica is a folder of User 
Guide Examples. This folder contains an Analytica model for each of 
Chapters 9, 10, 11, 12, 14, 15, and 16, and three Analytica models for 
Chapter 17. Use these models to more closely examine the examples 
shown in this Analytica User Guide.

See Chapter 8 in the Tutorial for a brief description of all the models 
contained in the Examples folder.
Analytica User Guide 11
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Chapter 1

Examining a 
Model



In this Chapter

This chapter shows you how to:

• Start up a model

• Explore its Diagram window

• Explore its Object window

• Explore its Result window

• Print the contents of windows



Opening, closing, and switching models
This chapter introduces the basics of interacting with a model in 
Analytica. It describes how to start up and explore a model, including 
its Diagram, Object, and Result windows, and how to print the 
contents of windows.

Opening, closing, and switching models

Models

A model is a collection of variables and modules used to represent a 
situation of interest. Between sessions, a model is stored in an 
Analytica document file with the file type “.ana”.

Opening a model

To open an existing model, do the following:

1. Start Analytica. The program begins with a new, untitled model 
open.

2. Click on File and select Open Model in the pull-down menu. A 
file dialog prompts you to locate and open a model.

As the model is read, a dialog box indicates progress:

Analytica Note:  Clicking on the Stop button halts the model reading 
process and results in a partially loaded model (the diagram will be 
incomplete).
Analytica User Guide 15
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After reading in the model, Analytica checks the definitions.

Analytica Note:  Clicking on the Stop button halts the checking of 
definitions and results in a diagram with missing arrows.

If the model contains variables without syntactically correct 
definitions, the “invalid variables” window displays (see “Invalid 
Variables” on page 393).

Closing a model

To close a model, select Close Model from the File menu. If you have 
made any changes to the model, a dialog box asks you whether y
want to save the changes before closing.

Switching to another model

Only one Analytica model can be open at a time. To switch to anot
model, first close the model. Then select Open Model from the File 
menu. A dialog box prompts you to locate and open another mode

Quitting Analytica

To quit Analytica, select Exit from the File menu. If you have made 
any changes, a Save dialog asks you whether you want to save y
model before quitting. 
16 Analytica User Guide
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The tool palette

When you open a model, the tool palette appears across the top of your 
screen. It provides a set of buttons to navigate around a model, to open 
different views of a model, and to change between browse and edit 
modes. 

The first five buttons on the tool palette apply to the active Analytica 
window (the frontmost window). 

Parent Diagram button

Opens a Diagram window for the module or model containing the 
active diagram window or variable. This button is grayed out if you 
are looking at the Diagram window for the top-level (or root) 
model. 

Outline button

Opens the Outline window and highlights the selected node or 
active module in the outline. See “The Outline window” on 
page 386.

Object button

Opens an Object window for the selected node or active module
See “The Object window” on page 25.

Result button

Opens a Result window for the selected variable. (See “The Re
window” on page 37.) This button is grayed out if no variable is 
selected. The keyboard equivalent for the result button is Ctrl-R

Definition button

Opens a view of the definition of the selected variable. If the 
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variable is defined as a distribution or sequence, the Object Finder 
opens (see “Object Finder dialog box” on page 143); if it is defin
as a table or probability table, its Edit Table window opens (see 
“Viewing an array as an Edit table” on page 179). Otherwise, an
Attribute panel (see “The Attribute panel” on page 27) or an Obje
window (see “The Object window” on page 25) opens, dependin
on the Edit Attributes setting in the Preferences dialog box (see
“Preferences dialog box” on page 80.) This button is grayed out
no variable is selected. The keyboard equivalent for the definitio
button is Ctrl-E.

The three tool buttons determine the mode of interaction with the 
model. One mode is always selected.

Browse tool button

Use to interact with the model in Browse mode. See “Browsing t
window” on page 19.

Edit tool button

Use to interact with the model in Edit mode. See Chapter 4, 
“Creating and Editing a Model”.

Arrow tool button

Use to interact with the model in Arrow mode, to add or delete 
arrows (dependencies) among the components of the model. Se
“Drawing arrows in a diagram window” on page 69.
18 Analytica User Guide



Browsing with Input and Output Nodes

Hand 
to
Browsing with Input and Output Nodes

When you open a model with input and output nodes, Analytica first 
displays a top level Diagram window, similar to the example here.

The input nodes show values that you can change to see their effects 
on the final values. The output nodes each show a Calc button. At 
least one node contains the details of the model. 

Browsing the window

An existing model opens in Browse mode. In Browse mode, the 
Browse tool button is highlighted in the tool palette, and the cursor is 
a hand ( ).

Use the Browse tool to change input node values, view output node 
results, and examine the model by opening windows to see more 
detail.

Viewing input node values

An input field lets you see a single numeric or text value. Click in the 
box to change the value.

Output node

Input nodes

tool is highlighted
 show that you are

browsing
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A popup menu lets you choose from a menu of alternatives. To see the 
alternatives, click on the popup menu. To select an alternative, click 
on it.

A List button lets you see an ordered set of values. To see the values, 
click on the button. To change a value, click in its cell. For more about 
lists, see “Editing a list” on page 190. 

An Edit Table button lets you see a multidimensional set of values
one or more tabular spreadsheet-like windows. To see the values, c
on the button. To change a value, click in its cell. For more about 
tables, see “Editing a table” on page 195.

A Distribution button lets you see a probability distribution. To see
the distribution and its parameters, click on the button. For more ab
probability distributions, see Chapter 13, “Expressing Uncertainty”

Viewing output node values

If the value of an output node has not yet been computed, the Calc 
button appears in the node. Click on the Calc button to compute and 
display the value. Chapter 2, “Viewing Results”, describes how to 
interpret and redisplay results.

Opening model details

To see the structure of the model, double-click on the details (round
thick-outline) node. A diagram window showing an influence diagra
will display (see “Examining an influence diagram window” on pag
21).
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Examining an influence diagram window
Examining an influence diagram window

When you open a model detail window, or a model without input and 
output nodes, Analytica displays a Diagram window for the model. 
The Diagram window depicts the model as an influence diagram. An 
influence diagram is an intuitive graphical view of the structure of a 
model, consisting of nodes and arrows. Each node depicts a variable 
or a module.

A variable is any object that has a value or can be evaluated. Nodes 
with thin outlines depict variables. A module, with a thick outline, 
contains its own influence diagram. 

The arrows in a Diagram window depict the influences among the 
variables. An influence arrow from one variable to another means that 
the value of the first variable directly affects the value (or probability 
distribution) of the second variable. 

For example, in the preceding diagram, the arrow from Buying price to 
Cost to Buy means that the price of the house affects the overall cost of 
purchasing it. A higher price means a greater cost, given a fixed Rate 
of inflation and Discount rate. The influence diagram shows the 
essential qualitative structure of the model, unobscured by details of 
the numbers or mathematical formulas that may underlie that 
structure.

For more on using influence diagrams to build clear models, see 
Chapter 6, “Creating Lucid Influence Diagrams”.

Selected node is
highlighted

Nodes
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Opening details from a diagram

To see more details of a model, double-click on nodes in the Diagram 
window: 

• Double-click on a variable (thin outline) node to open its Object 
window. See “The Object window” on page 25.

• Double-click on a module (thick outline) node to see its Diagram
window, showing the next level of detail of the model.

Going to the parent diagram

To see the diagram that contains the active module or variable, cl
on the Parent Diagram button in the tool palette. The module or 
variable will be highlighted in the parent diagram.

Analytica Note:  If the active diagram is of the top model, it has no 
parent diagram, and the Parent Diagram button is grayed out.

Finding remote inputs and outputs

When a variable depends on a remote variable—that is, a variable
another module that is not visible—a small arrowhead appears to
left of the node. If a variable has a remote output, a small arrowhe
appears to the right of the node. 

To go to the Diagram window containing a remote variable:

1. Click on the small arrowhead. A popup menu appears listing all 
inputs (or outputs), including those that are not remote.

2. Click on the desired input (or output). The Diagram window 
containing the remote variable opens, and the remote variable’s 
node is highlighted.

Small arrowhead
indicates that this

variable has remote
inputs

Popup menu of inputs
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Viewing results

Click on a variable node to select it; it becomes highlighted. Then 
click on the Result button in the tool palette to show the value of the 
variable as a table or graph in a Result window. Chapter 2, “Viewi
Results”, discusses how to interpret and redisplay results.

Analytica Note:  If the value has not already been computed, you may 
need to wait while the result calculates, and the waiting cursor ( ) 
appears. 

Recognizing nodes

Each node shape in a diagram represents a different class of obje
Here are the classes and their corresponding node shapes:

A rectangular node depicts a decision variable—that is, a quantity that 
the decision maker can control directly. For example, whether or n
you take an umbrella to work is your decision. If you are bidding on
contract, how much you bid is your decision. 

A rounded, thin-outline node depicts a general variable—that is, a 
quantity whose class is not determined more precisely, or a quant
that the decision maker cannot affect directly and that is not defined
probabilistic. Use a general variable initially if you’re not sure wha
kind of variable you’ll need, then change the node class later, if 
appropriate.

An oval node depicts a chance variable—that is, a variable that is 
uncertain and that the decision maker cannot control directly. A 
chance variable is usually defined by a probability distribution. Fo
example, whether or not it rains is a chance variable (unless you a
rain god). And whether or not your bid is the winning bid is a chan
variable in your model, although it is a decision variable for the pers
or organization requesting the bid.

A hexagonal node depicts an objective variable—that is, a quantity 
that evaluates the relative desirability of possible outcomes of 
combinations of decision and chance variables. Most models sho
contain a single objective node, although the objective can compr
several subobjectives.

A rounded, thick-outline node depicts a module—that is, a collection 
of nodes organized as a separate diagram. Modules can themselv
contain nested modules.

Decision

Variable

Chance

Objective

Module
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A parallelogram-shaped node depicts an index variable. An index is 
used to define a dimension of an array. For example, Year is an index 
for an array containing the U.S. GNP for the past 20 years. Or Nation 
name is an index for an array of GNPs for a collection of nations (see 
“Introduction to Arrays” on page 177). Index values appear in the ro
and column headers of a table, and in the x axis and key of a graph.

A trapezoid-shaped node depicts a constant—that is, a variable whose 
value is fixed. A constant has no inputs and is not computed. Exam
of numerical constants are the atomic weight of oxygen or the num
of feet in a kilometer. It is good practice to define such values as 
constants, so you can refer to them by name; otherwise, you must 
their numerical values into each expression that includes them an
search for the values when you need to change them.

A node resembling an arrow tail pointing right depicts a function. You 
can define functions to augment the functions provided in Analytic
see Chapter 20, “Building Functions and Libraries”.

An oval node with a double rounded outline depicts a determ 
(deterministic) variable—that is, a variable whose value cannot be 
directly controlled by the decision maker, and that is not uncertain
probabilistic. This node class is not included in the node palette to
encourage use of the general variable.

Selecting nodes

To perform an operation on a diagram, you must first select a node
a set of nodes), then select the operation to perform. There are var
ways to select nodes (similar to selecting icons in the finder):

To select one node

Click once on the node to select it. The selected node is highlight

You can also press the tab key to select one node at a time.

To select multiple nodes

Select one node, then click on another node while holding down t
shift key. This operation adds the new node to the set of selected no
highlighting them all. By repeating this process, you can select as
many nodes as you wish.

Index

Constant

Function

Determ
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The Object window
If the nodes are close together, you can also select them by dragging a 
selection rectangle around them.

To deselect one node

Click on a selected node while holding down the shift key. This 
operation removes the node from the selection, leaving the remaining 
nodes selected.

To deselect all nodes

Click on the background of the diagram to deselect all nodes. 

The Object window

The Object window shows the attributes that together specify a node. 
For a variable, as shown in the following figure, these attributes 
include the class, identifier (a brief, unique name), title, units, 
description, definition, inputs, and outputs. See the Glossary for 
descriptions of the attributes.

Opening an Object window

There are several ways to open the Object window for an object titled 
X: 

Double-click on an input
or output to open its

Object window

Class Identifier

Expressions popup menu (see
page 141)

Editable field
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• Double-click on X’s node in its Diagram window (see page 21).

• Select X in its Diagram window and click on the Object button 

( ) in the tool palette.

• Double-click on the entry for X in the Outline window (see “The 
Outline window” on page 386).

• If a Result window for X is displayed, click on the Object button 

( ) in the tool palette.

• Double-click on the entry for X in the Inputs or Outputs field of 
another variable.

Examining inputs and outputs

When you are looking at an Object window for a variable, you can
easily view the Object window for any of the variable’s inputs or 
outputs. Double-click on a node symbol, identifier, or title of a 
variable in the list of inputs or outputs.

Returning to the parent diagram

Click on the Parent Diagram button in the tool palette to see the 
diagram that contains this node, with the node highlighted.

Displaying additional attributes
• To display the value of a variable and its inputs, see “Showing m

values” on page 29. 

• To display additional attributes and create new attributes, see 
“Managing attributes” on page 390.
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The Attribute panel

attrib
The Attribute panel

The Attribute panel provides an alternative way to view attributes of 
a node. The Attribute panel appears as an extension below a Diagram 
window.

Displaying the attribute 

1. Click on the Key icon ( ) to display the Attribute panel.

2. Select a node to examine by clicking on it in the diagram.

Analytica Note:  If multiple nodes are selected, click on the diagram 
background to deselect them, then click on the node you wish to examine.

3. To examine a different attribute, click on the Attribute popup 
menu, and select the desired attribute. 

Selected node whose
ute is displayed below

Title of object

Attribute fieldContents of the 
attribute

Attribute popup menu selects the attribute

Partition

Size box

Key icon is open
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4. To examine the same attribute for another node, select that node 
in the Diagram window. If no node is selected (you have clicked 
on the background of the diagram), the corresponding attribute 
for the module is displayed.

The Attribute popup menu

When the Attribute panel is displayed, the Attribute popup menu is 
located at the top center of the Attribute panel. Use this popup menu 
to select another attribute to view. Variables, modules, and functions 
have different sets of attributes, as shown here:

See the Glossary for descriptions of these attributes. To display other 
attributes or to add new ones, see “Managing attributes” on page 

Changing the panel size

To change the height of the diagram in relation to the diagram’s 
Attribute panel, drag the partition up or down.

Variables Modules Functions
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Showing mid values
To change the size and shape of the Attribute panel, drag the size box 
up or down; the height of the Diagram panel remains fixed. 

To change the width and shape of the Diagram and Attribute panels, 
drag the size box right or left.

Closing the Attribute panel

To close the Attribute panel, click on the Key icon ( ).

Showing mid values

The mid value or deterministic result of a variable is computed by 
holding each uncertain (probabilistic) input at a single, central value. 
The mid value for a probability distribution is its median. The mid 
value of a variable is computed by using the mid value of each input. 
If all inputs are certain (nonprobabilistic), the calculated value is still 
referred to as the mid value in Analytica.
Analytica User Guide 29



Chapter Examining a Model1

ool 
 

 

To show the mid values of variables in the value attribute, select Show 
with Values from the Object menu. Mid values that are single values 
will display in object windows and the attribute panel. You can display 
these values to check that a calculation is performing correctly, or to 
find errors in the model.

Array values

If the mid value of the selected variable is an array, rather than a single 
number, the Result button appears.

To display the array, click on the Result button. (This is equivalent to 
clicking on the Result button on the tool palette, described in “The t
palette” on page 17.) A Result window opens, showing the values
either as a graph or as a table. For information about the Result 
window, see Chapter 2, “Viewing Results”.

Values of inputs

When Show with Values is turned on, the list of inputs displays one
of the following for each input:

• The mid value, if it is a a single number (or text) and has been 
computed.

List of inputs, with
units and values

Value of selected variable
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• Calc if it has not been computed. To calculate and view the valu
select the input as the variable you are examining and display it
object window or value attribute.

• Result if the mid value is an array. To display it, select the input 
node as the variable you are examining. The value attribute disp
the Result button; click on the Result button to see the values.

Printing

To print the contents of any window (Diagram, outline, object, resu
table, or a result graph window), activate the window and select th
Print... command from the File menu. To set printing options such a
page orientation, paper size, or scaling, use the Print Setup... 
command on the file menu. Any print settings that you specify are
associated only with window that was active when you selected Print 
Setup...

Previewing Page Breaks Before Printing

When you select the Print preview command on the File menu, a 

Preview window appears before printing. This window shows wha
will be printed with an indication of where page breaks will occur. 
Print settings such as scaling can be conveniently adjusted by selec

checked, shows
axes and other

dimensions

Opens the Print 
dialog box

Prints without 
opening the Print
dialog box
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the Setup... button until the desired page breaks have been obtained. 
When previewing a result table or graph, an option for showing or 
hiding the index variable titles can be toggled.

When viewing a diagram, outline, or object window, page breaks can 
be viewed while working by enabling Show Page Breaks on the 
Window menu.

Scaling Printouts

You can adjust the magnification of your printouts using the Print 
Setup... command on the file menu, or by using the Setup... button on 
the Print Preview window. You can specify magnification in two ways:

• Adjust to p% of normal size.

p< 100% shrinks the output (fits more on a page).
p>100% enlarges the output

• Fit to n page(s) wide by m page(s) tall.

Shrinks the output if necessary to fit on a maximum of n pages wide 
by m pages tall. The output is never enlarged to fill out the specifi
number of pages. Also, the aspect ratio is preserved, so the act
number of pages printed may be less than n x m.

Settings to magnify or
shrink print output
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Printing
Print multiple windows

To print the contents of several windows at one time, use the Print 
Report command in the File menu. Each window that is printed uses 
the print settings that have been specified for that window.

In addition to the Diagram, Result, and Object window options, there 
are two checkboxes:

Print Outline (All Objects)

If checked, this option prints an outline of all of the objects in the 
model. It prints a list of all nodes by title, indented to show their 
position in the module hierarchy.

Print Outline (Modules Only)

If checked, this option prints the model hierarchy as an indented list 
containing only the modules.

Diagram window
printing options

Result window
printing options

Object window printing 
options
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Chapter 2

Viewing Results



In this Chapter

This chapter shows you how to:

• Interpret Result windows

• View results as graphs and as tables

• View results that have more than two 
dimensions



The Result window
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This chapter describes the elements of Result windows, how to view 
results as graphs and as tables, and how to view results that have more 
than two dimensions. It also discusses how to select a method for 
displaying uncertainty about probabilistic values.

The Result window

Analytica computes the value of a variable from that variable’s 
definition and displays the value in a Result window. If the value is
probabilistic or an array, or both, it is displayed in a Result window
either a table or graph. The following figure shows a Result windo
of an array with the graph superimposed on a table.

Opening a Result window

To open a Result window for a variable in an influence diagram, se
the variable and do any of the following:

• Click on the Result button ( ).

• Select Show Result from the Result menu.

Uncertainty View popup
menu

Table view

Graph view

Index selection areaResult tool palette
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• Select an uncertainty view option (such as Mid Value or Mean 
Value) from the Result menu.

• Select Value from the Attribute panel’s popup menu.

• Select Probvalue from the Attribute panel’s popup menu.

• Press Ctrl-R.

To open a Result window for an output node, click on the Calc or 
Result button.

The Result tool palette 

The Result tool palette, in the upper left corner of the Result window
contains three items:

• The Uncertainty View popup menu. Pressing this popup menu 
brings up a menu of options for viewing the result data (see pag
45).

• The Table View button. Clicking this button displays the results a
a table (see page 41).

• The Graph View button. Clicking this button displays the results 
a graph (see page 42).

Toggle between the table and graph views using the Table View a
Graph View buttons.
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Index selection area

The top portion of a Result window is the index selection area, which 
identifies the rows and columns of a table, or the x-axis and key of a 
graph. Buttons and popup menus allow you to rearrange the table or 
graph by interchanging indexes.

The index selection area contains these items (example variables and 
indexes in the following text refer to the figure above):

• The title of the result, including the active uncertainty view, title o
the variable and units, if any; here, it is Mid Value of Costs of 
buying and renting ($).

• Index navigation buttons, if the result has three or more dimensi
(see the next page).

• The third or higher dimensions, if any (Buying price is a third 
dimension).

• The row or key index (Buy or rent).

• The column or x-axis index (Appreciation rate (%/year)).

• The totals checkboxes. These control whether numeric row or 
column totals are displayed in a result table. Also when this box
checked for a given index, the index slice will default to the 
“Totals” option if this index is transposed to a third or higher 
dimension.

Click on the popup menu (indicated by the down arrow ( ) for 
either index (row or column) to select a different index (or “No 
Index”). 

Totals row or column

Title of the result

Row or key index
Column or x axis index

Index navigation buttons

Third or higher
dimensions

X-Y button

Popup menu
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• The X-Y button (see “X-Y results” on page 339).

Index navigation buttons

When the result has three or more dimensions, not all values can
display on the table or graph. For each index, or dimension, beyond
second, a set of navigation buttons appears in the index selection 

Use the index navigation buttons to move among index values for 
third (or higher) dimension of results:

• Click the left arrow ( ) to select the previous index value.

• Click the right arrow ( ) to select the next index value.

• Click the down arrow ( ) to open a dialog box showing all the
values for this index.

The default view

When you first display a Result window, Analytica displays the res
as a graph, if possible, and otherwise as a table. You can change
default option with the “Default result view” setting in the Preferenc
dialog box (see “Preferences dialog box” on page 80).

When you display the Result window again, the view to be display
is recalled from earlier in the session or from the previously saved
session.

Dialog box listing all values
for the selected index

(Buying Price)

Selected value is 120K
Click on a value to select it and to close the 
dialog box

Totals option. When selected, the view 
displays numeric totals across this index 
(Buying price).
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Viewing a result as a table
Recomputing results

When a Result window is open, and then the value of an input to the 
evaluated variable is changed, a Calculate button appears in the index 
selection area.

Click on the button to recalculate the result.

Viewing a result as a table

Displaying a table

If a graph is displayed, change it to the corresponding table by clicking 

on the Table View button ( ).

Display of values

The table view displays one or two dimensions of a variable.

The display options depend on the number of dimensions in the 
variable.

One dimension

The index is displayed vertically (there are no options).

Three-dimensional table

Result Tool palette
(see page 38)

Index 
selection 
area 
(see page 39)
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Two dimensions

You can choose which index is displayed horizontally using the 
column index popup menu ( ), and which index is displayed 

vertically using the row index popup menu ( ). 

Three or more dimensions

You can select a two-dimensional view using the row and column 
popup menus. Select specific values for the third or higher 
dimensions using the index navigation buttons.

Formatting numbers

You can specify the number format for a table’s contents, using th
Number Format dialog box.

To display the Number Format dialog box:

1. Select the row(s), column(s), or cell that you wish to format.

2. Choose Number Format from the Result menu or press Ctrl-B.

See “Number Format dialog box” on page 127 for details on the 
number format options.

Viewing a result as a graph

Displaying a graph

If a table is displayed, change it to the corresponding graph by click

on the Graph View button ( ).
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Display of values

A graph displays the values from an array.

The vertical y axis shows the variable’s values. 

The display options depend on the number of dimensions in the 
variable.

One dimension

The values of the dimension are shown horizontally, along the x 
axis (there are no options). 

Two or more dimensions

You can choose which index is displayed along the x axis by using 
the x axis popup menu, and which index produces multiple curve
by using the key index popup menu.

The key shows the value of the index variable that corresponds 
each curve, indicated by pattern or color.

x axiskey

Result tool palette
(see page 38)

Index selection area
(see page 39)

y axis
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Select specific values for the third or higher dimensions using the 
index navigation buttons. 

Changing graph ranges and styles

You can override the default ranges and styles for a graph, or you can 
change the default for all graphs, using the Graph Setup dialog box. 

To display the Graph Setup dialog box, do one of the following:

• Select Graph Setup from the Result menu.

• Double-click anywhere on a graph in the Result window.

See “Graph Setup dialog box” on page 121 for details on the Grap
Setup options.

Uncertainty view options

The value of a variable in an Analytica model can be either certain 
(deterministic) or uncertain (probabilistic). An uncertain value can be
viewed in several different ways. Select the uncertainty view in eithe

• The Result menu.

• The Uncertainty View popup menu (top left corner of the Result 
window).

The check mark indicates the currently selected uncertainty view 
option. If the active window is not a Result window, selecting an 
uncertainty view option opens a Result window for the selected 
variable. 

Uncertainty View popup menu

Currently selected
uncertainty view option

Result menu uncertainty 
view options
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Uncertainty view options
The uncertainty view options are described briefly here. For more 
information on these options, see their entries in the Glossary and 
consult any standard statistics textbook.

The following examples use the variable Typical Uncertainty, which 
is defined as a normal distribution having a mean of 50 and a standard 
deviation of 30.

Mid Value

The mid value is the deterministic value, computed by holding 
probability distributions at their median values. This value is 
computed very quickly compared to the uncertainty values. The 
mid value is the only option available for a certain 
(nonprobabilistic) variable.

Mean Value

The mean value is an estimate of the expected value of the 
uncertain value. For a symmetrical distribution, such as a normal 
distribution, the mean is the same as the median (mid) value.
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Statistics

Statistics for the uncertain value, such as mean and standard 
deviation, are provided in a table. Select the statistics to be 
calculated using the Uncertainty Setup dialog (see “Statistics 
option” on page 290).

Probability Bands

Probability bands are specified at given percentile values. Select
probability bands you wish to show using the Uncertainty Setup
dialog (see “Probability Bands option” on page 290). 

Probability Density or Probability Mass

If the quantity is a continuous probability distribution, Analytica 
displays a probability density function. The horizontal (x) axis plots 
possible values of the uncertain quantity. The height of the curv
(probability density) is proportional to the likelihood that the 
quantity will have the x value. The highest point on the curve is th
most likely value (the mode). Where the curve is at zero height o
invisible, there is zero probability that the quantity will have that 
value. (For a discrete probability distribution, Analytica graphs th
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Uncertainty view options
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probability mass.)

The “common index” of Step is a counter to relate the variable’s
values to the probability density; at the first and last value of Ste
the probability density is zero.

Cumulative Probability

The cumulative probability distribution plots the possible values 
the uncertainty quantity along the horizontal (x) axis. The height of 
the graph at each value of x shows the probability that the quantity
will be less than or equal to that x value. The cumulative 
distribution ranges from a probability of 0 on the left to probabilit
of 1 on the right, without decreasing. The steeper the curve, the
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more likely the quantity will have a value in that region.

The “common index” of Step is a counter to relate the variable’s
values to the cumulative probability; at the first value of Step, th
cumulative probability is zero and at the last value of Step, the 
cumulative probability is 1.

Sample

A sample is an array of the random sample of values generated
the sampling process. The sample is the underlying representat
for an uncertain quantity. 

All other representations of uncertainty are estimated from the 
sample. The precision of the estimates depends on the sample 
and the sampling method (see Appendix D for selecting the sam
size and “Uncertainty Setup dialog box” on page 284 for setting 
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Comparing results
sample size).

Comparing results

To directly compare the values of two or more variables in one table 
or graph, select all the variables together and open a Result window 
(see page 37). A dialog box asks for confirmation.

Analytica creates a new node with a default title and displays the 
values in one table or graph.
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In this example, we have compared the changing values of three 
variables—Mortgage payments, Interest payments, and Property 
taxes—over ten time periods.
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Chapter 3

Analyzing Model 
Behavior



In this Chapter

This chapter shows you how to perform a 
parametric analysis on a model by

• Selecting variables as parameters

• Specifying alternative values for the 
parameters

• Examining the results



Varying input parameters
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A potent source of insight into a model is examining the behavior of 
its outputs as you systematically vary one or more of its inputs. This 
technique is called model behavior analysis. Each input that you vary 
systematically is called a parameter, and so this technique is also 
known as parametric analysis. Since you can view this as exploring 
hypothetical scenarios, it is also called scenario or what-if analysis. 
Analytica makes it simple to analyze model behavior in this way. All 
you have to do is to assign a list of alternative values to each input 
parameter. When you view the result of any output, Analytica 
computes and displays a table or graph showing how the output values 
vary for all combinations of the values for each input. 

This chapter describes how to select variables as parameters, how to 
specify alternative values for the parameters, and how to examine the 
results. 

Varying input parameters

The first step in analyzing model behavior is to select one or more 
input variables as parameters and to assign each parameter a list of 
possible values. 

Which inputs to vary

You can vary any numerical input variable of your model, including 
decisions and chance variables. Often you will want to vary each 
decision variable to see which value gives the best results according to 
the objectives. You may also want to vary some chance variables to 
see how they affect the results. It is often best to look first at the 
decision or chance variables that you expect to have the largest effect 
on the model outputs. In complicated models, you may want to start 
with an importance analysis, to identify which chance variables are 
likely to be most important. (See Chapter 16, “Analyzing Uncertain
and Sensitivity”.) You can then select the most important variables
the parameters to vary to analyze model behavior. 

How many values to assign

Usually it is best to assign a list of three alternative values to each
parameter—a low, medium, and high value. In some cases, two va
may be sufficient. If you have a special interest in a particular 
parameter (for example, if you suspect it may have a strongly 
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nonlinear effect) you may want to assign more than three values to 
examine in more detail the model behavior as the parameter varies. 
Naturally, the computation time increases with the number of values.

Creating a list

To create a list of values for a variable, change its definition following 
these steps:

1. Select the variable by clicking on its node in the influence 
diagram. 

2. Display the variable’s definition by clicking on the Definition 
button in the tools palette.

3. Click on the Expressions popup menu above the definition and 
select the List option. (Do not select the List of Labels option.) 

4. A dialog box asks for confirmation. Click on “OK”.

Analytica displays a list with one element, containing the old 
definition of the variable. 

New one-element list
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5. Select the element by clicking on it.

6. Type in the lowest value for the variable.

7. Press Enter and type in the next value.

8. Repeat step 7 until you have all the values you want.

Note that after you have entered two or more values into a list, the next 
item receives a default value. For example, if the last two values are 
10 and 20, Analytica offers 30 as the next value. 

For details on how to edit a list, see “Editing a list” on page 190. 

If you want to create a list with a large number of evenly spaced 
values, use the Sequence() function (see page 217).

How many inputs to vary

Typically you should start a model behavior analysis by varying ju
one input variable, the one you expect to be most important. Vary
additional variables one at a time, in order of their expected 
importance. If a variable turns out to have little effect, you may resto
it to its original value or probability distribution. If you have many 
inputs whose effects on model behavior you would like to explore
vary just a few at a time, rather than trying to vary them all 
simultaneously. 

Each parameter that you vary becomes a new dimension of your ou
result array. The computation time and memory needed increase 
roughly exponentially as you add parameters. Moreover, you may f
it hard to interpret an array with more than three or four dimension
Remember that the goal is to obtain insight into what affects the mo
behavior and how.
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Analyzing model behavior results

Once you have assigned a list to one or more inputs, you can examine 
their effect by viewing the result on an output variable. If your model 
has an objective, you might start by looking at that variable. 

1. Select the variable you wish to view by clicking on its node in the 
diagram. 

2. View the result by clicking on the result button in the tool 
palette. The result displays as a table or graph. 

The result is an array with a dimension for each input parameter that 
you have varied (in this example, Buying price and Appreciation rate). 
If an input parameter does not appear as a dimension of the result, it 
implies that the result variable does not depend on the input. The result 
may also have other dimensions that are not input parameters you have 
varied—for example, Time for a dynamic model. 
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It is generally easiest to look first at the result graph to see the mod
general behavior. You need to look only at the result table if you wa
to see the precise numerical values. If you are varying more than 
input parameter, try rearranging the dimensions (see “Index selec
area” on page 39) to get additional insights into model behavior.

Understanding unexpected behavior

If you find the model’s behavior unexpected or inexplicable, you m
want to look more deeply into how the behavior arises. An easy w
to do this is simply to look at the results for other variables betwee
the input(s) and the output(s) in which you’re interested. You can 
work forwards from an input towards the output, or backwards fro
the output towards the inputs. Look at the behavior of each 
intermediate variable, and see if you can understand why the inpu
affect it the way they do. 

Typically, the reason for unexpected behavior will quickly become
clear to you. It may be that some intermediate relationship has an
effect different from what you expected. It may turn out that there 
an error in a definition. In either case, this kind of exploration can 
very revealing about the model. You may end up improving the mo
or gaining a deeper understanding of the system it represents.

Result graph with
dimensions reversed
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Understanding model behavior

By examining result graphs, you can learn if each input affects the 
output, if the effect is linear or non-linear, and if there are interactions 
among inputs in their effect on the output. Below are some typical 
graph patterns and their qualitative interpretations.

• A horizontal line shows that changes in the input over the specif
range have no effect on the output.

• A straight line shows that the output depends linearly on the 
input—provided that you have specified more than two different
values for the input.
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• A bent or curved line shows that there is a nonlinear dependenc

(Note that if you have only two values for the input, the graph w
be a straight line even if there is a nonlinear dependence.)
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In this Chapter

This chapter shows you how to:

• Create a new model

• Save changes

• Create and edit nodes

• Draw arrows

• Make aliases



Creating and saving a model

 

x 

 

This chapter introduces you to the elements for building influence 
diagrams. It describes how to create a new model and save changes, 
how to create and edit nodes, and how to draw arrows and make 
aliases. 

Creating and saving a model

You can create new models in Analytica, as well as edit your models 
and save the changes that you make. 

Creating a new model

To create a model, do one of the following:

• Start Analytica. The program begins with a new, untitled model 
open.

• If Analytica is already running, click on File and select New Model 
in the pulldown menu. 

If an existing model is currently open, Analytica does one of the
following:

- If the model is unchanged, Analytica closes it.

- If the model has been changed, Analytica displays a dialog bo
that allows you to 

• save the model before closing it

• close it without saving

• or cancel the action.

Saving a model

To save changes to the model, select the Save command from the File 
menu (Ctrl-S).

To save the model file under a new name, select the Save As or Save 
a Copy In command from the File menu. After you use the Save As 
command, selecting the Save command will save the model with the
new name. After you use the Save a Copy In command, selecting the 
Save command will save the model with its original name.
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The model Object window

The model Object window shows information about the model, such 
as the author(s), and creation and save dates; it also includes space for 
a description of the model’s purpose. 

When you create a model, an Object window is displayed for the n
model, initially untitled, with the fields shown in the following figure
Enter information as appropriate.

See the Glossary for descriptions of the attributes.

After entering information into the model Object window, bring the
Diagram window to the top in any of three ways:

• Click on the Parent Diagram button. 

• Click anywhere in the Diagram window behind the Object windo

• Click on the Object window’s Close box.

You can now draw a diagram for the new model (see “Creating an
editing nodes in a diagram” on page 64).

Creating and editing nodes in a diagram

To create new nodes, or move or modify existing nodes, the Edit t
must be selected. 

Attributes

Blank Diagram window
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When a Diagram window for a new model is first opened, the Edit tool 
is selected by default. When a Diagram window for an existing model 
is first opened, the Browse tool is selected (see “Browsing the 
window” on page 19), so you can examine, but not change, the 
diagram.

To begin editing a diagram, click on the Edit tool ( ), if it is not

selected.

When you are in Edit mode or Arrow mode, the node palette appears 
at the right of the tool palette. 

Nodes

Selected node

Node paletteThe Edit tool is
highlighted to show that

it is selected

The node palette is displayed when 
either the Edit tool or Arrow tool is 
selected.
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For details about the node classes in the node palette, see 
“Recognizing nodes” on page 23.

Creating a node

To create a new node, press on the appropriate icon in the node pa
then drag the outline into the diagram. After placing the node in th
diagram, use the keyboard to enter its title.

Editing a node title

To edit the title of a node, first select the node, then click on that 
node’s text field. Pause between the mouse click to select the node
the mouse click to select the text; otherwise, your action may be 
interpreted as a double-click, opening the node’s Object window. T
node’s appearance changes to match the illustration of the node on
left, below. When you have finished typing, press Alt-Enter (or Enter 
on the numeric keypad) to accept the title change and resize the n
to fit the text.

When a node’s title is first created, its identifier is created from the 
first 20 characters of the title (underscores replace spaces). The no
identifier is the name used to refer to this node in the mathematic
definition of other nodes. The node keeps this identifier until it is 
explicitly edited, unless the Change Identifier preference is set (se
page 81).

Selecting nodes

To select a node, single-click on it. Handles indicate that you have
selected the node. To deselect a selected node, click anywhere ou
of it.

You can edit the title when
The node is resizedthe node looks like this

 to fit the text

handles
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To select or deselect multiple nodes, Shift-click. You can also select a 
group of nodes by dragging a rectangle around them. Move the cursor 
to a corner of the diagram (not in a node), press the mouse button, and 
drag the mouse to draw a rectangle. When you release the button, all 
the nodes completely inside the rectangle are selected.

Working with nodes

You can manipulate the nodes in a diagram in a variety of ways.

Moving a node

To move a node, press the mouse while the cursor is inside the node 
but not on a handle, then drag the node.

You can also move a selected node using the arrow keys (up, down, 
left, right).

Moving a node into a module

To move a node into a module in the diagram, drag the node onto 
the module until the module becomes highlighted. When you 
release the mouse button, the node goes into the module.

Alternatively, double-click on the module to open its diagram 
window. Move the module diagram window so both it and the node 
to be moved are visible. Then drag the node onto the module 
diagram window.

Changing the size of a node

To change the size of a node, drag a handle until the node is the size 
you desire.

By default, a node is resized keeping the center in place (that is, all 
four corners expand or contract). This helps to keep nodes on the 
grid and lined up with each other. To turn off the default so one 
corner at a time can be resized, uncheck the Resize Centered 
option in the Diagram menu.

Deleting a node

To delete a node, first select it. Then, choose Clear from the Edit 
menu, or press the Delete key. You will be prompted to confirm 
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your intentions before the node is deleted.

Copying and pasting nodes

To create nodes that have substantial information in common, you 
can use the standard Copy and Paste commands. Initially, the 
copies are identical except for their identifiers (which have 
numbers appended to them to make them unique).

Duplicating nodes

To create two sets of nodes that have substantial information in 
common, create the first set. Select the nodes, then choose 
Duplicate Nodes from the Edit menu. This is equivalent to using 
Copy and Paste, without writing to the clipboard.

Aligning to the grid

When the grid is on (the default), each node that you create or move is 
centered on a grid point. This default makes it easier for you to 
position nodes so that arrows are exactly horizontal or vertical when 
nodes are aligned vertically or horizontally. 

To recenter nodes, select Align Selection to Grid from the Diagram 
menu (Ctrl-J).

To turn the grid off in edit mode, uncheck Snap to Grid from the 
Diagram menu. When the grid is off in edit mode, the grid is still 
visible; you can move the nodes pixel by pixel.

Adjusting node Z-order

The node Z-order specifies what diagram elements will display on top 
of others if the items overlap. By defaults, text and picture nodes are 
behind arrows, and arrows are behind nodes. The Z-order can be 
changed by selecting a node or nodes and using the Send to Back and 
Bring to Front commands, which are found only on the right mouse 
button menu. 

Cutting a node Select Cut from the Edit menu( Ctrl-X).

Copying a node Select Copy from the Edit menu ( Ctrl-C).

Pasting a node Select Paste from the Edit menu ( Ctrl-V).
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Drawing arrows in a diagram window

Use the Arrow tool to draw or remove arrows (influences) between 
variable nodes. 

Arrow tool

The Arrow tool must be selected before you can manipulate arrows. 

To select the Arrow tool, click on the arrow button ( ) in the 

floating tool palette. Note that the cursor changes to an arrow.

Arrows and nodes

Arrow from variable node to variable node

Indicates that the target variable depends on the origin variable.

Arrow from variable node to module node

Indicates that at least one variable in the target module depends on 
the origin variable.

Arrow from module to
variable

Arrow from variable
to module

The Arrow tool is highlighted
to show

that it is selected
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Arrow from module node to variable node

Indicates that the target variable depends on at least one variable in 
the origin module.

Arrow from module node to module node 

Indicates that the target module contains at least one variable that 
depends on at least one variable in the origin module.

Double-headed arrow between module nodes

Indicates that each module contains at least one variable that 
depends on at least one variable in the other module.

Small arrowhead to the right or left of a variable node

Indicates that the variable has a remote input or output—a variable 
that is not inside the displayed variable’s module (see “Finding 
remote inputs and outputs” on page 22). 

Creating and removing arrows

To draw an arrow, first be sure the arrow tool ( ) is selected.

1. Drag from the origin node (it becomes highlighted) to the 
destination node (which also becomes highlighted).

2. When you release the mouse button, the arrow is drawn.

To draw multiple arrows to a single destination node, select all the
origin nodes. Then drag from any origin node to the destination no

To remove an arrow, do one of the following:

• Select the arrow, then press the Backspace or Delete key.

• Repeat the process of drawing an arrow from the origin node to 
destination node.
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Analytica Note:  An arrow is also drawn whenever the identifier of a 
variable is added to the definition of a variable (see “Creating or editin
a definition” on page 135). 

Model changes when creating an arrow

Creating an arrow between two nodes changes the model. The change 
depends on the classes of the two nodes.

Arrow between two variable nodes

When you draw an arrow from a variable node A to another 
variable node B, A becomes an input of B. You can then use this 
input in creating or editing the definition of B. (See Chapter 8, 
“Creating and Editing Definitions”.)

Arrow between a variable node and a module node

When you draw an arrow from a variable into a module, or from
module to a variable, Analytica creates an alias of the variable 
inside the module (see “Creating alias nodes” on page 74). You 
then open the module and draw arrows between the alias and o
variables in the module.

Arrow between two module nodes

When you draw an arrow from one module node to another, 
Analytica creates a new variable node in the first module and an
alias of that variable in the second module (see “Creating alias 
nodes” on page 74). You can then open each module and draw
arrows between the new nodes and other variables in the modu

Model changes when deleting an arrow

If B already has a definition that includes A and you delete the arrow 
from A to B, Analytica removes A from B’s definition. For example, if 
A is an index and B is defined as a table, Analytica removes A as an 
index of B.
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In some cases, removing A does not leave a valid definition for B (for 
example, when A is part of a mathematical expression such as 1/A). 
Under these circumstances, A is replaced with the keyword Expr and 
the entire expression is surrounded with FunctionOf(). This notation 
indicates that the definition is invalid and must be edited.

Cyclic dependency

A cyclic dependency occurs when a variable depends on itself directly 
or indirectly so that the arrows form a directed circular path. 

A cyclic dependency is permitted only in a dynamic model (see 
Chapter 17, “Modeling Changes over Time”), provided that the 
variable depends on its value in an earlier time period. 

Drawing arrows between variables in different 
modules

There are two direct methods and two indirect methods for drawing
arrow between two variables in different modules. The following 
examples demonstrate the direct methods of drawing an arrow fro
the variable Buying price to the variable Mortgage loan amount in 
another module (see the following figure).

Drawing arrows across windows
1. Open both module Diagram windows and bring to the top the 

module Diagram window containing the origin variable, Buying 
price.

2. Position the Diagram windows so the variable Mortgage loan 
amount is exposed in the window underneath.
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Drawing arrows between variables in different modules
3. Draw an arrow from the origin variable (Buying price) to the 
second variable (Mortgage loan amount). 

Result

An arrow points from Buying price to the Cost to Buy module; a small 
arrowhead points into Mortgage loan amount to indicate that a source 
node is in a different diagram. 

Moving, drawing, and moving back
1. Select Mortgage loan amount, then choose Move Into Parent 

from the Diagram menu to move the variable into the parent 
diagram.

Destination 
variable

Source node

Small arrowhead
indicates that this

variable has remote
inputs
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2. Draw an arrow from Buying price to Mortgage loan amount.

3. Move Mortgage loan amount back into its module by dragging it 
onto the Cost to Buy module node.

Indirectly drawing an arrow

The two indirect methods of drawing an arrow between two variables 
in different modules are:

• Edit the definition of the target variable, entering the identifier of
the input variable directly (see “Creating or editing a definition” o
page 135). The arrow appears when the definition is accepted.

• Use an alias node (see “Creating alias nodes” on page 74).

Creating alias nodes

An alias is a copy of a node, referring to the same variable or mod
as the original node. You can use an alias node to display the sam
variable in more than one module diagram. For example, often the
inputs to a variable are in one module, while its outputs are in oth
modules. To display an input variable’s node in the modules 
containing the outputs, create an alias in each of those modules. 

A variable or module can have only a single original node. You ca
create an unlimited number of alias nodes for any original node.

Create an alias in any of the three following ways:

Use the Make Alias command

Select the original node. Then choose the Make Alias option from the 
Object menu(Ctrl-M). The alias node appears next to the original 
node. You can then move it into another module by dragging it.

Use this method to make an alias of a module, if you want to show
module node in more than one diagram.

Original node

Alias node
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Draw arrow between variable and module

Draw an arrow from the original node to a module node, or from the 
module node to the original node. An alias for the original node 
appears in the module.

Example:

Draw an arrow from a variable (Buying price) to a module (Cost to 
Buy).

An arrow is displayed from the Buying price variable to the Cost to Buy 
module.

The new alias node appears in the diagram for the Cost to Buy module.
Analytica User Guide 75



Chapter Creating and Editing a Model4
Draw arrow between two modules

Draw an arrow from one module node (Cost to Buy) to another module 
node (Total Cost). 

Analytica creates a new variable node with a default title, such as Va1, 
in the first module, and creates an alias of Va1 in the second module.

Using an alias node

An alias looks and behaves similar to the original node that it is 
derived from, except that its title is in italics.

Analytica Note:  An alias of a module does not display any input or 
output arrows.

You can treat an alias node just as if it were the original node. Click 
once on an alias to select it (for example, to display its result). Double-
click on an alias to open the Object window for the original node. 

To use a variable with an alias as an input to another node, draw an 
arrow either from the original node or from its alias.

To create a new input to a variable with an alias, draw an arrow either 
to the variable or to its alias. An arrow to an alias of a variable creates 
a corresponding arrow to its original node in its diagram, if the original 
node is in the same module as the new input or an alias of the new 
input. 
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Modifying an alias node

When you create an alias node, it looks just like its original node, 
including its node shape, color, label font, and icons. The only 
difference is that the title is in italics. 

If you edit the title of an alias, the title of the original node changes to 
match the alias. Conversely, if you edit the title of the original node, 
the alias’s title changes to match the original.

To change the appearance of an alias node alone, use the Set Node 
Style option from the Diagram menu (see “Node Style dialog box” on
page 113).   If you use the Node Style dialog box to change the 
appearance of an alias node, its original node does not change. 
Similarly, using the Node Style dialog box to change the appearan
of an original node does not affect any of its previously created alia

Editing an attribute of a node

You can edit a user-modifiable attribute either in the Attribute pan
(see “The Attribute panel” on page 27) or in the Object window (se
“The Object window” on page 25). To change a node’s class, see 
“Changing the class of a node” on page 78.

To edit an attribute: 

1. If in the attribute panel, select the attribute in the attribute 
popup menu.

2. Click in the attribute field. If a gray outline appears around the 
attribute and the cursor is blinking, the attribute is 
user-modifiable.

3. Edit the attribute using the standard text-editing methods.

The edited text is stored when you click anywhere outside the attrib
field, or when you press Alt-Enter.

Attribute changes

Any changes to attributes propagate to all other displayed window
For example, if you change the title of an object, the new title is 
displayed in that object’s diagram. If you change the definition of a
variable, the arrows are redrawn to reflect changes in dependenc
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Cancel and Undo

While you are editing an attribute, you can cancel and revert to the 
previous value at any time by pressing the Esc (escape) key. If you 
have finished entering the value of the attribute, but now want to revert 
to the previous value of the attribute, select Undo from the Edit 
menu(Ctrl-Z).

Changing the class of a node

Use the Class popup menu to change the class of a node. This menu 
appears:

• In the top left corner of the Object window.

• In the Attribute panel when Class is the selected attribute.

The contents of the Class popup menu depend on whether the no
a variable or a module (see the preceding figure). 

Analytica Note:  You cannot change a variable into a module, or vice 
versa. You also cannot change a function into a variable or module, or 
vice versa.

To change a node’s class, press on the Class popup menu and se
another class. 

Variable classes

Module classes
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The variable classes are described in the section “Recognizing nod
on page 23. The module classes are described below.

Model

A module or hierarchy of linked modules that you work on during
session with Analytica. A model is saved in a file (an Analytica 
document) between sessions. Only a model saves preferences 
“Preferences dialog box” on page 80) and uncertainty options (s
see “Uncertainty Setup dialog box” on page 284).

Module

A collection of nodes that are displayed in a single diagram. A 
module is depicted on its parent diagram as a rounded node wit
thick outline. 

Filed Module

A module whose contents are saved in a file separate from the 
model that contains it. A filed module can be shared among seve
models, without having to make a copy for each model. See “Us
filed modules and libraries” on page 393.

Library

A module that contains functions and/or variables. User libraries
appear in the Definition menu below the system function libraries
giving easy access to their contents. See “Libraries” on page 41

Filed Library

A library whose contents are saved in a file separate from the mo
that contains it. A filed library can be shared among several mod
without having to make a copy for each model. See “Using filed
modules and libraries” on page 393.

Form

A module that creates an input node alias or an output node alia
when you draw an arrow from a node to the form. See Chapter 
“Creating Models to be Used by Others”.
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Preferences dialog box

Use the Preferences dialog box to inspect and set a variety of 
preferences for the operation of Analytica. All preference settings are 
saved with a model of class Model. 

To display the Preferences dialog box, select Preferences from the 
Edit menu.

Windows of each kind

Use the options in this box to control how many windows of various 
kinds are displayed at once (see “Managing windows” on page 40

One only

Check this box to close an existing window (if there is one) 
whenever you open a new window. 

Any number

Check this box to keep all windows open until you explicitly clos
them.

Result windows

Enter a value in this field to indicate the number of Result windo

Window control options Result format 
options

Variable naming options

Edit attribute options
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that you can keep open simultaneously. The default (and minimum) 
number is 2; the maximum number is 20.

Change Identifier

Use the options in this box to control the changing of identifiers. See 
“Creating and editing nodes in a diagram” on page 64 for a descript
of how identifiers are initially assigned.

When title changes

Check this box to change a variable’s identifier whenever you 
change its title. Analytica uses up to the number of specified 
characters (20 by default, range from 2 to 20), replacing spaces
returns with an underscore character (_), and omiting anything 
between parentheses.

If the box is not checked, the identifier is changed only when yo
explicitly edit it. 

Ask before renaming

Check this box to see a confirmation dialog box before automat
changing of a variable’s identifier.

 Opens

Use the options in this box to specify the window that displays wh
you select the edit definition button (Ctrl-E). When you are prompt
(for example, via an error message) to edit a definition, and you cl
on OK, this preference setting determines the window to display.

Object window

Select this option to open the Object window and select the 
definition text.

Diagram attribute panel

Select this option to open the Attribute panel on the appropriate
Diagram window and select the definition text.
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Default result view

Use the options in this box to control how data appear in Result 
windows the first time a result is calculated for a node (see “The Re
window” on page 37).

 Select this option to display a table.

 Select this option to display a graph. 

Checkboxes

Use these checkboxes to control various aspects of how Analytica
looks and behaves.

Check variable class

If checked, a warning displays for the following inconsistencies 
between a variable’s class and definition:

- A non-chance variable whose definition includes a probability
distribution.

- A constant whose definition is dependent on any other variabl
However, a constant defined as a table may have indexes as 
inputs.

- An index variable defined as a single value, array, or any 
function other than Sequence().

Check value bounds

If checked, the check attributes are computed. See “Checking th
validity of a variable’s values” on page 146.

Show undefined

If checked, nodes without a valid definition display with a cross-
hatch pattern.

Node is filled with diagonal pattern: the 
definition is missing
or is syntactically incorrect
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Show module hierarchy

If checked, a bar at the top of each Diagram window indicates the 
hierarchy depth of the active module. See “Show module hierarc
preference” on page 385.

Show result warnings

If checked, when a warning condition is encountered during res
evaluation, evaluation is interrupted, and a warning message 
displays for action. If unchecked, when a warning condition is 
encountered during result evaluation, no warning message is 
displayed, and evaluation continues.

Use Return to enter data

A standard windows keyboard has a Return key located on the 
alphanumeric section of the keyboard, and a separate Enter key
located on the numeric keyboad. When this checkbox is unchec
(the default), the Return key starts a new line in a multi-lined tex
field (such as a definition) while the Enter key or Alt-Return sign
that the data entry is complete. When this checkbox is checked,
these are reversed, with Enter or Alt-Return starting a new line a
Return completing the entry of data.

Auto recompute outgoing OLE links

If you have used the OLE linking feature to linked an Analytica 
result in your model to an external application, this checkbox 
controls whether this data is automatically recomputed and upda
whenever the result, or anything the result depend on, changes
When making several changes in computationally intensive 
models, it is often convenient to turn this checkbox off so that lar
recomputations after each small change. See OLE linking in 
“Chapter 18” beginning on page 363.
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Chapter 5

Building 
Effective Models



In this Chapter

This chapter shows you how to build 
models that are

• Focused

• Simple

• Clear

• Comprehensible

• Correct
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Creating useful models is a challenging activity, even for experienced 
modelers; effective use of influence diagrams can make the process 
substantially easier and clearer. This chapter provides tips and 
guidelines from master modelers (including Newton and Einstein) on 
how to build a model that is effective— that focuses on what matte
and that is simple, clear, comprehensible, and correct. The key is 
start simple and progressively refine and extend the model where t
of initial versions suggest it will be most important. 

Most of the material in this chapter, unlike the other chapters in th
User Guide, is not specific to Analytica. These guidelines are usefu
whether you are using Analytica, a spreadsheet, or any other mode
tool. However, Analytica makes it especially easy to follow these 
guidelines, using its hierarchical influence diagrams, uncertainty 
tools, and Intelligent Arrays.

These guidelines have been distilled from many years of experienc
master modelers, using Analytica and a variety of other modeling 
software. However, they are general guidelines, not rules to be 
adhered to absolutely. We suggest you read this chapter early in y
work with Analytica and revisit it from time to time as you gain 
experience.

Creating a model

Below are general guidelines to help you build models that provide 
greatest value with the least effort. 

Identify the objectives

What are the objectives of the decision maker? Sometimes the 
objective is simply to maximize expected monetary profit. More ofte
there are a variety of other objectives, such as maximizing safety,
convenience, reliability, social welfare, or environmental health, 
depending on the domain and the decision maker. Utility theory an
multiattribute decision analysis provide an array of methods to he
structure and quantify objectives in the form of utility. Whatever 
approach you take, it is important to represent the objectives in an
explicit and quantifiable form if the objectives are to be the basis f
recommending one decision option over another.
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It is a useful convention to put the objective variable or variables 
(hexagonal nodes) on the right of the diagram window, leaving space 
on the left side for the rest of the diagram.

The most common mistake in specifying objectives is to select 
objectives that are too narrow, by concentrating on the most easily 
quantifiable objective—typically, near-term monetary costs—and t
forget about the other, less tangible objectives. For example:

• When buying software you may want to consider the usability an
reliability of different software packages, not just cost and 
performance.

• In pricing a product, you may want to consider the long-term 
effects of increased market share in developing new customers
markets and not just short-term revenues.

• In selecting a medical treatment, you may want to consider the 
quality of life if you survive the treatment, and not just the 
probability of survival. 

For an excellent guide on how to identify and structure objectives, 
Value-Focused Thinking by Ralph Keeney. 

Identify the decisions

The purpose of modeling is usually to help you (or your colleague
organization, or clients) discover which decision options will best 
meet your (or their) objectives. You should aim, therefore, to inclu
the decisions and objectives explicitly in your model. 

A decision variable is one that the decision maker can affect directl
which computer to buy, how much to bid on the contract, which 
medical treatment to choose, when to start construction, and so o
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Occasionally, people want to build a model just for the sake of 
furthering understanding, without explicitly considering any 
decisions. Most often, however, the ultimate purpose is to make a 
better decision. In those cases, the decision variables are where you 
should start your model.

When starting a new influence diagram, put the decision variables
as rectangular nodes—on the left of the diagram window, leaving 
space for the rest of the influence diagram to the right.

Link the decisions to the objectives

The decisions and objectives are the starting and ending points of y
model. Once you have identified them, you have reduced the diag
construction to the process of creating the links between the decis
and objectives, via intermediate variables. You may wish to work 
forward from the decisions, or backward from the objectives. Som
people find it easiest to alternate, working inward from the left and t
right until they can link everything up in the middle.
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It helps to identify the decisions and objectives early during model 
construction, to maintain focus on what matters. There may be a 
bewildering variety of variables in the situation that may seem to be of 
potential relevance. But, you only need to worry about variables that 
influence how the decisions might affect the objectives. You can 
ignore any variable that has no effect on the objectives.

Focus on identifying the variables that make clear distinctions—
variables whose interpretations won’t change with time or viewer. 
Extra effort here will be repaid in model accuracy and cogency.

Move from the qualitative to the quantitative

An influence diagram is a purely qualitative representation of a mod
It shows the variables and their dependencies. It is usually best to d
in most or all of the first version of your model just as an influence
diagram, or hierarchy of diagrams, before trying to quantify the valu
and relationships between the variables. In this way, you can 
concentrate on the essential qualitative issues of what variables t
include, before having to worry about the details of how to quantif
the relationships. 

When the model is intended to reflect the views and knowledge o
group of people, it is especially valuable to start by drawing up 
influence diagrams as a group. A small group can sit around the 
computer screen; for a larger group, it is best if you have the mean
project the image onto a large screen, so that the entire group can
and comment on the diagram as they create it. The ability to focus
the qualitative structure initially lets you involve early in the proce
participants who might not have the time or interest to be involved
the detailed quantitative analysis. With this approach, you can ofte
obtain valuable insights and early buy-in to the modeling process fr
key people who would not otherwise be available. 

Keep it simple

“A theory should be as simple as possible, but no simpler.” 
Albert Einstein

Perhaps the most common mistake in modeling is to try to build a 
model that is too complicated or that is complicated in the wrong 
ways. Just because the situation you are modeling is complicated 
doesn’t necessarily mean your model should be complicated. Eve
model is unavoidably a simplification of reality; otherwise it would
not be a model. The question is not whether your model should be
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simplification, but rather how simple it should be. A large model 
requires more effort to build, takes longer to execute, is harder to test, 
and is more difficult to understand than a smaller model. And it may 
not even be more accurate.

Reuse and adapt existing models 

“If I have seen further than [others] it is by standing 
upon the shoulders of Giants.” 
Sir Isaac Newton

Building a new model from scratch can be a challenge. If you can find 
an existing model for a problem similar to the one you are now facing, 
it is usually much easier to start with the existing model and adapt it 
to the new application. In some cases, you may find parts or modules 
of existing models that you can extract and combine to address a new 
problem. 

To find a suitable model to adapt, you can start by looking through the 
example models distributed with Analytica. If there is an Analytica 
users’ group in your own organization, it may collect a model libra
of classes of problems of interest to your organization. 

Aim for clarity and insight

The goal of building a model is to obtain clarity about the situation
about which decision options will best further your objectives, and
why. If you are already clear about what decision to make, you do
need to build a model, unless, perhaps, you are trying to clarify th
situation and explain the recommended decisions for others. Eithe
way, your goal is greater clarity. This goal is another reason to aim
simplicity. Large and complicated models are harder to understan
and explain. 

Testing and debugging a model

Even with Analytica, it is rare to create the first draft of a model 
without mistakes. For example, on your first try, definitions may no
express what you really intended. It is important to test and evalu
your model to make sure it is expresses what you have in mind. 
Analytica is designed specifically to make it as easy as possible to
scrutinize model structures and dependencies, to explore model 
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implications and behaviors, and to understand the reasons for them. 
Accordingly, it is relatively easy to debug models once you have 
identified potential problems. 

Test as you build

With Analytica, you can evaluate any variable once you have provided 
a definition for the variable and all the variables on which it depends, 
even if many other variables in the model remain to be defined. We 
recommend that you evaluate each variable as soon as you can, 
immediately after you have provided definitions for the relevant parts 
of the model. In this way, you’ll discover problems as soon as poss
after specifying the definitions that may have caused them. You c
then try to identify the cause and fix the problem while the definitio
are still fresh in your memory. Moreover, you’ll be less likely to repe
the mistake in other parts of the model. 

If you wait until you believe you have completed the model before
testing it, it may contain several errors that interact in confusing wa
Then you’ll have to search through much larger sections of the mo
to track them down. But if you have already tested the model 
components independently, you’ll have already removed most of t
errors, and it will usually be much easier to track down any that 
remain.

Test the model against reality

The best way to check that your model is well-specified is to comp
its predictions against past empirical observations. For example, i
you’re trying to predict future changes in the composition of acid ra
you should try to compare its “predictions” for past years for which
you have empirical observations. Or, if you’re trying to forecast th
future profitability of an existing enterprise, you should first calibra
your model for past years for which accounting data are available

Test the model against other models

Often you don’t have the luxury of empirical measurements or data
the system of interest. In some cases, you’re building a new mode
replace an old model that is out-of-date, too limited, or not 
probabilistic. In these cases, it is usually wise to start by 
reimplementing a version of the old model, before updating and 
extending it. You can then compare the new model against the old 
to check for discrepancies. Of course, differences may be due to er
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in the new model or the old model. Once you have resolved any 
discrepancies, you can be confident that you are building on a 
foundation that you understand.

If the model is hard to test against reality in advance of using it, and if 
the consequences of mistakes could be catastrophic, you can borrow a 
technique that NASA uses widely for the space program. You can get 
two independent modelers (or two modeling teams) each to build their 
own model, and then check the models against each other. It is 
important that the modelers be independent, and not discuss their work 
ahead of time, to reduce the chance that they will both make the same 
mistake. For a sponsor of models for critical applications in public or 
private policy, this multiple model approach can be very effective and 
insightful. The competition keeps the modelers on their toes. 
Comparing the models’ structure and behavior often leads to valua
insights. 

Have other people review your model

It’s often very helpful to have outside reviewers scrutinize your 
model. Experts with different views and experiences may have 
valuable comments and suggestions for improving it. One of the 
advantages of using Analytica over conventional modeling 
environments is that it’s usually possible for an expert in the doma
to review the model directly, without additional paper documentatio
The reviewer can scrutinize the diagrams, the variables, their 
definitions, and the behavior of the model electronically. You can 
share models electronically on diskette, over a network, or by 
electronic mail. 

Test model behavior and sensitivities

Many problems become immediately obvious when you look at a 
result—for example, if it has the wrong sign, the wrong order of 
magnitude, or the wrong dimensions, or if Analytica flags an 
evaluation error. Other problems, of course, are not immediately 
obvious—for example, if the value is wrong by only a few percenta
points. For more thorough testing, it is often helpful to analyze the
model behavior by specifying a list of alternative values for one or t
key inputs (see Chapter 3, “Analyzing Model Behavior”), and to 
perform sensitivity analysis (see Chapter 16, “Analyzing Uncertain
and Sensitivity”). If the model behaves in an unexpected way, this m
be a sign of some mistake in the specification. For example, supp
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that you are planning to borrow money to buy a new computer, and the 
net value increases with the interest rate on the loan; you might suspect 
a problem in the model.

Celebrate and learn from unexpected behavior

If analyzing the behavior or sensitivities of your model creates 
unexpected results, there are logically two possibilities: 

• Your model contains an error, in that it does not correctly expres
what you intended. 

• Your expectations about how the model should behave were wro

You should first check the model carefully to make sure it contains
errors, and does indeed express what you intended. Explore the m
to try to figure out how it generates the unexpected results. If afte
thorough exploration you can find no mistake, and the model pers
in its unexpected behavior, do not despair! It may be that your 
intuitions were wrong in the first place. This discovery should be a
cause for celebration rather than disappointment. If models alway
behaved exactly as expected, there would be little reason to build
them. The most valuable insights come from models that behave 
counter-intuitively. When you understand how their behavior arise
you can deepen your understanding and improve your intuition—
which is, after all, a fundamental goal of modeling. 

Document the model as you build it

Give your variables and modules meaningful titles, so that others—
you, when you revisit the model a year later—can more easily 
understand the model from looking at its influence diagrams. It’s 
better to call your variable Net rental income than NRI23.

It’s also a good idea to document your model as you construct it b
filling in the Description and Units attributes for each variable and
module. You may find that entering a line or three of description fo
each variable explaining clearly what the variable represents will h
to keep you clear about the model. Entering units of measurement
each variable can help you avoid simple mistakes in model 
specification. Avoid the temptation to put documentation off until th
end of the project, when you may run out of time, or may have 
forgotten key aspects.
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Most models, once built, spend the majority of their lives being used 
and modified by people other than their original author. Clear and 
thorough documentation pays continuing dividends; a model is 
incomplete without it.

Expanding your model

Extend the model by stages

The best way to develop a model of appropriate size is to start with a 
very simple model, and then to extend it in stages in those ways that 
appear to be most important. With this approach, you’ll have a usa
model early on. Moreover, you can analyze the sensitivities of the
simple model to find out where the key uncertainties and gaps are,
use this to set priorities for expanding the model. If instead you try
create a large model from the start, you run the risk of running out
time or computer resources before you have anything usable. And 
may end up putting much work into creating an elaborate module 
an aspect of the problem that turns out to be of little importance.

Identify ways to improve the model

There are many ways to expand a model:

• Add variables that you think will be important. 

• Add objectives or criteria for evaluating outcomes. 

• Expand the number of decision options specified for a decision 
variable, or the number of possible outcomes for a discrete cha
variable. 

• Expand a single decision into two or more sequential decisions,
with the later decision being made after more information is 
revealed.

• For a dynamic model, expand the time horizon (say, from 10 yea
to 20 years) or reduce the time steps (say, from annual to quarte
time periods). 

• Disaggregate a variable by adding a dimension (say, projecting 
sales and costs by each division of the company instead of only
the company as a whole).
Analytica User Guide 95



Chapter Building Effective Models5

rt. 
re 

nd 

le, 

t to 
ng 
 

lly, 
ll 
 on 
e 

me 

on 

le 

 
ta, 
to 

plex 
r 
ider 
Before plunging in to one of these approaches to expanding a model, 
it’s best to list the alternatives explicitly and think carefully about 
which is most likely to improve the model the most for the least effo
Where possible, perform experiments or sensitivity analysis to figu
out how much effect alternative kinds of expansion may have. 

Changing the size or numbers of dimensions of tables is a difficult a
time-consuming task in conventional modeling environments. 
Analytica makes it relatively easy, since you only need to change 
those definitions that directly depend on the dimension (for examp
the edit tables).

Discover what parts are important to guide expansion

A major advantage of starting with a simple model is that you use i
guide extensions in the ways that will be most valuable in improvi
the model’s results. You can analyze the sensitivities of the simple
model (for example, using importance analysis, as described in 
“Importance analysis” on page 343) to identify which sources of 
uncertainty contribute most to the uncertainty in the results. Typica
only a handful of variables contribute the lion’s share of the overa
uncertainty. You can then concentrate your future modeling efforts
those variables and avoid wasting your energy on variables whos
influence is trivial. 

Early intuitions about what aspects of a model are important are 
frequently wrong, and the results of the sensitivity analysis may co
as a surprise. Consequently, it’s much safer to base model 
development on sensitivity analysis of simple models than to rely 
your intuitions about where to spend your efforts in model 
construction.

Once you have identified the most important variables in your simp
model, there are several ways to reduce the uncertainty they 
contribute. You can refine the estimated probability distribution by
consulting a better-informed expert, by analyzing more existing da
by collecting new data, or by developing a more elaborate model 
calculate the variable based on other available information. 

Simplify where possible

There’s no reason that a model must grow successively more com
as you develop it. Sensitivity analysis may reveal that a variable o
submodel is just not very important to the results. In this case, cons
eliminating it. You may find that some dimensions of tables are 
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unimportant—for example, that there’s little difference in the 
performance of different divisions. If so, again, consider aggregat
over the divisions and eliminating that dimension from your mode

Simplifying a model has many benefits. It becomes easier to 
understand and explain, faster to run, and cheaper to maintain. Th
savings may afford you the opportunity to elaborate on more 
significant aspect of the model.
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Chapter 6

Creating Lucid 
Influence 
Diagrams



In this Chapter

This chapter shows you how to:

• Build influence diagrams

• Customize your diagrams



This chapter presents guidelines for building influence diagrams in 
Analytica and explains how to customize your diagrams.

Hierarchical influence diagrams can provide an intuitive form to 
display the essential qualitative structure of a model with great clarity, 
uncluttered by the quantitative details. 
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It is also possible to create influence diagrams that are impenetrable 
spaghetti! 

Guidelines for creating lucid and elegant diagrams

Where aesthetics are involved, rules cannot be hard and fast. You may 
want to adapt and modify these guidelines to suit your particular 
applications.

Use clear, meaningful node titles

Aim to make each diagram stand by itself and be as comprehensible as 
possible. Each node title can contain up to 255 characters of any kind, 
including spaces. Use clear, concise language in titles, not private 
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codes or names (as are often used for naming computer variables). 
Mixed-case text (first letter uppercase and remaining letters 
lowercase) is clearer than all letters uppercase.

Use consistent node sizes

Diagrams usually look best if most of the variable nodes are of the 
same size, rather than sized to fit their title text.

Node sizes will be uniform if you set the default minimum node size 
in the Diagram Style dialog box (see page 111) large enough so that it 
will fit the full title for almost all of the nodes. The default minimum 
is used unless the text is too lengthy, in which case the node expands 
vertically to fit the text.

Good object titlesPoor object titles

Inconsistent node sizes Consistent node sizes
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If you have nodes of several different sizes, you can make them more 
consistent by selecting Adjust Size (Ctrl-T) from the Diagram menu. 
All of the selected nodes are resized to the default minimum node size, 
or the minimum size needed to enclose each node’s title, whicheve
larger.

You can also resize several nodes by the same amount simultaneo
by following these steps:

1. Select the nodes to resize.

2. Resize one of the selected nodes by dragging one of its handles. 
All the other selected nodes are also resized.

Use small and large nodes sparingly

Sometimes it is more effective to make a few specialized nodes e
large or small. For example, start and end nodes, which may link 
other models, often look best when they are very small. Converse
you may want to make key input nodes containing large tables or 
model nodes containing the “guts” of a model unusually large to 
convey their importance.

Arrange nodes from left to right (or top to bottom)

People like to read diagrams, like text, from left to right, or top to 

bottom.1 Try to put the decision node(s) on the left or top and the 
objective node(s) on the right or bottom of the diagram, with all of t
other variables or modules arranged between them. 

1. For applications in Arabic, Hebrew, or other languages written from right to left, 
you may want to reverse this convention.
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You may want to allow a few arrows to go counter to the general flow 
in order to reduce crossing arrows, or overlaps. In dynamic models, 
there may be feedback loops (depicted with dashed arrows), which 
may appropriately go counter to the general flow.

Tolerate spaghetti at first…

It is often hard to figure out a clear diagram arrangement in advance. 
It is usually easiest to start a new model using the largest Diagram 
window you can get. Click the maximize box to have the diagram fill 
your screen. You may want to create key decisions and other input 
nodes near the left or top of the window, and objectives or output 
nodes near the right or bottom of the window. Aside from that, create 
nodes wherever you like, without worrying too much about clarity.

…reorganize later

When you start linking nodes, the diagram may start to look tangled. 
This is the time to start reorganizing the diagram to create some 
clarity. Try to move linked nodes together into a module. Develop 
vertical or horizontal lines of linked nodes. Accentuate symmetries, if 
you see them. Gradually, order will emerge.

Decision variables on
the left

Objective variable on the right
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Align nodes horizontally or vertically

It usually looks best to align nodes with their centers on the same 
horizontal or vertical lines, so that many arrows are exactly horizontal 
or vertical. The square grid of 9x9 points underlying each diagram 
makes this easy. When Resize Centered is selected in the Diagram 
menu (the default), each node is centered on a grid point. 

If nodes are not centered on a grid point, recenter them by following 
these steps:

1. Select all nodes in the diagram with the Select All (Ctrl-A) 
command from the Edit menu.

2. Select Align Selection To Grid from the Diagram menu.

Hide less important arrows

Sometimes nodes are so interrelated that it is hard or impossible to 
arrange a diagram to avoid arrows crossing each other or crossing 
nodes. It may be helpful to hide some arrows that show less important 
linkages. For example, indexes are often connected to many other 
variables; therefore, hiding the arrows from indexes can greatly 
simplify a diagram. 

You can hide all of the arrows linking indexes, functions, or modules, 
or the dashed feedback arrows in dynamic models, using the Set 
Diagram Style command from the Diagram menu (see page 111). 
You can also hide the input or output arrows from each node 
individually, using the Set Node Style command (see page 113).

Good alignmentPoor alignment
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Keep diagrams compact

Screen space is valuable. To save space, keep nodes close together, 
leaving enough space between them for the arrows to be visible. 

When first creating a diagram, use plenty of space. Your diagram 
window can be as large as your monitor screen. Using this space, find 
a clear arrangement, one that minimizes arrow crossing and avoids 
node overlaps. 

After you have a clear arrangement, you can usually make the diagram 
more compact by moving the nodes closer together and moving the 
entire diagram closer to the upper left corner of the window. You can 
then reduce the window size to fit the diagram

A spread-out diagram

A compact diagram
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Organizing a module hierarchy

In addition to properly arranging the nodes in a single diagram, you 
can also improve the clarity of your models by using module 
hierarchies effectively.

Group related nodes in the same diagram

When assigning nodes to diagrams, the goal is to put groups of nodes 
with many links among them in the same diagram, and to separate 
them from other groups with which they have few or no links. For 
example, the diagram below shows that a group of nodes related to 
annual housing costs have been organized into the Annual costs 
module within the larger model.

Sometimes you have a good idea of how to group nodes before you 
create them. In such cases, it is easy to create the modules first, and 
then create and link the nodes in groups in each module.
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In other cases, it may not be obvious what groupings will work best. It 
is then often best to create all the nodes in a single large diagram. After 
drawing all the arrows, you may have a confusing spaghetti diagram. 
At this point, try to move the nodes around to identify groups 
containing 5 to 15 nodes, with many links within each group and fewer 
links between groups. When you arrive at a satisfactory grouping, 
create a module node for each group and move the group of variables 
into its own module.

Use 5 to 15 nodes per diagram

In creating a hierarchy of diagrams of a model that contains 100 
variables, you could create a single module with 100 nodes, 10 
modules with an average of 11 nodes each, 20 modules with 6 nodes 

each, or 50 modules with 3 nodes each.1 

A module containing more than 15 nodes is often hard to decipher, 
unless there are very strong regularities in the structure. On the other 
hand, if the modules are small, averaging fewer than 5 nodes, you need 
so many modules that it is easy for users to get lost.

The range of 5 to 15 nodes per diagram is a good general goal. But 
don’t feel too constrained by it if a few diagrams must be much sma
or larger than this range.

Contrast the module hierarchy in the illustration on page 108 with 
spaghetti on page 102. The relationships among objects are much
easier to see and understand in the model with 10 nodes in the to
level module and 12 nodes in the embedded module (page 108) t
in the model with 25 top-level nodes (page 102).

Color in influence diagrams

Color can greatly improve the clarity and appeal of diagrams. The
diagram’s background and its nodes are all lightly colored by defa
You can change the colors to meet your special needs.

1. Each module also creates a new node, so the total number of nodes is the number 
of variables plus the number of modules.
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Use colors judiciously

Selecting garish, uncoordinated colors can take attention away from 
the diagram. Light colors work best because the black arrows and text 
are easier to read over them. Analytica’s default colors provide a li
neutral color for the background and a slightly stronger color for th
nodes.

Background color

Light background colors work best so that the black arrows displa
clearly. 

Node colors

If you wish to change the color of nodes, it is best to have all simi
nodes be the same color. It generally looks messy to have nodes 
many different colors.

Changing background or node colors

To change the color of the diagram background, or one or more no
select the Edit Tool and bring the diagram window to the front. Sel
Show Color Palette from the Diagram menu.

Select the node or nodes, or click in the diagram background to se
the background for changing color. The current color displays in th
single square at the top of the color palette. Click on a color squar
select the new color.

For more color selections, click on the Other button to display a color 
wheel with the colors available on your monitor.

In the color wheel, select a color by clicking with the mouse pointer
the desired color.
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Diagram Style dialog box
Grouping nodes by color

Additional visual organization can be achieved by grouping related 
nodes in rectangular boxes of varying colors, as used in the following 
form.

To create grouping rectangle, create a text node using the T button on 
the toolbar palette, leave the text blank or enter text as desired, and 
resize the node to the size of the group. When resizing, you may find 
it convenient to deselect the Resized centered option on the Diagram 
menu. With the node selected, check the fill color option on the Set 
Node Style... dialog from the Diagram menu, and use the color palette 
to choose the background color. Finally, if the rectangle is obscuring 
other items on the digram, select Send to Back from the right mouse 
button menu.

If you plan to print your diagram on a black and white printer, you 
should select a color other than pure white, or include a node border 
for the group (from the Set Node Style dialog). Since Analytica 
suppresses the diagram background color when printing to a black and 
white printer, pure white groupings without borders will not show up 
on printouts.

Diagram Style dialog box

Use the Diagram Style dialog box to control various aspects of the 
diagram display: the default font size and typeface for the node labels, 
whether arrows are displayed for specified node classes, and the 
default node size. 
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To display the Diagram Style dialog box, select Set Diagram Style... 
from the Diagram menu.

Show arrows to/from

Use the options in this box to control various arrow displays.

Indexes

Turns on or off the display of arrows into and out of index 
variables. 

Functions

Turns on or off the display of arrows into and out of functions.

Modules

Turns on or off the display of arrows into and out of modules. 

Dynamic

Shows and hides dynamic arrows (for variables defined using the 
Dynamic() function, see page 350).

Diagram arrow
display options

Diagram font
style options

Drag to set default
node size
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Node Style dialog box
Default node size

Drag the handle in this box to set the default node size. When you 
create a new variable or select the Adjust Size command from the 
Diagram menu, the node is made this size. When you change the title 
of a node, its size is adjusted to this size if the new title fits within it.

Font Style

Use the options in this box to set a default typeface and font (size) for 
all the nodes in the model.

Node Style dialog box

Use the Node Style dialog box to control the display of one or more 
nodes in a diagram. 

You can specify the typeface and font (size), and whether to display 
the incoming arrows, outgoing arrows, the node outline, or the node 
label. The options for each node override the defaults specified for the 
entire diagram in the Diagram Style dialog box.

Changing the node style

To change the node style:

1. Select one or more nodes.

2. Choose Set Node Style... from the Diagram menu.
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Display

Use the options in this box to control various display options:

Input arrows

Display arrows coming into a node.

Output arrows

Display arrows going out of a node.

Label

Display the node label (title or identifier).

Border

Display the node border.

Fill color

Display the node color. If unchecked, the node will appear 
transparent.

Checkbox filled in
with light gray
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Changing the size of the diagram
Bevel

Display the border beveling (3D button effect).

Analytica Note:  A checkbox filled in with light gray indicates that this 
option is not the same for all selected nodes. If you leave it unchanged 
(gray), each node keeps its current setting for this option. If you change 
this option (on or off), all nodes are changed to the new setting. 

Font Style

Use the options in this box to change the typeface and font (size) from 
the defaults (see page 113) to a custom style for the selected node(s).

Changing the size of the diagram

The diagram is preset to display and print in the orientation 
determined by the setting in the Page Setup dialog box. On your 
monitor, the size is shown by the extent of the colored background. 
You can change the size of the diagram in whole-page increments.

To change the size of the diagram:

1. Drag a node into the region beyond the current diagram extent. 

This causes the diagram to expand in whole page increments. If the 
Print Setup for the diagram is set to fit on mxn pages, this may 
simply change the location of the page breaks.

A second (obsolete) method for changing the size of a diagram is:

1. Bring the diagram window to the front.
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2. Select Set Diagram Size... from the Diagram menu.

3. Specify the size diagram you want.

Each rectangle in the grid represents a page. The size of the page is 
determined by the paper size and the Reduce or Enlarge percentage 
setting in Page Setup. To increase or decrease the size by whole-
page increments, click the rectangle that you want to have as the 
bottom-right boundary of the diagram.

Analytica Note:  If you are decreasing the diagram size, you cannot 
remove pages that contain nodes.

4. Click on Set.

When you save a model and later open it, the diagram size is reset to 
the number of pages holding the nodes.

Since the diagram extent automatically expands to be no smaller than 
the extent of existing nodes, use of the Diagram Size dialog to set the 
extent is only necessary if you wish to have the diagram extent larger 
than the extent of existing nodes. You should not explicitly set the 
diagram size with this method if you use or plan to use the Print Setup 
option Fit on mxn pages.

Taking screenshots of diagrams

This section contains some tips for taking good screenshots of 
influence diagrams and other Analytica windows for use in hardcopy 
documents.
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Use Browse mode

When making screen captures of a Diagram window, be sure that the 

Browse tool ( ) is selected rather than the Edit or Arrow tool. The 

diagram is clearer in Browse mode, without the background grid 
visible.

Switch off cross-hatching

By default, the nodes of undefined variables show a cross-hatched 
pattern around the title. To get rid of this pattern, deselect the Show 
undefined option in the Preferences dialog box (see “Preferences 
dialog box” on page 80).

Diagram colors

Use white for the background if you plan to print screenshots of th
diagram on a black and white printer at less than 600 dpi (dots pe
inch). A light grey works well on a printed version if you have a 60
dpi or better printer. 

Use a common level of reduction

When scaling down screenshots of windows, use a consistent 
reduction value. If your page setup precision bitmap alignment opt
is on, use a multiple of 25%; if the precision bitmap alignment opti
is off, use a multiple of 24%. Other reductions can create interfere
in printing and result in distorted screenshots. 
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Formatting 
Graphs and 
Tables



In this Chapter

This chapter shows you how to control the 
display of results in graphs and tables.



Graph Setup dialog box
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This chapter describes how to control the display of results in graphs 
and tables.

Graph Setup dialog box

Use the Graph Setup dialog box to select the graphing tool and control 
graphing options.

Display the Graph Setup dialog box in one of three ways:

• Select Graph Setup from the Result menu. 

• Select Graph Setup from the right mouse button menu.

• Double-click on a graph in the Result window.

To set defaults for all new graphs, open the Graph Setup dialog b
when no graph is the active window. 

To establish settings for the graph of results of a specific variable,
open the Graph Setup dialog box when that graph is the active 
window.

The settings are saved when you save the model.

Setup option popup menu

Several options for viewing and changing settings in the Graph Se
dialog box are accessible using its Setup option popup menu.

Buttons

Set Default

Accepts all Graph Setup settings for the current and all future grap
and closes the dialog box.
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Cancel

Leaves the Graph Setup settings unchanged, and closes the dialog box.

When you first open the Graph Setup dialog box for a model, the 
Graph Frame setup option displays.

Selecting the Graphing Tool

Analytica results may be displayed using either Analytica’s built-in
graphing engine, or Excel’s graphing engine. To use Excel Graph 
must have Microsoft Excel 8 (also known as Excel 97) or Excel 20
installed on your computer (Excel is not included with Analytica). 

To select the graphing tool, select Excel Graph® from the setup 
option pulldown menu. 

Analytica® (built-in)

By default, Analytica’s graphing tool is selected. If you previously ha
selected Excel Chart, use this option to choose Analytica’s graphi
tool.

Excel Chart®

Select this option to use Excel’s graphing engine. Excel will launc
when you select this icon, and will remain active as long as the gra
is displayed. In future sessions, Excel graph will launch whenever
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result graph for the evaluated variable is set to use Excel graph. Once 
the graph is viewed, graph settings can be adjusted from the Excel 
window. Double click on the graph in Analytica to bring the Excel 
window to the foreground. See “Using Excel Graph with Analytica” 
on page 130.

Graph Frame setup option

To change the graph frame in an Analytica graph, select the Graph 
Frame setup option from the popup menu.

Value entry boxes

Number of intervals between tick marks

If 0, Analytica chooses the number of intervals. If you enter a numb
n, Analytica uses either n or n+1, depending on the minimum and 
maximum values.

Minimum/maximum value

After unchecking the Choose axis ranges automatically checkbox, 
can enter the desired value.

axis maximum value

Number of intervals
between tick marks

along
y-axis

y-axis minimum
value

x-axis minimum
value

x-axis maximum 
value

Number of intervals 
between tick marks 
along x-axis
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Checkboxes

Choose axis ranges automatically

Controls whether the ranges on the axes are set automatically. You 
must uncheck this box before you can edit the minimum and maximum 
fields for each axis. For bar graphs, you can change only the y-axis 
values.

You cannot uncheck this box to set defaults for all new graphs. You 
must uncheck it for each graph. 

Display Key

Shows the key (for a result of two or more dimensions). 

Include 0

Includes 0 (the origin) on the given axis.

Graph Style setup option

To change the graph style in an Analytica graph, select the Graph 
Style setup option from the popup menu.

Open or closed
frame

Tick marks on x and 
y axes

Grid marks

Plot data as lines,
points, symbols,

bars

Font for labels in 
graph
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Graph Style setup option
Grid

Controls whether a background grid displays, and if it is comprised of 
dots or lines.

Frame

Controls whether the graph displays the axes alone, or with a frame 
around the graph.

Tick Marks

Controls how the tick marks appear along the axes.

None

Display no tick marks.

Bottom and Left Only

Display tick marks along the bottom and left hand axes.

All Sides

Display tick marks all around the frame.

Show Numbers/Labels 

Display numbers or labels along the axes.

Line Style

Controls the style of the graph.

Line graph

Different line styles and colors are used for each key value.

Line and data markers

Different line styles, colors, and symbols are used for each key 
value. You can size the symbols.
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Data markers (dots)

Useful with a large number of data points.

Data markers only

Different symbols are used for each key value; you can size the 
symbols.

Bar chart

Bars are of equal width and are center labeled on the horizontal 
axis. (Default for Probability Mass Function of a Probtable.)

Overlap

Specifies the vertical spacing of bars within the same group. 
Positive values cause the bars within a group to overlap, negative 
values introduce space between bars of the same group.

Origin

Specifies the y-value for the base of the bars in the graph. The 
default is zero (i.e., bars extend from the y-origin to the plotted 
value). The value in this field may be a number, or it may be an 
Analytica expression. If the result is dimensioned by the x-axis or 
key indexes, each bar can have its base positioned independently.

Histogram

Horizontal lines are plotted for each result point, positioned so that 
they extend to midway between the point and its neighbors on both 
sides. (This is the default style for probablity density functions and 
cumulative distribution functions when viewed with equal x-axis 
steps.)

Symbol Size

Enter the desired symbol size in points. 
Minimum size: 4
Default size: 6
Maximum size: 36

Font Style

Sets the typeface for the graph. (Font size is determined by the window 
size and is adjusted when the window is resized.)
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Number Format dialog box

Number formats can be specified for a table’s contents, its row an
column indexes, and for the y axis on a graph.

The number format for a variable affects the display of all of its valu
everywhere they appear. For example, if you set the number forma
an Index variable in one Result window, the same number format 
used if the Index variable appears in another Result window.

To set the number format:

1. Open a Result window. 

2. If the Result window is a table, select a row, column, or cell. 

3. Choose Number Format from the Result menu or Ctrl-B to 
display the Number Format dialog box.

The top line shows the variable to which the number format will be
applied.

Formats

Choose from the following number formats:

Format choices

Variable

Example of 
format

Options 
(depend on format 
choice)

Format Description Example

Suffix the default (see the following table) 12.35K

Exponent scientific exponential 1.235e04

Fixed Point fixed decimal point 12345.68
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The suffix characters are:

Analytica Note:  If fixed point is selected, a number larger than 109 
displays in exponent format.

Analytica for Windows uses the $ for a currency symbol, the comma 
for a thousands separators (‘,’), and a period (‘.’) for a decimal po

Options

The options in the Number Format dialog box depend on the form
selected.

The maximum number of digits or decimal digits is 15 (14 for fixed
point and percent); the maximum number precision is 15 digits (9 
integers). The Suffix format shows a minimum of four significant 
digits.

Currency

Prepends a dollar sign (‘$’) when displaying numbers.

Integer fixed point with no decimals 12346

Percent percentage 1234568%

Date text date 12 Jan 93

Boolean true or false True

Format Description Example

Power 
of 10

Suffix Prefix Power 
of 10

Suffix Prefix

3 K Kilo -2 % percent

6 M Mega or Million -3 m milli

9 G Giga -6 µ micro (mu)

12 T Tera or Trillion -9 n nano

15 Q Quad -12 p pico

-15 f femto
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Decimal digits

If set to 1 or more, numbers are padded with zeros to fill out the 
specified number of digits after the decimal point.

Number of digits

For Exponent format, numbers are padded with zeros. For Suffix 
format, fewer digits can be displayed.

Date formats

These formats show a number as a date, computed as the number of 
days since January 1, 1904 (34,699 is January 1, 1999). The format 
used for the long and short formats can be set in the Regional Setting 
Properties dialog box from the Windows control panel. If you select a 
format that includes the day of week, the day of week will be 
suppressed when data is copy and pasted or OLE linked to an external 
application (this allows applications such as spreadsheets to parse the 
dates).

Thousands separators

When selected, inserts commas between every third digit.

Using multiple formats in a single result table

When viewing a result, the number format setting for a variable 
applies to all values in the body of its result table. For most variables, 
this is desirable since your variables should contain only a single type 
of information (e.g., only dollar amounts, or only percentages, but not 
both). However, occassionally you may want to bring together 
multiple pieces of information into a single “report,” with each 
column (or row) formatted differently.

A report with multiple number formats can be created as follows:

1. Create a separate variable for each column (or row) of the 
report. Set the number format for each of these variables as you 
wish the corresponding column in the report to be formatted.

2. Create a node to represent the report. Define the node to be a 
list. In each cell of the list, type the identifier of the variable 
containing the contents for that column or row of the report. 

3. Display the result as a table.
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When a variable is defined as a list of identifiers, the result table uses 
the number format for the source variable to format the column or row 
corresponding to that variable. If the number format is not set for the 
variable corresponding to a column, the number format for the result 
being viewed is then used.

Using Excel Graph with Analytica

You may view result graphs using either Analytica’s built-in graphin
tool, or Microsoft Excel’s graphing tool. When Excel Graph is used
Excel is launched and remains active in the background, while the
graph itself appears within the Analytica result window. The use o
Excel graph requires that Microsoft Excel 8 (or Microsoft Office 97
or later, be installed on your computer. Microsoft Excel is not includ
with Analytica.

It is generally more convenient to use Analytica’s built-in graphing
tool to display most results, especially during model development
since this avoids the overhead of launching Excel, uses less spac
your model files, and makes it easier to switch between alternativ
result views. However, because Excel graph does offer additional
graph types and formatting control not available in Analytica, utilizin
an Excel graph can be very useful for creating highly specialized 
presentation-quality graphs.

Switching a Result Graph to an Excel Graph

Starting with an Analytica result graph in view:

1. Double click on the graph.

2. When the ‘Graph Setup’ box appears, select ‘Excel Graph’ from 
the Setup option pulldown menu.

3. Click on the ‘Excel Chart’ icon and click the Apply button.

Excel is launched, and the graph is drawn within the Analytica result 
window. To change graph settings, double click on the graph to bring 
Excel to the foreground, then use the menu options from Excel to 
select the graph type and formatting settings as desired.
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Important Notes about Using Excel Graph

Formatting Settings

With an Excel Graph, various changes to the state of a result window 
can cause formatting settings to return to their default values or be lost.  
These modifications include:  

• Certain changes in variable’s result values.

• Switching the graph view (e.g. Probability Density Function 
view to Sample view).

• Altering axes order.

Any of these events will cause you to lose modifications you may ha
implemented to the series definitions (i.e. X Values, Y Values or 
Series Names) since OLE will update your graphing data, thus 
overwriting your modifications.

There are other special cases when formatting settings can be res
Switching the graph view or axes order may reset your axis labels
Also, if you change the graph view, the graph type is not preserve

In general, the reformatting of graph settings is appropriate and sho
not be a significant issue.  However, you may elect to link your mo
results directly into an Excel spreadsheet and then use the data.

Excel Graph as Default will Increase Model File Size

Using Excel Graph as the default is not recommended for medium
large size models because the overhead associated with Excel G
will inflate the size of your model files (30KB per graph).  Thus, whe
employing Excel Graph for a particular node you should choose th
Apply button and not the Set default button from the Graph Setup 
dialog box.

In medium to large size models where you would like to have man
nodes displaying their results using Excel Graph, it’s wise to place
‘copies’ of these nodes in a saved module to save room.  To explo
this strategy, do not make copies of the nodes using the Copy and 
Paste operations.  Instead, create a new node with the same title a
make its definition merely the identifier for the node of which you a
making a copy.
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Three-Dimensional Graphing

Excel Graph has the ability to display your model results as a three-
dimensional surface.  In these plots the ‘z’ coordinate is the graph
key.  To create three-dimensional plots of your model result when
using Excel Graph, go to Excel’s Chart menu, select Chart Type and 
choose the Surface option.

Keeping Excel Open

You may want to avoid restarting Excel each time you graph Analyt
model results with Excel Graph.  When using Excel Graph from 
Analytica, Analytica will first try to use an existing instance of Exce
but if Excel is not running, Analytica will launch it.  If Analytica 
launches Excel and only Analytica is using it, when the last result
window containing an Excel Graph is closed, Analytica will close 
Excel.

To avoid restarting Excel repeatedly, launch Excel yourself before 
evaluating any nodes using Excel Graph.  Analytica will use this insta
of Excel, but will not close it.
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In this Chapter

This chapter shows you how to:

• Create definitions

• Edit definitions

• Use the Object Finder

• Check the validity of a variable’s value



Creating or editing a definition
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This chapter introduces the tools for creating and editing powerful 
mathematical models by giving each variable a formula that defines 
how to compute its value in its definition. The definition of a variable 
can be a simple number, text, a probability distribution, or a more 
complicated expression. It can also be a list or table of numbers or 
other expressions. Subsequent chapters present more details about 
using mathematical expressions, arrays, and probability distributions.

Creating or editing a definition

To create or edit the definition of a variable, first be sure that the Edit 

tool ( ) is selected. Select the variable and do any of the following:

• Enter Ctrl-E.

• Click on ( ) in the tool palette.

• Select Edit Definition from the Definition menu.

• Double-click on the variable to open its Object window. Then clic
in the definition field.

• Click on the Key icon ( ) to open the Attribute panel of the 
diagram. Select Definition from the Attribute popup menu. Then c
lick in the definition field.
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If the inputs to the variable were specified by drawing arrows in the 
diagram, the definition initially looks like the illustration below. The 
definition field is blank and a popup menu listing the inputs to the 
variable appears above the definition field. If the variable has no 
inputs, the Inputs popup menu does not appear.

To edit a definition that is a simple number, text, or other expression:

1. Select the definition.

2. Edit it by typing, by deleting, or by using the standard text 
editing operators—that is, Copy (Ctrl-C), Cut (Ctrl-X), and 
Paste (Ctrl-V).

See Chapter 10, “Using Expressions”, for the syntax of numbers, 
operators, simple expressions, and mathematical functions.

You can change the definition to one of several commonly used 
expressions with the Expression popup menu (see “The Expressio
popup menu” on page 141).

Inputs popup menu

Attribute panel

Object window

Variable 
title

Expression popup 
menu

Cancel 
button

Accept 
button

Definition 
field
136 Analytica User Guide



Creating or editing a definition

s in 
Special editing key combinations

A few special key combinations are quite useful when editing textual 
definitions. The arrow keys move one character or line at a time, and 
Home and End move to the beginning and end of the current line. 
Simultaneously depressing the Ctrl key with Left or Right moves to the 
beginning or end of the next word or identifier. If, in addition, the Alt 
key is depressed, the cursor is moved to the matching parenthesis 
when you are adjacent to a parenthesis. If the Shift key is depressed 
during any of these cursor movements, the spanned text will be 
selected to be available for copy/paste operations, etc. A rapid method 
for selecting an identifier is to double click on the identifier using the 
mouse.

Parenthesis matching

Analytica expressions can often contain many levels of nested 
parentheses. The parenthesis matching keys make it easy to find the 
corresponding parenthesis in an expression. Alt-Ctrl-Left and Alt-Ctrl-
Right moves from the outside of a parenthesis adjacent to the cursor to 
the outside of the corresponding. For example, in the figure below, 
pressing Alt-Ctrl-Right when the cursor is at point A moves the cursor 
to point B. Subsequently pressing Alt-Ctrl-Left moves the cursor back 
to A.

Comments in definitions

It is wise to generously document your models. However, descriptions 
of variables and algorithms are usually best placed in the description 
attribute and/or user-defined attributes for a variable. However, 
comments intelligently embedded in a definition can also be very 
useful for improving readability of long expressions. Comments can 
also be used to disable portions of expressions while debugging.

Comments can occur at any point in a expression, provided they do not 
sever an identifier name. Comments begin and end with curly braces 
(i.e., ‘{‘ and ‘}’), and may not be nested. During parsing and 
evaluation, everything between curly braces is ignored. Comment
the cells of an edit table are not preserved.

c * ( - (Ln(Uniform(1f,1) ) )^(1/k)

A B
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Identifiers

To refer to the value of another variable, use its identifier. To place a 
variable’s identifier at the insertion point in the definition, do any of 
the following:

• If the variable is an input, select it from the Inputs popup menu.

• Type in the variable's identifier. To see all nodes in the active 
diagram labelled with their identifiers, select Show By Identifier 
from the Object menu (Ctrl-Y).

• Select Paste Identifier from the Definition menu and use the Find
button or identifier menu items (see “Object Finder dialog box” o
page 143).

Functions

You can paste functions at the insertion point by doing either of th
following:

• Select Paste Identifier from the Definition menu to open the 
Object Finder (see “Object Finder dialog box” on page 143).

• Select the function from its library in the Definition menu (see 
“Pasting from a library in the Definition menu” on page 145).

Syntax check

After entering or editing a definition, press Alt-enter or click on the 

accept button ( ) to perform a syntax check of the revised definiti
and accept the changes.

Click on the cancel button ( ) to cancel your changes.
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The definition Warning icon ( ) appears next to the definition if it is 
not syntactically correct. Click on the icon to see a message about what 
may be wrong. 

A definition’s syntax check may reveal syntax errors. (See “Syntax
error” on page 476.) For example, if a definition contains text that 
not an identifier, the following dialog box appears: 

How a valid definition may change the diagram

After you give a variable a valid definition, the influence diagram 
containing that variable might change.

Cross-hatching disappears

If the “Show Undefined” preference is selected (see “Preferences
dialog box” on page 80), a node whose definition is missing or 
syntactically incorrect displays with a cross-hatch pattern.

For example:

Definition
Warning icon

Cross-hatch pattern: the definition is 
missing or is syntactically incorrect
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After the definition is checked to be syntactically correct, the 
variable’s node in the influence diagram is clear.

Arrow updating

As part of the syntax check, the influence arrows going into the act
variable (its inputs) are reconciled with the definition.

• An arrow is drawn if the identifier of another variable is included 
the definition.

• An arrow is removed if the identifier of an input is omitted from th
definition.

To avoid removing influence arrows while editing a definition, do n
click on the check mark or press Alt-Enter to leave the definition. 
Instead:

• In the Object window, click on the close button.

• In the attribute panel, select a different attribute or select a differ
variable in the diagram.

Node is clear: the definition 
is syntactically correct
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The Expression popup menu
The Expression popup menu

Click on expr to see the Expression popup menu. The Expression 
popup menu shows the type of the definition, which is an empty 
expression in the following figure. 

Use this popup menu to change the definition to one of several 
common kinds of expressions. The entries in this menu depend on the 
class of the node being defined.

Expression

Shows the definition as a mathematical expression, even if it was 
defined using the other expression types in this popup menu. See 
Chapter 10, “Using Expressions”.

Expression popup menu

Current definition type
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List 

Creates an ordered set of expressions or numbers. See “Creating
index” on page 185.

List of Labels

Creates an ordered set of text labels. See “Creating an index” on 
page 185.

Sequence

Creates a list of numerical values. See “Sequence(Start,End, Steps
on page 217.

Table

Creates an array of numbers or expressions. See Chapter 11, 
“Modeling with Arrays and Tables”. 

Probability table

Creates an array defining probabilities (numbers or expressions) 
across the domain of a discrete (chance) variable. See “Using a 
probability table” on page 311.

Distribution

Creates an uncertain definition by selecting a function from the 
Distribution system library. See “Defining a variable as a distributio
on page 279.

Choice

Creates a popup menu for choosing one or all elements from a list.
“Creating a popup menu” on page 153.
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Other

Opens the Object Finder dialog box, which is described in the next 
section. Changes the definition to the function or variable that you 
select from the Object Finder.

Object Finder dialog box

Use the Object Finder dialog box to browse system functions, your 
own library functions, and all of a model’s identifiers and place any
these objects into a definition.

Open the Object Finder in either of the following ways:

• To insert the desired function or identifier at the insertion point in
the definition, select Paste Identifier from the Definition menu.

• To replace the entire definition with the desired function or 
identifier, select Other from the Expression popup menu.

Library popup menu

Contents of selected library

Parameters to selected function

Description of selected
function
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the 
Use the Library popup menu to select a group of identifiers or a 
library. 

• For identifiers, scroll to select:

• For a library, the contents of the selected library are listed below 
popup menu, showing the parameters if they are functions. 

Use the Find button to search on the identifiers or titles of all 
variables, modules, and functions.

Found Objects Displays identifiers of objects found with 
the Find dialog. (See below.)

All Available Displays all library functions and 
identifiers.

All Modules Displays identifiers in all modules.

Current Module Displays identifiers in the current module.

Inputs Displays identifiers of the inputs to the 
selected node.

Identifier menu items
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Pasting from a library in the Definition menu
Matching objects are listed in the Found Objects library.

To use a function, identifier, or system expression in a definition, 
select it. For a function, enter the required parameters in the parameter 
fields.

Click on OK to place the function, identifier, or expression in the 
definition.

Pasting from a library in the Definition menu

Use the Definition menu to quickly paste a function or system 
expression into a definition, when you do not need the description of 
the function or expression.

While editing a definition:

1. Have the cursor at the point you want to insert a function or 
expression.

2. From the Definition menu, select the library and then the 
function or expression.
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3. The function or expression is pasted into the definition.

4. Replace all parameters with input identifiers or expressions. 
Each parameter is enclosed in << >>. To replace it, select both 
<< >> and its contents, then type or use the Inputs button or the 
Paste Identifier command to open the Object Finder dialog box.

Checking the validity of a variable’s values

You can create an automatic check on the validity of the value of a 
variable using its Check attribute. For example, to check that the value 
of Percent_damage is between 0 and 100, you give it a check of:

Percent_damage>=0 AND Percent_damage<=100

When the variable is evaluated, and if the Check attribute fails 
(evaluates to False), Analytica will give a warning and the opportunity 
to edit the definition.

There are two steps to using value checking:

1. Display the Check attribute.

2. Define checks for variables.
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Checking the validity of a variable’s values

k 
Displaying the Check attribute

If you want to use checking, first set the Check attribute to be 
displayed in the Object window and Attribute view, since it is hidden 
by default.

To show the Check attribute:

1. Select Attributes from the Object menu to open the Attributes 
dialog box. See “Managing attributes” on page 390.

2. Scroll down the Attribute list and find Check.

3. Click on Check once to select it, and a second time to add a chec
mark next to it. The check mark indicates that the attribute is 
displayed in the Object window and in the Attribute popup 
menu.

4. Click on the OK button.

Now the Check attribute appears in Object windows and in the 
Attribute popup menu in the Attribute panel below the diagram.

Defining the check 

You can set the check attribute for any variable. First open the Object 
window for the variable, or show its Check attribute in the Attribute 
view. Enter an expression in the Check attribute field to constrain the 
value of a variable. The expression should refer to this variable by 

Check attribute
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identifier or Self, and must be a Boolean (that is, evaluate to True or 
False). For example, to constrain the value for the lifetime of a car 
(Lifetime) to be greater than 0 and less than 12, define the check as: 

or

If the check expression refers to another variable, a dependency is 
created between the variable being checked and the variable included 
in the check expression. If the definition does not already refer to the 
other variable, an arrow will be drawn between the two variables.

Triggering a check

Analytica performs the check the first time it evaluates the checked 
variable. Analytica evaluates a variable the first time you ask to see its 
result, or the result of another variable that depends on it. Analytica 
also performs the check on an input node immediately after you edit 
the input value (see “Using input nodes” on page 151).

If a check fails

If a check fails (the check evaluates to False), Analytica gives you the 
option of editing the variable's definition, cancelling, or continuing. 
you continue, the check will not be performed again unless you cha
the definition of the variable or a variable it depends on.

Disabling value checking

You can disable all value checking by unchecking the Check value 
bounds checkbox in the Preferences dialog box (see page 80). Th
checkbox is checked by default. 
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Creating Models 
to be Used by 
Others



In this Chapter

This chapter shows you how to create a 
user interface for other users of your 
model.



Using input nodes
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You can use input and output nodes to create a simple user interface 
for other people who will use your Analytica model. Input nodes allow 
the user to see and change the values of variables directly from 
Diagram windows. Similarly, with output nodes you can display 
selected output numbers in a diagram and open tables or graphs with 
a single click. Users of your model can then easily view and modify 
input variables, and view the results, without navigating the details of 
the model, unless they wish to. 

The diagram below contains input nodes on the left side and output 
nodes on the right side. The details of how the model computes the 
outputs from the inputs are available inside the “Details” module, f
anyone who is interested. 

Using input nodes

An input node lets you, or your end user, see and easily change th
value of a variable directly in the diagram, without opening an 
attribute view or Object window (see “Browsing with Input and 
Output Nodes” on page 19). In Browse mode you can change only
values and definitions of input nodes.

An input node is an alias of a variable that you want to treat as an in
to the model (see “Using an alias node” on page 76).

The type of definition of the original variable determines the 
appearance of the input node (see “The Expression popup menu”
page 141). If you want your users to be able to change the type o
definition, instruct them on how to open an attribute view or Objec
window and use the Expression popup menu.
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Input field

A single number or text value (scalar) displays as an input field. You 
can have Analytica check if the input value is acceptable by using the 
check attribute (see “Checking the validity of a variable’s values” o
page 146); the check is performed on input of a new value.

Input popup menu

A choice displays as an input popup menu. To create an input me
for an input node, see “Creating a popup menu” on page 153.

List

A list or list of labels displays as a List button (see “Creating an index”
on page 185).

Edit table

An edit table displays as an Edit Table button (see “Viewing an array 
as an Edit table” on page 179).

Probability distribution

A probability distribution displays a button with the name of the 
distribution (see Chapter 13, “Expressing Uncertainty”).

Creating an input node

To create an input node from a variable:

1. Select the variable.

2. Select Make Input Node from the Object menu. The input node 
will appear in the same diagram next to the selected node.

3. Move the input node to the location you want.

4. Adjust the size of the node.

To make several input nodes at once, select the variables and the
choose Make Input Node.
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Creating a popup menu

n 
 

Creating a popup menu 

For the classes of nodes that may be used for parametric analysis, such 
as decision and chance, the Expression popup menu includes the 
Choice option. The Choice option provides a way to offer the user a 
choice of selecting one or all values from a list.

Creating a menu from a list

If the original variable is already defined as a list of numbers or labels, 
create a popup menu to select from the list as follows:

1. Show the definition of the variable as a list, either in the 
attribute view or the object window.

2. Press the Expression popup menu and select the Choice option. 
Press OK to “Replace current definition with a Choice?”

3. The object finder dialog displays with parameter I=Self and 
n=0. Press OK.

The definition field of the original variable now displays as a popup 
menu, and in browse mode, the input node displays as a popup menu. 
The original definition (list of numbers or labels) is now available as 
the domain of the variable—the possible outcomes. In the expressio
view, the popup menu displays as the Choice() function (see page
234).

Analytica Note:  To define Var1 as a popup menu of another variable 
Var2, that is defined as a list, select Choice from the Expression popup 
menu, and set the first parameter to I=Var2 in the Object Finder dialog 
(see “Choice(I,n,inclAll)” on page 234).

Analytica Note:  To hide the “All” option on the popup, enter 
inclAll=False as the third parameter in the Object Finder dialog.
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Creating a new definition

If a variable has no previous definition, when you select Choice from 
the Expression popup menu, a domain (possible outcomes) of List of 
labels is created, with one element in the list.

To change the domain to List of numbers, press the Domain popup 
menu and select List of numbers.

Edit the list of values as you would edit a list of labels or list of 
numbers (see “Editing a list” on page 190). When you press Alt-Enter, 
the definition field becomes a popup menu of the domain values.

Analytica Note:  The values in the domain are evaluated 
deterministically.

Using output nodes

An output node gives you, or your end user, rapid access to a selec
result in the model. You can use output nodes to focus attention o
particular outputs of interest.

An output node displays a result value in the view style—table or 
graph, the indexes displayed, and the uncertainty view—last selec
for display and saved with the model. It also shows the uncertaint
view icon (see “Uncertainty view options” on page 44). 

If the result is a single value (mid value or mean), it displays direc
in the output field.
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If the result is an array, the output node displays a Result button. Click 
on the button to display the table or graph.

After you display the table or graph, you can use the result tool palette 
to change the view.

If the value of an output has not yet been computed, the Calc button 
appears in the node. Click on the Calc button to compute and display 
the value. 

Creating an output node

To create an output node from a variable:

1. In a diagram window, select the node of the variable from which 
you wish to create an output node.

2. Select Make Output Node from the Object menu. The output 
node will appear in the diagram next to the selected node.

3. Move the output node to the location you want.

4. Adjust the size of the node.

The view style of the output result—table or graph—will be the form
you last set for it (see Chapter 7, “Formatting Graphs and Tables”

Resizing controls

If you use a pulldown menu containing long strings, you may wish
widen the pulldown control as necessary to accomodate your long
string. Input and output nodes contain text and graphics, in addition
the control itself. The node resizing handles that appear as small b
squares at the corners of the node adjust the size of the bounding
rectangle that holds all these items, but does not change the width
the control itself. To change the width of a control (a pulldown men
textedit box, or button), position the mouse over the left edge of th
control, depress the mouse button and drag the mouse to the left 
right.

Drag these to resize node

Drag here to resize control
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Changing display style

The title and units of an input or output node are obtained from the 
original node. To edit them, edit the title and units of the original node 
(see “Editing an attribute of a node” on page 77). If you edit the tit
or units of the original node, the input or output node's title or unit
changes to match the original.

By default, an input or output node shows its original node's title 
(label) in the original font, with no node outline or arrows. The nod
takes its color from its original node when the node is created. La
changes to the original node color do not change the color of the in
or output node. 

To change the appearance of an input or output node alone, use thSet 
Node Style... and Show Color Palette options from the Diagram 
menu (see “Node Style dialog box” on page 113 and “Changing 
background or node colors” on page 110). When you use these opt
to change the appearance of an input or output node, its original n
does not change. Similarly, using these options to change the 
appearance of an original node does not affect its previously crea
input or output node.

Using form modules

It is often helpful to group input and output nodes into a single 
diagram for easy access by model users. The form module makes it 
easy for you to create input and output nodes in the form by draw
arrows between the form and variables.

To create a form:

1. Make sure you are in a diagram window with the Edit tool 
selected.

2. Drag the module icon off the node palette and position it in the 
diagram.

3. Type in a title for the module—for example, Inputs.

4. Open the attribute view at the bottom of the diagram window.
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5. From the attribute popup menu, select Class. A popup menu of 
available classes displays.

6. Select Form from the popup menu of classes.

Creating input and output nodes in a form module

An input or output node is an alias to another variable in the model. 
Creating an input or output node is similar to creating an alias (see 
“Creating alias nodes” on page 74). To create a set of input and/o
output nodes in the form module:

1. Adjust the diagram(s) on your screen so the form node and the 
source variables for the input or output nodes are all visible 
(they can be in the same or different diagram windows).

2. In the tool palette, click on the arrow button ( ).

3. For input nodes, draw an arrow from the form node to each 
variable. Analytica creates an input node for each variable 
inside the form module. 

4. For output nodes, select the variables and draw arrows from the 
variables to the form node. Analytica creates an output node for 
each selected variable inside the form module.

5. When you have finished creating input and output nodes, 
double-click on the form node to open its diagram window.

6. In the tool palette, click on the edit button ( ).

7. Rearrange and resize the input and output nodes for clarity. It 
is usually clearest to put the input nodes down the left side and 
the output nodes down the right side. 

A form module is like any other module, except when you draw arro
to or from the form module. So you can also create nodes that are
inputs or outputs and modules inside a form. If you have too many
nodes to fit comfortably in a single diagram, you can create additio
modules (which need not be forms) to enclose related groups of inp
and outputs.
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Adding icons to nodes

You can add an icon to any node in a diagram. The Icon window 
contains an enlarged space that you can use for creating or editing an 
icon.

Opening the Icon window

To add an icon: 

1. Make sure that the Edit tool is selected.

2. Select the node that you wish to illustrate.

3. Choose Edit Icon from the Diagram menu to open the Icon 
window.

The same node with an icon added. Adjust 
the size of the node as necessary to show the 
icon and title.
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Drawing or editing an icon

You can draw or edit the icon one pixel at a time using mouse clicks, 
or you can draw lines by holding down the mouse button as you drag 
the cursor.

• To make a dark pixel light or a light pixel dark, click on the pixel.

• To set the node’s icon, click on the  button.

• To restore the original icon in the window (or to clear the window

there was no previous icon), click on the  button.

You can copy and paste an icon from one place in a model to ano
using the standard Copy (Ctrl-C) and Paste (Ctrl-V) commands. 

Adding graphics, frames, and text to a diagram

Adding graphics

You can add a graphic image created in another application to an
node or to the diagram background. Both color bitmaps and PICT
graphics can be pasted in.

To paste in a graphic:

1. Copy (Ctrl-C) the graphic to the clipboard from within a 
graphics application.

2. Make sure that the Edit tool is selected in Analytica.

3. Select the node or the diagram window where you want the 
graphic to appear.

4. Paste (Ctrl-V) the graphic from the clipboard.

When you paste a graphic into the diagram window, a special nod
class picture is created. Variable, module, and function nodes can 
placed on top of picture nodes.

To remove a graphic, select it and press Delete, or choose Clear from 
the Edit menu.
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Adding a frame

You can create a rectangular frame for nodes in a diagram in either of 
the following ways:

• Paste a graphic into the diagram window to create a picture nod
then delete the graphic. This leaves a blank picture node. Use t
Node Style dialog box (see “Node Style dialog box” on page 113
to display the border of the node. Other nodes can be placed on
of this node.

• Create a decision node and leave the title blank. Give it a definit
of 0 (or any number) to remove the cross-hatch pattern. Use the
Node Style dialog box (see “Node Style dialog box” on page 113
to hide the label and fill color. Create this frame first, then create
the nodes to be framed and place them in the frame. If you crea
framing decision node after you create the nodes to be framed, 
nodes will be “under” the framing decision node; they will be 
visible, but you will not be able to select them.

Adding text

To add text to a diagram, drag a text node from the text button ( )
the toolbar to the diagram and enter the desired text. This creates a
node with a special class text. Use the handles to resize the node, an
use the Node Style Dialog box (see “Node Style dialog box” on pa
113) to change the font or to change the background from transpa
to filled.
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In this Chapter

This chapter shows you how to:

• Create expressions

• Edit expressions
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This chapter describes the building blocks for creating and editing 
expressions to define variables: numbers, operators and mathematical 
functions.

Numbers

The following formats are all valid for entering numbers:

• The signed integer after the E is an exponent that denotes a po
of ten. For example:

5E4 = 5 x 104 = 50,000

4.3E-3 = 4.3 x 10-3 = 0.0043

• A character suffix denoting a power of ten is a convenient way t
express very large or small numbers. For example:

50K → 50,000

1.5m → 0.0015

The character suffixes are the same as used in the default outp

Number Format Examples

Integers 2, 10, 1234

Decimals 32.5, .0002, 0.000012345

Suffix 250K, 10.5M, 10.5m, 22%

Exponential form 53E11, 1E20, 4.5632E-25
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number format (see the table on page 128).

Analytica Note:  The character suffixes m (10-3) and M (106) are 
distinct. This is the only situation in which the case of a letter makes any 
difference for input to Analytica. For example, you can use k and K 
interchangeably.

Range 

Analytica can represent numbers between 10-308 and 9•10+307.

Numbers out of range

When a calculation results in a number whose absolute value is less 
than the smallest number that can be represented, Analytica rounds the 
number to 0 (zero) without warning. For example:

        1/10^1000 → 0

INF (infinity)

When a calculation results in a number whose absolute value is greater 
than the largest that can be represented, Analytica displays it as INF 
or -INF, for positive or negative infinity. For example:

10^1000 → INF

-10^1000 → -INF

1/0 → INF

Power 
of 10

Suffix Prefix Power 
of 10

Suffix Prefix

3 K Kilo -2 % percent

6 M Mega or Million -3 m milli

9 B Billion -6 µ micro (mu)

9 G Giga -9 n nano

12 T Tera or Trillion -12 p pico

15 Q Quad -15 f femto
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You can enter INF as a value in an expression. Analytica can perform 
some computations with INF, such as:

INF + 10 → INF

INF/0 → INF

10 - INF → -INF

Other computations with INF, such as difference and ratio, give results 
that are ill-defined and return NAN (Not A Number):

INF - INF → NAN

INF/INF → NAN

Note that a NAN may be detected in an expression using The IsNaN 
function. See page 266.

Precision

The maximum internal precision of numbers is 15 significant digits.

Some calculations, especially those that involve small differences 
between numbers, may result in less precision than the maximum.

Text values

You can specify a text value by enclosing text in single quotes, for 
example:

’A’, ’A25’, ’A longish string - with punct.’

A text value can contain any character, including comma, space, and 
new line. To include single quote(’) in the string, type two single 
quotes together, such as: ’Isn’’t this easy?’ (the actual string 
then contains only one apostrophe character). You can enter a text value 
directly as the value of a variable, or in an expression, including as an 
element of a list (see “Creating an index” on page 185 and “List v
List of Labels” on page 188) or edit table (see “Creating an array w
an Edit table” on page 191). Analytica displays text values in resu
without the enclosing quotes. 
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Boolean or logical values

There are two Boolean or logical values — True and False. You can 
specify a Boolean value in an expression as False or True, or, 
equivalently, as the numbers, 0 or 1. For example:

False or True → True

1 And 0 → False

Analytica treats every nonzero number as True. For example:

2 And True → True

Analytica displays Boolean results as 0 or 1, by default. To displa
them as False or True, change the format of the definition or result to
Boolean (see “Number Format dialog box” on page 127). 

Operators

An operator is a symbol, such as a plus sign (+), that represents a
computational operation or action such as addition or comparison
Analytica includes the following sets of standard operators.

Arithmetic operators

The arithmetic operators apply to numbers and produce numbers.

Operator Meaning Examples

+ plus 3+2 → 5

- minus 3- 2 → 1

* multiplied by 3*2 → 6

/, ÷ divided by
3/2 (=  ) → 1.5

^ to the power of 3^2 (= 32) → 9

root

4^.5 (= ) → 2

3
2
---

4
1
2
---
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Operators
Comparison operators

The comparison operators apply to numbers and text values and 
produce Boolean values. Applied to text values, they use the standard 
ASCII ordering of characters.

Logical operators

The logical operators apply to Boolean values and produce Boolean 
values.

Operator Meaning Examples
(1 = true, 0 = false)

< less than 2<2
’A’<’B’

→ 0
→ 1

<=, ≤ less than or equal to 2<=2
’ab’<=’ab’

→ 1
→ 1

= equal to 100=101
’AB’=’ab’

→ 0
→ 0

>=, ≥ greater than or equal to 100>=1 
’ab’>=’cd’

→ 1
→ 0

> greater than 1>2
’A’>’a’

→ 0
→ 1

<>, ≠ not equal to 1<>2
’A’<>’B’

→ 1
→ 1

Operator Meaning Examples
(1 = true, 0 = false)

b1 AND b2 true if both b1 and b2 are true, 
otherwise false

1 AND 
20<2

→ 0

b1 OR b2 true if b1 or b2 or both are true, 
otherwise false

0 OR 1<2 → 1

NOT b true if b is false, otherwise false NOT (2<3) → 0
Analytica User Guide 167



Chapter Using Expressions10

 

r 

ser-

rs 

ce 

. 

ser-
If b Then u Else v

This is a conditional expression. If the Boolean expression b is true, it 
returns the value of u. If b is false, it returns the value of v. For 
example:

If 2 > 4 Then 100 Else 0 → 0

In Analytica, the Else part of the expression is required.

Two additional conditional operators, Ifall...Then...Else 
and Ifonly...Then...Else exists for arrays; see “Conditional
operators” on page 201.

Scoping operator (::)

Analytica 2.0 contains many new functions that did not exist in 
previous versions of Analytica. Some models created in previous 
versions may contain variables or user-defined functions with the 
same name as new built-in functions. In this situation, an identifie
name appearing in an expression may be ambiguous. 

For example, suppose a model written in Analytica 1.2 contains a u
defined function named Irr. If a variable in this model uses the Irr 
function, the :: operator is prepended to, or omitted from, the 
identifier name in order to disambiguate whether the definition refe
to the user-defined Irr function, or the built-in Irr function. 

Prepending :: to the name of a built-in function causes the referen
to always refer to the built-in function when there is an ambiguity. 
Otherwise, the identifier will refer to the user’s variable or function
With this convention, existing models are not changed by the 
introduction of new user-defined functions.

Example

Suppose a model from an older version of Analytica contains the u
defined function: Irr( Values,I ). Then 

Irr( Payments,Time ) User’s Irr function

::Irr( Payments,Time ) The built-in function
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Operator binding precedence

A precedence hierarchy resolves potential ambiguity when evaluating 
operators and expressions. The hierarchy of precedence for operators, 
from most tightly bound to least tightly bound is:

functions, not

^

- (unary)

*, /

+, -

<, >, <=, >=, =, <>

and, or

If ... Then ... Else

Within each level of this hierarchy, the operators bind from left to 
right (left associative).

Examples

The following arithmetic expression:

1 / 2 * 3 - 3 ^ 2 + 4

is interpreted as:

((1 / 2) * 3) - (3 ^ 2) + 4

The following logical (Boolean) expression:

If a and b > c or d + e < f ^ g Then x Else y + z

is interpreted as:

If ((a and (b > c)) or ((d + e) < (f ^ g))) Then 

x Else (y + z)

Functions

Analytica provides a large number of built-in functions for performing 
mathematical, array, statistical, textual, and financial computations. 
There are also probability distribution functions for uncertainty and 
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sensitivity analysis. The Enterprise version of Analytica also includes 
functions for accessing external ODBC data sources. Finally, you can 
write and use your own user-defined functions.

Calls to Analytica functions have the form:

FunctionName( param1, param2, ... )

In other words, the function name followed by a comma-delimited list 
of parameters. Parameters can themselves be expressions built out of 
constants, variable names, operators, and functions. Here are some 
simple examples of expressions involving functions.

Exp(1) → 2.718281828459

Sqrt(3^2 + 4^2) → 5

Round(2*Pi) → 6

Mod( X, 3 ) → 1 where X → 7

Pmt( 8%, 30, -1000) → $88.83

N * Sum( w*w, J )

Normal(500,100)

Functions are described in the chapters that follow. The next section 
provides a list of available functions along with page numbers where 
they are described.

Library Organization

Commonly used math functions are located in the Math Library; more 
advanced and less commonly used mathematical and statistical 
functions are in the Advanced Math Library. The commonly used 
array functions are included in the Array Library; the interpolation, 
matrix, text, data typing, and less commonly used functions are in the 
Special Library.

Function See Page Library
Abs() 213 Math

Arccos() 260 Adv. Math

Arcsin() 261 Adv. Math

Arctan() 213 Math

Arctan2() 261 Adv. Math

Area() 224 Array

Argmax() 225 Special

Array() 219 Array

Average() 225 Array

Bernoulli() 317 Distribution
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Beta() 295 Distribution

BetaFn() 261 Adv. Math

BetaI() 261 Adv. Math

Ceil() 213 Math

Certain() 318 Distribution

ChanceDist() 319 Distribution

Choice() 234 Array

Combinations() 262 Adv. Math

Concat() 241 Array

Correlation() 328 Statistical

Cos() 213 Math

Cosh() 262 Adv. Math

Cubicinterp() 239 Special

CumDist() 296 Distribution

CumIPmt() 254 Financial

CumNormal() 262 Adv. Math

CumNormalInv() 262 Adv. Math

CumPrinc 254 Financial

Cumproduct() 230 Array

Cumulate() 230 Array

DbLabels() 427 Database*

DbQuery() 427 Database*

DbTable() 428 Database*

DbTableNames() 428 Database*

DbWrite() 429 Database*

Decompose() 246 Special

Degrees() 214 Math

Determinant() 247 Special

Determtable() 322 Array

Dydx() 337 Special

Dynamic() 350 Special

Elasticity() 338 Special

Erf() 263 Adv. Math

ErfInv() 263 Adv. Math

Exp() 214 Math

Factorial() 214 Math

Floor() 214 Math

For...Do 267 Special

Fractiles() 297 Distribution

Frequency() 329 Statistical

Fv() 255 Financial

Gamma() 298 Distribution

GammaFn() 263 Adv. Math

GammaI() 263 Adv. Math

GammaIInv() 264 Adv. Math

GetFract() 330 Statistical

Ident[I=U] 235 Special

IndexNames() 243 Special
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Integrate() 231 Array

Invert() 247 Special

IPmt() 255 Financial

Irr() 256 Financial

IsNaN() 266 Special

IsNumber() 266 Special

IsText() 266 Special

IsUndef() 266 Special

Kurtosis() 330 Statistical

Lgamma() 264 Adv. Math

Linearinterp() 239 Special

Ln() 214 Math

LogNormal() 300 Distribution

Logten() 215 Math

Max() 226 Array

MDArrayToTable() 249 Array

MDTable() 250 Array

Mean() 331 Statistical

Mod() 215 Math

Mid() 332 Statistical

Min() 227 Array

Normal() 301 Distribution

Normalize() 232 Array

NPer() 256 Financial

Npv() 257 Financial

Permutations() 264 Adv. Math

Pmt() 257 Financial

PPmt() 258 Financial

Probability() 332 Statistical

ProbBands() 332 Statistical

ProbDist() 302 Distribution

ProbTable() 314 Distribution

Product() 227 Array

Pv() 258 Financial

Radians() 215 Math

Rank() 233 Array

RankCorrel() 333 Statistical

Rate() 258 Financial

Regression() 264 Adv. Math

Round() 215 Math

Sample() 333 Statistical

SDeviation() 334 Statistical

Sequence() 243 Array

Sin() 215 Math

Sinh() 265 Adv. Math

Size() 243 Array

Skewness() 334 Statistical

Slice() 236 Array
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* Database functions are available only in Analytica Enterprise.

Sortindex() 243 Array

SqlDriverInfo() 429 Database*

Sqr() 215 Math

Sqrt() 216 Math

Statistics() 335 Statistical

Stepinterp() 240 Special

StringLength() 252 Special

StringReplace() 252 Special

Subindex() 228 Special

Subscript() 237 Array

Subset() 244 Array

Substring() 253 Special

Sum() 229 Array

Table() 221 Array

Tan() 216 Math

Tanh() 266 Adv. Math

Transpose() 248 Special

Triangular() 303 Distribution

Truncate() 306 Distribution

Uncumulate() 233 Array

Uniform() 304 Distribution

Unique() 245 Array

Using...Do 270 Special

Variance() 335 Statistical

WhatIf() 338 Special

WhatIfAll() 339 Special

XIrr() 259 Financial

XNpv() 260 Financial
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Chapter 11

Modeling with 
Arrays and 
Tables



In this Chapter

This chapter shows you how to handle 
arrays and tables.



Introduction to Arrays
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The value of a variable may be a scalar—a single number, text, or 
Boolean—or it may be an array—a collection of values, viewable as
a table with one or more dimensions. The ease and flexibility with
which you can create, operate with, and display multi-dimensiona
arrays is the source of much of the power of Analytica for creating a
managing substantial models. An array’s dimensions are identified
using index variables. You can extend a dimension by adding 
elements to its index, or add a dimension to an array variable, and
change in dimensions will automatically carry through the rest of t
model.

There are some subtleties to the effective use of arrays. Your prio
experience with spreadsheets or programming languages may mis
you about how best to use arrays in Analytica. So, if you plan to u
arrays in your models, we suggest that you first read the following
section, “Introduction to Arrays”, and “Operations on arrays” on pa
180. The remainder of this chapter provides the details on how to
create index variables, how to use Edit tables to create array valu
and how the arithmetic, comparison, logical, and conditional operat
work with arrays. Chapter 12, “Function Reference”, describes the
special functions that create and operate on arrays.

Introduction to Arrays

What is an array?

An array is a collection of values that you can view as a table or gra
An array has one or more dimensions, which may appear as the r
headers or column headers of a table. For example, the value of 
variable Fuel price per gallon is a one-dimensional array with two 
values, $1.50 for the small car (which uses regular gasoline) and $1
for the large car (which uses premium gasoline):
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Maintenance cost per year is defined as a two-dimensional array, 
which varies by Car type and by Year:

The small car is cheap to maintain initially, but it gets more expensive 
than the large car after 3 years as its components start to wear out and 
need replacing.

Analytica Note:  You can swap the rows (Car type) and columns (Year) 
by using the row or column popup menus (see “Index selection area”
page 39).

What is an index?

Each dimension of an array is identified by an index variable. The 
index variable holds the possible values, either a list of numbers or a 
list of labels. In the examples above, Car type is a list of labels, “small 
car” and “large car”. Year is a list of numbers.

To create an index, see “Creating an index” on page 185.

Before creating an array, it is usually best to create the indexes for
array’s dimensions. An index may be used in multiple arrays. Whe
building a model that will use several multidimensional arrays, a k
task is to define the indexes.
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Index variables in a diagram

Below is a diagram of a Car cost model, which includes the variables 
described above. The two index variables are shown as parallelogram 
nodes on the diagram.

Fuel price per gallon is the destination of an arrow from Car type 
because it is defined as an array indexed by Car type. Similarly, 
Maintenance cost per year has arrows from Car type and from Year, 
because it is indexed by both.

Analytica Note:  By default, Analytica does not show arrows to and from 
index variables. You can display these arrows, as in this example, by 
selecting the option in the Diagram Style dialog from the Diagram menu 
(see “Diagram Style dialog box” on page 111).

Viewing an array as an Edit table

An Edit table is a window that appears similar to a Result table. Unlike 
a Result table, you can select or change the indexes of the array and 
enter or edit the value of each element. If you select a variable defined 

as an Edit table and click on the edit definition button ( ), you will 
see its Edit table.

index variables
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Example (continued from above)

Miles per gallon,:

To create or edit an array with an Edit table, see “Creating an arra
with an Edit table” on page 191.

Two sources of array value

When you evaluate a variable and its Result window shows an ar
value, there are two possible sources. A variable will have an arra
value if: 

• it is defined as an array using an Edit table, or

• it is defined as an expression calculated from one or more other
array-valued variables.

Operations on arrays

Arithmetic operations and simple functions generalize 
straightforwardly when they are applied to arrays, according to the
dimensions of the arrays. This section gives some simple exampl

Operation on a scalar and an array

An operation applied to a scalar and an array results in an array of
same shape, applying the scalar operation to each element in the a

Example (continued)
Miles_per_year: 10K (a scalar)

Gallons per year: Miles_per_year / Miles_per_gallon
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Operations on arrays
The result of an operation (division in this case) combining a scalar 
and an array is a result array with the same index(es) as the original 
array:

Operation on two arrays with the same indexes

An arithmetic operator applied to two arrays with the same indexes 
creates another array with the same indexes. Analytica applies the 
operator to pairs of corresponding elements.

Example (continued)
Fuel cost per year:

Fuel_price_per_gall * Gallons_per_year

Both Fuel price per gallon and Gallons per year are arrays with the 
same index, Car type. The result is an array also indexed by Car type, 
containing the value obtained by multiplying the corresponding 
elements of each array:

Operation on a one- and two-dimensional array

An arithmetic operator applied to a one-dimensional array and a two-
dimensional array, that have one index in common, creates another 
two-dimensional array with the same two indexes. 
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Example (continued)
Op_cost_per_year:

Fuel_cost_per_year + Maintenance_per_year

Operating cost per year is the sum of a one dimensional variable 
indexed by Car type and a two-dimensional variable indexed by Car 
type and Year. The result is a two-dimensional array indexed by both 
indexes: 

Each Car type (row) in the result uses the fuel cost and maintenance 
cost for the corresponding Car type. Each Year (column) uses the same 
annual fuel cost, which does not change by year, and the 
corresponding maintenance cost, which does change by year.

Changing the above table to a graph, using the graph button ( ), 
shows:

The graph shows how the operating costs of the small car are less than 
the costs of the large car in the first 3 years and grow to be larger in 
the 5th year, crossing over just after the 4th year.
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Summing over an index variable

The Sum() function sums an array over one index, giving a result 
without that index.

Example (continued)
Total operating cost: Sum(Op_cost_per_year,Year)

This operation sums Operating cost per year over the Year dimension, 
producing a result indexed only by the Car type dimension:

Analytica Note:  The expression does not need to mention any other 
possible indexes, such as Car type.

Because the Sum() function eliminates one index of an array, it is 
called an array-reducing function. Analytica includes several array-
reducing functions (see “Array-reducing functions” on page 223).

Operation on arrays with different dimensions

An arithmetic operator applied to two one-dimensional arrays with
different indexes creates a two-dimensional array with both indexe

Example (continued)

Miles per year is redefined as a list (see “Creating a list” on page 18

Miles_per_year: [5000, 10K, 15K]

A list is a one-dimensional array that is indexed by itself. Lists are
eligible to be used as indexes of other arrays.

The definitions of Miles_per_gallon, an array indexed by Car type, and 
Gallons per year, a ratio, remain unchanged.
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Gallons per year: Miles_per_year / Miles_per_gallon

The result of Gallons per year is now an array indexed by both Miles 
per year and Car type (compare to the definitions in the section 
“Operation on a scalar and an array” on page 180): 

Each value in the table is computed from the Miles per year for the 
column divided by the Miles per gallon for each Car type (row). For 
example, 5000 miles per year divided by the large car’s 25 miles p
gallon gives 200 gallons per year.

The list value for Miles per year propagates through the model as a ne
dimension to all its dependent variables. Recomputing the result f
Operating cost per year now gives a three-dimensional table with an
added index of Miles per year:
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The results for the other Car type can be displayed by clicking on the 

diagonal arrow ( ):

General rule for operations on arrays

We can summarize and generalize the behavior of an operation on two 
arrays with the following rule: An operation on two arrays yields an 
array whose indexes are the union of the indexes of the two arrays. In 
this way, Analytica combines arrays without requiring explicit 
iteration over each index. We call this feature of generalized 
operations for multidimensional values Intelligent Arrays™.

Creating an index

Analytica includes a specific class of variable node—the index 
variable—to identify dimensions of arrays. Other variables, such a
decision nodes, are often also used to identify dimensions of arra
Actually, any variable defined as a list (one-dimensional array) ca
serve as an index to an array. For clarity in your model diagram, u
the index variable whenever possible. (The terms index and index 
variable are used interchangeably here.)

Create an index variable in the following way:

1. Select the Edit tool ( ) and have the Diagram window active.

2. Drag the parallelogram shape ( ) from the node palette to the 

diagram.

3. Give the new index a descriptive title.

4. Define the index as a list, list of labels, or sequence (see below).
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Creating a list

To define a variable as a list, first select the variable and open one of 
the following: 

• The variable’s Object window.

• The Attribute panel of the diagram (see “Displaying the attribute
on page 27). 

• In the Attribute panel, select Definition from the Attribute popup 
menu (see “The Attribute popup menu” on page 28) as the attrib
to display.

To create a list: 

1. Press the Expression popup menu above the definition field and 
select List (for numbers) or List of Labels (for text). 

(If the variable already has a definition, Analytica confirms that yo
wish to replace it. Click on OK to replace the definition with a one
element list.) 

A one-element list is displayed in the definition field. 

2. Select the element by clicking on it.

3. Type in a number or expression (for List) or text (for List of 
Labels).

4. Press Enter and type in the next value.

List icon for the Expression popup 
menu

New one-element list
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5. Repeat step 4 until you have entered all the values you want.

Autofilling a list

Analytica gives the first cell of a list the default value 1 or the value 
of the variable’s previous definition. When you press Enter, Analytica 
gives the second cell the value of the first cell plus 1.

After you have entered at least two values, Analytica gives each n
cell a value that is incremented by the difference between the last 
values.

Autofilling a list of labels

Analytica gives the first cell of a list of labels the default text value
item 1. Analytica gives each subsequent cell receives a value th
same as the previous cell.

Creating a list with the Sequence option

For the classes of nodes that are often defined as lists, such as in
and decision variables, the Expression popup menu includes the 
Sequence option.

Values entered into a list
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The Sequence option provides a quick way to define a list of equally 
spaced numbers.

When you select Sequence, the Object Finder opens, showing the 
Sequence() function (see page 227).

After entering the Start, End, and Stepsize values, click OK; the 
definition field shows the Sequence button with its parameters.

Analytica Note:  To edit the Sequence, click on the Sequence button.

List vs. List of Labels

You can display a list or list of labels in two ways: “List View” or 
“Expression View”. The “List View” displays by default; the 
Expression popup menu shows the list or list of labels icon.

List View
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The “Expression View” displays when you select  in the 
Expression popup menu.

Expression View

[1,2,3,4,5]

List (of numbers)

In a list of numbers (usually called simply a list), each value is a 
number or an expression that evaluates to a number. For example
sequence of five integers above is a list.

List of labels

In a list of labels, every value is text. For example, the set of state
below is a list of labels; in the expression view, each label is contain
in single quotation marks.

List view

Expression view

[’Alabama’, ’Alaska’, ’Arizona’,’Arkansas’]

To include a single quote (apostrophe) as part of the text in a labe
expression view, insert two adjacent single quotes, e.g.

[‘can’’t’,’won’’t’,’didn’’t’]
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Mixing numbers and text

A list can include a mix of cells containing text and numbers. In both 
views the text is contained in single quotation marks. For example:

List view

Expression view

[1, ’Alabama’, 2, ’Alaska’]

If you attempt to mix numbers and text in a list of labels, all the values 
will be treated as text. For example:

List view

Expression view

[’1’, ’Alabama’, ’2’, ’Alaska’]

Analytica Note:  A list cell can contain any valid expression, including 
one that refers to other variables or one that evaluates to an array.

Editing a list

You can edit a list by changing, adding or deleting cells (list items).

Inserting cells

To add a cell at the end of the list, select the last cell and press Enter 
or the down arrow key.
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To insert a cell anywhere other than at the end of the list, select a cell 
and choose Insert Rows (Ctrl-I) from the Edit menu. The value in the 
selected cell is duplicated in the new cell.

To insert several contiguous cells in the middle of the list, select the 
number of cells you want to insert and choose Insert Rows (Ctrl-I) 
from the Edit menu. The value of the last selected cell is duplicated in 
the new cells.

Deleting cells

To delete one or more cells, select them and do one of the following:

• Choose Delete Rows (Ctrl-K) from the Edit menu.

• Press Delete.

Analytica Note:  If you add or delete a cell in a list that is an index of an 
edit table, the corresponding elements of the table are also added or 
removed (see “Editing a table” on page 195).

Navigating a list

Use the up and down arrow keys to move the cursor up and down the 
list. 

Creating an array with an Edit table

To define a variable as an array (table), first select the variable and 
open one of the following:

• The variable’s Object window.

• The Attribute panel of the Diagram window (see “Displaying the
attribute” on page 27).

In the Attribute panel, select Definition from the Attribute popup 
menu (see “The Attribute popup menu” on page 28) as the attrib
to display.
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To create a table:

1. Press the Expression popup menu above the definition field and 
select Table.

If the variable already has a definition, you are asked to confirm 
that you wish to replace it.

2. The Indexes dialog box displays for selecting the table’s indexes
(dimensions). 

Description of selected 
variable

Show all variables 

Selected variable Move button

Indexes for the table

Values of the selected
variable
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3. Select a variable from the Indexes list and click on the move 

button ( ), or double-click on the variable, to select it as an 
index of the table. Repeat for each index you want.

4. Click on OK to create the table and open the Edit Table window 
for editing the table’s values (see “Editing a table” on page 195).

Indexes dialog box

The Indexes dialog box contains (see figure above):

Preview

A list of the values of the selected index variable. If the selected 
variable is not a list, it says “Can’t use as index.”

All variables checkbox

If checked, the Indexes list includes all variables in the model. If
not checked, it lists only variables of the class Index and Decisio
plus the variable being defined (Self) and Time. If you select this 
variable (Self) as an index, the variable itself holds the alternative
index values.

Selected indexes

A list of all indexes already selected for this variable.

new index

Select to create a new index.

Creating a new index

You can create an index variable in the course of creating a table,
the following way:

1. Select new index from the variables list in the Indexes dialog 
box.
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2. Enter a title for the index.

3. Click on the Create button. 

4. To make the new index an index of the table, click on the  
button. 

Enter the values of the Index in the Edit Table window (see the 
following section).

Removing an index

To remove an index from a table:

1. Select the index from the Selected Indexes list.

2. Click on the  button.

Removing an index will leave the first table (slice) along that index as 
the value of the array.

System index variables Run and Time

Analytica includes two system index variables: Run and Time. You can 
generally treat these index variables like any other index variable.

Run is the index for the array of sample values for probabilistic 
simulation. You can examine the array with the Sample uncertainty 
mode (see “Sample” on page 48) or the Sample() function (see page 
333).

Time is the index for dynamic simulation. It is the only index permitte
for cyclically dependent modeling (see Chapter 17, “Modeling 
Changes over Time”).

Select new
index

Enter index title
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Editing a table

To open the Edit Table window, click on the Edit Table button in 
either:

• The Object window (see “The Object window” on page 25) 

• The Attribute panel of the diagram (see “Displaying the attribute
on page 27)

In the Attribute panel, select Definition from the Attribute popup 
menu (see “The Attribute popup menu” on page 28).

The Edit Table window

The Edit Table window appears similar to the Result window Table
view (see “Viewing a result as a table” on page 41). The difference
that you can add indexes and edit (change) the values in cells in an
Table window. 

Selecting cells

Select a single cell

Click on the cell once. 

Select multiple cells

Drag the mouse from one cell to another to select a rectangular
region. 

Index button

Cancel button
Accept button
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Editing a cell

Enter an expression into a cell in the same manner as you would in a 
definition field. Press Enter to accept the value and to select the next 
cell.

Analytica Note:  Edit tables are not designed for defining complex 
expressions in each cell. Rather than define a cell as a complex 
expression, create a new variable, and define it as the complex 
expression. Then enter the new variable’s identifier in the edit table c

Adding and deleting cells

To add cells by adding rows or columns to a table:

1. Select the row (or column) before which you wish to insert a new 
one.

2. Choose Insert Rows (or Insert Columns) from the Edit menu.

The added cells contain zeros.

To delete cells by deleting rows (or columns) in a table:

1. Select the row (or column) you wish to delete.

2. Choose Delete Rows (or Delete Columns) from the Edit menu.

You can only add or delete an element of an index in this way if the 
index was defined as a list or list of labels. You cannot modify an 
index defined as a Sequence() or other expression from an edit 
table.

Analytica Note:  When you change an index in this way, you will also
affect any other arrays using this index.

Copying and pasting cells

You can copy a cell or a range (two-dimensional rectangular region) 
of cells from a table. 

To copy a cell or region:

1. Select the cell or region.
196 Analytica User Guide



Calculating with arrays

log 

s 

re 

pt 

r 

ays 
2. Choose Copy from the Edit menu (Ctrl-C). 

3. Paste the item(s) into another cell or region by selecting Paste 
from the Edit menu (Ctrl-V). The region you paste into must 
either be a single cell at the top left corner of the destination 
region, or it must have the same size as the copied region.

Adding or removing indexes

Click on the Index button ( ) to add more indexes (increasing the 
number of dimensions) or to remove indexes (decreasing the number 
of dimensions). The Indexes dialog box appears (see “Indexes dia
box” on page 193).

Any new index of size n copies the current table with its current value
n times along the new dimension.

Saving the table

Click on the Accept button ( ) to perform a syntax check and sto
changes you have made.

Click on the Cancel button ( ) to discard changes made since 
opening the window, or since the last time you clicked on the Acce
button. 

If you close an Edit Table window without clicking on the Accept o
Cancel buttons, the changes are accepted. 

Calculating with arrays 

Conventions for array examples

Most of the examples in this and the next chapter show variables 
defined as tables (arrays) or evaluating to arrays. Indexes and arr
in these examples are represented as follows:

• An index or list and its values

IndexName:

value1 value2 valueN
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• An expression that evaluates to a scalar or an array

expression → result

• A one-dimensional array

Index_a 

• A two-dimensional array

Index_b , Index_a  

• A three-dimensional array

Index_a , Index_b , Index_c displayed value 

Scalar functions

Any function that takes a scalar parameter (e.g., see “Math functio

on page 213) can be applied to an array, resulting in an array of th
same shape. Each element of the resulting array is calculated by 
applying the function to the corresponding element of the input ar

This example takes the square root of every value in a one-
dimensional array.

Sqrt([1, 2, 3, 4, 5]) →

a b c
value value value

a b c
x value value value
y value value value
z value value value

a b c
x value value value
y value value value
z value value value

↔

1 2 3 4 5
1.000000 1.414214 1.732051 2.000000 2.2360
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Arithmetic operations

An arithmetic operator (+, -, *, /, ^) applied to two arrays 
results in an array indexed by every index variable in the two input 
arrays. Several examples illustrate this:

• An arithmetic operator applied to a scalar and an array results in
array of the same shape, applying the scalar operation to each 
element in the array:

X: 

10 * X ^ 2 →
X 

• An arithmetic operator applied to two arrays that are both indexe
by the same variable creates another array indexed by the sam
variable with the operator applied to pairs of corresponding 
elements:

X + Sqr(X) →
X 

• An arithmetic operator applied to two arrays with different index
variables (or with no index variables) creates an array indexed b
every index variable in the two arrays, with the operator applied
all pairs of elements:

Inflation: 

Price: 

Inflation * Price →

2 3 4

2 3 4
40 90 160

2 3 4
6 12 20

1.05 1.10 1.15

5K 10K 15K
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Price , Inflation 

Comparison and logical operations

The comparison operators (>, >=, =, <=, < and so on) and the logical 
operators (And and Or) combine array values in the same way as the 
arithmetic operators. (See “Operators” on page 166 for the full list
operators.) The only difference from the arithmetic operators is th
both comparison and logical operators return arrays of Boolean 
values, and the logical operators treat their operands as Boolean. E
cell contains either 1 (True) or 0 (False) (see “Boolean or logical 
values” on page 166).

For example:

Vw_price: 

Honda_price: 

Honda_price > Vw_price →
Vw_price , Honda_price 

Honda_price = Vw_price →
Vw_price , Honda_price 

1.05 1.10 1.15
5000 5250 5500 5750
10K 10.5K 11K 11.5K
15K 15.75K 16.5K 17.25K

8250 10K 15K

12.5K 15K 20K

12.5K 15K 20K
8250 1 1 1
10K 1 1 1
15K 0 0 1

12.5K 15K 20K
8250 0 0 0
10K 0 0 0
15K 0 1 0
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Honda_price > VW_price OR Honda_price = Vw_price 
→
Vw_price , Honda_price 

Conditional operators

The conditional operators are:

If B then U else V 

Ifonly B then U else V

Ifall B then U else V. 

All three conditional operators return elements of U and V depending 
on the value of B. The three operators differ on whether U and V are 
evaluated when B is constant, and on what the final result is indexed 
by. The following table summarizes what gets evaluated in each case:

What gets evaluated:

What the final result is indexed by (B in the table indicates that the 
result is indexed by the dimensions of B, etc.): 

12.5K 15K 20K
8250 1 1 1
10K 1 1 1
15K 0 1 1

B contains 
only True

B contains 
only False

B contains both 
True and False

If B, U B, V B, U, V
Ifonly B, U B, V B, U, V
Ifall B, U, V B, U, V B, U, V

B contains 
only True

B contains 
only False

B contains both 
True and False

If B, U B, V B, U, V
Ifonly U V B, U, V
Ifall B, U, V B, U, V B, U, V
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If B Then U Else V

Returns U or V, or an array whose cells contain values of U or V, 
depending on the value of B.

• If B has the value True (or any nonzero number), it returns the valu
of U and does not evaluate V.

• If B has the value False (or 0), it returns the value of V and does not 
evaluate U.

• If B is an array which contains at least one True (nonzero) value 
and at least one False (0) value, it evaluates both U and V. It returns 
an array indexed by the union of the indexes of B, U, and V, 
containing elements from U or V according to the corresponding 
elements of B.

• If B is an array containing only True (only non-zero numbers), U is 
evaluated, V is not evaluated, and the result is indexed by the 
indexes of B and U.

• If B is an array containing only False (only zeros), U is not 
evaluated, V is evaluated, and the result is indexed by the indexes
B and V.

Examples

N: 

If N > 0 Then ’Yes’ Else ’No’ → 

N 

If N = 2 Then ’Yes’ Else ’No’ →

N 

If N < 0 Then ’Yes’ Else ’No’ → ’No’

1 2 3

1 2 3
'Yes' 'Yes' 'Yes'

1 2 3
'No' 'Yes' 'No'
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Avoiding Evaluation

You may want to avoid evaluation of U for elements of B that give 
undefined results. For example:

Myarray:

In2 

If Myarray > 0 Then Ln(Myarray) Else 0 gives a warning 
message on evaluating Ln(-10). Ignoring the message gives

In2 

To avoid evaluation of U for the elements that are false, evaluate 
If...Then...Else on each element of Myarray using a 
For...Do loop (see page 267) or Using..In..Do (see page 270).

Using Temp := Myarray in In2 Do

If Temp > 0 Then Ln(Temp) Else 0 

Ifonly B Then U Else V

Ifonly is similar to If, except that it does not include the 
dimensions of B in the result if B is constant.

• If B has the value True (or any nonzero number), it returns the valu
of U and does not evaluate V.

• If B has the value False (or 0), it returns the value of V and does not 
evaluate U.

• If B is an array which contains at least one True (nonzero) value 
and at least one False (0) value, it evaluates both U and V. It returns 
an array indexed by the union of the indexes of B, U, and V, 
containing elements from U or V according to the corresponding 
elements of B. 

• If B is an array containing only True (only non-zero numbers), U is 
evaluated, V is not evaluated, and U is returned. Unlike If, The 
dimensions of B are not included in the result.

21 22 23
-10 0 10

21 22 23
0 0 2.303
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• If B is an array containing only False (only zeros), U is not 
evaluated, V is evaluated, and V is returned. Unlike If, The 
dimensions of B are not included in the result.

When to use

The main difference between Ifonly and If is that Ifonly 
collapses the array dimensions when B is constant. In general, 
Ifonly can cause confusion when dimensions disappear simply 
because numbers (in B) come out equal in a coincidental situation. 
However, if your intention is to reduce the dimensionality of the res
when B is constant, then use Ifonly. 

In the world of array abstraction, one can consider an array that is
indexed by I to be equivalent to an array that is constant across I, with 
each slice along I being equal to the original array. In this sense, If 
and Ifonly return equivalent results. If dimensions are re-introduc
later, the downstream results will be the same in the two cases. 
However, since the dimensionality is smaller for results of Ifonly, 
there can be a slight computational advantage over If. Due to the use 
of sparse array representations inside Analytica’s engine, the 
difference in computational advantage is usually very small.

Examples:

N: 

Ifonly N > 0 Then ’Yes’ Else ’No’ → ’Yes’

Ifonly N = ’A’ Then ’Yes’ Else ’No’ → ’No’

Ifonly N = 2 Then ’Yes’ Else ’No’ →

N 

1 2 3

1 2 3
'No' 'Yes' 'No'
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Ifall B Then U Else V

Ifall is similar to If, except that it always evaluates both U and V, 
and returns a value whose dimensions are always the same—the u
of the indexes of B, U, and V. If, Ifonly, and Ifall give the 
same result when B is an array whose values are partially true.

When to use

When B is an array, the number and identity of the dimensions of t
result of an If expression can vary according to the values in B. Use 
Ifall instead of If to ensure that the dimensions of the result are
always the same.

Examples:

N: 

Ifall N > 0 Then ’Yes’ Else ’No’ →

N 

Ifall N = 2 Then ’Yes’ Else ’No’ →

N 

Ifall N = ’A’ Then ’Yes’ Else ’No’→

N 

1 2 3

1 2 3
'Yes' 'Yes' 'Yes'

1 2 3
'No' 'Yes' 'No'

1 2 3
'No' 'No' 'No'
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Chapter 12

Function 
Reference



In this Chapter

This chapter shows you how to use 
Analytica’s built-in functions. 

This chapter covers mathematical, array, 
financial, text, and special functions. 
Functions for uncertainty and sensitivity 
analysis are covered in later chapters.



Overview
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Analytica provides a large collection of built-in functions for 
performing common mathematical, financial, statistical, and array 
computations.

Overview

This chapter describes most of Analytica’s built-in functions. It is 
organized by the type of function:

• Basic math functions (“Math functions” on page 213). Note that 
additional math functions are listed separately in “Advanced ma
functions” on page 260.

• Functions that create lists (“Functions that create lists” on page 
216).

• Functions that create arrays (“Functions that create arrays” on p
218).

• Functions that reduce an array to another array with one fewer 
dimension (“Array-reducing functions” on page 223).

• Functions that return an array with the same number of dimensi
as the input array (“Transforming functions” on page 229).

• Functions that select part or a slice of an array (“Functions that 
select part of an array” on page 234).

• Functions that interpolate values between array elements 
(“Interpolation functions” on page 238).

• Other array functions (“Other array functions” on page 241).

• Matrix functions for two-dimensional arrays (“Matrix functions” 
on page 246).

• Functions for using and manipulating strings (“Text Functions” o
page 252).

• Functions commonly used for financial computations (“Financia
Functions” on page 253).

• Advanced mathematical and statistical functions. These function
tend to have specialized applications and require advanced 
mathematical experience. The Regression function, which provid
generalized linear curve-fitting, may be of special interest for ma
users (“Advanced math functions” on page 260).

• Functions for detecting whether values are strings, numbers, or
special values (“Datatype Functions” on page 266).
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• Control functions for iterating over array elements (“Control 

functions” on page 267).

Examples

The examples in this chapter refer to the following variables:

Car_type: 

Years: 

Mpg: 

Time: 

Cost: Mpg , Car_type 

Car_prices: Car_type , Years 

Cost_in_time: Mpg , Time , Car_type = VW 

VW Honda BMW

1985 1986 1987 1988

26 30 35

0 1 2 3 4

VW Honda BMW
26 2185 2810 3435
30 1705 2330 2955
35 1585 2210 2835

1985 1986 1987 1988
VW 8000 9000 9500 10K
Honda 12K 13K 14K 14.5K
BMW 18K 20K 21K 22K

0 1 2 3 4
26 2185 2294 2409 2529 2656
30 2810 2951 3098 3253 3416
35 3435 3607 3787 3976 4175

↔
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Overview
Cost_in_time: Mpg , Time , Car_type = Honda 

Cost_in_time: Mpg , Time , Car_type = BMW 

Array Abstraction

Analytica performs operations on arrays without your needing to 
explicitly identify or iterate over the dimensions of each array. When 
you use variables in expressions, you only need to refer explicitly to 
dimensions that are relevant to the operations being performed. If the 
actual values involve dimensions other than those that appear in your 
expressions, Analytica will automatically abstract over those 
dimensions with no extra effort on your part. 

Because array abstraction automatically takes care of most iteration 
over arrays, Analytica expressions seldom contain explicit looping 
constructs. Individual expressions involving multi-dimensional arrays 
can be very simple, while in other languages the same operations 
would require multiple nested loops over the non-relevant dimensions.

Designing a model often requires you to make hard tradeoffs between 
computational complexity, which dimensions to include, and the 
degree of detail. Spreadsheets and other programming languages force 
you to make these decisions early before you have implemented your 
algorithms and obtained the information that is relevant for making 
these tradeoffs. The automatic management of dimensionality 
provided by array abstraction makes it easy for you make these 
tradeoffs late in the model building process. 

Relating indexes to values

The dimensions (indexes) of a multidimensional array are ordered 
from outermost to innermost as they appear in the function viewed as 
an expression. The outermost is the dimension that changes most 

0 1 2 3 4
26 2385 2314 2529 2649 2856
30 2910 3041 3238 3343 3526
35 3535 3847 3897 4166 4365

0 1 2 3 4
26 3185 3294 3409 3529 3656
30 3810 3951 4098 4253 4416
35 4435 4607 4787 4976 5175

↔
↔
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slowly; the innermost is the dimension that changes most rapidly. For 
example, the following expression defines a three-dimensional array 
indexed by Index_a, Index_b, and Index_c that contains the eight 
values in the value list. Each value’s subscript shows its position in
resulting array:

Table(Index_1, Index_2, Index_3)

(valueace, valueacf, valueade, valueadf, valuebce, 

valuebcf, valuebde, valuebdf)

Index_1: 

Index_2: 

Index_3: 

Index_1 , Index_2 , Index_3 = e 

Index_1 , Index_2 , Index_3 = f 

Index_1 is the outermost dimension, whose index value changes le
rapidly in the value list. In other words, the value of Index_1 stays a 
for the first half of the value list while the values of the other index
change, then the value of Index_1 changes to b.

Index_3 is the innermost dimension, whose index value changes w
every subsequent value in the value list. Index_2 is the intermediate 
dimension, changing more rapidly than Index_1, but less rapidly than 
Index_3.

a b

c d

e f

c d
a value_ace value_ade
b value_bce value_bde

c d
a value_acf value_adf
b value_bcf value_bdf

↔
↔
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Math functions

These functions can be accessed under the Definition menu Math 
command, or in the Object Finder dialog box, Math library. 
Additional math functions that are highly specialized or less common 
are also available in the Advanced Math library, described on page 
260.

Abs ( X )

Returns the absolute value of X.

Abs(180) → 180

Abs(-210) → 210

Arctan ( X )

Returns the arctangent of X in degrees. 

Arctan(0) → 0

Arctan(1) → 45

Arctan(Tan(45)) → 45

See also Arctan2 in the Advanced Math functions on page 261.

Ceil(X)

Returns the smallest integer that is greater than or equal to X.

Ceil(3.1) → 4 Ceil(5) → 5

Ceil(-2.9999) → -2 Ceil(-7) → -7

Cos ( X )

Returns the cosine of X, X assumed in degrees.

Cos(180) → -1

Cos(-210) → -0.866
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Degrees( R )

Converts from radians to degrees. 

Degrees( Pi/2 ) → 90

Degrees( -Pi ) → -180

Exp ( X )

Returns the exponential of X—that is, ex. X must not be greater than 
709.

Exp(5) → 148.4

Exp(-4) → 0.01832

Factorial ( X )

Returns the factorial of X, which must be between 0 and 170. 

Factorial(5) → 120

Factorial(0) → 1

If X is not an integer, X is rounded to the nearest integer before taking 
the factorial.

Floor(X)

Returns the largest integer that is smaller than or equal to X.

Floor( 2.999 ) → 2 Floor(3) → 3

Floor(-2.01 ) → -3 Floor(-5) → -5

Ln ( X )

Returns the natural logarithm of X, which must be positive.

Ln(150) → 5.011

Ln(Exp(5)) → 5
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Math functions
Logten ( X )

Returns the logarithm to the base 10 of X, which must be positive.

Logten(180) → 2.255

Logten(10 ^ 30) → 30

Mod( X, Y )

Returns the remainder (modulus) of X/Y. 

Mod(7,3) → 1 Mod(12,4) → 0

Mod(-14,5) → -4

Radians( D )

Converts from degrees to radians.

Radians(-90) → -1.57079633

Radians(180) → 3.141592654

Round ( X )

Returns the value of X rounded to the nearest integer. 

Round(1.8) → 2 Round(-2.8) → -3

Round(1.499) → 1    Round(-2.499) → -2

Sin ( X )

Returns the sine of X, X assumed in degrees. 

Sin(30) → 0.5

Sin(-45) → -0.7071

Sqr ( X )

Returns the square of X.

Sqr(5) → 25
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86, 
Sqr(-4) → 16

Sqrt ( X )

Returns the square root of X, which must be positive or zero. 

Sqrt(25) → 5

Tan( X )

Returns the tangent of X, X assumed in degrees.

Tan(45) → 1

Functions that create lists

Use the List option in the Expression popup menu to define a variable 
as a list of numbers or text values (labels) (see “Creating a list” on
page 186). You can also create a list within a variable definition us
the functions described below. 

[ u1, u2, u3, … um ]

The list of expressions, separated by commas and surrounded by 
brackets, creates a list, whose values are u1, u2, u3, … um. 

Using square brackets to specify a list directly as an expression is 
equivalent to using the List or List of Labels options in the 
Expression popup menu, as described in “Creating a list” on page 1
according to the type of values.

Examples

[8000, 12K, 15K]
[’VW’, ’Honda’, ’BMW’]
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m 
Sequence ( Start, End, Stepsize )

Creates a list of numbers increasing or decreasing from Start to End by 
increments (or decrements) of Stepsize. Stepsize is optional and must 
be a positive number; if it is omitted, Analytica uses increments of 1. 
Start, End, and Stepsize must be deterministic scalar numbers, not 
arrays.

Using this function is equivalent to using the Sequence option in the 
Expression popup menu, as described in “Creating a list with the 
Sequence option” on page 187. 

Library

Array

Examples

If End is greater than Start, the sequence is increasing: 

Sequence(1,5) →

Expression view: [1,2,3,4,5]

If Start is greater than End, the sequence is decreasing: 

Sequence(5,1) → [5,4,3,2,1]

If Start and End are not integers, and if Stepsize is not specified, 
Analytica rounds them first: 

Sequence(1.2,4.8) → [1,2,3,4,5]

If Stepsize is specified, Analytica can create non-integer values fro
Start to End with the Stepsize:

Sequence(0.5,2.5,0.5) → [0.5,1,1.5,2,2.5]

List view:
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Functions that create arrays

Use the Table option in the Expression popup menu to define a 
variable as an array (see “Creating an array with an Edit table” on p
191). 

For more flexibility and control, you can define a variable as an arr
by entering the Array() or Table() function as an expression.

An array viewed as an expression appears in the Table() function 
syntax:

An array 
viewed as a 
table

Table

An array viewed
as an expressio

Expression
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Array( I1, I2, … In, A)

Assigns a set of indexes, I1, I2, … In, as the indexes of the array A, with 
I1 as the index of the outermost dimension (changing least rapidly), I2 
as the second outermost, and so on. (See “Relating indexes to val
on page 211.) A must have at least n dimensions. The elements of A are 
listed in square brackets as the last parameter, or A is a previously 
defined array. 

Use Array() to specify an array directly as an expression. Array() 
is similar to Table() (see page 221); in addition, it lets you define
an array with repeated values (see Example 3), and change index
a previously defined array (see Example 4).

Library

Array

Example 1

Definition viewed as an expression: 

Array(Car_type, [32, 34, 18])

Definition viewed as a table:

Car_type 

Note: Example variables are defined on page 210.

Example 2

If an array has multiple dimensions, then the elements are listed i
nested brackets, following the structure of the array as an array o
arrays (of arrays..., and so on, according to the number of dimensio

Definition viewed as an expression: 

Array(Car_type, Years, [[8K, 9K, 9.5K, 10K],

[12K, 13K, 14K, 14.5K], [18K, 20K, 21K, 22K]])

VW Honda BMW
32 34 18
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Definition viewed as a table:

Car_type , Years 

The size of each array in square brackets must match the size of the 
corresponding index. In this case, there is an array of three elements 
(for the three car types), and each element is an array of four elements 
(for the four years). An error message displays if these sizes don’
match. See also Size() on page 243.

Note: Example variables are defined on page 210.

Example 3

If an element is a scalar where an array is expected, Array() expands 
it to create an array with the scalar value repeated across a dimen

Definition viewed as an expression:

Array(Car_type, Years, [[8K, 9K, 9.5K, 10K], 

13K, [18K, 20K, 21K, 22K]])

Definition viewed as a table:

Car_type , Years 

Note: Example variables are defined on page 210.

1985 1986 1987 1988
VW 8000 9000 9500 10K
Honda 12K 13K 14K 14.5K
BMW 18K 20K 21K 22K

1985 1986 1987 1988
VW 8000 9000 9500 10K
Honda 13K 13K 13K 13K
BMW 18K 20K 21K 22K
220 Analytica User Guide



Functions that create arrays
Example 4

Use Array() to change an index of a previously defined array. 

Car_model:

Table_a: Table(Car_type) (32, 34, 18)

Table_b: Array(Car_model, Table_a) →

Car_model 

Note: Example variables are defined on page 210.

Table ( I1, I2, … In ) ( u1, u2, u3, … um )

Creates an n-dimensional array of m elements, indexed by the indexes 
I1, I2, … In. In the set of indexes, I1 is the index of the outermost 
dimension, varying the least rapidly.

The second set of parameters, u1, u2 … um, specifies the values in the 
array. The number of values, m, must equal the product of the sizes of 
all of the dimensions. 

Each u is an expression that evaluates to a number, text value or 
probability distribution. It can also evaluate to an array, causing the 
dimensions of the entire table to increase. u cannot be a literal list.

Both sets of parameters are enclosed in parentheses; the separating 
commas are optional except if the table values are negative.

Use Table() to specify an array directly as an expression. Table() 
is similar to Array() (see page 219); Table() requires m numeric 
or text values.

A definition created as a table from the Expressions popup menu uses 
Table() in expression view.

Library

Array

Jetta Accord 320

Jetta Accord 320
32 34 18
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Example 1

Definition viewed as an expression: 

Table(Car_type) (32, 34, 18)

Definition viewed as a table: 

Car_type 

Note: Example variables are defined on page 210.

Example 2

Definition viewed as an expression: 

Table(Car_type, Years)

(8K, 9K, 9.5K, 10K, 12K, 13K, 14K, 14.5K, 18K, 

20K, 21K, 22K)

Definition viewed as a table: 

Car_type , Years 

Note: Example variables are defined on page 210.

VW Honda BMW
32 34 18

1985 1986 1987 1988
VW 8000 9000 9500 10K
Honda 12K 13K 14K 14.5K
BMW 18K 20K 21K 22K
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Example 3

A table created with blank (zero) cells appears in expression view 
without the second set of parameters.

Definition viewed as a table:

Car_type , Years 

Definition viewed as an expression: 

Table(Car_type, Years)

Note: Example variables are defined on page 210.

Array-reducing functions

An array-reducing function operates across a dimension of an array 
and returns a result that has one dimension less than the number of 
dimensions of its input array. When applied to an array of n 
dimensions, a reducing function produces an array that contains n-1 
dimensions.

The function Sum(X, I) illustrates some properties of reducing 
functions.

Examples

Sum(Car_prices, Car_type) →

Years 

1985 1986 1987 1988
VW 0 0 0 0
Honda 0 0 0 0
BMW 0 0 0 0

1985 1986 1987 1988
38K 42K 44.5K 46.5K
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Sum(Car_prices, Years) →

Car_type 

Sum(Sum(Car_prices, Years), Car_type) → 171K

The second parameter, I, specifying the dimension over which to sum, 
is optional. But if the array, X, has more than one dimension, Analytica 
may not sum over the dimension you expect. For this reason, it is safer 
always to specify the dimension index explicitly in Sum() or any 
other array-reducing function.

If the index variable, I, is not a dimension of the array, X, Sum(X, I) 
returns X unreduced. In this way, Analytica will evaluate the model 
properly even if the number of dimensions changes. 

Note: Example variables are defined on page 210.

Area ( R, I, X1, X2 )

Returns the area (sum of trapezoids) under array R across index I 
between X1 and X2. I must contain increasing numbers. X1 and X2 are 
optional; if they are not specified, the area is calculated across all of I. 

If X1 or X2 fall outside the range of values in I, the first value (for X1) 
or last value (for X2) are used. Area() computes the total integral 
across I, returning a value with one less dimension than R. Compare 
Area() to Integrate() (see page 231).

Library

Array

Example

Area(Cost_in_time, Time, 0, 5000) →

Car_type , Mpg 

VW Honda BMW
36.5K 53.5K 81K

26 30 35
VW 9653 12.42K 15.18K
Honda 10.11K 12.84K 15.86K
BMW 13.65K 16.42K 19.18K
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Note: Example variables are defined on page 210.

Argmax ( R, I )

Returns the corresponding value in index I for which R is the 
maximum. If more than one value equals the maximum, returns the 
index of the last occurrence.

Library

Special

Example

Argmax(Car_prices, Car_type) →

Years 

To obtain the corresponding value in index I for which A is the 
minimum, use Argmax(-A,I).

Argmax(-Car_prices, Car_type) →

Note: Example variables are defined on page 210.

Average ( X, I )

Returns the mean value of all of the elements of array X, averaged over 
index I.

Library

Array 

Examples
Average(Mpg) → 30.33

1985 1986 1987 1988
BMW BMW BMW BMW

1985 1986 1987 1988
VW VW VW VW
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Average(Car_prices, Car_type) →
Years 

Note: Example variables are defined on page 210.

Join(A, I, separator,finalSeparator)

Returns the elements of A (as text) concatenated along I and separated 
by separator. If the optional finalSeparator parameter is provided, it 
is used as the final separator. If any elements are numeric, they are 
converted to strings using the number format settings for the current 
node.

A: I

Join(A,I,’, ’) → ’VW, Honda, BMW’

Join(A,I,’, ’,’ and ’) → ’VW, Honda and BMW’

Max ( X, I )

Returns the highest valued element of X along index I. 

Library

Array

Examples
Max(Years) → 1988

Max(Car_prices, Years)  →
Car_type 

To obtain the maximum of two numbers, first turn them into an array: 

1985 1986 1987 1988
12.67K 14K 14.83K 15.5K

1 2 3
VW Honda BMW

VW Honda BMW
10K 14.5K 22K
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Array-reducing functions
Max([10,5]) → 10

Note: Example variables are defined on page 210.

Min ( X, I )

Returns the lowest valued element of X along index I. 

Library

Array 

Examples
Min(Years) → 1985

Min(Car_prices, Years) →
Car_type 

To obtain the minimum of two numbers, first turn them into an array:

Min([10, 5] ) → 5

Note: Example variables are defined on page 210.

Product ( X, I ) 

Returns the product of all of the elements of X, along the dimension 
indexed by I. 

Library

Array 

Examples
Product(Mpg) → 27.3K

VW Honda BMW
8000 12K 18K
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Product(Cost, Mpg) →

Car_type 

Note: Example variables are defined on page 210.

Subindex ( A, U, I )

Returns the value of I corresponding to value U in array A. If more than 
one value corresponds, returns the index value of the last occurrence. 
For the values that do not correspond, returns undefined (shows as 
blank, see also IsUndef(..) on page 266).

Argmax() uses Subindex(A, Max(A, I), I) to return the 
index value corresponding to the maximum value in A. See 
Argmax() on page 225. 

Library

Special

Examples

Subindex(Car_prices, 12K, Car_type) →

Years 

Subindex(Car_prices, 12K, Years) →

Car_type 

If U is an array of values, an array of index values is returned.

VW Honda BMW
5.905G 14.47G 28.78G

1985 1986 1987 1988
Honda

VW Honda BMW
1985
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Transforming functions
Subindex(Car_prices, [12K, 21K], Car_type) →

Subindex , Years 

Note: Example variables are defined on page 210.

Sum ( X, I )

Returns the sum of array X over the dimension indexed by variable I. 

Library

Array

Examples
Sum(Mpg) → 91

Sum(Car_prices, Years) →

Car_type 

Note: Example variables are defined on page 210.

Transforming functions

A transforming function operates across a dimension of an array and 
returns a result that has the same dimensions as its input array.

The function Cumulate(X,I) illustrates some properties of 
transforming functions.

Example
Cumulate(Car_prices,Years) →

1985 1986 1987 1988
12K Honda
21K BMW

VW Honda BMW
36.5K 53.5K 81K
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Car_type , Years  

The second parameter, I, specifying the dimension over which to 
cumulate, is optional. But if the array, X, has more than one dimension, 
Analytica may not cumulate over the dimension you expect. For this 
reason, it is safer always to specify the dimension index explicitly in 
any transforming function.

Note: Example variables are defined on page 210.

Cumproduct ( X, I )

Returns an array with each element being the product of all of the 
elements of X along dimension I up to, and including, the 
corresponding element of X. 

Library

Array

Example

Cumproduct(Cost_in_time, Time) →

Mpg , Time , Car_type = VW 

Note: Example variables are defined on page 210.

Cumulate ( X, I )

Returns an array with each element being the sum of all of the 
elements of X along dimension I up to, and including, the 
corresponding element of X. 

1985 1986 1987 1988
VW 8000 17K 26.5K 36.5K
Honda 12K 25K 39K 53.5K
BMW 18K 38K 59K 81K

0 1 2 3 4
26 2185 5.012M 12.07G 30.54T 81.11Q
30 2810 8.292M 25.69G 83.57T 285.5Q
35 3435 12.39M 46.92G 186.6T 778.9Q

↔
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Transforming functions
If X is not indexed by I, Cumulate(X,I)operates as if X were 
indexed by I, but constant across I. Using this, a convenient trick for 
numbering the elements of an index is to use Cumulate(1,I).

Library

Array

Example

Cumulate(Cost_in_time, Time) →

Mpg , Time , Car_type = VW 

Cumulate(1,Car_type) →

Years 

Note: Example variables are defined on page 210.

Integrate ( R, I )

Returns the result of applying the trapezoidal rule of integration of 
array R over index I. Integrate() computes the cumulative 
integral across I, returning a value with the same number of 
dimensions as R. Compare Integrate() to Area() (see page 224).

An alternative syntax is Integrate(R1, R2, I), which returns 
the integral of array R1 over array R2. If R2 has one dimension, its 
index must also be an index of R1 and I is optional. If R2 has more than 
one dimension, then I is required and must be an index of both R1 and 
R2.

Library

Array

0 1 2 3 4
26 2185 4479 6888 9417 12.07K
30 2810 5761 8859 12.11K 15.53K
35 3435 7042 10.83K 14.8K 18.98K

VW Honda BMW
1 2 3

↔
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Example

Integrate(Cost_in_time, Time) →

Mpg , Time , Car_type = VW 

Note: Example variables are defined on page 210.

Normalize ( R, I )

Returns an array that is normalized array R, so the area across index I 
is 1. 

Normalize() does not force the values along index I to sum to 1; to 
make the values sum to 1, divide R by Sum(R, I).

An alternative syntax is Normalize(R1, R2, I), which returns 
the normalized array of array R1 over array R2. If R2 has one 
dimension, its index must also be an index of R1 and I need not be 
stated. If R2 has more than one dimension, then I is required and must 
be an index of R1 and R2.

Library

Array

Example

Normalize(Cost_in_Time, Time) →

Mpg , Time , Car_type = VW 

Note: Example variables are defined on page 210.

0 1 2 3 4
26 0 2240 4591 7060 9653
30 0 2881 5905 9081 12.42K
35 0 3521 7218 11.1K 15.18K

↔

0 1 2 3 4
26 0.2264 0.2377 0.2496 0.2620 0.2752
30 0.2263 0.2377 0.2495 0.2620 0.2752
35 0.2264 0.2377 0.2496 0.2620 0.2751

↔

232 Analytica User Guide



Transforming functions
Rank ( X, I )

Returns an array of the rank values of X across index I. The lowest 
value in X has a rank value of 1, the next-lowest has a rank value of 2, 
and so on. I is optional if X is one-dimensional. If I is omitted when X 
is more than one-dimensional, the innermost dimension is ranked.

If two values are equal, they receive the same rank and the next higher 
value receives a rank 2 higher.

Library

Array

Examples

Rank(Mpg) →

Mpg 

Rank(Car_prices, Car_type) →

Car_type , Years 

Note: Example variables are defined on page 210.

Uncumulate ( X, I, firstElement)

Uncumulate(X,I) returns an array whose first element (along I) is 
the first element of X, and each other element is the difference between 
the corresponding element of X and the previous element of X. 
Uncumulate(X,I,firstElement) returns an array with the 
first element along I equal to firstElement, and each other element 
equal to the difference between the corresponding element of X and the 
previous element of X.

Uncumulate(X,I) is the inverse of Cumulate(X,I). 
Uncumulate(X,I,0) is similar to a discrete differential operator. 

26 30 35
1 2 3

1985 1986 1987 1988
VW 1 1 1 1
Honda 2 2 2 2
BMW 3 3 3 3
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 of 
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Library

Array

Example

Uncumulate(Cost_in_time, Time) →

Mpg , Time , Car_type = VW 

Uncumulate(Cost_in_time, Time,0) →

Mpg , Time , Car_type = VW 

Note: Example variables are defined on page 210.

Functions that select part of an array

Analytica includes four functions that are useful for selecting an 
element or slice of an array. 

With Choice(), you can select an element from a list.

With Slice(), you can select the nth element or “plane” of an arra
With Ident[I=U] and Subscript(), you can select the element
or “plane” of an array whose index matches a given value.

All these functions return a result that has one dimension less than
number of dimensions of its input array.

Choice ( I, n, inclAll)

Appears as a popup menu in the definition field, allowing selection
the nth item from I (see “Creating a popup menu” on page 153). 
Choice() must appear at the topmost level of a definition. It cann

0 1 2 3 4
26 2185 109 115 120 127
30 2810 141 147 155 163
35 3435 172 180 189 199

0 1 2 3 4
26 0 109 115 120 127
30 0 141 147 155 163
35 0 172 180 189 199

↔
↔
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Functions that select part of an array

nt. 
be used inside another expression. The optional inclAll parameter 
controls whether the “All” option (n=0) appears on the popup (inclAll 
defaults to True).

Library

Array

Examples
Choice(Years, 2) → 1986

If n=0, all values of I are returned: 

Choice(Years, 0) →
Years 

Note: Example variables are defined on page 210.

Ident [I = U ]

Returns a specific element or slice of an array, where Ident is the 
identifier of an array variable, I is an index variable, and U is one or 
more elements of index I that corresponds to the desired array eleme
Ident[I = U] is equivalent to Subscript(U1,I,U2) when 
Ident is a variable identifier that evaluates to U1. 

Library

Special

Examples

Car_prices[Car_type = ‘VW’]  →

Years 

1985 1986 1987 1988

1985 1986 1987 1988
8000 9000 9500 10K
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Car_prices[Car_type = [‘VW’, ‘Honda’]]  →

Years 

You can specify more than one index when each index is given a single 
value.

Car_prices[Car_type = ‘Honda’, Years = 1986] → 

13K

Note: Example variables are defined on page 210.

Slice ( U, I, N )

Returns the element or cross-section of array U, for which index I has 
position N. I must be an index of U, and N must be an integer or array 
of integers between 1 and the length of I.

If N is an integer, the result of Slice()  is an array indexed by all 
indexes of U except I. If N is an array, the result of Slice()  is also 
indexed by the indexes of N.

If U is a scalar, Slice(U,I,N)  returns U.

Library

Array

Examples

Here, Analytica returns the values in Cost corresponding to the first 
element in Car_type, that is, the values of VW:

Slice(Cost, Car_type, 1)  →

Mpg 

Here, N is an array of positions:

1985 1986 1987 1988
VW 8000 9000 9500 10K
Honda 12K 13K 14K 14.5K

26 30 35
2185 1705 1585
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Functions that select part of an array
Slice(Cost, Car_type, [1, 2]) →

Mpg 

Note: Example variables are defined on page 210.

Subscript ( U1, I, U2 )

Returns the element or slice of array U1, for which index I has value 
U2. I must be an index of U1, and U2 must be value(s) of I.

If U2 is a single value, the result of Subscript() is an array indexed 
by all indexes of U1 except I. If U2 is an array, the result of 
Subscript() is also indexed by the indexes of U2.

If U1 is a single value, Subscript(U1,I,U2) returns U1.

Subscript(U1,I,U2) is equivalent to Ident[I = U] when 
Ident is a variable identifier that evaluates to U1. Subscript() 
allows U1 to be an arbitrary expression.

Library

Array

Examples

To see the values in Cost corresponding to Mpg = 26:

Subscript(Cost, Mpg, 26) →
Car_type 

Here U2 is an array of values:

26 30 35
1 2185 1705 1585
2 2810 2330 2210

VW Honda BMW
2185 2810 3435
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Subscript(Cost, Car_type, [‘VW’, ‘Honda’])  →
Car_type , Mpg 

Example of an arbitrary expression as the first parameter:

Subscript(Cost/12, Mpg, 26)  →

Car_type 

Note: Example variables are defined on page 210.

Interpolation functions

Analytica includes three functions that interpolate across arrays. The 
graph below is a simple comparison of the three. 

The first two examples use the following variables:

Index_a:

26 30 35
VW 2185 1705 1585
Honda 2810 2330 2210

VW Honda BMW
182.1 234.2 286.2

Cubicinterp*

♦

*

∆

♦

D

R

X

Stepinterp

Linearinterp

∆

a b c
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Interpolation functions
Index_b:

Array_a:

Index_a , Index_b 

Cubicinterp ( D, R, X, I)

Returns the natural cubic spline interpolated values of R along D, 
interpolating for values of X. D and R must both be indexed by I, and 
D must be increasing along I. 

For each value of X, Cubicinterp() finds the nearest values from 
D, and using a natural cubic spline between the corresponding values 
of R, computes the interpolated value. If X is less than the minimum 
value in D, it returns the first value in R; if X is greater than the 
maximum value in D, it returns the last value for R.

Library

Special

Example

Cubicinterp(Index_b, Array_a, 1.5, Index_b) →

Index_a 

Linearinterp ( D, R, X, I)

Returns linearly interpolated values of X, given R representing an 
arbitrary piecewise linear function. D and R must both be indexed by 
I, and D must be increasing along I. R is an array of the corresponding 
output values for the function (not necessarily increasing and may be 
more than one dimension). X may be probabilistic and/or an array. 

1 2 3

1 2 3
a 7 -3 1
b -4 -1 6
c 5 0 -2

a b c
0.6875 -2.875 2.219
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For each value of X, Linearinterp() finds the nearest two values 
from D and interpolates linearly between the corresponding values 
from R. If X is less than the minimum value in D, it returns the first 
value in R. If X is greater than the maximum value in D, it returns the 
last value in R. 

Library

Special

Example

Linearinterp(Index_b, Array_a, 1.5, Index_b) →

Index_a 

Stepinterp ( D, A, X, I)

Returns the element or slice of array A for which D has the smallest 
value that is greater than or equal to X. D and A must both be indexed 
by I, and D must be increasing along index I. If X is greater than all 
values of D, returns the element for which D has the largest value. 

If X is a single value, the result of Stepinterp() is an array indexed 
by all indexes of A except D’s index. If X is an array, the result of 
Stepinterp() is also indexed by the indexes of X.

Stepinterp() is similar to Subscript() (see page 237); 
however, Subscript() selects based on the index value being equal 
to X, while Stepinterp() selects based on the array value being 
greater than or equal to X.

Stepinterp() can be used to perform table lookup.

Library

Special

Examples

To see the values in Cost corresponding to Mpg >= 33:

a b c
2 -2.5 2.5
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Other array functions
Stepinterp(MPG, Cost, 33, MPG) →

Car_type 

Here X is an array of values:

Stepinterp(MPG, Cost, [28,33], MPG) →

Note: Example variables are defined on page 210.

Other array functions

Concat ( A1, A2, I, J, K )

Appends array A2 to array A1. I and J are indexes of A1 and A2, 
respectively. K is the index of the resulting dimension, and usually 
consists of the list created by concatenating I and J. 

A1 and A2 must have the same number of dimensions. If they are one-
dimensional, the parameters I, J, and K are optional. If they are not 
specified, the resulting array is unindexed. 

If A1 and A2 are multidimensional, they must have the same 
nonconcatenated indexes.

Library

Array

Examples

In addition to the variables on page 210, these examples use the 
following:

VW Honda BMW
1585 2210 2835

VW Honda BMW
28 1705 2330 2955
33 1585 2210 2935
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More_years: 

All_years: 

More_prices: Car_type , More_years 

Concat(Years, More_years) →

Concat 

Sequence2: Sequence(1,7)

Concat(Years, More_years, Years, More_years, 
Sequence2) →

Sequence2 

Concat(Car_prices, More_prices, Years, 
More_years, All_years) →

All_years , Car_type 

1989 1990 1991

1985 1986 1987 1988 1989 1990 1991

1989 1990 1991
VW 11K 12K 12.5K
Honda 15K 15.5K 16.5K
BMW 23.5K 25K 27K

1985 1986 1987 1988 1989 1990 1991

1 2 3 4 5 6 7
1985 1986 1987 1988 1989 1990 1991

VW Honda BMW
1985 8000 12K 18K
1986 9000 13K 20K
1987 9500 14K 21K
1988 10K 14.5K 22K
1989 11K 15K 23.5K
1990 12K 15.5K 25K
1991 12.5K 16.5K 27K
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IndexNames(A)

Returns a list of the names of the indexes of the array A.

Library

Special

Example
IndexNames(Car_prices) → [‘Car_type’,’Years’]

Note: Example variables are defined on page 210.

Size ( U )

Returns the number of array elements of U. 

Library

Array

Examples
Size(Years) → 4

Size(Car_prices) → 12

Size(10) → 1

Note: Example variables are defined on page 210.

Sortindex ( D, I )

D is an array indexed by I. SortIndex(D,I) returns the elements of I, 
rearranged to indicate the ordering of the values in D (from smallest 
to largest value). The result is indexed by I. If D is indexed by 
dimensions other than I, each “column” is individually sorted, with the
resulting sort order being indexed by the extra dimensions. To obt
the sorted array D, use (see page 237):

D[I=Sortindex(D,I)]

When D is a one-dimensional array, the second parameter is optio
When the second parameter is omitted, the result is an unindexed
The one-parameter form should be used only when it is necessary
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.

obtain an unindexed result, such as when the result is being assigned 
to an index variable. The one-parameter form cannot array abstract if 
a new dimension is added to D.

Library

Array

Examples
Maint_costs:

Car_type 

SortIndex (Maint_costs,Car_type) →

SortIndex: Car_type

SortIndex (Maint_costs) →

SortIndex 

Define Index_new as an index node:

Index_new: Sortindex(Maint_costs)

Subscript(Maint_costs, Car_type, Index_new) →

Note: Example variables are defined on page 210.

Subset ( D )

Returns a list containing all the elements of D’s index for which D’s 
values are true (that is, non-zero). D must be a one-dimensional array

VW Honda BMW
1950 1800 2210

VW Honda BMW
Honda VW BMW

Honda VW BMW

Honda VW BMW
1800 1950 2210
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Other array functions
When to use:

Use Subset() to create a new index that is a subset of an existing 
index.

Library

Array

Example
Subset(Years < 1987) → [1985, 1986]

Note: Example variables are defined on page 210.

Unique(A,I)

Returns a maximal subset of I such that each indicated slice of A along 
I is unique. 

When to use:

Use Unique() to remove duplicate slices from an array, or to 
identify a single member of each equivalence class.

Library

Array

Example

DataSet: PersonNum , Field 

Unique(DataSet,PersonNum) → [1,2,3]

Unique(DataSet[Field=’Company’],PersonNum) → [1,3]

LastName FirstName Company
1 Smith Bob Acme
2 Jones John Acme
3 Johnson Bob Floorworks
4 Smith Bob Acme
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Matrix functions

Matrix functions perform matrix operations. In Analytica, a matrix is 
defined as a two-dimensional array of numbers with indexes of equal 
length.

Decompose ( C, I, J ) 

Returns the Cholesky decomposition (square root) matrix of matrix C 
along dimensions I and J. Matrix C must be symmetric and positive-
definite. (Positive-definite means that v * C * v > 0, for all vectors v.)

Cholesky decomposition computes a lower diagonal matrix L such that 
L * L’ = C, where L’ is the transpose of L.

Library

Special

Example
MatrixS:

l , m 

Decompose(MatrixS,l,m) →

l , m  

1 2 3 4 5
1 6 2 6 3 1
2 2 4 3 1 3
3 6 3 9 3 4
4 3 1 3 8 4
5 1 3 4 4 7

1 2 3 4 5
1 2.4495 0 0 0 0
2 0.8165 1.8257 0 0 0
3 2.4495 0.5477 1.6432 0 0
4 1.2247 0 0 2.5495 0
5 0.4082 1.4606 1.3389 1.3728 1.0113
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Matrix functions
Determinant ( C, I, J )

Returns the determinant of matrix C along dimensions I and J.

Library

Special

Example
MatrixA:

j , i 

Determinant(MatrixA, i, j) → 89

Invert ( C, I, J )

Returns the inversion of matrix C along dimensions I and J.

Library

Special

Example 

Set number format to fixed point, 3 decimal digits.

Invert(MatrixA, i, j) →

j , i 

1 2 3
a 4 1 2
b 2 5 3
c 3 2 7

1 2 3
a 0.326 -0.034 -0.079
b -0.056 0.247 -0.090
c -0.124 -0.056 0.202
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Transpose ( C, I, J )

Returns the transpose of matrix C along dimensions I and J.

Library

Special

Example

Transpose(MatrixA, i, j) →

j , i 

Dot product of two matrices

The dot product (i.e., matrix multiplication) of MatrixA and MatrixB is 
equal to

Sum(MatrixA * MatrixB, i)

Example

MatrixA is defined as above.

MatrixB:

k , i 

1 2 3
a 4 2 3
b 1 5 2
c 2 3 7

1 2 3
l 3 2 1
m 2 5 3
n 4 1 2
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Sum(MatrixA * MatrixB, i) →

k , j 

Array flattening functions

The MDArrayToTable() function “flattens” a multi-dimensional 
array into a two-dimensional table. The MDTable() function does 
the inverse, creating a multi-dimensional array from a table of valu
Viewing tabular results in a multi-dimensional form via MDTable() 
often provides informative new perspective on existing data.

Many external application programs, including spreadsheets and 
relational databases, are limited to two-dimensional tables. Thus,
when transfering multi-dimensional data between these appliation
and Analytica, it may be necessary to convert multi-dimensional d
into two-dimensional tables before transfering.

MDArrayToTable(A, I, L)

Transforms a multi-dimensional array, A, into a two-dimensional 
array (i.e., a table) indexed by I and L. The result contains one row 
along I for each element of A. L must contain a list of names of the 
indexes of A, followed by one final element. All elements of L must be 
strings. The column corresponding to the final element of L contains 
the cell value. If L does not contain all the indexes of A, array 
abstraction will create a set of tables indexed by the dimensions n
listed in L.

Before using MDArrayToTable(), you must define the index I with 
the appropriate number of elements. The number of elements in I may 
be either size(A), or the number of non-zero elements of A, 
otherwise an error results.

Library

Array

a b c
l 16 19 20
m 19 38 37
n 21 19 28
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Example
Rows := sequence(1,size(Cost_in_time))

Cols := [‘Mpg’,’Time’,’Car_type’,’Cost’]

MDArrayToTable(Cost_in_time,Rows,Cols) →

Rows , Cols

Note: Example variables are defined on page 210.

MDTable(T,Rows,Cols,Vars,conglomFn,missingval)

Returns a multi-dimensional array from a two-dimensional table of 
values. T is a two-dimensional array (i.e., a table) indexed by Rows 
and Cols. Each row of T specifies the coordinates of a cell in a multi-
dimensional array, along with the value for that cell.

The dimensions of the final result are given by the optional parameter 
Vars. Vars must be a list of index identifiers or index names. The 
length of Cols must be one greater than the length of Vars.

If Vars is omited, the dimensions of the final result are specified by the 
first n-1 elements of Cols (n=size(Cols)). In this case, the elements of 
Cols must be index identifiers or index names. 

The first n-1 columns of T specify the coordinates of a cell in the 
result. The final column of T specifies the value for the indicated cell.

Before using MDTable, you must define all of the indexes for the 
result. Each index must include all values that occur in the 
corresponding column of T or an error will result. The Unique()  
function is useful for defining the necessary indexes.

Mpg Time Car_type Cost
1 26 0 VW 2185
2 26 0 Honda 2385
3 26 0 BMW 3185
4 26 1 VW 2294
5 26 1 Honda 2314
6 26 1 BMW 3294
7 26 2 VW 2409
. . .
45 35 4 BMW 5175
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Array flattening functions

 

 

It is possible that two or more rows of T specify identical coordinates. 
In this case, a conglomeration function is used combine the values for 
the given cell. The conglomFn parameter is a string specifying which 
conglomeration function is to be used. Possible values are: ‘sum’ 
(default), ‘min’, ‘max’, ‘average’, or ‘product’.

It is also possible that no row in T corresponds to a particular cell. In
this case, the cell value is set to missingval, or if the missingval 
parameter is omited, the cell value is set to undefined. Note that 
undefined values can be detected using the IsUndef() function.

Library

Array

Example

Suppose T, Rows, and Cols are defined as indicated by the following
table:

Rows , Cols

MDTable(T,Rows,Cols,[Car_type,Mpg],

’average’,’n/a’) →

Car_type , Mpg

Notice that in the example, Rows 6 and 7 both specified values for 
Car_type=BMW, Mpg=35. The ‘average’ conglomeration function 
was used to combine these.

Car_type Mpg X
1 VW 26 2185
2 VW 30 1705
3 Honda 26 2330
4 Honda 35 2210
5 BMW 30 2955
6 BMW 35 2800
7 BMW 35 2870

26 30 35
VW 2185 1705 n/a
Honda 2330 n/a 2210
BMW n/a 2955 2835
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Text Functions

Analytica provides several functions for manipulating text strings. 
These are divided between the Array and Special libraries.

Join(A, I, separator,finalSeparator)

See “Join(A, I, separator,finalSeparator)” on page 226.

Split(S, separator)

Returns a list of substrings from S by splitting S each time separator 
occurs.

Example
Split(’Al#Bob#Carl’,’#’) → [’Al’,’Bob’,’Carl’]

Stringlength(Text)

Returns the number of characters in Text.

Example
Stringlength(’Hello’) → 5

Stringreplace(Text,pattern,s,all)

When the all parameter is False  or omitted, Stringreplace returns 
Text with the first occurrence of pattern replaced by s. When all is set 
to True , returns Text with all occurrences of pattern replaced by s.

Example
Stringreplace(’ababac’,’ba’,’x’) → ’axbac’

Stringreplace(’ababac’,’ba’,’x’,True) → ’axxc’
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Substring(Text,M,N)

Returns the substring of Text from the Mth to Nth characters (where 
the first character is M=1). N is optional, and if omitted, returns the 
substring starting at M to the end of the string.

Example
Substring(’Hello world’,3,5) → ’llo’

Substring(’Hello world’,7) → ’world’

Financial Functions

These functions can be accessed under the Definition menu Financial 
command, or in the Object Finder dialog box, Financial library. 

Where possible, the function names and parameters match those found 
in Microsoft Excel.

Parameters:

The same parameters occur in many of the financial functions. These 
parameters are described here. Dollar amounts for both parameters 
and return values of functions are always expressed as the amount you 
receive. If you make a payment, the amount is negative. If you receive 
a payment, the amount is positive.

Rate: The interest rate per period. For example, if periods are months, 
the rate should be adjusted to the monthly rate, not the annual rate 
(e.g., 8%/12 , or 1.08^(1/12)-1  with monthly compounding).

Nper: Number of periods in the lifetime of an annuity. 

Per: The period (between 1 and Nper) being computed. 

Pv: The present value of the annuity. For example, for a loan this is 
the loan amount (positive if you receive the loan, negative if you are 
the lender).

Fv: The future value of the annuity. This is the remaining value of the 
annuity after the final payment. In the case of a loan, for example, this 
is the balloon payment at the end (positive if you are the lender, 
negative if you pay the balloon amount). This parameter is usually 
optional with a default value of zero.
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Pmt: The total payment per period (interest + principal). If you receive 
payments, this is positive. If you make payments, this is negative.

Type: Indicates whether payments are due at the beginning or end of 
each period.

True: Payments are due at the beginning of each period, with the 
first payment due immediately.

False: (default) Payments are due at the end of each period.

Cumipmt( Rate, Nper, Pv, StartPeriod, EndPeriod, Type )

Returns the cumulative interest paid on an annuity between, and 
including, StartPeriod (shown as sp in equation below) and EndPeriod 
(shown as ep in equation below). The annuity is assumed to have a 
constant interest rate and periodic payments. This is equal to 

Example

Interest payments during the first year on a $100,000 loan at 8% is:

CumIPmt(8%/12,360,100K,1,12) → -7,969.81

The result is negative since these are payments.

Cumprinc( Rate, Nper, Pv, Start_period, End_Period, Type )

Returns the cumulative principal paid on an annuity between, and 
including, StartPeriod (shown as sp in equation below) and EndPeriod 
(shown as ep in equation below). The annuity is assumed to have a 
constant interest rate and periodic payments. The result is equal to

IPmt Rate n Nper Pv 0 Type,,,,,( )
n sp=

ep

∑

PPmt Rate n Nper Pv 0 Type,,,,,( )
n sp=

ep

∑
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Example

The total principal paid during the first year on a $100,000 loan at 8% 
is:

CumPrinc(8%/12,360,100K,1,12) → -835.36

The result is negative since these are payments.

Fv( Rate, Nper, Pmt, Pv, Type )

Returns the future value of an annuity investment with constant 
periodic payments and fixed interest rate. The result is positive if you 
receive money at the end of the annuity’s lifetime, and negative if y
must make a payment at the end of the annuity’s lifetime.

Examples

You invest $1000 in an annuity that pays 6% annual interest, 
compounded monthly (0.5% per month), that pays out $50 at the 
of each month for 12 months, and then refunds whatever is left af
12 months. The amount refunded is:

Fv(0.5%, 12, 50, -1000) → $444.90

You borrow $50,000 at a fixed annual rate of 12% (1% per month)
You make monthly payments of $550 for 15 years, and then pay o
the remaining balance in a single balloon payment. That final ballo
payment is (the negative is because it is a payment for you):

-Fv(1%, 15*12, -550, 50000) → $25,020.99

You open a fixed-rate bank account that pays 0.5% per month in 
interest. At the beginning of each month (including when you open 
account) you deposit $100. The amount in the account at the end o
each of the first three years is:

Fv(0.5%,[12,24,36],-100,0,True) → 

[$1239.72, $2555.91, $3953.28]

Ipmt( Rate, per, Nper, Pv, Fv, Type )

Returns the interest portion of a payment on an annuity, assuming
constant period payments and fixed interest rate. 
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The interest you pay in the 24th month on a 30-year fixed $100K loan 
at 8%/12 monthly interest is (the result of IPmt is negative since this 
is a payment for you):

-IPmt(8%/12, 24, 12*30, 100K) → $655.59

Irr( Values, I, Guess )

Returns the Internal Rate of Return of a series of periodic payments 
(negative values) and inflows (positive values). The IRR is the 
discount rate at which the Net Present Value (NPV) of the flows is 
zero. The array Values must be indexed by I.

If the cash flow never changes sign, IRR() will have no solution and 
returns NaN (not a number). If a cash flow changes sign more than 
once, Irr() may have multiple solutions, and will return the first 
solution found. The implementation uses an iterative gradient-descent 
search to locate a solution. The optional argument, Guess, can be 
provided as a starting value for the search (default is 10%). When there 
are multiple solutions, the one closest to Guess will usually be 
returned. If no solution is found within 30 iterations, Irr() returns 
NaN.

To compute the IRR for a non-periodic cash flow, use XIRR().

Example

Earnings: Time

Irr(Earnings,Time) → 17.15%

Nper( Rate, Pmt, Pv, Fv, Type )

Returns the number of periods of an annuity with constant periodic 
payments and fixed interest rate.

1999 2000 2001 2002 2003 2004
-1M -500K -100K 100K 1M 2M
256 Analytica User Guide



Financial Functions
Example

You invest $10,000 in an annuity that pays 8% annually. Each year 
you withdraw $1,000. Your annuity will last for

NPer(8%,1000,-10K) → 20.91 (years)

Npv( DiscountRate, Values, I )

Returns the net-present value of a cashflow with equally spaced 
periods. The Values parameter contains a series of periodic payments 
(negative values) and inflows (positive values), indexed by I. Future 
values are discounted by DiscountRate per period. The NPV is given 
by

Note that the first value is discounted as if it is one step in the future. 
To compute the NPV for a non-periodic cash flow, use Xnpv().

Example

Earnings: Time

At a discount rate of 5%, the net present value of the this cash flow is:

Npv( 5%, Earnings, Time ) → $865,947.76

Pmt( Rate, Nper, Pv, Fv, Type )

Returns the total payment per period (interest + principal) for an 
annuity with constant periodic payments and fixed interest rate.

Example

You obtain a 30-year fixed mortgage at 8%/12 per month for $100K. 
Your monthly payment will be (note that the result of Pmt is negative 
since this is a payment for you):

-Pmt( 8%/12, 30*12, 100K ) → $733.76

Values I j=[ ]
1 DiscountRate+( )j

----------------------------------------------------

j 1=

n

∑

1999 2000 2001 2002 2003 2004
-1M -500K -100K 100K 1M 2M
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Ppmt( Rate, Per, NPer, Pv, Fv, Type )

Returns the principal portion of a payment on an annuity with constant 
period payments and fixed interest rate.

Example

You have a 30-year fixed $100K loan at a rate of 8%/12 monthly. On 

your 24th payment, the amount of your payment that goes towards 
principal is (note that the result of PPmt() is negative since this is a 
payment for you):

-PPmt(8%/12, 24, 12*30, 100K) → $78.18

Pv( Rate, Nper, Pmt, Fv, Type )

Returns the present value of an annuity. The annuity is assumed to 
have constant periodic payments to you of Pmt per period for Nper 
periods, with a return of Rate per period.

Example

To receive $100 per month from an annuity that returns 6%/12 per 
month for the next 10 years, you would need to invest (note that the 
result from Pv() is negative since you are paying to make the 
investment):

-Pv(6%/12, 10*12, 100) → $9,007.35

Rate( NPer, Pmt, Pv, Fv, Type, Guess )

Returns the interest rate (per period) for an annuity. The value returned 
is the interest rate that results in equal payments of Pmt per period over 
the NPer periods of the annuity.

In general, Rate() may have zero or multiple solutions. The 
implementation uses an interative search algorithm. The optional 
Guess may be provided as a starting point for the search, which will 
usually result in the solution closest to Guess being returned. If no 
solution is found in 30 iterations, Rate() returns NaN.
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Example

You obtain a 30-year mortgage at a supposed 7% annual percentage 
rate for $100K. To do so, you pay $2,000 up front in “points”, and 
another $1,500 in fees. Assuming you hold the loan for its full term
the effective interest rate of your loan (for you) is

Rate(30,Pmt(7%,30,100K),100K-3500) → 7.36%

Xirr( Values, Dates, I, Guess )

Returns the annual Internal Rate of Return (IRR) for a series of 
payments (negative values) and inflows (positive values) that occu
non-periodic intervals. Both Values and Dates must be indexed by I. 
The Values array constains the cash flow amounts, the Dates array 
contains the date of each payment or inflow, where each date is 
Analytica’s expressed as the number of days since Jan 1, 1904. T
rate is based on a 365 day year.

If the cash flow never changes sign, there is no solution and Xirr() 
returns NaN. If the cash flow changes sign more than once, Xirr() 
may have multiple solutions, but will return only the first solution 
found. The optional parameter, Guess, may be provided as a starting 
point for the iterative search, and Xirr() will generally find the 
solution closest to Guess. If not provided, Guess defaults to 10%. If no 
solution is found within 30 iterations, Xirr() returns NaN.

To compute the IRR for a series of period payments, use Irr(). 

Example

EarningAmt: J

EarningDate: J

XIrr(EarningAmt,EarningDate,J) → 9.31%

1 2 3 4
-400K -200K 100K 600K

1 2 3 4
July 5, 1999 Dec 1, 1999 Jan 21, 2000 Aug 10, 2001
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t 
Analytica Note:  EarningDate can be entered by selecting Number 
Format from the Result menu while editing the table for EarningDate. 
From the Number Format Dialog, select a date format, then enter the 
dates.

Xnpv( Rate, Values, Dates, I )

Returns the Net Present Value (NPV) of a non-periodic cash flow with 
a constant discount rate. Rate is the annual discount rate for a 365 day 
year. Both Values, the cash-flow amounts, and Dates, the date of each 
payment (negative value) or inflow (positive value), must be indexed 
by I.

See also Npv().

Example

Using the cash flow shown in the example for XIrr() above, the net 
present value at a 5% discount rate is:

XNpv(5%,EarningAmt,EarningDate,J) → $42,838.71

Advanced math functions

These functions can be accessed under the Definition menu 
Advanced Math command, or in the Object Finder dialog box, 
Advanced Math library. Functions in this section are generally for 
more advanced mathematical users than those found in “Math 
functions” on page 213.

Arccos(X)

Returns the inverse cosine of X, where X is between 0 and 1. The resul
is in degrees, between 0 and 180.

Arccos(1) → 0

Arccos(Cos(45)) → 45
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Arcsin(X)

Returns the inverse sine of X, where X is between 0 and 1. the result is 
in degrees, between -90 and 90.

Arcsin(1) → 90

Arcsin(Sin(45)) → 45

Arctan2( Y, X )

Returns the arctangent of Y/X without loosing information about 
which quadrant the point is in. The result is the angle (in degrees) 
between the X axis and the point (X,Y) in the two dimensional plane, 
in the range (-180,180]. If Y=X=0, returns zero.

Arctan2( -1,1 ) → -45

ArcTan2( 0,-1 ) → 180

BetaFn( A, B )

The Beta function, defined as:

BetaI( X, A, B )

The incomplete beta function, defined as:

The incomplete beta function is equal to the cumulative probability of 
the beta distribution at X. It is useful in a number of mathematical and 
statistical applications.

The cumulative binomial distribution, defined as the probability that 
an event with probability p occurs k or more times in n trials, is given 
by:

BetaFn A B,( ) x
A 1–

1 x–( )B 1–
xd

0

1

∫=

BetaI X A B, ,( ) 1
Beta A B,( )
--------------------------- x

A 1–
1 x–( )B 1–

xd
0

X

∫=

Pr BetaI p k n k– 1+, ,( )=
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The Student’s distribution with n degrees of freedom, used to test 
whether two observed distributions have the same mean, is readi
available from the beta distribution as:

The F-distribution, used to test whether two observed samples with

and  degrees of freedom have the same variance, is readily obta

from BetaI as:

Combinations( k, n )

“n choose k”. The number of unique ways that k items can be chosen 
from a set of n elements (without replacement and ignoring the orde

Combinations(2,4) → 6

They are: {1,2}, {1,3}, {1,4}, {2,3}, {2,4}, {3,4}

Cosh(X)

The hyperbolic cosine of X, X assumed to be in degrees.

CumNormal( X, mean, stddev )

Returns the cumulative density function for a normal distribution wi
a given mean and standard deviation. Mean and stddev are optio
and default to a standard normal distribution.

CumNormal(1) - CumNormal( -1 ) → .683

i.e., 68.3% of the area under a normal distribution is contained wit
one standard deviation of the mean.

CumNormalInv( Y, mean, stddev )

The inverse cumulative normal density. Returns the value X for wh
the area under a normal density from -INF to X is equal to Y. Mea
and stddev are optional and default to Mean=0, stddev=1.

Student x n( ) 1 BetaI n n x2+( )⁄ n 2⁄ 1 2⁄, ,( )–=

n1

n2

F x n1 n2, ,( ) BetaI n2 n1x n2+( )⁄( )=
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Erf( X )

The error function, defined as:

ErfInv( Y )

The inverse error function. Returns the value X such that Erf(X)=Y.

ErfInv(Erf(2)) → 2

GammaFn( X )

Returns the gamma function of X, defined as

The gamma function grows very quickly. For example, when n is an 
integer, GammaFn(n+1) = n!. For this reason, it is often preferable to 
use the LGamma function.

GammaI( X, A, B )

Returns the incomplete gamma function, defined as:

A is the shape parameter, B is an optional scale factor (default B=1). 
Note that some textbooks use  as as the scale factor. The 

incomplete gamma function is defined for .

The incomplete gamma function returns the cumulative area from zero 
to X under the gamma distribution.

The incomplete gamma function is useful in a number of mathematical 
and statistical contexts.

Erf x( ) 2

π
------- e

t2–
td

0

x

∫=

Γ X( ) t
x 1–

e
t–

td
0

∞

∫=

GammaI X A B, ,( ) 1
Γ A( )
------------ e

t–
t
A 1–

td
0

x B⁄

∫=

λ 1 A⁄=

X 0≥
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The cumulative Poisson distribution function, which encodes the 
probability that the number of Poisson random events (x) occuring will 
be less than k (where k is an integer) where the expected mean number 
is A, is given by (recall that parameter B is optional):

GammaIInv( Y,A,B )

The inverse of the incomplete gamma function. Returns the value X 
such that GammaI(X,A,B)=Y. B is optional and defaults to 1.

Lgamma( X )

Returns the Log Gamma function of X. Without numerical overflow, 
this function is exactly equivalent to ln(GammaFn(X)). Because the 
gamma function grows so rapidly, it is often much more convenient to 
use LGamma() to avoid numeric overflow.

Permutations( k,n )

The number of possible permutations of k items taken from a bucket 
of n items.

Permutations(2,4) → 12

They are: {1,2}, {1,3}, {1,4}, {2,1}, {2,3}, {2,4}, {3,1}, {3,2}, {3,4}, 
{4,1}, {4,2}, {4,3}

Regression( Y,B,I,K )

Generalized linear regression. Finds the best-fit (least squared error) 
curve to a set of data points. Regression finds the parameters  in an 

equation of the form:

The data points are contained in Y (the dependent variable) and B (the 
independent variables), both of which must be indexed by I. B is the 
basis set and is indexed by I and K. The function returns the set of 
parameters  indexed by K.

P x k<( ) GammaI k A,( )=

ak

y akBk x( )
k

∑=

ak
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With the generalized form of linear regression, it is possible to have 
several independent variables, and your basis set may even contain 
non-linear transformations of your independent variables. 
Regression() may be used to find the best-fit planes or 
hyperplanes, best-fit polynomials, and more complicated functions.

Regression uses a state-of-the-art algorithm based on singular-value 
decomposition that is numerically stable, even if the basis set contains 
redundant terms.

Example 1

Suppose a set of (x,y) points are contained in X and Y, both indexed by 
I, and we wish to find the parameters m and b of the best-fit line 

. We first define an index K as a list of labels:

K: [’m’,’b’]

Next, define B as a table indexed by K:

B: K 

Regression(Y,B,I,K)  returns the coefficients m and b as an 
array indexed by K.

Example 2

We wish to fit the following polynomial to (x,y) data:

Define K to be the list:

B: [X^5,X^4,X^3,X^2,X,1]

Regression(Y,B,I,B)  returns the best-fit coefficients of the 
polynomial indexed by B.

Sinh( X )

The hyperbolic sine of X, X assumed in degrees.

m b
X 1

y mx b+=

y a5x
5

a4x
4

a3x
3

a2x
2

a1x a0+ + + + +=
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Tanh( X )

The hyperbolic tangent of X, X assumed in degrees.

Datatype Functions

Non-array values in Analytica may be numbers, text, or the special 
value undefined. The functions in this section, found on the Special 
menu, can be used to determine the value type.

Isnan(X)

Returns True if X is numeric but not a number nor infinity (i.e., if X is 
NaN).

IsNaN(0/0) → True IsNaN(5) → False

IsNaN(Inf) → False IsNaN(‘Hello’) → False

Isnumber(X)

Returns True if X is numeric.

IsNumber(0) → True IsNumber(0/0) → True

IsNumber(Inf) → True IsNumber(’hi’) → False

IsNumber(5) → True IsNumber(’5’) → False

Istext(X)

Returns True if X is a string.

IsText(7) → False IsText(’hello’) → True

IsText(’7’) → True

Isundef(X)

Returns True if X is the special value undefined . Equivalently, 
returns False if X is a number or a string.
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The special value undefined cannot be directly entered in an 
expression. However, it may result from the evaluation of certain 
Analytica expressions. For example, the Subindex() function 
returns undefined if the given value is not found.

Isundef(’hello’) → False Isundef(5) → False

Isundef(0/0) → False Isundef(1/0) → False

Isundef(Subindex(Time*2,1000,Time)) → True

Note: In the last example, Time*2 does not contain the value 1000, so 
Subindex returns undefined.

Control functions

The two functions in this section can be used to control specialized 
evaluation of arrays.

For Temp:= I Do Expr

For each successive value of index I, assigns that value to variable 
Temp, and evaluates expression Expr. Expr may refer to I and/or Temp. 
Temp is a local or temporary variable that can be referred to only 
within the expression Expr.

The result of the For control function is an array indexed by I 
containing the results of evaluating Expr. I must be an index variable, 
or be defined as a list or Sequence() .

If you make appropriate use of the intelligent array features described 
earlier in this and preceding chapters, you will rarely need to use For 
structure (unlike in conventional computer languages, which require 
extensive use of For loops and related control structures for handling 
arrays). For  is sometimes useful in these specialized cases:

• To avoid the attempted evaluation of out-of-range values by nest
an If-Then-Else inside a For.

• To apply an Analytica function that requires a scalar or one- or 
two-dimensional array input to a higher-dimensioned array.

• To reduce the memory needed for calculations with very large 
arrays by reducing the memory requirement for intermediate 
results.
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Avoiding out-of-range errors: Consider the following expression:

If X<0 Then 0 Else Sqrt(X)

The If-Then-Else is included in this expression to avoid the 
warning “Square root of a negative number.” However, if X is an array 
of values, this expression may not avoid the warning since Sqrt(X) 
is evaluated before If-Then-Else selects which elements of 
Sqrt(X) to include. To avoid the warning (assuming X is indexed by 
I) the expression can be rewritten as

For j:=I do
If X[I=j]<0 then 0 else Sqrt(X[I=j])

or as (see next section):

Using y:=X in I do
If y<0 Then 0 else Sqrt(y)

Situations like this can often occur during slicing operations. For 
example, to shift X one position to the right along I, the following 
expression would encounter an error:

if I<2 then X[I=1] else X[I=I-1]

The error occurs when X[I=I-1] is evaluated since the value 
corresponding to I-1=0 is out-of-range. The avoid the error, the 
expression can be re-written as:

For j:=I do 
If j<2 then X[I=1] else X[I=j-1]

Note that out-of-range errors can also be avoided without using For 
by placing the conditional inside an argument. For example, the tw
examples above can be written without For as follows:

Sqrt(if X<0 then 0 else X)

X[I=(if I<2 then 1 else I-1)]
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Dimensionality reduction: For can be used to apply a function that 
requires a scalar, one- or two- dimensional input to a multi-dimensional 
result. This usage is rare in Analytica since array abstraction normally 
does this automatically; however, the need occassionally arises in some 
circumstances.

Suppose you have an array A indexed by I, and you wish to apply a 
function f(x) to each element of A along I. In a conventional 
programming language, this would require a loop over the elements of 
A; however, in almost all cases, Analytica’s array abstraction does 
automatically — the expression is simply: f(A), the result remains 
indexed by I. However, there are a few cases where Analytica does 
automatically array abstract, or it is possible to write a user-define
function that does not automatically array abstract (e.g., by declar
a parameter to be of type Scalar, see page 407). For example, 
Analytica does not array abstract over functions such as Sequence, 
Split, Subset, or Unique, since these return unindexed lists o
varying lengths that are unknown until the function evaluates. 
Suppose we have the following variables defined (note: A is an array 
of text strings):

A: Index_1

Index_2:

We wish to split the strings in A and obtain a two dimensional array o
letters indexed by Index_1 and Index_2. Since Split does not 
array abstract, we must do each row separately and re-index by 
Index_2 before the result rows are recombined into a single array. T
is accomplished by the following loop.

for Row:=Index_1 do

Array(Index_2,Split(A[Index_1=Row],’,’))

resulting in

1 A,B,C
2 D,E,F
3 G,H,I

1 2 3
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Index_1 , Index_2  

Reducing Memory Requirements: In some cases, it is possible to 
reduce the amount of memory required for intermediate results during 
the evaluation of expressions involving large arrays. For example, 
consider the following expression:

MatrixA: A two dimensional array indexed by M and N.
MatrixB: A two dimensional array indexed by N and P.

Average(MatrixA * MatrixB, N)

During the calculation, Analytica needs memory to compute MatrixA 
* MatrixB, an array indexed by M, N, and P. If these indexes have sizes 
100, 200, and 300 respectively, then MatrixA * MatrixB contains 
6,000,000 numbers, requiring over 60 megabytes of memory at 10 
bytes per number.

To reduce the memory required, use the following expression instead

For L:=M Do Average(MatrixA[M=L]*MatrixB,N)

Each element MatrixA[M=L]*MatrixB has dimensions N and P, 
needing only 200x300x10= 600 kilobytes of memory at a time.

Note that for the special case of a dot product (See “Dot product of 
matrices” on page 248.), where an expression has the form 
Sum(A*B,I), Analytica performs a similar transformation 
internally.

Using Temp := X Do Expr

Assigns the value of X to a temporary variable, Temp, and then 
evaluates Expr, which is an expression referring to Temp.

Temp is a local or temporary variable that can be referred to only 
within the expression Expr. Use Using ... do whenever a complex 
subexpression appears more than once in an expression. The Using 
expression is more compact to write, clearer to read, and more 
efficient to evaluate, since Expr is evaluated only once.

1 2 3
1 A B C
2 D E F
3 G H I
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If you have two or more common subexpressions you can use two or 
more nested Using ... do expressions.

Analytica Note:  The temporary variables from a Using ... do 
control expression are accessible only within the variable that defines 
them. If your model has the same subexpression in the definitions of 
multiple variables, consider defining a new permanent variable with this 
expression, and using that variable instead of the subexpression in each 
definition.

An alternate syntax is

Using Temp:= X in I do Expr

where I is an index of X. This alternative form is essentially a 
shorthand for

For j:=I do

using Temp:=X[I=j] do Expr

Library

Special

Examples

Instead of defining a variable as:

Sum(Array_a*Array_b,N)/

(1+Sum(Array_a*Array_b,N))

define it as:

Using t:=Sum(Array_a*Array*b,N) Do t/(1+t)

To compute a correlation between Xdata and Ydata, instead of:

Sum((Xdata-Sum(Xdata,Data_index)/Nopts)*(Ydata-

Sum(Ydata,Data_index)/Nopts),Data_index)/

Sqrt(Sum((Xdata-Sum(Xdata,Data_index)/

Nopts)^2,Data_index) * Sum((Ydata-

Sum(Ydata,Data_index)/Nopts)^2,Data_index))

define the correlation as:
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Using mx:=Sum(Xdata,Data_index)/Nopts Do

Using my:=Sum(Ydata,Data_index)/Nopts Do

Using dx:=Xdata-mx Do

Using dy:=Ydata-my

Do Sum(dx*dy,Data_index)

/Sqrt(Sum(dx^2,Data_index)*

Sum(dy^2,Data_index))

The latter expression is faster to execute and clearer to read.

Note: The correlation expression in this example is an alternative to 
Analytica’s built-in Correlation() function (See 
“Correlation ( X, Y )” on page 328.) when data is dimensione
by an index other than the system index Run.
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In this Chapter

This chapter shows you how to:

• Choose a distribution

• Define a variable as a distribution

• Use Analytica’s built-in probability 
distributions



Choosing an appropriate distribution
Analytica makes it easy to model and analyze uncertainties even if you 
have minimal background in probability and statistics. The graphs 
below review several key concepts from probability and statistics that 
will help you understand the probabilistic modeling facilities in 
Analytica. This chapter assumes that you have encountered most of 
these concepts before, but possibly in the distant past. If you need 
more information, see the Glossary or refer to an introductory text on 
probability and statistics.

Choosing an appropriate distribution

With Analytica you can express uncertainty about any variable by 
using a probability distribution. You may base the distribution on 
available relevant data, on the judgment of a knowledgeable 
individual, or on some combination of data and judgment. 
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Answer the following questions about the uncertain quantity to select 
the most appropriate kind of distribution:

• Is it discrete or continuous?

• If continuous, is it bounded?

• Does it have one mode or more than one?

• Is it symmetric or skewed?

• Should you use a standard or a custom distribution?

We will discuss how to answer each of these in turn.

Is the quantity discrete or continuous?

When trying to express uncertainty about a quantity, the first techn
question is whether the quantity is discrete or continuous. 

A discrete quantity has a finite number of possible values—for 
example, the gender of a person or the country of a person’s birth
Logical or Boolean variables are a type of discrete variable with onl
two values, true or false, sometimes coded as yes or no, present 
absent, or 1 or 0—for example, whether a person was born before
January 1, 1950, or whether a person has ever resided in Californ

A continuous quantity can be represented by a real number, and h
infinitely many possible values between any two values in its doma
Examples are the quantity of an air pollutant released during a giv
period of time, the distance in miles of a residence from a source o
pollution, and the volume of air breathed by a specified individual 
during one year. 

For a large discrete quantity, such as the number of humans resid
within 50 miles of Disneyland on December 25, 1980, it is often 
convenient to treat it as continuous. Even though you know that th
number of live people must be an integer, you may want to repres
uncertainty about the number with a continuous probability 
distribution.

Conversely, it is often convenient to treat continuous quantities as
discrete by partitioning the set of possible values into a small finite 
of partitions. For example, instead of modeling human age by a 
continuous quantity between 0 and 120, it is often convenient to 
partition people into infants (age < 2 years), children (3 to 12), 
teenagers (13 to 19), young adults (20 to 40), middle-aged (41 to 
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and seniors (over 65 years). This process is termed discretizing. It is 
often convenient to discretize continuous quantities before assessing 
probability distributions. 

Does the quantity have bounds?

If the quantity is continuous, it is useful to know if it is bounded before 
choosing a distribution—that is, does it have a minimum and/or 
maximum value?

Some continuous quantities have exact lower bounds. For examp
river flow cannot be less than zero (assuming the river cannot reve
direction). Some quantities also have exact upper bounds. For 
example, the percentage of a population that is exposed to an air 
pollutant cannot be greater than 100%. 

Most real world quantities have de facto bounds—that is, you can 
comfortably assert that there is zero probability that the quantity 
would be smaller than some lower bound, or larger than some upp
bound, even though there is no precise way to determine the bou
For example, you can be sure that no human could weigh more th
5000 pounds; you might be less sure whether 500 pounds is an 
absolute upper bound. 

Many standard continuous probability distributions, such as the 
normal distribution, are unbounded. In other words, there is some
probability that a normally distributed quantity is below any finite 
value, no matter how small, and above any finite value, no matter h
large.

Nevertheless, the probability density drops off quite rapidly for 
extreme values, with near exponential decay, in fact, for the norm
distribution. Accordingly, people often use such unbounded 
distributions to represent real world quantities that actually have fin
bounds. For example, the normal distribution generally provides a
good fit for the distribution of heights in a human population, even
though you may be certain that no person's height is less than zer
greater than 12 feet.

How many modes does it have?

The mode of a distribution is its most probable value. The mode of
uncertain quantity is the value at the highest peak of the density 
function, or, equivalently, at the steepest slope on the cumulative 
probability distribution. 
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Important questions to ask about a distribution are how many modes it 
has, and approximately where it, or they, are? Most distributions have 
a single mode, but some have several and are known as multimodal 
distributions. 

If a quantity has two or more modes, you can usually view it as a 
combination of two or more populations. For example, the distribution 
of ages in a daycare center at leaving time might include one mode at 
age 3 for the children and another mode at age 27 for the parents and 
caretakers. There is obviously a population of children and a 
population of parents. It is generally easier to decompose a 
multimodal quantity into its separate components and assess them 
separately than to assess a multimodal distribution. You can then 
assess a unimodal (single mode) probability distribution for each 
component, and combine them to get the aggregate distribution. This 
approach is often more convenient, because it lets you assess single-
mode distributions, which are easier to understand and evaluate than 
multimodal distributions.

Is the quantity symmetric or skewed?
A symmetrical distribution is symmetrical about its mean. A skewed 
distribution is asymmetric. A positively skewed distribution has a 
thicker upper tail than lower tail; and vice versa, for a negatively 
skewed distribution. 

Probability distributions in environmental risk analysis are often 
positively skewed. Quantities such as source terms, transfer factors, 
and dose-response factors, are typically bounded below by zero. There 
is more uncertainty about how large they might be than about how 
small they might be. 

A standard or custom distribution?

The next question is whether to use a standard parametric 
distribution—for example, normal, lognormal, or beta—or a custom
distribution, where the assessor specifies points on the cumulative
probability or density function.

mode

modes

Symmetric

Positive Skew
Negative Skew
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Considering the physical processes that generate the uncertainty in the 
quantity may suggest that a particular standard distribution is 
appropriate. More often, however, there is no obvious standard 
distribution to apply.

It is generally much faster to assess a standard distribution than a full 
custom distribution, because standard distributions have fewer 
parameters, typically from two to four. You should usually start by 
assigning a simple standard distribution to each uncertain quantity 
using a quick judgment based on a brief perusal of the literature or 
telephone conversation with a knowledgeable person. You should 
assess a custom distribution only for those few uncertain inputs that 
turn out to be critical to the results. Therefore, it is important to be able 
to select an appropriate standard distribution quickly for each quantity. 

Defining a variable as a distribution

To define a variable as an Analytica probability distribution, first 
select the variable and open either the variable’s Object window or
Attribute panel of the diagram (see “The Attribute panel” on page 2
with Definition selected from the Attribute popup menu (see “The 
Attribute popup menu” on page 28).

To define the distribution:

1. Click on the Expression popup menu above the definition field 
and select Distribution.
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The Object Finder opens, showing the Distribution library.

2. Select the distribution you wish to use.

3. Enter the values for the parameters. You can use an expression 
or refer to other variables by name in the parameter fields.

4. Click on OK to accept the distribution.

If the parameters of the distribution are single numbers, a button 
appears with the name of the distribution, indicating that the variable 
is defined as a distribution. To edit the parameters, click on this button. 

If the parameters of the distribution are complex expressions, the 
distribution displays as an expression. For example,

Normal((Price/Mpy) * Mpg, Mpg/10)

Library popup menu: Distribution 
library is selected

Parameters to the
distribution

Example probability density, 
indicating parameters

Button with the name of the 
distribution

Parameters of the distribution
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Entering a distribution as an expression

Alternatively, you can directly enter a distribution as an expression:

1. Set the cursor in the definition field and type in the distribution 
name and parameters, e.g.

Normal(.105,0.015)

2. Press Alt-enter or click on the  button.

You can also paste a distribution from the Distribution library in the 
Definition menu (see “Pasting from a library in the Definition menu
on page 145).

You can edit a distribution as an expression, whether it was entere
a distribution from the Distribution library or as an expression, by 
selecting expr from the Expression popup menu.

Including a distribution in a definition

You can enter a distribution anywhere in a definition, including in a
cell of an edit table. Thus, you can have arrays of distributions. 

To enter a distribution:

1. Set the insertion point where you wish to enter the distribution 
in the definition field or edit table cell.

2. Enter the distribution in any of the following ways:

• Type in the name of the distribution.

• Paste it from the from the Distribution Library under the 
Definition menu.

• Select Paste Identifier from the Definition menu to paste it 
from the Object Finder.
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3. Type in missing parameters, or replace parameters enclosed as 

<<x>>.

Overview of built-in probability distributions

Analytica has the following built-in probability functions in the 
distribution library. The continuous functions are described in Chapter 
14 and the discrete functions are described in Chapter 15.

In addition to the above distribution, Analytica provides several 
additional distributions as module libraries. These are found in the 
Libraries folder in the Analytica directory. To use these 
distributions, select Add Module... from the File menu, and select 
Continuous Distributions.ana or Discrete Distributions.ana. You can 
link or embed the library. The additional distributions provided by 
these libraries are

Continuous Beta()
Cumdist()
Fractiles()
Gamma()
Lognormal()
Normal()
Probdist()
Triangular()
Uniform()

Discrete Bernoulli()
Certain()
Chancedist()
Probtable

Continuous Exponential()
Logistic()
LogTriangular()
LogUniform()
Weibull()

Discrete Binomial()
Geometric()
Hypergeometric()
Poisson
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Probabilistic Calculation

Analytica performs probabilistic evaluation of probability 
distributions through simulation—by computing a random sample 
values from the actual probability distribution for each uncertain 
quantity. The result of evaluating a distribution is represented 
internally as an array of the sample values, indexed by Run. Run is an 
index variable that identifies each sample iteration by an integer fr
1 to Samplesize.

You can display a probabilistic value using a variety of uncertainty
view options—the mean, statistics, probability bands, probability 
density (or mass function), and cumulative distribution function (s
“Uncertainty view options” on page 44). All these views are derive
or estimated from the underlying sample array, which you can insp
using the last uncertainty view, Sample.

Example

A:  Normal(10,2) →

Iteration (Run)  

Analytica Note:  The values in a sample are generated at random from 
the distribution; if you try this example and display the result as a table, 
you may see values different from those shown here. To reproduce this 
example, reset the random number seed to 99 and use the default 
sampling method and random number method (see “Uncertainty Se
dialog box” on page 284). 

For each sample run, a random value is generated from each 
probability distribution in the model. Output variables of uncertain 
variables are calculated by calculating a value for each value of Run.

Example

B:  Normal(5,1) →

Iteration (Run)

1 2 3 4 5 6
10.74 13.2 9.092 11.44 9.519 13.03

1 2 3 4 5 6
5.09 4.94 4.65 6.60 5.24 6.96
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C:  A + B →

Iteration (Run) 

Note that each sample value of C is equal to the sum of the 
corresponding values of A and B.

To control the probabilistic simulation, as well as views of 
probabilistic results, use the Uncertainty Setup dialog box (see 
“Uncertainty Setup dialog box” on page 284).

Analytica Note:  If you try to apply an array reducing function (see 
“Array-reducing functions” on page 223) to a probability distribution 
across Run, Analytica returns the distribution's Mid value.
Example
X: Beta(2,3)
Mid(X) → 0.3857 and Max(X,Run) → 0.3857
To evaluate the input parameters probabilistically and reduce acros
Run, use Sample() (see page 333).
Example
Max(Sample(X),Run) → 0.8892

Uncertainty Setup dialog box

Use the Uncertainty Setup dialog box to inspect and change the sample 
size, sampling method, statistics, probability bands, and samples per 
plot point for probability distributions. All settings are saved with your 
model.

To open the Uncertainty Setup dialog box, select Uncertainty 
Options... from the Result menu or Ctrl-U. To set values for a specific 
variable, select the variable before opening the dialog box.

1 2 3 4 5 6
15.83 18.13 13.75 18.04 14.76 19.99
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The five options for viewing and changing information in the 
Uncertainty Setup dialog box can be accessed using the Analysis 
option popup menu.

Uncertainty Sample 

To change the sample size or sampling method for the model, select 
the Uncertainty Sample option from the Analysis options popup 
menu. 

Press here to see additional
uncertainty sample

parameters.
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The default dialog box shows only a field for sample size. To view and 
change the sampling method, random number method, or random 
seed, press the More Options button.

Sample size

This number specifies how many runs or iterations Analytica performs 
to estimate probability distributions. Larger sample sizes take more 
time and memory to compute, and produce smoother distributions and 
more precise statistics. See Appendix D, “Selecting the Sample Siz
for guidelines on selecting a sample size. The sample size must b
between 2 and 32,000. You can access this number in expression
your models as the system variable Samplesize.

Sampling method

The sampling method is used to determine how to generate a ran
sample of the specified sample size, m, for each uncertain quantity, X. 
Analytica provides three options:

Simple Monte Carlo

The simplest sampling method is known as Monte Carlo, named a
the randomness prevalent in games of chance, such as at the fam
casino in Monte Carlo. In this method, each of the m sample points for 
each uncertainty quantity, X, is generated at random from X with 
probability proportional to the probability density (or probability mas
for discrete quantities) for X. Analytica uses the inverse cumulative 
method; it generates m uniform random values, ui for i=1,2,...m, 
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between 0 and 1, using the specified random number method (see 
below). It then uses the inverse of the cumulative probability 
distribution to generate the corresponding values of X, 

Xi where P( ) = ui for i=1,2,...m.

With the simple Monte Carlo method, each value of every random 
variable X in the model, including those computed from other random 
quantities, is a sample of m independent random values from the true 
probability distribution for X. You can therefore use standard 
statistical methods to estimate the accuracy of statistics, such as the 
estimated mean or fractiles of the distribution, as for example 
described in Appendix D, “Selecting the Sample Size”.

Median Latin hypercube (the default method)

With median Latin hypercube sampling, Analytica divides each 
uncertain quantity X into m equiprobable intervals, where m is the 
sample size. The sample points are the medians of the m intervals, that 
is, the fractiles 

Xi where P( ) = (i-0.5)/m, for i=1,2,...m.

These points are then randomly shuffled so that they are no longe
ascending order, to avoid nonrandom correlations among differen
quantities.

 Random Latin hypercube

The random Latin hypercube method is similar to the median Lati
hypercube method, except that instead of using the median of eac
the m equiprobable intervals, Analytica samples at random from ea
interval. With random Latin hypercube sampling, each sample is a t
random sample from the distribution. However, the samples are n
totally independent.

Choosing a sampling method

The advantage of Latin hypercube methods is that they provide m
even distributions of samples for each distribution than simple Mon
Carlo sampling. Median Latin hypercube is still more evenly 
distributed than random Latin hypercube. If you display the PDF o
variable that is defined as a single continuous distribution, or is 
dependent on a single continuous uncertain variable, using media

x Xi≤

x Xi≤
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Latin hypercube sampling, the distribution will usually look fairly 
smooth even with a small sample size (such as 20), whereas the result 
using simple Monte Carlo will look quite noisy.

If the variable depends on two or more uncertain quantities, the 
relative noise-reduction of Latin hypercube methods is reduced. If the 
result depends on many uncertain quantities, the performance of the 
Latin hypercube methods may not be discernibly better than simple 
Monte Carlo. Since the median Latin hypercube method is sometimes 
much better, and almost never worse than the others, Analytica uses it 
as the default method.

Very rarely, median Latin hypercube can produce incorrect results, 
specifically when the model has a periodic function with a period 
similar to the size of the equiprobable intervals. For example, with

X: Uniform(1, Samplesize)

Y: Sin(2*Pi*X)

median Latin hypercube method will give very poor results. In such 
cases, you should use random Latin hypercube or simple Monte Carlo. 
If your model has no periodic function of this kind, you do not need to 
worry about the reliability of median Latin hypercube sampling.

Random number method

The random number method is used to determine how random 
numbers are generated for the probability distributions. Analytica 
provides three different methods for calculating a series of 
pseudorandom numbers.

Minimal Standard (the default method)

The Minimal Standard random number generator is an implementation 
of Park and Miller’s Minimal Standard (based on a multiplicative 
congruential method) with a Bays-Durham shuffle. It gives 
satisfactory results for less than 100,000,000 samples.

L’Ecuyer

The L’Ecuyer random number generator is an implementation of 
L’Ecuyer’s algorithm, based on a multiplicative congruential metho
which gives a series of random numbers with a much longer perio
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(sequence of numbers that repeat). Thus, it provides good random 
numbers even with more than 100,000,000 samples. It is slightly 
slower than the Minimal Standard generator.

Knuth

Knuth’s algorithm is based on a subtractive method rather than a 
multiplicative congruential method. It is slightly faster than the 
Minimal Standard generator.

Random seed

This value must be a number between 0 and 100,000,000 (108). The 
series of random numbers starts from this seed value when:

• A model is opened

• The value in this field is changed

• The Reset once box is checked, and the Uncertainty Setup dial
box is closed by clicking on the Accept or Set Default button.

Reset once

Check the Reset once box to produce the exact same series of ran
numbers.
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Statistics option

To change the statistics reported when you select Statistics as the 
uncertainty view for a result, select the Statistics option from the 
Analysis option popup menu. 

Probability Bands option

To change the probability bands displayed when you select 
Probability Bands as the uncertainty view for a result, select the 
Probability Bands option from the Analysis option popup menu.
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Probability Density and Cumulative Probability options

To change how probability density or the cumulative probability 
values are drawn or to change their resolution, select the respective 
option from the Analysis option popup menu. 

Analytica estimates the probability density function and cumulative 
distribution function, like other uncertainty views, from the 
underlying array of sample values for each uncertain quantity. As with 
any simulation-based method, each estimated distribution will have 
some noise and variability from one evaluation to the next.

Samples per plot point

This number controls the average number of sample values used to 
estimate each point on the probability density function (PDF) or 
cumulative distribution function (CDF) curves.

For a small number of samples per plot point (less than or equal to 10), 
more points are each estimated from fewer sample values and so are 
more susceptible to random noise. If the quantity is defined by a single 
probability distribution, and if you use median Latin hypercube 
method (the default), this noise will be slight and the curve will look 
smooth. In other cases, the noise may have a large effect, and using a 
larger number of samples per plot point will produce a smoother curve. 
There is a trade-off; with larger numbers the smoothing may miss 
details of the shape of the curve. PDFs may be much more susceptible 
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to random noise than CDFs, so you may wish to use larger numbers 
for PDFs than CDFs.   Ultimately, to reduce the noise, use a larger 
sample size (for details on selecting the sample size, see Appendix D, 
“Selecting the Sample Size”).

Equal probability steps

With this option, Analytica uses the sample to estimate a set of m+! 
fractiles (quantiles), Xp, at equal probability intervals, where p=0, q, 
2q, ... 1,  and q = 1/m. The cumulative probability is plotted at each o
the points Xp, increasing in equal steps along the vertical axis. Poin
are plotted closer together along the horizontal axis in the regions
where the density is the greatest. In the probability density graph vi
the areas under the density function between successive fractiles
equal because they each represent the same probability, q. The density 
between two successive fractiles is plotted at the mid point (on the
horizontal axis) of the two fractiles.

Equal X axis steps

With this option, Analytica estimates cumulative probability using 
equally spaced points along the X axis. In the probability density graph
view, it shows a histogram where the height of each horizontal is 
estimated as the fraction of the sample values that fall within that X 
interval. 
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In this Chapter

This chapter shows you how to use 
Analytica’s built-in continuous probability 
distributions.



Continuous distribution functions
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This chapter describes Analytica’s built-in continuous probability 
distributions. Additional continuous probability distributions are 
included in the Libraries folder distributed with Analytica.

Analytica Note:  To reproduce the graphs in this chapter, use a sample 
size of 1000.

Continuous distribution functions

Beta ( X, Y, lower, upper )

Creates a distribution of numbers between 0 and 1 with  

representing the mean, if the optional parameters lower and upper are 
omitted. For bounds other than 0 and 1, specify the optional lower and 
upper bounds to offset and expand the distribution.

X and Y must be positive.

When to use

Use a beta distribution if the uncertain quantity is bounded by 0 an
(or 100%), is continuous, and has a single mode. This distribution
particularly useful for modeling an opinion about the fraction of a 
population that has some characteristic. For example, if you have
observed n members of the population, of which r display the 
characteristic c, you can represent the uncertainty about the true 
fraction with c using a beta distribution with parameters X = r and Y = 
n - r.

If the uncertain quantity has lower and upper bounds other than 0 
1, include the lower and upper bounds parameters to obtain a 
transformed beta distribution. The transformed beta is a very flexibl
distribution for representing a wide variety of bounded quantities.

Library

Distribution

X
X Y+( )

---------------
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Examples
Beta (5, 10) →

Beta (5, 10, 2, 4) →

Cumdist ( P, R, I )

Specifies a continuous probability distribution by an array of 
cumulative probabilities, P, for an array of corresponding outcome 
values, R, for the quantity. Either R must be an index of P, or P and R 
must have an index in common. If P or R have more than one index, 
you must specify the relevant index for linking P and R as a third 
parameter, I.

Cumdist() uses linear interpolation of the cumulative distribution 
between the specified points, which implies a piecewise uniform 
distribution.  
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The values of P must be nondecreasing. P’s first value must be equal 
to or greater than 0, and its last value must be 1. The values of R must 
be increasing.

Library

Distribution

Example

Array_b:

Index_a 

Array_x:

Index_a 

CumDist(Array_b, Array_x) →

Fractiles ( L )

Specifies a continuous probability distribution by an array of even
spaced fractiles, L. L must be a one-dimensional array of 
nondecreasing numbers.  If L contains n+1 numbers, then Li is the i/n 
fractile—that is, for an uncertain quantity, x, 

1 2 3
0 0.6 1.0

1 2 3
10 20 30
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P(x ≤ Li ) = i/n.  Fractiles() uses linear interpolation on the 
cumulative distribution between the specified fractiles, which implies 
a piecewise uniform distribution.

If any value in L is probabilistic, its mid value is used to obtain the 
fractile.

Library

Distribution

Example

The following definition describes a distribution over the range 0 to 
120 (0 and 100% fractiles), with its median at 45 (50% fractile), and 
quartiles at 30 and 60 (25% and 75% fractiles):

Fractiles( [0, 30, 45, 60, 120] ) →

Gamma( A,B )

Creates a gamma distribution with shape parameter A and scale 
parameter B. The scale parameter, B, is optional and defaults to B=1. 
The gamma distribution is bounded below by zero (all sample points 
are positive) and is unbounded from above. It has a theoretical mean 

of and a theoretical variance of . When , the 

distribution is unimodal with the mode at . An exponential 

distribution results when . As , the gamma distribution 
approaches a normal distribution in shape.

The gamma distribution encodes the time required for A events to 
occur in a Poisson process with mean arrival time of B.

A B⋅ A B2⋅ A 1>
A 1–( ) B⋅

A 1= A ∞→
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Note that some textbooks use Rate=1/B, instead of B, as the scale 
parameter.

When to use

Use the gamma distribution with A>1 if you have a sharp lower bound 
of zero but no sharp upper bound, a single mode, and a positive skew. 
Note that the Lognormal distribution is also an option in this case. 
Gamma() is especially appropriate when encoding arrival times for 
sets of events. A gamma distribution with a large value for A is also 
useful when you wish to use a bell-shaped curve for a positive-only 
quantity.

Library

Distribution

Examples

Gamma distributions with mean=1:

Gamma(1,1)

Gamma(2,1/2)

Gamma(3,1/3)

Gamma(4,1/4)

Gamma(1/2,2)
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Lognormal ( median, gsdev )

Creates a lognormal distribution with median of median and geometric 
standard deviation of gsdev. The geometric standard deviation must be 
1 or greater. The range [median/gsdev, median × gsdev] encloses about 
68% of the probability. Gsdev is sometimes also known as the 
uncertainty factor or error factor.) Median and gsdev must be 
positive.

The log of a lognormal quantity has a normal distribution with mean 
of Log(median) and standard deviation of Log(gsdev).

While the lognormal distribution is unbounded above, Analytica’s 

Lognormal() function truncates sample values at median/gsdev3 on 

the bottom and median × gsdev3 at the top.

When to use

Use the lognormal distribution if you have a sharp lower bound of ze
but no sharp upper bound, a single mode, and a positive skew. No
that the gamma distribution is also an option in this case. This 
distribution is particularly appropriate if you believe that the uncerta
quantity is the product (or ratio) of a large number of independent
random variables.

Library

Distribution

Examples
Lognormal(5, 2) →
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The case of gsdev=1 gives a delta function (spike) at median.

Lognormal(5, 1) →

Normal ( mean, stddev )

Creates a normal or Gaussian probability distribution with mean and 
standard deviation stddev. The standard deviation must be 0 or greater. 
The range [mean-stddev, mean+stddev] encloses about 68% of the 
probability.

While the normal distribution is unbounded above and below, 
Analytica’s Normal() function truncates sample values at 3 × stddev 
above and below the mean.

When to use

Use a normal distribution if the uncertain quantity is unimodal and
symmetric and the upper and lower bounds are unknown, possibl
very large or very small (unbounded). This distribution is particular
appropriate if you believe that the uncertain quantity is the sum or
average of a large number of independent, random quantities.

Library

Distribution
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Example
Normal(30, 5) →

Probdist ( P, R, I )

Specifies a continuous probability distribution as an array of  
probability density values, P, for an array of corresponding outcome 
values, R, for the quantity. Probdist performs a linear interpolation 
between the points on the density function. The values of P must be 
nonnegative. They will be normalized so that the total probability 
enclosed is 1.0. The values of R must be increasing. 

The values of P should start and end at 0. If the first (or last) value of 
P is not zero, Analytica assumes zero at 2R1 - R2 (or 2Rn - Rn-1). 

Either R must be an index of P, or P and R must have an index in 
common. If P or R have more than one index, you must specify the 
relevant index for linking P and R as a third parameter, I. 

Library

Distribution

Example

Array_p:

Index_a 

1 2 3 4 5 6
0 0.4 0.2 0.5 0.2 0
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Continuous distribution functions
Array_r:

Index_a 

Probdist(Array_p, Array_r) →

Triangular ( min, mode, max )

Creates a triangular distribution, with minimum min, mode mode, and 
maximum max. Min must be not be greater than mode, and mode must 
not be greater than max.

When to use

Use the triangular distribution when you have the bounds and the 
mode, but have little other information about the uncertain quantity.

Library

Distribution

1 2 3 4 5 6
10 15 20 25 30 35
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Example
Triangular(2, 7, 10) →

Uniform ( min, max )

Creates a uniform distribution between values min and max.

When to use

If you know nothing about the uncertain quantity other than its 
bounds, a uniform distribution between the bounds is appealing. 
However, situations in which this is truly appropriate are rare. Usually 
one end, or the middle, of the range is more likely than the rest; that 
is, the quantity has a mode. In such cases, a beta or triangular 
distribution is a better choice.

Library

Distribution
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Example
Uniform(5, 10) →

Continuous Distribution Library

In addition to the built-in distributions provided by Analytica, several 
less-commonly used distributions are available in the 
ContinuousDistributions library module. To use these distributions, 
select the Add Module... command from the File menu and embed (or 
link) the file Libraries/ContinuousDistributions.ana in your model.

The ContinousDistributions library module includes these 
distributions:

Exponential( R )

An exponential distribution with rate R. The exponential distribution 
has a mean and standard deviation of 1/R. It is commonly used to 
model the time until the next event occurs assuming that events 
randomly and independently of when previous events have occurred.

Logistic( mean, scale)

The logistic distribution with the indicated mean, magnified by scale. 
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Logtriangular( min, mode, max )

The natural logrithm of a variable distributed according to a log 
triangular distribution obeys a triangular distribution. Used when no 
information other than the bounds and mode are available for a 
quantity, and the quantity represents a geometric variable such as a 
percent increase.

Loguniform( lower, upper )

A variable whose natural logrithm is distributed uniformly. Used 
when a variable is geometric by nature, such as a percent increase, but 
when nothing more than the absolute bounds are known.

Weibull( scale, shape )

Specifies a Weibull distribution. The Weibull distribution is bounded 
below by zero and unbounded from above. It is often used to describe 
data resulting from life and fatigue studies and reliability models.

Truncating Distributions

Truncate ( Dist, X )

Truncates a probabilistic value Dist at and below deterministic value 
X. If Dist is not a distribution, Truncate returns Dist.

Truncate does not discard sample values; it generates a new complete 
sample for the quantity with the same probability distribution as Dist 
above X, and 0 below X.  

Since Truncate() resamples from the truncated distribution, the 
result will be nearly independent of Dist. Hence, importance and other 
measures that depend on correlations with Dist or with probabilistic 
variables on which Dist depends will be near zero, which may be 
misleading. 

Library:

Special
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Truncating Distributions
Examples:

Mpg: Normal(28, 5)
Truncate(Mpg, 21) →

To truncate a distribution at or above a specified value, use: 

-Truncate(-Dist, -X)

-Truncate(-Mpg, -32) →
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Chapter 15

Using Discrete 
Probability



In this Chapter

This chapter shows you how to:

• Use Analytica’s discrete probability 
table functions

• Use Analytica’s discrete probability 
distributions



Using a probability table

ns 
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t 
This chapter describes Analytica’s discrete probability table functio
and discrete probability distributions. Additional discrete probabili
distributions are included in the Libraries folder distributed with 
Analytica.

Using a probability table

To describe a variable as a discrete uncertainty, Analytica provide
special kind of edit table called a probability table. (See also Chapter 
11, “Modeling with Arrays and Tables“.)

Creating a probability table

To define a variable as a discrete probability distribution in a 
probability table:

1. Determine the variable’s domain—the list of possible outcomes.

2. Select the variable and open one of the following:

The variable’s Object window.

The Attribute panel of the Diagram window (see “The Attribute 
panel” on page 27).

In the Attribute panel, select Definition from the Attribute popup 
menu (see “The Attribute popup menu” on page 28) as the attrib
to display.

3. Click on the Expression popup menu above the definition field 
and select Probability Table.

If the variable already has a definition, a dialog box confirms tha
you wish to replace it.
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Analytica Note:  If the definition of a variable is already a probability 
table, a ProbTable button appears in the definition. Click on it to see the 
Edit Table window (see “Viewing an array as an Edit table” on page
179).

4. The Indexes dialog box opens to confirm your choices for the 
indexes of the table. Only variables with a domain of List of 
numbers or List of labels are shown by default. The variable 
being defined is already listed as a selected index (with Self in 
parentheses). Add or remove any other discrete inputs (or other 
Index variables).

Analytica Note:  Self is required as an index of a probability table. It 
refers to this variable’s domain values.

5. Click on the OK button. An Edit Table window appears.

6. Enter the possible outcomes (the domain) in the first column. If 
the outcomes are numeric, they must be in increasing order.

7. Enter the probability of each possible outcome in the second 
column. (The probabilities should sum to 1.)
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Example

If P is a variable whose value is a probability (between 0 and 1) and 
the possible weather outcomes are sunny and rainy, then the following 
is a probability table for weather:

Editing the domain 

The domain attribute has values (the possible outcomes) and a type. In 
a probability table, you can edit the values directly in the first column 
of the Edit Table window, as an index of the table. Each entry must be 
a number or label (text); it cannot be an expression.

You can also edit the domain values in the Object window and 
Attribute panel.

Domain

Domain values

Domain type
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Changing the domain type

The domain popup menu shows the domain type. For a probability 
table, the domain type is either a list of numbers or a list of labels and 
is set by your entry in the first row’s cell in the edit table.

To change the domain type, press on the popup menu and select 
desired type.

Expression view of probability table 

When you select the expression view of a definition that was crea
as a probability table, it has the following appearance. You canno
create a probability table as an expression.

Probtable ( I1, I2, … In ) ( p1, p2, p3, … pm )

Describes an n-dimensional conditional probability table, indexed by 
the indexes I1, I2, … In. One index must be Self. 

p1, p2, p3, … pm are the probabilities in the array.

Example

The Weather probability table on page 312, when viewed as an 
expression, looks like this:

Probtable (Self)(P, (1-P))

Note that the domain values do not appear in the expression view.

Using labels in a probability table

A discrete probability distribution can describe the probability that a 
variable falls into a category. For example:

In a probability table, Analytica assumes that label outcomes are 
ordered, with the first value being the minimum and the last value 
being the maximum. In the first example above, this ordering has 
meaning; in the second example above, it does not. This ordering is 
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used to compute the following statistics. Use these statistics with 
caution, since they are a function of the order sequence of the 
qualitative outcomes.

Also use caution applying the logical operators (>,<,=) to a label 
valued distribution. The logical operators use the ASCII sort 
sequence, not the ordering of label outcomes.

Adding dimensions to a probability table 

You may wish to add dimensions to a probability table. For example, 
in the Weather probability table (see page 312), you may wish to 
distinguish between daylight and evening, with different probabilities 
for rainy weather in daylight and evening. So you would add a 
dimension with two values: daylight and evening.

You can add indexes or decision variables defined as lists, similar to 
adding indexes to an edit table, as follows:

1. Open the Edit Table window by clicking on the ProbTable 
button.

2. Click on the Indexes ( ) button to open the Indexes dialog 
box.

3. Click in the All variables checkbox above the left hand list.

4. Move the desired variables to add them as indexes.

5. Click on the OK button to accept the changes.

Statistics available for label valued distributions 
Frequency (use Frequency(X,X))
Mid Value (Median)
Min
Max
Probability bands
Sample

Statistics not available for label valued distributions
Correlation
Kurtosis
Getfract
Mean
Rankcorrel
Skewness
Standard deviation
Variance
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Creating a conditional dependency

After you have defined several probability tables, you may want to 
make some probabilities in a probability table conditional on the 
outcomes of other variables. This is called a conditional dependency. 

To create a conditional dependency in a probability table:

1. Open the Edit Table window by clicking on the ProbTable 
button.

2. Click on the Indexes ( ) button. Other variables that are 
defined as probability tables appear in the list of domains.

3. Move the variables you wish to be conditionally dependent, to 
add them as indexes.

4. Click on the OK button to accept the changes.

The resulting table is indexed by both the domain of your variable and 
the domains of the conditionally dependent variables.

Analytica Note:  You must have already specified the variables as 
probability tables, before adding them with the Indexes dialog box.

Other discrete distribution functions

To define a variable as a discrete probability distribution other than 
probability table and view its Probability Mass Function, you must 
first set its domain type and then assign the range of possible outcomes 
to its domain.

To set a discrete domain type and assign domain values:

1. Select the variable and open the Attribute panel of the Diagram 
window (see see “The Attribute panel” on page 27).

2. Select the Domain attribute from the popup menu.
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3. The domain type popup menu shows the default of Continuous. 
Select either List of numbers or List of Labels.

4. Analytica displays a list containing one element. Enter the 
domain values like any list (see “Creating a list” on page 186).

Analytica Note:  The domain must include all the values that appear in 
the sample of the discrete probability distribution. If it does not, then the 
total Probability Mass Function will be less than 1.

Bernoulli ( P )

Creates a discrete probability distribution with probability P of result 
1 and probability (1 - P) of result 0. P is a probability value or array of 
probabilities, each between 0 and 1. The Bernoulli distribution is 
defined as:

If Uniform(0, 1) < P Then 1 Else 0

If P is greater than 1, the distribution is made up of all 1’s. If P is less 
than 0, the distribution is made up of all 0’s.

Library

Distribution

Example

The domain, List of numbers, is [0, 1].
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Bernoulli_ex: Bernoulli (0.3) →

Certain ( U )

Returns the value of U.

Library

Distribution

When to use

Use Certain() when an input node is defined as a distribution (see 
“Using input nodes” on page 151), and, in browse mode, you wan
replace the distribution with a nonprobabilistic value. 

Example

Index_a:

Array_p:

Index_a 

Certain (Array_p ) →

1 2 3

1 2 3
0.3 0.4 0.3

1 2 3
0.3 0.4 0.3
318 Analytica User Guide



Other discrete distribution functions

l.
Chancedist ( P, A, I )

Creates a discrete probability distribution. A is an array of outcomes, 
and P is the corresponding array of probabilities. A and P must both be 
indexed by I. 

The values of A must be unique; if A is numeric the values must be 
increasing.

When to use

Use Chancedist() instead of the probability table when:

• The array of outcomes A is multidimensional, or

• The outcomes and probabilities arrays are defined as other 
variables; the variables can be used in other parts of your mode

Library

Distribution

Example

Index_b:

Array_q:

Index_b 

The domain, List of labels, is ['Red','White','Blue'].

Red White Blue

Red White Blue
0.3 0.2 0.5
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Chancedist(Array_q,Index_b,Index_b) →

Using a deterministic conditional table

Sometimes a variable’s value is deterministic (not uncertain) and 
conditionally dependent on the outcomes of discrete uncertain 
variables. The Determtable() function defines this dependency.

The Determtable() function appears similar to an edit table or a 
probability table. Each cell contains nonprobabilistic (deterministic
values. At least one index is a probability table (a discrete probabilis
variable). Other indexes are typically decision variables defined a
lists. The Determtable() function returns an array that is reduced ac
its probabilistic index(es). The evaluation result shows the value 
considering the uncertain distribution of each probabilistic index.

Creating a determtable

To define a variable as a determtable:

1. Determine the variable’s domain—the list of possible outcomes.
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r 
2. Press the Expression popup menu above the definition field and 
select Other.

Analytica opens the Object Finder dialog box (see “Object Finde
dialog box” on page 143).

3. Select Array from the Library popup menu and select 
Determtable from the function list.
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4. Click on the Indexes button to specify discrete probability 

variables as inputs. The Indexes dialog box appears.

5. Click on OK to accept the indexes and open an Edit Table 
window.

6. Enter the outcomes corresponding to each outcome of your 
discrete inputs.

Expression view of a determtable

When you select the expression view of a definition that was created 
as a determtable, it has the following appearance. You cannot initially 
create a determtable as an expression.

Determtable( I1, I2, … In  ) ( r1, r2, r3, … rm )

Describes an n-dimensional conditional deterministic table, indexed 
by the indexes I1, I2, … In. The last index, In, is the innermost index, 
varying the most rapidly. r1, r2, … rm are the outcomes in the array. 
Determtable returns an array that is reduced across its indexes that are 
probability tables.

Example

In “Using a probability table” beginning on page 311, Weather is 
defined as a probability table. If P, the probability of “sunny”, is 0.4, 
then the probability of “rainy” is 0.6. Party location is a decision 
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variable with values [’outdoors’, ’porch’,’indoors’]. Value to Me is a 
determtable, containing utility values (or “payoffs”) for each 
combination of Party location and Weather:

Evaluating Value to Me gives the value of each party location, 
considering the uncertain distribution of Weather. The mean value of 
Value to Me is the expected utility:

Discrete Distribution Library

In addition to the built-in distributions, the Discrete Distributions 
library module provided with Analytica contains several additional
but less commonly used, distributions. To use these in your mode
select the Add Module... command from the File menu, and embed 
(or link) the file 

Libraries/DiscreteDistributions.ana.

The discrete distributions library module provides the following 
discrete distributions.

Binomal(n, p)

The binomial distribution describes the number of times an event 
occurs in n independent trials, given that the event occurs with 
probability p on each trial.
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Geometric( p )

The geometric distribution describes the number of independent trials 
required until the first successful outcome occurs. The parameter p is 
the probability that a successful outcome occurs on any given trial.

Hypergeometric( n, d, m)

The hypergeometric distribution describes the number of “red ball
drawn in n trials without replacement from an “urn” containing m total 
balls, d of which are red.

Poisson( R )

The Poisson distribution describes the number of events that occu
one unit of time, given that the average rate at which events occu
random is R events per time unit.
324 Analytica User Guide



Chapter 16

Analyzing 
Uncertainty and 
Sensitivity



In this Chapter

This chapter shows you how to:

• Analyze the uncertainty of variables

• Analyze relationships between 
uncertain variables

• Analyze the sensitivity of outputs to 
changes in inputs



Statistical functions

n 
 

This chapter describes Analytica’s tools for analyzing the uncertainty 
of variables, relationships between uncertain variables, and sensitivity 
of outputs to changes in inputs. It covers the statistical functions, 
sensitivity analysis functions, scatter graphs, and importance analysis.

Statistical functions

This section describes Analytica’s built-in statistical functions, for use 
in variable definitions. Many of these functions are used in the Result 
window Uncertainty View options (see “Uncertainty view options” o
page 44). These functions can assist with analysis of probabilistic
variables. 

Analytica Note:  All statistical functions produce estimates from the 
underlying random sample for each probabilistic quantity. These 
estimates are not exact, but will vary from one evaluation to the next due 
to the variability inherent in random sampling. Hence, your results may 
not exactly match the results shown in the examples here. For greater 
precision, use a larger sample size (see Appendix D on how to select a 
sample size).

The calculation formulas use the following notation:

xi the ith sample value of probabilistic variable X

the mean of probabilistic variable X (see Mean())

σ standard deviation (see Sdeviation())

m sample size (see Appendix D).

Analytica Note:  These statistical functions will not calculate statistics 
for an array of data unless it is a sample indexed by Run. To obtain 
statistics on an array of data with another index, see the Data Statistics 
library in the Libraries folder. 

The examples in this section use the following variables:

Alt_ fuel_ price: Normal(1.25, 0.1)
Fuel_price: Normal(1.19, 0.1)
Skfuel_price: Beta(4,2,1,1.5)

x
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Correlation ( X, Y )

Returns an estimate of the correlation between the probabilistic 
expressions X and Y, where -1 means perfectly negatively correlated, 
0 means no correlation, and 1 means perfectly positively correlated. 

Correlation(X,Y), a measure of probabilistic dependency 
between uncertain variables, is sometimes known as the Pearson 
product moment coefficient of correlation, r. It measures the strength 
of the linear relationship between X and Y, using the formula:

Library

Statistical

Example

With Samplesize set to 100 and number format set to two decimal 
digits:

Correlation(Alt_fuel_price + Fuel_price, 

Fuel_price) → 0.71

Correlation of two independent, uncorrelated distributions approaches 
0 as the samplesize approaches infinity.

Example

With Samplesize = 20:

Correlation(Normal(1.19,0.1), Normal(1.19,0.1))

→ -.28

With Samplesize = 1000:

Correlation(Normal(1.19,0.1),Normal(1.19,0.1))

→ 0.03

xi x–( ) yi y–( )

i

∑

xi x–( )
2

i

∑ yi y–( )
2

i

∑×
------------------------------------------------------------
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Frequency ( X, I )

If X is a discrete uncertain variable, returns an array indexed by I, 
giving the frequency, or number of occurrences of discrete values I. I 
must contain unique values; if numeric, the values must be increasing. 

If X is a continuous uncertain variable and I is an index of numbers in 
increasing order, it returns an array indexed by I, with the count of 
values in the sample X that are equal to or less than each value of I and 
greater than the previous value of I.

If X is nonprobabilistic, Frequency() returns Samplesize for each 
value of I equal to X.

Since Frequency() is computed by counting occurrences in the 
probabilistic sample, it is a function of Samplesize (see “Uncertainty 
Setup dialog box” on page 284). If you want the relative frequency
rather than the count of each value, divide the result by Samplesize.

Library

Statistical

Example (Continuous)

Index_a: [1.2,1.25] 

Frequency(Fuel_price, Index_a) →
Index_a 

Example (Discrete)

Bern_out: [0,1]

(Possible outcomes of the Bernoulli Distribution)

With Samplesize = 100:
Frequency(Bernoulli (0.3), Bern_out) →
Bern_out 

1.2 1.25
54 19

0 1
70 30
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With Samplesize = 25:
Frequency(Bernoulli (0.3), Bern_out) →
Bern_out  

(Compare the Bernoulli example on page 317.)

Getfract ( X, P )

Returns an estimate of the Pth fractile (also known as quantile or 
percentile) of X. This is the value of X such that X has a probability P 
of being less than that value. If X is nonprobabilistic, all fractiles are 
equal to X.

The value of P must be a number or array of numbers between 0 and 
1, inclusive.

Library

Statistical

Examples

Getfract(X,0.5)returns an estimate of the median of X.

Getfract(Fuel_price, 0.5) → 1.19

The following returns a table containing estimates of the 10%ile and 
90%ile values, that is, an 80% confidence interval.

Fract: [0.1,0.9]

Getfract(Fuel_price, Fract) →
Fract 

Kurtosis ( X )

Returns an estimate of the kurtosis of X. X must be probabilistic.

0 1
18 7

0.10 0.90
1.06 1.32
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Kurtosis is a measure of the peakedness of a distribution. A 
distribution with long thin tails has a positive kurtosis. A distribution 
with short tails and high shoulders, such as the uniform distribution, 
has a negative kurtosis. A normal distribution has zero kurtosis.

Kurtosis(X) uses the formula:

Library

Statistical

Example
Kurtosis(Skfuel_prices) → -0.48

Mean ( X )

Returns an estimate of the mean of X if X is probabilistic. Otherwise, 
returns X. 

Mean(X) uses the formula:

Library

Statistical

Examples
Mean(Fuel_price) → 1.19

Mean(Skfuel_price) → 1.33

1
m
---

xi x–

σ
-------------

4

i 1=

m

∑
 
 
 
 

3–

1
m
---- xi

i 1=

m

∑ x=
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Mid ( X )

Returns the mid value of X. Mid(X) forces deterministic evaluation 
in contexts where X would otherwise be evaluated probabilistically. 

The mid value is calculated by substituting the median for most full 
probability distributions in the definition of a variable or expression, 
and using the mid value of any inputs. The mid value of a variable or 
expression is not necessarily equal to its true median, but is usually 
close to it.

Library

Statistical

Example
Mid(Fuel_price) → 1.19

Probability( B ) 

Returns an estimate of the probability or array of probabilities that the 
Boolean value B is true.

Library

Statistical

Example
Probability(Fuel_price < 1.19) → 0.5

Probbands ( X )

Returns an estimate of probability or “confidence” bands for X if  X is 
probabilistic. Otherwise returns X for every band. The probabilities are
specified in the Uncertainty Setup dialog box, Probability Bands 
option (see “Uncertainty Setup dialog box” on page 284).

Library

Statistical
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Example

Probbands(Fuel_price) →
Probability 

Rankcorrel ( X, Y )

Returns an estimate of the rank-order correlation coefficient between 
the distributions X and Y. X and Y must be probabilistic.

Rankcorrel(X,Y), a measure of the dependence between X andY, 
is sometimes known as Spearman’s rank correlation coefficient, rs.

Rank-order correlation is measured by computing the ranks of the
probability samples, and then computing their correlation. By usin
the rank order of the samples, the measure of correlation is not 
affected by skewed distributions or extreme values, and is, therefo
more robust than simple correlation. Rank-order correlation is used
importance analysis (see “Importance analysis” on page 343).

Library

Statistical

Example

With Samplesize = 100:
Rankcorrel(Fuel_price, Alt_fuel_price) → .02

Sample ( X )

Evaluates X probabilistically and returns a sample of values from th
distribution of X in an array indexed by the system variable Run. If X 
is not probabilistic, returns X. The system variable Samplesize 
specifies the size of this sample. You can set Samplesize in the 
Uncertainty dialog box (see “Uncertainty Setup dialog box” on pag
284).

Library

Statistical

0.05 0.25 0.5 0.75 0.95
1.025 1.123 1.19 1.257 1.355
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When to use

Use when you want to force probabilistic evaluation, or look at raw 
sample values. 

Example

Here are the first six values of a sample:

Sample(Fuel_price) →
Iteration(Run) 

Sdeviation ( X )

Returns an estimate of the standard deviation of X from its sample if X 
is probabilistic. If X is nonprobabilistic, returns 0. 

Sdeviation(X) uses the formula:

Library

Statistical 

Example
Sdeviation(Fuel_price) → 0.10

Skewness ( X )

Returns an estimate of the skewness of X. X must be probabilistic.

Skewness is a measure of the asymmetry of the distribution. A 
positively skewed distribution has a thicker upper tail than lower tail, 
while a negatively skewed distribution has a thicker lower tail than 
upper tail. A normal distribution has a skewness of zero.

1 2 3 4 5 6
1.191 1.32 1.19 1.164 1.191 0.962
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Statistical functions
Skewness(X) uses the formula:

Library

Statistical 

Example
Skewness(Skfuel_price) → -0.45

Statistics ( X )

Returns an array of statistics of X. Select the statistics in the 
Uncertainty Setup dialog box, Statistics option (see “Uncertainty 
Setup dialog box” on page 284).

Library

Statistical

Example
Statistics(Fuel_price) →

Statistics 

Variance ( X )

Returns an estimate of the variance of X if X is probabilistic. If X is 
nonprobabilistic, returns 0.

Variance(X) uses the formula:
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Library

Statistical

Example
Variance(Fuel_price) → 0.01

Sensitivity analysis functions

Sensitivity analysis enables you to examine the effect of a change in 
the value of an input variable on the values of its output variables. 

Examples

The examples in this section refer to the following variables:

Gasprice: Normal(1.3, .3) 

(cost of gasoline per gallon within market fluctuations)

Mpy: 12K

(the average number of miles driven per year)

Mpg: Normal(28, 5)

(fuel consumption averaged over driving conditions)

Fuelcost: Gasprice * Mpy / Mpg

(annual cost of fuel)
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Sensitivity analysis functions
Probability density of Fuelcost: 

Dydx ( Y, X )

Returns the derivative of expression Y with respect to variable X, 
evaluated at mid values. This function returns the ratio of the change 
in Y to a small change in X that affects Y. The “small change” is 

, or 1.0E-6 if X = 0. 

Library

Special

Examples

Because Fuelcost depends on Mpg, a small change in Mpg seems to 
have a modest negative effect on Fuelcost:

Dydx(Fuelcost, Mpg) → -19.7

The reverse is not true, because Mpg is not dependent on Fuelcost. 
That is, Fuelcost does not cause any change in Mpg:

Dydx(Mpg, Fuelcost) → 0

In this model of Fuelcost, a small change in Gasprice has by far the 
largest effect of all its inputs:

Dydx(Fuelcost, Gasprice) → 428.6 

Dydx(Fuelcost, Mpy) → 0.04643

X 10000⁄
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Elasticity ( Y, X )

Returns the percent change in variable Y caused by a 1 percent change 
in a dependent variable X. 

Elasticity() is related to Dydx() in the following manner:

Elasticity(Y,X) = Dydx(Y,X)*(X/Y)

Library

Special

Examples
Elasticity(Fuelcost, Mpg) → -0.9901

Elasticity(Fuelcost, Gasprice) → 1

A 1% change in variables Mpg and Gasprice cause about the same 
degree of change in Fuelcost, although in opposite directions.

Mpg is inversely proportional to the value of Fuelcost, while Gasprice 
is proportional to it.

Whatif ( Ident, Tempval, X )

Returns the value of expression Ident when variable Tempval is set to 
the value of expression X. Tempval must be a variable. The original 
definition of Tempval is restored after evaluation of the Whatif() 
expression, allowing you to explore the effect of a change in Tempval 
without permanently changing it.

Library

Special

Example
Fuelcost → 557.1

Whatif(Fuelcost, Mpy, 14K) → 650
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X-Y results
WhatIfAll(Ident, varlist, X)

Returns the mid value of Ident when the each of variables in varList is 
assigned the value in X one at a time, with the remaining variables 
remaining at their nominal values. The result is indexed by varList. By 
having X indexed by varList, a different value can be assigned to each 
variable. 

WhatIfAll is useful for performing ceteris paribus style sensitivity 
analysis, in which only on variable is varied at a time. Tornado 
diagrams are one such example. Tornado-style analyses are useful 
since they do not require inputs to be uncertain.

Example

Suppose Z is a function of A, B, and C, and we wish to examine the 
effect on Z when each input is varied, one at a time, by 10% from its 
nominal value. Define:

L := [90%,110%]

V := [A,B,C]

MyTornado := WhatIfAll( Z, V, L*V )

X-Y results

When evaluating a variable, you can specify another variable to view 
it against, for Mid, Mean, Statistics, Probability Bands, and Sample.

To graph one variable against another:

1. Open a Result window for the y- (vertical axis) variable. 

2. Click on the XY button located in the top right corner of the 
window to open the Object Finder dialog box.

3. In the Object Finder, select the x- (horizontal axis) variable 

XY button
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The two variables in an XY window must share at least one index, and 
all indexes of X must also be indexes of Y. The popup menu in the 
index selection area becomes Common Index—only indexes of both 
X and Y may be selected. 

Example
Degrees: Sequence(0,360,10)

Sine: Sin(Degrees)

Cosine: Cos(Degrees) →
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Scatter plots
Click on the XY button. In the Object Finder dialog under Current 
Module select the variable Sine to display: 

Click on the Table View button to display:

To return to the graph or table of Cosine vs. Degrees, click in the XY 
checkbox.

Scatter plots

A scatter plot, graphing the samples of two probabilistic variables 
against each other, can provide insight into their probabilistic 
relationship.
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To generate a scatter plot for two variables, X and Y:

1. Open a Result window for Y.

2. Click on the XY button located in the top right corner of the 
window to open the Object Finder dialog box.

3. In the Object Finder, select the X variable.

4. In the Uncertainty View popup menu (at the top left of the 
Result window), select the Sample view.

If the variables are independent, the scatter plot points will fall 
randomly on the graph. If the variables are totally dependent, the 
scatter plot points will fall along a single line. The strength of the 
relationship is indicated by the degree to which the points are close to 
a line. If the line is straight, the relationship is linear; if the line is 
curved, the relationship is nonlinear.

You can superimpose several scatter plots of Y in an array of uncertain 
quantities depending on X. The different quantities will be represented 
by differently colored dots or symbols.

Example
X: Uniform(1,2)

Y: Normal(10,3)
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Importance analysis
The resulting scatter plot, of two independent variables, is:

Importance analysis

In most complex models, many of the input variables are uncertain. It 
is often useful to understand how much each uncertain input 
contributes to the uncertainty in the output. Typically, a few uncertain 
inputs are responsible for the lion’s share of the uncertainty in the 
output, while the rest have little impact. 

The importance analysis features in Analytica can help you quickly 
learn which inputs contribute the most uncertainty to the output. You 
can then concentrate on getting better estimates or building a more 
detailed model for the one or two most important inputs without 
spending considerable time investigating issues that turn out not to 
matter very much.

Importance analysis defined 

Importance is the absolute rank-order correlation between the sample 
of output values and the sample for each uncertain input. It is a robust 
measure of the uncertain contribution because it is insensitive to 
extreme values and skewed distributions. Unlike commonly used 
deterministic measures of sensitivity, it averages over the entire joint 
probability distribution. Therefore, it works well even for models 
where the sensitivity to one input depends strongly on the value of 
another.

Creating an importance variable

To create an importance analysis variable:
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1. Be sure you are in Edit mode. Select an output variable’s node 

(usually your model’s objective node, but it can be any variable 
that has uncertain inputs).

2. Select Make Importance from the Object menu.

Analytica creates two new variables, an index variable and a general 
variable. If Output Variable is the title of the node you selected, the 
index variable is titled Output Variable Inputs, and the general variable 
is titled Output Variable Importance.

Example

Donuts_per_year: Normal(150,50)

Donut_price:  Normal(0.4,0.04)

Annual_donut_expense:  Donuts_per_year * Donut_price

Since the two inputs are multiplied, we would expect the input with the 
greater relative uncertainty, Donuts_per_year, to contribute more 
uncertainty to Annual_donut_expense.

After you select Annual_donut_expense and then Make Importance 
from the Object menu, the diagram contains two new variables.
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Importance analysis
Annual_donut_expense Inputs is a one-dimensional Edit Table of the 
chance variables. Its index contains the titles of the chance nodes, and 
its values are the identifiers of those nodes.

Annual donut expense Inputs evaluates to a set of probability 
distributions, one for each chance variable.

Annual donut expense Importance is defined as

Abs(Rankcorrel(Annual_donut_expense_inputs, 

Annual_donut_expense))

The Rankcorrel() function computes the rank-order correlation of 
each input to the output, and then the Abs() function computes the 
absolute value, yielding a positive relative importance.

As expected, Donuts_per_year contributes considerably more 
uncertainty to Annual_donut_expense than Donut_price.
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Analytica Note:  Importance, like every other statistical measure, is 
estimated from the random sample. The estimates may vary slightly from 
one sample to another due to random noise. For a sample size of 100, an 
importance of 0.1 may not be significantly different from zero. But an 
importance of 0.5 is significantly different from zero. The main goal is to 
discover those uncertain inputs, typically only two to five, that are the 
primary contributors to the uncertainty in the output. For greater 
precision, use a larger sample size.

Editing importance variables

If you create an importance analysis variable for a model, and 
subsequently refine the model by redefining or adding uncertain 
inputs, you may want to change the set of input variables used for the 
importance analysis. Or, you may want to remove variables that you 
already know don’t contribute significantly to the uncertainty in the
result. Do one of the following:

• Select Output Variable and then Make Importance from the 
Object menu. The Output Variable Inputs node will be updated.

• Open Output Variable Inputs’ Edit Table and edit the list of input 
variables.
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Chapter 17

Modeling 
Changes over 
Time



In this Chapter

This chapter shows you how to use the 
system function Dynamic and the system 
variable Time.



The Time index

d. 

 

ne 
 

A dynamic variable is a quantity that changes over time—for 
example, the effect of inflation on car prices over a ten-year perio
The system function Dynamic() and system variable Time enable 
you to model changes over time. 

Analytica Note:  Read Chapter 11, “Modeling with Arrays and Tables“
before using these features.

The term dynamic is used in this chapter to refer to the Dynamic() 
function.

The Time index

Dynamic simulation time periods are specified in the system variable 
Time. To perform dynamic simulation, you must provide a definition 
for Time. 

To edit the definition of Time, select Edit Time from the Definition 
menu to open the Object window for Time.

Time is defined by default as a list of three numbers 0, 1, and 2. You 
may want to define Time as a list of years, as in the following example:

Time becomes the index for the array that results from the 
Dynamic() function. 

Analytica Note:  A model can have only one definition Time—that is, o
set of time periods for Dynamic() functions. Any number of variables
in the model can be defined using Dynamic().
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Using the Dynamic function

Dynamic ( initial1, initial2..., initialn, Expr )

Performs dynamic simulation, calculating the value of its defined 
variable at each element of Time. The result of Dynamic() is an 
array, indexed by Time. 

Initial1, ...initialn are the values of the variable for the first n time 
periods. Expr is an expression giving the value of the variable for each 
subsequent time period. Expr can refer to the variable in earlier time 
periods, that is, contain its own identifier in its definition. If variable 
Var is defined using Dynamic(), Expr can be a function of 
Var[Time-k] or Self[Time-k], where k is an expression that 
evaluates to an integer between 1 and t, and t is the time step at which 
Expr is being evaluated.

Analytica Note:  Square brackets ([ ]) are necessary around Time-t.

The Dynamic() function must appear at the topmost level of a 
definition. It cannot be used inside another expression.

When a dynamic variable refers to itself, it appears in its own list of 
inputs and outputs, with a symbol for cyclic dependency: .

Library

Special

When to use

Use Dynamic() for defining variables that are cyclically dependent. 
This is the only function in Analytica that permits reference to the 
same variable, or other dynamic variables, at earlier time periods.

Example

Dynamic() can be used to calculate the effect of inflation on the 
price of gasoline in the years 1990 to 1994. 

If the initial value is $1.20 per gallon and the rate of inflation is 5% 
per year, then Gasprice can be defined as: 
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Using the Dynamic function
Dynamic(1.2, Gasprice[Time-1] * 1.05) or 
Dynamic(1.2, Self[Time-1] * 1.05).

Clicking on the Result button and viewing the mid value as a table 
displays the following results: 

For 1990, Analytica uses the initial value of Gasprice (1.2). For each 
subsequent year, Analytica multiplies the value of Gasprice at 
[Time-1] by 1.05 (the 5 percent inflation rate).

Ident [ Time-k ]

Given a variable Ident and brackets enclosing Time minus an integer k, 
returns the value for Ident, k time periods back from the current time 
period. This function is only valid for variables defined using the 
Dynamic() function. 

Library

Special
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More about the Time index

Reference to earlier time

Time-k in the expression var[Time-k] refers to the position of 
the elements in the Time index, not values of Time.

For example, if Time equals [1990,1994,1998,2002,2006], 
then the value of Gasprice[Time-3] in year 2006 would refer to 
the price of gasoline in 1994, not 2003. When you refer to the Time 
variable directly, not as an index, the expression refers to the values of 
Time. For example, the expression (Time-3) in 2006 is 2003.

The offset, k, may be an expression, and may even be indexed by Time. 
When k is indexed by Time, then the offset varies at different points in 
Time. However, Slice(k,Time,t) must be between 1 and t-1. It must be 
positive since the expression is not allowed to depend on values in the 
future (that have not yet been computed). It must be less than t-1 since 
the expression cannot depend on values “before the beginning of
time”.

Defining time

There are three ways to define the Time index, each of which has 
different advantages:

• Sequence (the preferred method)
• List (numeric)
• List of labels (text)
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Time as a sequence

Using the Sequence() function is the easiest way to define Time 
with equal intervals (see “List vs. List of Labels” on page 188 and
“Creating an array with an Edit table” on page 191). The numeric 
values for Time can be used in other expressions.

Example

Time as a list (numeric)

When Time is defined as a numeric list, it will usually consist of 
increasing numbers. The intervals between entries can be unequal
the values for Time can be used in other expressions.

Example

Time:

When you use time periods that differ by a value other than 1, typ
(Time-1) won’t provide the value of the previous time period. Yo
can use the syntax Ident[Time-1] if you want to utilize a variable 
indexed by Time, but if you want to perform an operation that depend
on the difference in time between the current time period and the 
one, you must first create a node that uncumulates the Time index:
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YearsPassed: Uncumulate(Time)

Now you can include this node in a dynamic expression that depends 
on the time between time periods. The following definition is 
equivalent to the one on page 351 but allows for changes in time 
period increments:

Gasprice: Dynamic(1.2, Gasprice[Time - 1] *

1.05 ^ YearsPassed) →
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e 
Time as a list of labels (text)

When Time is defined as a list of labels, Time values cannot be used in 
other expressions as numbers.

The resulting graph of any Dynamic() function, with the x–axis set 
to Time, will show the labels at equal x–axis intervals.

Example

Time:

Gasprice: Dynamic(1.2, Gasprice[Time-1] * 1.05) →

Using Time in a model

You can use Time like any index variable; you can change only its titl
and definition. To include the Time  node on a diagram:

1. Open the Object window for Time by selecting Edit Time from 
the Definition menu.
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2. Select Make Alias from the Object menu (see “Using an alias 

node” on page 76).

When the Time node displays on a diagram, arrows from Time to all 
dynamic variables display by default.

Initial values for Dynamic

A dynamic definition of var usually includes the expression 
Self[Time-k] or var[Time-k], where k is the number of time 
periods to subtract from the current Time value. You must supply at 
least 1 initial value. 

As an example, when k in [Time-k] is greater than 1, suppose your 
car insurance policy depends on the premium you paid two years ago. 
To calculate your payments in 1992, you must refer to the amount paid 
in 1990. A dynamic variable representing such a rate for insurance 
needs two initial values for Time, such as: 

Insurance: 

Dynamic(600, 700, Insurance[Time - 2] * 1.05) →
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Using arrays in Dynamic

The initial value of a dynamic variable—that is, the first parameter
the Dynamic() function—can be a number, variable identifier, or 
other expression that evaluates to a single number, list, or array. 
Analytica evaluates a dynamic variable starting from each initial 
value, in each time period, so the result is a correctly dimensioned
array. 

Example

Expanding the example (see “Using the Dynamic function” on pag
350), suppose the inflation rate of gasoline is uncertain. Instead o
providing a single numerical value, you could define the inflation ra
as a list: 

Using the new Inflation variable in the definition for Gasprice, the 
results show three different rates of increases in gasoline prices f
1990 to 1994:

Gasprice: 

Dynamic(1.2,Gasprice[Time - 1] * (1 + 

Inflation)) →
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is, 
Dependencies with Dynamic

All variables with dynamic inputs are evaluated dynamically—that 
their results are arrays indexed by Time.

Example

A series of dynamic definitions produce equations for distance, 
velocity, and acceleration:

Acceleration: -9.8

Dt: 0.5

Time: Sequence(0, 6, Dt)

Velocity: 
Dynamic(0, Self[Time-1] + Acceleration * Dt/2)

Distance: 
Dynamic(100, Self[Time-1] + Velocity * Dt) →
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Dependencies with Dynamic
Dynamic dependency arrows

If a variable is dynamically dependent on another variable, a gray 
arrow is drawn between the variables.

To show or hide dynamic dependency arrows:

1. Select Set Diagram Style... from the Diagram menu to open the 
Diagram Style dialog box (see “Diagram Style dialog box” on 
page 111).

2. Click in the Dynamic checkbox to show dynamic arrows (or 
uncheck it to hide the arrows).

3. Click OK  to accept the change.

Expressions inside dynamic loops

A dynamic loop is a sequence of variables beginning and ending at the 
same variable, with each consecutive variable dependent on the 
previous one. At least one variable in a dynamic loop is defined using 
the dynamic function. 

When the definition of a variable in a dynamic loop is evaluated, the 
definition is repeatedly evaluated in the context of Time=t (as t 
increments through the values of Time). The value for any identifer 
that appears in an expression is implicitly sliced at Time=t (unless it is 
explicitly offset in Time). As an example, suppose A is indexed by 
Time, and X is defined as:

dynamic(0, self[Time-1] + Max(A,Time) )

During evaluation, A would be a scalar at any given time point since it 
is implicitly sliced across Time. When A is not indexed by Time, 
Max(A,Time) simply returns A, so that the above expression is 
equivalent to

dynamic( 0, self[Time-1] + A )

To add the greatest value of A along Time in this expression, you must 
introduce an extra variable to hold the maximum value, defined simply 
as Max(A,Time), and ensure that the two variables do not occur in the 
same dynamic loop.
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If you attempt to operate over the Time dimension from within a 
dynamic loop, Analytica issues the warning: “Encountered applicati
of an array function over the Time index from within a dynamic loo
The semantics of this operation may be different than you expect.

Uncertainty and Dynamic

Uncertain variables propagate uncertainty samples during dynam
simulation. If an uncertain variable is used in a dynamic simulatio
its uncertainty sample is calculated only once, in the initial time 
period. 

Example

The following definitions model population changes over time:

Population: Normal(30, 2)

Birthrate: Normal(1.2, .3)

Time: Sequence(1, 10, 1)

Pop_by_year: Dynamic(Population, Self[Time-1] +
Birthrate)
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Uncertainty and Dynamic
The uncertainty samples for Population and Birthrate are each 
calculated once, at the initial time period. The same samples are then 
used for each subsequent time period.

Resampling

If you want to create a new uncertainty sample for each time period 
(that is, resample for each time period), place the distribution in the 
last parameter of the Dynamic() function. For example, replace 
Birthrate with its definition in Pop_by_year:

Pop_by_year: Dynamic(Population, Self[Time - 1] +
Normal(1.2, .3))

An alternative way to create a new uncertainty sample for each time 
period is to make Birthrate a dynamic variable.

Birthrate: Dynamic(Normal(1.2, .3), Normal(1.2, .3))

Pop_by_year: Dynamic(Population, Self[Time-1] +
Birthrate)
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Importing, 
Exporting, and 
OLE Linking 
Data



In this Chapter

This chapter shows you how to exchange 
data between Analytica and other 
applications.

OLE linking makes it possible to link data 
to and from external applications. With 
OLE linking, changes to inputs or results 
are automatically and instantaneously 
propagated between applications.



Copying and pasting

e 
e 
s 
This chapter describes how to exchange data between Analytica and 
other applications. The primary methods are:

• Using the standard Copy and Paste commands

• Using OLE Linking

• Using the Import and Export commands

Copying and pasting

You can use the standard Copy and Paste commands with any 
modifiable attribute of a variable, module, or function. 

Pasting data from a spreadsheet

To paste tabular data from a spreadsheet into an Analytica table:

1. Select a group of cells in a spreadsheet. 

2. Select Copy from that program’s Edit menu, to copy the data to 
the clipboard. 

3. Bring the Analytica model to the front and open the Edit Table 
window you want to paste the data into. 

4. Select a top-left cell or the same number of cells that you 
originally copied. 

5. Select Paste from the Edit menu (Ctrl-V).

Analytica Note:  When copying a row of data from a spreadsheet into a 
one-dimensional table, transpose the data first so that you are copying it 
as a column of cells, not a row of cells.

Pasting data from another program

To paste data from a program other than a spreadsheet:

• Use tab characters to separate items, and return characters to 
separate lines.

• Use numbers in floating point or exponential format. You can us
the suffixes that Analytica recognizes (including K, M, and m; se
page 163 for a comprehensive list). Dollar signs ($) and comma
(thousands separators) are not permitted.
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Copying a diagram

To copy an influence diagram, including the objects represented by the 
nodes:

1. Select the group of nodes you wish to copy.

2. Select Copy from the Edit menu (Ctrl-C). The objects that the 
nodes represent, as well as a picture of the selected nodes with 
all of the relevant arrows between the selected nodes, are copied 
to the clipboard.

To copy an entire influence diagram window, select Copy Diagram 
from the Edit menu. The entire influence diagram is copied as a 
Picture representation without copying the objects that the nodes 
represent.

Copying an edit table or result table

To copy data from an Edit Table or Result Table:

1. Open the window containing the table.

2. Select cells and choose Copy from the Edit menu (Ctrl-C).

To copy all the elements of a table in addition to the index elements, 
select Copy Table from the Edit menu. The entire multidimensional 
array is copied as a graphic and as a list of two-dimensional tables in 
a special text format (see “Edit Table data import/export format” on 
page 378).

Copying a result graph

To copy or export a result graph:

1. Open the Result window containing the graph. 

2. Select Copy from the Edit (Ctrl-C) menu to copy a PICT 
representation of the graph.

Linking Analytica results to other applications 

By using OLE linking, results from Analytica models can be linked
into OLE compliant applications like Word and Excel. Linking data
can save a great deal of work because it saves you from performi
repeated copy and paste operations between Analytica and other
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applications whenever your model results change. Without OLE, if 
you copied Result tables from Analytica, pasted them into a Word 
document, and later you tweak your model results, you would need to 
re-copy and re-paste all those Result tables. However, if you link those 
tables using OLE, all the data in the Word document will update either 
automatically, or if you prefer, when you explicitly decide to update 
the data. 

You may link any of the Result table views, i.e. Mid, Mean, Statistics, 
Probability Density, Cumulative Probability and Sample table views. 
For Result tables with more than two dimensions you may decide to 
link the entire table as a series of two-dimensional tables using the 
Copy table option in Analytica’s Edit menu. In addition you may link 
any two-dimensional slice of a multi-dimensional table with the 
regular Copy command. You may also link data cells that are a sub
of a table. However, you may not link non-table data such as the 
information that is contained in the object window or attribute pan

Linking procedure

Steps for linking result data from your Analytica model to an extern
OLE-compliant application are as follows. For concreteness, we’ll
assume here that the other application is Microsoft Excel.

1. In the Analytica Result window, select the cells you want to link 
and choose ‘Copy’ from the ‘Edit’ menu.

2. From Excel, select the cells where you would like the Analytica 
data linked.

3. From Excel’s ‘Edit’ menu, choose ‘Paste Special…’

4. The ‘Paste Special’ dialog box will appear.

5. In this box, choose the option ‘Paste link’ as ‘Text’ and click the 
‘OK’ button.

You’re done. Any changes to the source Result table will be propaga
to the linked data in Excel. The procedure for linking Analytica mode
results to other OLE-compliant applications will be similar to the abo
steps.

Note: The external application must support OLE-linking of tab-
delimited textual data. Applications that do not support this 
format will not display “Text” as an option in Step 5 above, o
will disable the Paste Special... menu item in Step 3. 
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Detailed example of linking Analytica results

This example will itemize detailed steps for linking an Analytica 
Result table into an Excel spreadsheet. Suppose you would like to link 
the model results displayed above into an Excel spreadsheet. You can 
start by linking the column and row headers. Go to the node titled 
Cashflow category and evaluate its result. Notice the result of node 
Cashflow Category is displayed as a column of cells, but you would 
like to have them linked into Excel as a row. Unfortunately you may 
not link this data as a row with a single ’Copy/Paste Special’ operation 
since Excel will not let you transpose the linked data from a column to 
a row. However, you can easily work around this limitation. Link the 
values into an unused portion of your spreadsheet or to a blank sheet 
using the linking procedure described in the previous section. In the 
cells where you actually would like the labels to appear as a row, 
simply reference the linked cells. In other words, define the cells that 
will comprise the column headers for the linked table you are creating 
using the names of the corresponding linked cells.

Now it’s time to link the values of Time as the row headers in your 
linked table. Time is an Analytica system variable and one of the 
elementary ways to copy its values for linking is to create a node called 
Time and give it the definition time. Evaluate this node and then link 
the values displayed in the Result table using the linking procedure 
described in the previous section.

Linking the body of the table is just a straightforward application of 
the linking procedure. The number format of the cells will be 
preserved in fixed point format, but you may want to use Excel 
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formatting to get the dollar sign and thousand separator displayed. 
Note that Excel may switch to the exponential number format or 
display ’########’ if your columns are not wide enough. 

The body of the table and its indexes (the row and column headers) are 
linked. For instance, if your Analytica model results change and you 
decide also to change the value of ’cost’ to ’expense’, these changes will 
be reflected in you’re linked table in Excel (see the figure below).

Important notes about linking to Analytica results

Changing file locations

When moving linked files from one drive partition to another on the 
same machine or between two different computers, keep the relative 
paths the same. The simplest way to do this is to keep the linked model 
files and the other application files to which they are linked in the 
same folder.

Automatic vs. manual updating

OLE links are set for ‘automatic’ updating by default, but you may
change this setting to ‘manual’. This would be desirable if the data
linked from an Analytica model with a lengthy re-computation time 
to an application with a lengthy re-computation time. 
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To change a link’s setting to manual in Word:

1. On Word’s edit menu, select ‘Links…’

2. In the ‘Links’ box that appears select the link(s) you’re 
interested in adjusting.

3. Click on the radio button labeled ‘manual’ and click the ‘OK’ 
button.

In other OLE compliant applications the steps for switching from 
‘automatic’ to ‘manual’ updating should be very similar to the ones
listed above.

You may also decide to set all your OLE links to be updated manua
using a preference setting in Analytica. From the ‘Edit’ menu, sele
‘Preferences…’, then in the ‘Preferences’ dialog box, uncheck the
check box located on the bottom right labeled ‘Auto recompute 
outgoing OLE links’.

Number formatting

When linking data into OLE compliant applications, the number 
format will be the same as Analytica’s format at the time of link 
creation. However, if Analytica data with ‘Suffix’ format (Analytica’s
default) is linked, the linked data’s number format will be 
‘Exponential’. In programs that have their own number formatting 
settings such as Excel, the number format will likely be adjusted 
according to the settings for the cells you are pasting into. Howev
you must still be careful about losing significant digits (see next 
paragraph).

Another important consideration regarding number formatting is 
precision. Before linking from Analytica, you should first adjust the
number format so it displays all the significant digits you would lik
to have in the other OLE-savvy application to which you are linkin

Refreshing links when Analytica model is not running

If you refresh the links between an Analytica model and another O
savvy application when the Analytica model is not running, the 
following events will occur:

1. A new instance of Analytica will launched,

2. The model will be automatically loaded, 

3. The nodes upon which the links are dependent will be evaluated, 
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4. The links will become reactivated, and

5. The linked data will be updated.

There are two ways to refresh the links this way. The first case occurs 
when a file with links is opened while the model file to which it is 
linked is closed, and you answer ‘Yes’ to the dialog box prompting y
to update the linked data. The other way is if you are working with
file containing links to a model that is not running and you explicit
update the links. To explicitly update the links in Excel, you would
select ‘Links…’ from the ‘Edit’ menu. Then in the ‘Links’ dialog box,
select the links you would like to refresh and click the ‘Update’ butto

Linking data from other applications into Analytica

Using OLE linking, you may incorporate data originating in OLE-
compliant applications as the input for nodes in your Analytica mod
You accomplish this by linking the external data to Edit tables in 
Analytica. Once again, this removes the need to perform numerou
copy and paste operations each time the source data in the other
application changes. 

When linking data into Analytica, you may link data into any Edit 
table with less than three dimensions. When linking data in Edit tab
you must link all the contents of the table; linking a subset of an E
table is not supported. You may not link data from other applicatio
to anywhere else than an Edit table in Analytica including the diagr
windows, object windows, and the attribute panel.

Linking procedure

Steps for creating a linked Edit table in Analytica with data from a
Excel spreadsheet:

1. In Excel, select the cells you want to link to Analytica and choose 
‘Copy’ from the ‘Edit’ menu.

2. In Analytica, make the Edit table where you want the Excel data 
linked the front most window.

3. From the ‘Edit’ or the right mouse button pop-up menu, choose 
‘Paste Special…’ and the ‘Paste Special’ dialog box will appear. 

4. It will already be set for ‘Paste link’ as ‘Text’ (see figure 5), so 
just click ‘OK’. 
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The process for linking data from Word or other OLE compliant 
applications will be analogous to the steps just outlined.

Example of linking a table into Analytica

This section will itemize detailed steps for linking a table from Excel into 
Analytica by creating a node with a ‘Linked Table’ definition. 
Specifically, suppose you desire to link the Excel table displayed in 
following figure into Analytica.

Start by creating two indexes in Analytica to store the row and colu
headers. Title the first index Items and the second Status. Select the 
node Items and then click the Show definition button on the toolbar 
(this is the button with the pencil icon) or right mouse menu. In the
attribute panel or object window that appears, click on the expr popup 
menu and choose List of labels. Press the 'down arrow' or 'Return' ke
three times. This will give you three cells — item 1, item 2 and item 3. 
In Excel, copy the three cells used as the row headers (i.e. 'Red 
Widgets', 'Blue Widgets' and 'Green Widgets'); return to Analytica and 
do a regular paste into the three cells of the definition for the inde
node 'Items'. 

Now you need to copy the values of the column headers (i.e. 'In Stock' 
and 'Ordered') into the definition for the index node Status. Since 
Analytica enforces strict dimension checking (i.e. you cannot past
3 x 1 array of cells into a 1 x 3 array of cells), you are required to fi
convert the row into a column. This is easily accomplished by copy
the row, moving to an unused portion of the spreadsheet or onto a
blank sheet, and choosing Paste special... from Excel's Edit menu. 
The Paste Special dialog box will appear and you need only select th
Transpose check box on the bottom right. Click the 'OK' button and
you have converted the column header cells from a row into a colu
Now copy this column, go back to Analytica, select the Status node, 
and click the Show definition toolbar button. Select the first cell 'item 
1' and choose Paste from the Analytica's Edit menu.
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Since you’ve finished creating the indexes, you’re ready to start on the 
node that will contain the linked table. Create a variable node in 
Analytica and title it Inventory. With this node selected, click the 
Show definition button on the toolbar. In the attribute panel or object 
window that appears, click on the expr popup menu and choose Table. 
The Indexes dialog appears. In this dialog, select Items and click the 
’>>’ button. This will move Items to the Selected Indexes section. You 
also want to select Status and then click the ’>>’ button to make it a 
selected index as well. Click the ’OK’ button and an Edit table will 
appear as follows.

Go to Excel and select the numerical values displayed in the table and 
choose Copy from the Edit menu. Return to Analytica (while in Edit 
mode), click anywhere in the Edit table grid and choose Paste 
Special… from either the Edit  menu or the right mouse menu. Now 
choose Paste special… from the Edit  menu and the Paste Special 
dialog box comes into view. You want the settings in the box to be 
Paste link and ‘Text’ which are the default settings (see below). Clic
'OK'.
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The caption for the table changes from ’Edit Table’ to ’Linked Table’ 
and you’re done. If you arrange the applications windows so that you 
can see the source table in Excel and the Linked table in Analytica (see 
Figure 6), you can readily demonstrate that the link is activated. 
Change the value for ’Green Widget’s Ordered’ from 2 to say 17. The 
corresponding value in Analytica’s Linked table will change 
accordingly.

Note – the data within the table is linked and will be updated 
automatically when altered, but the row and column headers are n
linked and any changes to their values will have to be propagated
using the standard cut and paste operations. Perform this by copy
to the indexes used by the table, not to the table itself.
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Important notes about linking into Analytica edit tables

Changing file locations

When moving linked files on the same machine or between two 
different computers, keep the relative paths the same so that the files 
can locate each other. The simplest way to do this is to keep the linked 
model file(s) and the other application file(s) to which it is linked in 
the same folder.

Automatic vs. manual updating

OLE links are set for ‘automatic’ updating by default, but you may
change this setting to ‘manual’. This may be desirable if the linked
data is used in a model with a lengthy computation time. To chang
link’s setting to ‘manual’ updating:

1. On Analytica’s ‘Edit’ menu, select ‘OLE Links…’

2. In the ‘Edit Analytica Links’ box that appears select the link(s).

3. Click on the radio button labeled ‘manual’ and click the ‘OK’ 
button.

Terminating links

You may want to terminate a link to a source file for a number of 
reason including if you do not have the source file or if you would like 
to edit the values in a Linked table. To break a link, bring up the Edit 
Analytica Links  dialog, by choosing OLE Links…  from the Edit  
menu. Select the link you would like to terminate and click the Break 
Link  button.

Activating other application

If you have linked data from an external application into Analytica, 
after loading Analytica you can make the other application visible 
using the Open Source button on the OLE Links...  dialog, accessed 
through the Edit  menu. If you implement a portion of your model in 
Analytica and a portion in an external application, with OLE links in 
both directions, you can make both applications simultaneously 
visible on the screen by loading the Analytica model first, then 
pressing the Open Source button to open the external application.
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Importing and exporting

Importing a definition

To import a definition from a text file into expression format:

1. Select the definition field of the variable in either the Object 
window or Attribute panel definition view.

If the variable is defined as a List, List of Labels, or edit table, 
select the cell(s) in which to import.

2. Select Import... from the File menu. A dialog box prompts you 
for the file name from which to import.

Importing into an edit table

To import data from a tab-delimited text file into an edit table:

1. Open the window containing the table.

2. Select cells and choose Import… from the File menu. 

A dialog box prompts you for the file name from which to import.

To import all the elements of a multidimensional table including the 
index elements, a special text format is required (see “Edit Table data 
import/export format” on page 378). This is also the format in whic
an Edit Table or Result Table is exported. The indexes of the table
must have been previously created as nodes.
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Exporting

To export a variable’s definition or result table to a text file, first be
certain that the text file is closed.

1. Select the variable to be exported from and open either the 
Object window, definition in the Attribute panel or Result 
window.

2. Select the definition field, list cell(s), or table cell(s) for 
exporting.

3. Select Export from the File menu. A dialog box prompts you for 
the file name to export to.

Printing to a file

Another way of exporting any Diagram window, Object window, or
Result window to a file is to print to a file:

1. Select Print from the File menu. 

2. Select Print to File and press Enter or click on OK. 

3. Enter the name of the file and the format for the file in the dialog 
box that appears.
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Edit Table data import/export format

Multidimensional data being imported or copied into an Edit Table 
must be in a text file with the special format described in this section. 
This is also the format in which an edit table or result table is exported.

• TextTable is a keyword.

• Attribute is the name of the attribute into which the data is to be
pasted (usually Definition).

• Variable identifier is the identifier of the variable node into which
the data is to be pasted. 

• Index identifier is the identifier of the index for this variable. This
node must already exist in the model.

• Each index value and array value pair must be separated by tab
characters.

One-dimensional array 

The format for a one-dimensional array is:

TextTable <Attribute> <Variable identifier>
<line break>

<tab><Index identifier><line break>

<Index value><tab><Array value><line break>
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Two-dimensional array 

The format for a two-dimensional array is:

TextTable <Attribute> <Variable identifier>
<line break>

<Index1 identifier>< tab><Index1 values separated by tabs><line 
break>

<Index2 identifier><line break>

<Index2 value1><tab><Array values separated by
tabs><line break>

<Index2 value2><tab><Array values separated by
tabs><line break>

<Index2 valueN><tab><Array values separated by
tabs><line break>

Keyword Attribute Variable identifier

TextTable Definition House_cost_inputs

House_inputs

PropTax 3400

Tax rate 0.44

Maintenance 4000

Interest 0.105

Appreciation 0.08

Index Identifier

Index values Array values
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Three-dimensional array

The format for a three-dimensional array is:

TextTable <Attribute> <Variable identifier> <line break>

<Index1 identifier><tab><Index1 Value1><line break>

<Index2 identifier><tab><Index2 values separated by tabs><line break>

<Index3 identifier><line break>

<Index3 value1><tab><Array values separated by tabs><line break>

<Index3 value2><tab><Array values separated by tabs><line break>

<Index3 valueN><tab><Array values separated by tabs><line break>

<Index1 identifier><tab><Index1 Value2><line break>

<Index2 identifier><tab><Index2 values separated by tabs><line break>

<Index3 identifier><line break>

<Index3 value1><tab><Array values separated by tabs><line break>

<Index3 value2><tab><Array values separated by tabs><line break>

<Index3 valueN><tab><Array values separated by tabs><line break>

TextTable Definition Mortgage

Down payment  20000 45000  60000

Buying price 

200000 180000 155000 140000

400000 380000 355000 340000

600000 580000 555000 540000

Keyword Attribute Variable identifier

Index1

Index1 valuesArray values

Index2

Index2 values
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and so on for each value of Index1. 

Example:

Number Format

Numerical data can be imported in any format recognized by 
Analytica (see “Number Format dialog box” on page 127). 

Numerical data will be exported in the format set for the table, wit
these exceptions:

• Suffix format numbers will be exported in scientific exponential 
format.

• Fixed decimal point numbers of more than 9 digits will be export
in scientific exponential format.

• If a date format begins with the day of the week, e.g., “Saturday
January 1, 2000”, the weekday is suppressed: “January 1, 2000

TextTable Definition Net_diff

Buying price  200000

Years owned  5 10 15

Down payment 

20000 10112  12160  13525 

45000 10093  12158  13540 

60000 10073  12157  13555 

Buying price  400000

Years owned  5 10 15

Down payment 

20000 10180. 14201. 16867.

45000 10160. 14199. 16882.

65000 10141. 14198. 16897.

Buying price  60000

Years owned  5 10 15

Down payment 

20000 10248  16242  20209

45000 10228  16241  20224

60000 10208  16239  20239

Keyword Attribute Variable identifier

Index1

Index2

Index1 Value1

Index3

Index3 values

Index2 values

Index1 Index1 Value2

Array values

Index1 Index1 Value3
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Chapter 19

Working with 
Large Models



In this Chapter

This chapter shows you how to:

• Navigate large models

• Combine existing models into an 
integrated model



Show module hierarchy preference
Large models, which include many variables organized into multiple 
modules at several levels of hierarchy, can be challenging to find your 
way around. The first part of this chapter describes how to navigate 
larger models, using the hierarchy preference, the Outline window, 
and variable input and output attributes. The second part of this 
chapter describes how to combine existing models into an integrated 
model.

Show module hierarchy preference

Often a large model has many layers of hierarchy. You can see the 
hierarchy depth of each module at the top of its Diagram window by 
setting a preference. Select Preferences... from the Edit menu to 
display the Preferences dialog box.

If you check the Show module hierarchy box, the top of the active 
Diagram window displays one or more module node shapes to indicate 
its hierarchy depth.

Show module
hierarchy option

Indicates that this module has a parent in the model
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The Outline window

The Outline window displays a listing of the nodes inside a model. It 
can also show the module hierarchy as an indented list of modules. It 
provides an easy way to orient yourself in a large model and to 
navigate within it.

Opening the Outline window

To open the Outline window, click on the Outline button in the tool 

palette ( ).

The Outline window highlights the entry for the selected module or 
variable. 

Opening details from an outline

To display a module’s Diagram window, double-click on its entry in
the outline.

To display a variable’s Object window, double-click on its entry in th
outline.

Check to display only
modules

Attribute popup menu

Attribute panel

List of variables,
modules, and functions

Selected object is
highlighted
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Expanding and contracting the outline

By default, the outline lists all nodes in the model. Check the Modules 
Only box to list only the modules (exclude variables and functions). 

In the outline, each module entry has a triangle icon ( or ) to let 
you display or hide the module’s contents. 

Indicates that the module’s contents are not shown in the Outline 
window. Click on this icon to display the module’s contents.

Indicates that the module’s contents are shown as an indented l
Click on this icon to hide the module’s contents.

Viewing and editing attributes

The Attribute panel at the bottom of the Outline window works jus
like the Attribute panel available at the bottom of a Diagram windo
(see “Displaying the attribute” on page 27). 

To view the attributes of a listed node:

1. Select the node by clicking on it.

2. Choose the attribute to examine from the Attribute popup menu 
(see “The Attribute popup menu” on page 28).

If you edit attributes in this panel, the changes are propagated to any 
other Attribute panels and Object windows.

Click here to see
modules only
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Viewing values

To see the Outline window with mid values, select Show With Values 
from the Object menu. Each variable whose mid value has been 
evaluated and is a scalar will display in the window (see “Showing m
values” on page 29). 

Finding variables

To locate a variable in its diagram, by identifier or by title, use the
Find dialog box.

Find dialog box

To display the Find dialog box: 

1. Select Find... (Ctrl-F) from the Object menu. 

2. Choose the attribute to search by: Identifier or Title.
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3. In the text field, enter the identifier or title for the Analytica 
object for which you want to search. You can enter an 
incomplete identifier or title, such as “down” for “Down 
payment.”

4. Click on the Find button to initiate the search. 

The Diagram window containing the object found is displayed, with 
the node of the object selected.

If the name you type does not match completely any existing identifier 
or title (depending on which attribute you are searching), the first 
identifier or title that is a partial match will be displayed.

To find the next object that is a partial match to the last identifier or 
title that you entered, select Find Next (Ctrl-G) from the Object 
menu.

To find an object whose identifier matches the selected text in an 
attribute field (such as a definition field), select Find Selection 
(Ctrl-H) from the Object menu. 
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Managing attributes

Every node in an Analytica model is described by a collection of 
attributes. For some models, you may want to control the display of 
attributes or create new attributes. Some attributes apply to all classes 
(variable, module, and function). Others apply to specific classes, as 
listed in the following table.

Key:

For descriptions of the attributes, see the Glossary.

Attributes dialog box

Use the Attributes dialog box to control the display of optional 
attributes in the Object window and Attribute panel and to define new 
attributes.

Attribute Function Module Variable

Author *

Check √ √

Class * * *

Created *

Definition * *

Description * * *

Domain √

File Info *

Help √ √ √

Identifier * * *

Inputs √ √

Last Saved *

Outputs √ √

Parameters *

Probvalue √

Title * * *

Units * *

Value √

User-created (up to 5) √ √ √

plain = modifiable by user * = always displayed

italic = set by Analytica √ = optionally displayed
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To open the Attributes dialog box, select Attributes. . . from the 
Object menu. 

Class popup menu

Use this menu to select the attribute list for variables, modules, or 
functions.

Attribute list

This list shows attributes for the selected class. Attributes with an 
asterisk (*) are always displayed in the Object window and 
Attribute panel. Attributes with a check mark (√) are optionally 
displayed.

Displaying optional attributes

To display an optional attribute in the Object window and Attribute 
panel, click on it once to select it, then click on it again to show a check 
mark.

To hide an optional attribute, click on it once to select it, then click on 
it again to remove the check mark.

Creating new attributes

You can create up to five additional attributes. For example, you could 
use a Reference attribute to include the bibliographic reference for a 
module or variable.

Class popup menu

Asterisk indicates an
attribute that is always displayed

in Object window
Check mark indicates optional

attribute is displayed

Attribute list

Create new attribute
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To create a new attribute in the Attributes dialog box:

1. Select new attribute from the attribute list to show the new 
attribute Title field and the Create button. 

2. Enter the title for the new attribute in the Title field. The title 
can contain a maximum of 14 characters; 10 characters are the 
maximum recommended for visibility with all screen fonts.

3. Click on the Create button to define the new attribute.

A newly created attribute is displayed for modules, variables, and 
functions. To control whether or not it is displayed for modules, 
variables, or functions, select the Class popup menu in the Attributes 
dialog box, and turn the check mark on or off.

Renaming an attribute

To rename a created attribute:

1. Select it in the attribute list. The Title field and the Rename 
button appear.

2. Edit the name of the attribute in the Title field.

3. Click on the Rename button.

Referring to the value of an attribute

Analytica includes the following function for referring to the value of 
an attribute in a variable’s definition:

Attrib Of Ident

Returns the value of attribute Attrib of the object whose identifier is 
Ident. 

The result is a text value for all attributes except Value and Probva
which may return a number, text, or array.

Library

Special

Example

Units of Time → ’Years’
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Invalid Variables
Analytica Note:  When the value of an attribute changes, variables 
whose definitions include this expression are not recomputed. You must 
delete and reenter the definition.

Invalid Variables

To locate all variables in a model with syntactically incorrect or 
missing definitions, select Show Invalid Variables from the 
Definition Menu.

Double-click on a variable to open its Object window. From the Object 
window, you can edit the definition, or click on the Parent Diagram 

button ( ) to see the variable in its diagram.

Using filed modules and libraries

Modules and libraries can be components of a model. If you are 
building several similar models, or if you are building a large model 
composed of similar components, you can create modules and libraries 
for reuse. (See Chapter 20 for details about libraries.)

To use a module or library in more than one model, create a filed 
module or filed library. 

Creating a filed module or library

To create a filed module or library:

1. Create a module by dragging the module icon from the node 
palette onto the diagram, and give it a title.

2. Create functions and/or variables in the module, or create them 
elsewhere and move them into the module.
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3. Change the class of the module to Module ( ) or Library 

( ) (see “Changing the class of a node” on page 78).

4. The Save As dialog box appears. Give the filed module or library 
a name and save it.

5. If you want the original model to load the new filed module or 
library the next time it is opened, save the model using the Save
command.

Locking a filed module or library

To prevent a filed module or library from being modified, lock it:

1. Close the filed module or library, or close Analytica.

2. In Windows Explorer, select the filed module or library.

3. Select Properties from the File menu.

4. Check the Read-only checkbox.

5. Close the Properties window.

Check this option to lock
a library or module file
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Adding a module or library to a model

To add a filed module or library to the active model, use the Add 
Module dialog box (see “Add Module dialog box” on page 395). Yo
can either embed a module copy or link to the original of the filed 
module or library.

Removing a module or library from a model

To remove a filed module or library from a model, first select it. The
select Cut or Clear from the Edit menu. An embedded copy will be 
deleted; a linked original will still exist as a separate file.

Warning: Any definitions that use a function in a deleted library or 
that have an input from a deleted module or library will 
have the deleted object removed and will be changed to 
FunctionOf(remaining variables).

Saving changes

After you have linked to a filed module or library, the Save command 
saves every filed module and library that has changed, as well as
model containing them, in their corresponding files.

The Save As and Save a Copy In commands save only the active (top
most window’s) model, filed module or filed library.

Add Module dialog box

Use the Add Module dialog box to add a filed module or library to the
active model.
Analytica User Guide 395



Chapter Working with Large Models19

file 
To open the Add Module dialog box, select Add Module from the File 
menu (Ctrl-L).The standard Open Model dialog box appears. Select 
the desired module in that dialog box. The following dialog box then 
appears:

Analytica Note:  Be sure that the selected model or module was saved 
with a class of filed module or filed library. If it was saved with a class 
of model, when it is linked to the root model, its preferences and 
uncertainty settings will overwrite the preferences and uncertainty 
settings of the root model.

An added module or library must be either embedded or linked. You 
can optionally overwrite any nodes with the same identifiers.

Embed a copy

Embeds a copy of the selected module or library in the active model, 
making it a part of, and saving it with, the model. Any changes to the 
copy will not affect the original filed module or library.

Link to original

Creates a link to the selected module or library, which can be 
separately opened and saved. If you make changes to a linked module 
or library from one model, the changes are saved in the original’s 
and any other models linked to the original will be affected by the 
changes.
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A linked module or linked library has a bold arrow pointing into it on 
the diagram.

Merge contents (overwrite)

Select this checkbox to overwrite existing nodes in the active model 
with nodes having the same identifiers from the added module or 
library. This is useful if the file being added contains updates from a 
previous version.

If you do not select this checkbox, and a node in the file being added 
has an identifier that duplicates one in the active model, a warning 
message is display. If you proceed, the identifier in the active model 
is modified, and the identifier in the file being added remains 
unchanged.

Combining models into an integrated model

Large models introduce a unique set of modeling issues. Modelers 
may want to work on different parts of a model simultaneously, or at 
remote locations. During construction, a large model may be more 
tractable when broken into modular pieces (modules), but all modules 
should use a common set of indexes and functions. Analytica provides 
the functionality required to support large-scale, distributed modeling 
efforts.

This section describes how to best use Analytica for large modeling 
projects and contains suggestions for planning a large model where 
responsibility for each module is assigned to different people (or 
teams).

Define public variables

The first step to creating an integrated model is to define public 
variables for use by all modules and agree on module linkages.

Bold arrow indicates that this is a 
linked module
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Every integrated model will have variables that are used by two or 
more projects (for example, geographical, organizational, or other 
indexes, modeling parameters, and universal constants). These public 
variables should be defined in a separate module, and distributed to all 
project teams. Each team uses Add Module (see “Add Module dialog 
box” on page 395) to add the public variables module to its model
the outset of modeling. Using a common module for public variab
avoids duplication of variables and facilitates the modules’ 
integration.

Source control over the public variables module must be establish
at the outset so that all teams are always working with the same pu
variables module. Modelers should not add, delete, or change 
variables in the public variables module unless they inform the sou
controller, who can then distribute a new version to all modelers.

If multiple teams will be working on separate projects, it is essenti
that the teams agree upon inputs and outputs. Modelers must spe
the input variables, units, and dimensions that they are expecting 
well as the output variables, units, and dimensions that they will b
providing. The indexes of these inputs and outputs should be 
contained in the public variables module.

Create a modular model

By keeping large pieces of a model in separate, or filed modules, 
modelers can work on different parts of a model simultaneously. Y
can break an existing model into modules, or combine modules into
integrated model. In both cases, the result is a top-level model, in
which the modules are added.

To save pieces of a large model as a set of filed modules, see “Us
filed modules and libraries” on page 393.

To combine existing models into a new, integrated model:

1. Create or open the model that will be the top level of the 
hierarchy. This is the model to which all submodels will be 
added.

2. Using Add Module (see “Add Module dialog box” on page 395), 
add in the submodels. Be sure to check the Merge option in the
Add Module dialog box. Add the modules in the following 
sequence:

• Any public variable modules
398 Analytica User Guide



Combining models into an integrated model

r 

d 

s the 
n 
 

ed 
ated 

 

een 

, 
.

d 
• All remaining modules in order of back to front; that is:

- first, the module(s) whose outputs are not used by any othe
module, and

- last, the module(s) which take no inputs from any other 
module.

3. Save the entire integrated model, using the Save command.

The two alternative methods of controlling each module’s input an
output nodes so the modules can be easily integrated, are: 

• Identical identifiers

• Redundant nodes

Identical identifiers

Assign the input nodes in each module the exact same identifiers a
output nodes in other modules that will be feeding into them. Whe
you add the modules beginning with the last modules first (that is,
those at the end of model flow diagram), the input nodes will be 
overwritten by the output nodes, thus linking the modules and 
avoiding duplication.

With identical identifiers, the individual modules cannot be evaluat
alone because they are missing their input data. They can be evalu
only as part of the integrated model.

Redundant nodes

Place the output node identifiers in the definition fields of their 
respective input nodes. Due to the node redundancy, this method
requires more memory than using identical identifiers, and it is 
therefore less desirable when large tables of data are passed betw
modules. However, since no nodes are overwritten and lost upon 
integration, this method preserves the modules’ structural integrity
with both input and output nodes visible in each module’s diagram

With redundant nodes, each module can be opened and evaluate
alone, using stand alone shells.
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Stand alone shells

With redundant nodes, you can create a top-level model that contains 
one or more modules and the public variables module plus dummy 
inputs and outputs. Such a top-level model is called a stand alone shell 
because it allows you to open and evaluate a single module “stand
alone” from the rest of the integrated model. Stand alone shells ar
useful when modelers want to examine or refine a particular modu
without the overhead of opening and running the entire model.

To create a stand alone shell for module Mod1, which is a filed 
module:

1. Open the integrated model and evaluate all nodes that feed 
inputs to Mod1.

2. Use the Export command (see “Importing and exporting” on 
page 376) to save the value of each feeding node in a separate
file. Make a note of:

• the identifier of each node and the indexes by which its result
are dimensioned,

• the identifiers of Mod1’s output nodes, if you want to include 
their dummies in the stand alone shell. 

3. Close the integrated model.

4. Create a new model, to be the stand alone shell.

5. Use Add Module to add the public variables module.

6. For each input node, create a node containing an Edit Table, 
using the identifier and dimensions of the feeding nodes you 
noted from the integrated model.

7. Use the Import command (see “Importing and exporting” on 
page 376) to load the appropriate data into each node's Edit 
Table.

8. Use Add Module to add Mod1  into the stand alone shell.

9. To include output nodes at the top level of the hierarchy, create 
nodes there and define them as the identifiers of Mod1’s outputs.

10. Save the shell.
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The shell now has all the components necessary to open and evaluate 
Mod1, without loading the entire model. As long as modelers do not 
make changes to the dimensions or identifiers of module inputs and 
outputs, they can modify a module while using the stand alone shell, 
and the resulting module will be usable within the integrated model.

Cautions in combining models

Identifiers

Every object in a model must have a unique identifier. The identifiers 
of filed libraries and filed modules that you add to a model, as well as 
their variables and functions, cannot duplicate identifiers in the root 
model. See “Merge contents (overwrite)” on page 397.

Created attributes

When you combine models with created attributes, the maximum 
number of defined attributes is five (see “Managing attributes” on 
page 390).

Location of linked modules and libraries

If the model will eventually be distributed to other computers, all 
modules and libraries should be on the same drive as the root mo
prior to being added to the root model. When the model is distribut
distribute it with all linked modules and libraries.

Managing windows

An Analytica model can potentially display thousands of Diagram,
Object, and Result windows. To prevent your screen from becomi
cluttered, Analytica limits the number of windows of each type tha
can be open at once. The default limits are:

• The top-level Diagram window and not more than one Diagram 
window for each lower level in the hierarchy

• One Object window

• Two Result windows

The oldest window of the same type is deleted whenever you disp
a new window that would otherwise exceed these limits.
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Overriding the limits on the number of windows

To display more windows of the same type, override the default limits 
in one of the following ways: 

• Open a second Object window, or open a Diagram window witho
closing an existing Diagram window at the same level, by press
the Control key (Ctrl) while you click or double-click to open the 
new window.

• Use the Preferences dialog box (see “Preferences dialog box” o
page 80) to change the limits. Select Preferences... from the Edit 
menu. 

.

In the “Windows of each Kind” area, select Any number instead 
of One only.

To display more Result windows and keep the limit on Diagram 
and Object windows, enter the maximum number of Result 
windows.

Click here to allow an unlimited
number of windows on the screen at

once

Enter the maximum number of
Result windows
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In this Chapter

This chapter shows you how to:

• Create your own functions

• Create your own function libraries



Creating a function
You can create your own functions to perform calculations you use 
frequently. A function has one or more parameters; its definition can 
be an arbitrary expression containing these parameters. To control the 
evaluation of the parameters, or to check that they are of the 
appropriate type (for example, scalar or array, deterministic or 
probabilistic), you can specify various qualifiers.

A collection of functions in a library can be used by more than one 
model. Libraries of functions are available for some applications. 
(They are located in the Libraries folder inside the Analytica folder on 
your hard disk.) You may want to look at some of these libraries to see 
if they provide functions that you can use or that you can refer to as a 
starting point for creating your own functions.

Creating a function

To define a function:

1. Make sure the Edit tool is selected and you can see the node 
palette (see page 65).

2. Drag the Function node icon from the node palette into the 
Diagram area.

3. Title the node, and double-click on it to open its Object window.

4. Enter the new function’s attributes (described in the next 
section).

Attributes of a function

A function has attributes in common with other nodes, such as 
identifier, title, description, and definition, and a unique attribute, 
parameters.

Identifier

If you are creating a library of functions, make a descriptive identifier. 
This identifier appears in the function list for the library under the 
Definition  menu, and is used to call the function. Analytica makes all 
characters except the first one lower case.
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Title

If you are creating a library of functions, limit the title to 22 
characters. This title appears in the Object Finder dialog box to the 
right of the function.

Units

If desired, use the units field to document the units of the function
result. The units are not used in any calculation.

Parameters

The parameters to be passed to the function must be enclosed in
parentheses, separated by commas. For example: (x,y,z)

The parameters may have type qualifiers (see the next section).

If you are creating a library of functions, use descriptive abbreviatio
for the parameters and give them a logical sequence. The parame
will appear in the Object Finder dialog box and they will be pasted
when the function is pasted from its library in the Definition menu.

Description

If you are creating a library of functions, enter an explanatory 
description. This text appears in a scrolling box in the bottom half
the Object Finder dialog.

Definition

The definition of a function is an expression that includes all of its
parameters. When you select the definition field of a function, the
Inputs popup menu lists the parameters.
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Parameter qualifiers

The expressions passed into a function are evaluated, by default, 
according to their context—that is, deterministically or 
probabilistically. You can control the evaluation of a function more
precisely by specifying parameter qualifiers.

Function parameter type qualifiers

You can specify one of the following types for each parameter of a
function:

ArrayType

An array of one or more dimensions. 

Ascending

A list or one-dimensional array of increasing numeric values. 

Context, Expr

Default qualifier; evaluates according to the surrounding context. 

DetermType

Forces deterministic evaluation.

IndexType

A variable defined as a list or list of labels, or an array indexed by s

Numeric

A number or an array of numbers. 

Positive

A single positive number. 

Prob

Forces probabilistic evaluation. 
Analytica User Guide 407



Chapter Building Functions and Libraries20
Samp

Forces probabilistic evaluation and returns an error message if the 
result is not indexed by Run.

Scalar

A single number. 

Syntax
(Parameter1: Qualifier1; Parameter2: Qualifier2)

Examples:

The default qualifier type is Context, or Expr (the two are 
equivalent). A parameter list, x and y, using the default qualifier looks 
like this:

(x,y)

• To apply the Prob parameter type qualifier to x:

(x:Prob;y)

• To apply Prob to both x and y:

(x,y:Prob)

• To apply Prob to only y:

(x;y:Prob)

• To apply IndexType to x and Prob to y:

(x:IndexType;y:Prob)
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Example function

The following function, Capm(), computes the expected return for a 
stock under the capital asset pricing model..

Parameters

The three parameters, Rf, Rm, and Beta, are qualified to be numeric.

Definition

The definition is an expression using Rf, Rm, and Beta.

Sample usage

You use the Capm() function in a definition in the same way you 
would use Analytica’s built-in functions. For example, if the risk fre
rate is 5%, the expected market return is 8%, and StockBeta is defined 
as the beta value for a given stock, we can find the expected retu
according to the capital asset pricing model as:

Stock_return: Capm(5%,8%,StockBeta)

This definition functions equally well when StockBeta is an array of 
beta values. In this case, the result will be an array of expected retu
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Libraries

When you place functions and variables in a library, the library 
becomes available as an extension to the system libraries. Its functions 
and variables also become available. Up to eight user libraries can be 
used in a model.

There are two types of user libraries (see also “Changing the clas
a node” on page 78):

• A library ( ) is a module within the current model.

• A filed library ( ) is saved in a separate file, and can be shar

among several models.

Creating a library

To create a library of functions and/or variables:

1. Create a module by dragging the module icon from the node 
palette onto the diagram, and give it a title.

2. Change the class of the module to library or filed library (see 
“Changing the class of a node” on page 78).

3. Create functions and/or variables in the new library or create 
them elsewhere in the model and then move them into the 
library.

Functions and variables in the top level of the library can be accessed 
from the Definition  menu or Object Finder. Use modules within the 
library to hold functions and variables (such as test cases) that will not 
be accessible to models using the library.

Adding a filed library to a model

Add a filed library to a model using the Add Module dialog box (see 
“Add Module dialog box” on page 395).

Using a library

When defining a variable, you can use a function or variable from
library in any of the following ways:
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• Type it in.

• Select Paste Identifier from the Definition menu to open the 
Object Finder.

• Select Other from the Expression popup menu to open the Obje
Finder.

• Paste from the library under the Definition menu.

A user library
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Example

Compare the way the Capm() function is displayed in the Object 
window (page 409) to the way it is displayed in the Object Finder:
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In this Chapter

This chapter describes those features 
available only in the Enterprise version of 
Analytica: 

• Functions to access external databases 
using ODBC and SQL.

• Features to protect or hide sensitive 
information when distributing your 
models to others.

Note: You must use Analytica Enterprise 
to create or set these features, 
including database access with 
ODBC and information hiding. 
However, you can run a model 
created in Analytica Enterprise with 
Analytica 2.0 or the Analytica 
Browser, and the model will be able 
to access databases and hide the 
information as specified in the 
original model.
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Analytica Enterprise

Analytica Enterprise is a version of Analytica that extends the 
functionality of version 2.0 to include features useful for developing 
and using models within a large enterprise or organization. Two key 
areas of functionality included with the Enterprise version are:

• Database access. A collection of database functions make it 
possible to read and write data between external ODBC databa
and your Analytica models.

• Protecting Intellectual Property. When you distribute your mode
to end-users, you can hide selected variable definitions from the
end-user, and/or prevent end-users from editing your model.

Accessing external databases

Analytica Enterprise provides several functions for querying extern
databases using ODBC. ODBC (Open Database Connectivity) is a 
widely used standard for connecting to relational databases, on ei
local or remote computers, and issuing queries in SQL (Standard 
Query Language). 

Analytica Note:  You can define and create database accesses only with 
Analytica Enterprise. However, you may use Analytica 2.0 or the 
Analytica Browser to run a model created with Analytica Enteprise, and 
to execute the database access features.

Overview of ODBC in Analytica

The Standard Query Language (SQL) is a widely used language 
designed especially for the relational database model. In a relatio
database, data is organized in two-dimensional tables, where the 
columns of a table serve as fields or labels, and the rows corresp
to records, entries, or instances. Common database terminology u
the terms columns and rows for these roles.   In Analytica, it is more
natural to refer to these as labels and records. For instance, an address
book table might have the columns or labels: LastName, FirstNam
Address, City, State, Zip, Phone, Fax, E-mail, and each individual
would occupy one row or record in that table.
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Regardless of the underlying organization of data in a data source, the 
result of an SQL query is always a two-dimensional table, called a 
Result Table. Here the rows are the records matching whatever criteria 
is specified by the query, and the columns are the fields that are 
requested.

Analytica Enterprise provides functions that take as a parameter an 
SQL query, formulated with standard SQL syntax as an Analytica text 
string. When evaluated, these functions return the result of the query 
as a two-dimensional table in Analytica. A two-dimensional table in 
Analytica requires two indexes: the rows are indexed by a record 
index, and the columns are indexed by a label index. So, the basic 
structure of an Analytica model for retrieving a result table is:

(The dotted lines explicitly show what the Result Table is indexed by). 
Each of the three nodes in the above figure could require the 
information from the Result Table. For example, the definition of the 
Record Index would require knowing how many records (rows) are in 
the result table; the Label Index may need to read the names of the 
columns (although, often these will be known in advance); and of 
course, the Result Table needs to read the table. Thus, special 
functions in the Database library are used to define each of the above 
three variables. These functions work in concert to perform the query 
only once (when the Record Index is evaluated), and share the result 
table between the nodes. 

For the address database example above, we can obtain the record 
index as Individuals, the label index as Address_fields, and the 
resulting table as Address_table, as follows:

Individuals:=DBQuery(Data_source,’SELECT*FROM 

Addresses’) 

Address_fields:=DBLabels(Individuals) 

Address_table:=DBTable(Individuals, 

Address_fields) 

Record
Index

Column
Index

Result Table

Record
Index

Label
Index

R esult
Table
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In the above example, the Record Index is defined using DBQuery(), 
the Label Index is defined using DBLabels(), and the Result Table 
is defined using DBTable(). Each function is described below.

To specify a data source query, two basic pieces of information must 
always be known: The data source identifier, and the SQL query 
string.   These two items are the arguments to the DBQuery() 
function, and are discussed in the following two subsections

Identifying the data source

A data source is described by a text value, which may contain the 
Domain Service Name (DSN) of the data source, login names and 
passwords, etc. Here, we describe the essentials of how to identify and 
access a data source. These follow standard ODBC conventions. For 
more details, consult one of the many texts on ODBC.

Note: You must have a DSN already configured on your machine. If 
not, consult with your Network Administrator. See 
section “Configuring a DSN” below.

The general format of a data source identification string is (the single 
quotes are Analytica’s string delimiters):

’attr1=value1; attr2=value2; attr3=value3;’

For example, the following data source identifier specifies the 
database called ’Automobile Data’, with a user login ’John’ and a 
password of ’Lightning’:

’DSN=Automobile Data;UID=John;PWD=Lightning’

If a database is not password protected, then a data source descriptor 
may be as simple as:

’DSN=Automobile Data’

If a default data source is configured on your machine (consult your 
database administrator), you may specify it as:

’DSN=DEFAULT’

Some systems may require one login and password for the server, and 
another login and password for the DBMS. In this case, both can be 
specified as:

’DSN=Automobile Data; UID=John; 
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 PWD=Lightning; UIDDBMS=JQR; PWDDBMS=Thunder’

You can use the DRIVER attribute to specify explicitly which driver 
to use, instead of letting it be determined automatically by the data 
source type. e.g., 

’DSN=Automobile Data;DRIVER=SQL Server’

Instead of embedding a long data source connection string inside the 
DBQuery() statement, you can define a variable in Analytica whose 
value is the appropriate text string. The name of this variable can then 
be provided as the argument to DBQuery(). Another alternative is to 
place the connection information in a file data source (a .DSN file). 
Such a file would consist of lines such as:

DRIVER = SQL Server
UID = John
PWD = Lightning
DSN = Automobile Data

Assuming this data is in a file named MyConnect.DSN, the connection 
string can be specified as:

’FILEDSN=MyConnect.DSN’

In some applications, you may wish to connect directly to a driver 
rather than a registered data source. Some drivers may allow this as a 
way to access a data file directly, even when it is not registered. Also, 
some drivers may provide this as a way of interrogating the driver 
itself. To perform such a connection, use the driver keyword. For 
example, if the Paradox driver accepts the directory of the data files as 
an argument, you may specify:

’DRIVER={Paradox Driver};DIRECTORY=’D:\CARS’

The specific fields used here (UID, PWD, UIDDBMS, PWDDBMS, 
DIRECTORY, etc.) are interpreted by the ODBC driver, and therefore 
depend on the specific driver used. Any fields interpreted by your 
driver are allowed. 

If you do not wish to embed the full DSN in the connection string, a 
series of dialogs will pop up when the DBQuery() function is 
evaluated. For example, you can leave the UID and PWD (user name 
and password) out of your model. When the model is evaluated, 
Analytica will prompt you to enter the required information. Explicitly 
placing information in your model eliminates the extra dialog. A blank 
connection string may even be used, in which case you will need to 
choose among the data sources available on your machine when the 
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model is being evaluated. Although the user can form the DSN via the 
graphical interface at that point, the result is not automatically placed 
in the definitions of your Analytica model. However, you may be able 
to store the information in a DSN file (depending on which drivers and 
driver manager you are using). You may also be able to register data 
sources on your machine from that interface.

Configuring a DSN

To access a database using ODBC, you must have a Data Source Name 
(DSN) already configured on your machine. In general, configuring a 
DSN requires substantial database administration expertise as well as 
the appropriate access permissions on your computer and network. To 
configure a data source, you should consult with your Network 
Administrator and/or your database product documentation. The 
general task of configuring a DSN is beyond the scope of this manual.

If you find you must configure a DSN yourself, the process usually 
involves the following steps (assuming your database already exists):

1. Select the ODBC icon from the Windows Control Panel.

2. Select the “User DSN”, “System DSN”, or “File DSN” tab 
depending on your needs. Most likely, you will want “System 
DSN”. Press the “Add...” button.

3. Select the driver. For example, if your database is a Microsoft 
Access database, select “Microsoft Access Driver” and press 
“Finish”. 

4. You will be led through a series of dialogs specific to the driver 
you selected. These will include dialogs that will allow you to 
specify the location of your database, as well as the DSN name
that you will use from your Analytica model. An example is 
shown here:
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Specifying an SQL query

You may use any SQL query as a text parameter within an Analytica 
database function. SQL queries can be very powerful, and may include 
multiple tables, joins, splits, filters, sorting, and so on. We give only a 
few simple examples here. The user interested in more demanding 
applications should consult a text on SQL, of which there are many 
available.

The SQL expression to select a complete table in a relational database, 
where the table is named ’VEHICLES’, would be:

’SELECT * FROM vehicles’

(Note that SQL is case insensitive, unlike Analytica). To select only 
two columns (make and model) from this same table and sort them by 
make:

’SELECT make,model FROM vehicles ORDER BY make’

These examples provide a starting point. When using multiple tables, 
one detail to be aware of is that it is possible in SQL to construct a 
result table with two columns containing the same label. For example:

’SELECT * FROM vehicles,companies’

where both tables for vehicles and companies contain a column 
labeled ’Id’. In this case, you will only be able to access one (the first) 
of the two columns using DBTable(). Thus, you should take care to 
ensure that duplicate column labels do not result. This can be 
accomplished, for example, using the ’AS’ keyword, e.g., 

The DSN used in
your Analytica queries.

The actual location 
of the database.
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’SELECT vehicles.Id AS vid,companies.Id AS

cid,* FROM vehicles,companies’

For users that are unaccustomed to writing SQL statements, products 
exist that allow SQL statements to be constructed from a simple 
graphical user interface. Many databases allow queries to be defined 
and stored in the database. For example, from Microsoft Access, one 
can define a query by running Access and using the Query Wizard 
graphical user interface. The query is given a name and stored in the 
database. The name of the query can then be used where the name of 
a table would normally appear, e.g., 

’SELECT * FROM myQuery’

Retrieving an SQL result table

To retrieve a result table from a data source, you need: (1) The data 
source connection string, (2) the SQL query.    These are discussed in 
the previous two sections. For illustrative purposes, suppose the 
connection string is ’DSN=Automobile Data’, and the SQL 
statement is ’SELECT * FROM vehicles’. In Analytica, you 
perform the following steps:

1. Create an index node. Name it RecordIndex, and specify its 
definition as:

DBQuery( ’DSN=Automobile Data’, 

’SELECT * FROM vehicles’ )

2. Create a second index node, and name it Labels. Specify its 
definition as:

DBLabels( Record_index )

3. Create a variable node, name it Result Table, and specify its 
definition as:

DBTable( Record_index,Labels)

You can now display Result Table to examine the results.

This basic procedure can be repeated for any result table. The structure 
of the model stays the same, and just the connection string and SQL 
query string change. 
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Separating columns in a model

Instead of retrieving relational data as a single two-dimensional table, 
as described above, it is often more convenient for further modeling in 
Analytica to break each column out into a separate variable. For this 
to be useful, each column variable shares the Record Index as a 
common index. An alternative structure is therefore:

With this model structure, the Record Index is again defined using 
DBQuery(), and each column is defined using DBTable(). The 
actual SQL query is issued only once when the Record Index is 
evaluated.

Suppose you wished to have Make, Model, Year, MPG, etc., as 
separate Analytica variables, each a one-dimensional array with a 
common index. In this case, the steps are as follows:

1. Create an index node. Name it Record Index, and specify its 
definition as:

DBQuery( ’DSN=Automobile Data’, 

’SELECT * FROM vehicles’ )

2. Create a variable node named Make, and give it the definition:

DBTable( Record_index, ’make’ )

3. Create a variable node named Year, and give it the definition:

DBTable( Record_index, ’year’ )

4. Create a variable called CarModel, and give it the definition:

DBTable( Record_index, ’model’ )

In this case, Model is a reserved word in Analytica, so the variable 
cannot be named Model. But, the second argument to DBTable() 
specifies the name of the column as stored in the database. This does 
not have to be the same as the name of the variable in Analytica.

Record
Index

Column 1 Column 2 Column n

Record
Index
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The intelligent array feature can be used in Analytica to construct a 
table containing only a subset of the columns in a Result Table. For 
example, if vehicles has a large number of columns, a node defined by:

DBTable(Record_index,[’make’,’model’,’year’])

will have only three columns. This table will be indexed by 
Record_index and by an implicit index (a.k.a. a null index or a 
self-index).   Note that the first argument to DBTable() must always 
be an indexed defined by DBQuery() -- remember the SQL query is 
defined in that node, and this is how DBTable() knows which table 
is being retrieved.

DBWrite: Writing to a database

You can use SQL to change the contents of the external data source 
from within Analytica, or from within an Analytica model. Using the 
appropriate SQL statements, records can be added to or deleted from 
an existing table (in the data source), columns may be added (if your 
data source driver supports this), and tables may be created or deleted. 

You can not use the DBQuery() function to alter the data source, 
since it processes the SQL statement in read-only mode. To change the 
data source, use the DBWrite() function. DBWrite() is identical 
to DBQuery() except that the SQL statement is processed in read-
write mode. 

You can issue any alteration that can be expressed as an SQL 
statement, and that is supported by the ODBC driver you are using, 
from Analytica using DBWrite(). However, to get data from your 
model into the database, you must convert that data into a text value 
— more precisely, into an SQL statement. Doing so can be tricky, 
some tools have been provided to make the process a little easier.
this section, we will show how one of the more common cases can
handled — the task of writing the data in a multi-dimensional array
a table in a database.   To do this, we will make use of the 
ODBC_Library.ana library, which is collection of user-defined 
functions written in Analytica and included in the example models
distributed with Analytica.

The example scenario is this: An Analytica model computes a varia
A, whose result is an array indexed by I, J, and K. We want this array 
to be written to a table in our database named TableA.   Other 
applications can then make use of this data.
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There are basically two complications with this example. The first is 
the fact that our array is three-dimensional, while a database table is 
always two-dimensional. The second complication is that, even if you 
have a two-dimensional table in Analytica, how do you construct the 
SQL string to write the table to the database?

Our approach is to first convert the three-dimensional array A into a 
two dimensional table, which we will store in an Analytica variable 
named TableA. TableA will need two indexes: ARowIndex and 
ALabelIndex. These three variables are defined as follows:

ALabelIndex := concat(IndexNames(A),[’A’])

ARowIndex := sequence(1,size(A))

TableA:= MDArrayToTable(A,ARowIndex,ALabelIndex)

MDArrayToTable() is described on page 249. ALabelIndex 
evaluates to [’I’,’J’,’K’,’A’], and ARowIndex sets aside one row for each 
element of A. TableA is then a table with one row for each element of 
A, where the value of each index for that element is listed in the 
corresponding column, and the value of that element appears in the 
final column. 

Next, set up TableA in the database with the same columns. This is 
most easily done using the front end provided with your database. For 
example, if you are using MS Access, start the MS Access program, 
and from there, create a new table. Alternatively, you could issue the 
statement

DBWrite(DB,’CREATE TABLE TableA(I TEXT,J TEXT,K 

TEXT,A TEXT)’) 

from an Analytica expression (replacing TEXT with whatever type is 
appropriate for your application). Be sure that the column labels in the 
database table have the same names as the labels of ALabelIndex in the 
Analytica model.

Note: It is possible (and easy) to use column labels in the database 
that are different from the index names in the Analytica model. 
To do this, define ALabelIndex to be 1-D array. The domain of 
the array should be the database labels, and the values of the 
array should be the index names (with the final value being 
arbitrary).

With our data now in a 2-D table form, as needed for a database table, 
we must now construct the SQL string to write the table to the 
database. Before doing this, a few choices must be made. Should the 
write operation append rows to the existing database table? Or should 
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it entirely replace the table? Or perhaps, it should replace only selected 
entries. The various choices made impact how the SQL statement is to 
be constructed. Here we will totally replace any existing data with the 
new data, so that after the operation completes, the table in the 
database will be exactly the same as TableA in the Analytica model. 
The SQL statements for performing the write this looks like:

DELETE * FROM TableA

INSERT INTO TableA(I,J,K,A) VALUES 
(’i1’,’j1’,’k1’,’a111’)

INSERT INTO TableA(I,J,K,A) VALUES 
(’i1’,’j1’,’k2’,’a112’)

...

The first statement removes existing data, since we are replacing 
whatever is there. Then, there will be one INSERT INTO statement for 
each row of TableA. The data to the right of the VALUES keyword is 
replaced by the specific values for indexes I,J,K, and array A (the 
example above assumes the values are all strings).   If your values are 
numeric, you should note that MSAccess is happy quoting numeric 
values when the column is numeric.

Since writing the table requires a series of SQL statements, we have 
two options: Evaluate a series of DBWrite() functions, or lump the 
series of SQL statements into one long string and issue one 
DBWrite() statement. In Analytica, the second option is much more 
efficient for two reasons. First, the overhead of connecting with the 
database occurs only one time.   Second, intermediate result tables do 
not have to be read from the ODBC driver, while if you issued separate 
DBWrite() statements, each one would go through the effort of 
acquiring the result table, only to be ignored. 

Important feature (double semi-colon) 

To allow multiple SQL statements in a single DBWrite() function 
(or in a single DBQuery() function), Analytica provides an 
extension to the SQL language. The double semi-colon separates 
multiple statements. For example, the expression

’DELETE * FROM TableA ;; SELECT * FROM TableA’ 
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first deletes the data from the table, and then reads the (now empty) 
table. When ;; is used, only the last SQL statement in the series returns 
a result table. Note also that most statements that write to a database 
return an empty result table.

We are now ready to write the Analytica expression that will construct 
the SQL statement to write the table to the database.   The function to 
do this already exists in the ODBC_Library. First, use the Add Module 
item on the File menu to insert the ODBC_Library into your model; 
then use the WriteTableSql() function, which returns the SQL 
statement (as a text value) for writing the table to the database. The 
function requires that I and L contain no duplicates (which should be 
the case anyway). 

To perform the write, set the definition of a node (named WriteIt) to: 

WriteIt := DBWrite(DB, WriteTableSql(A, RowIndex, 
LabelIndex,’TableA’))

Any time WriteIt is evaluated, Analytica writes the table to the 
database.

Creating a button to initiate the write operation

The one problem with this setup is that the data doesn’t get written 
until WriteIt gets evaluated. Because Analytica is entirely demand 
driven, WriteIt will not be automatically evaluated when A changes. A 
better solution is to make WriteIt a button (output node) on the 
diagram. Then a user can press the button to initiate the write-to-
database operation. To create the button, select the WriteIt node and 
select the Make Output Node command on the Edit menu.

In most cases, it is the side effect, and not the result, of evaluating 
DBWrite() that is of interest. Therefore, there is no reason to force 
a user to view an empty result window when the WriteIt button is 
pressed. This can be avoided by having WriteIt evaluate to a string, 
which will then show in place of the button when the most recently 
computed result has been written to the database. To accomplish this, 
the definition for WriteIt can be changed to

WriteIt := 

using dummy:=

DBWrite(DB, WriteTableSql(A, RowIndex, 

LabelIndex,’TableA’)) 

do 

’Done’
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Database functions

The Database Library on the Definition menu contains five functions 
for working with ODBC databases.

Note: These functions are available only in Analytica Enterprise.

DBLabels( dbIndex )

Returns a list of the column labels for the result table. This statement 
may be used to define an index which can then be used as the second 
argument to DBTable(). The first argument, dbIndex, must be 
defined by a DBQuery() statement.

DBQuery( connectionString, sql )

Used to define an index variable. The definition of the index should 
contain only one DBQuery() statement. ConnectionString specifies 
a data source (e.g., ’DSN=MyDatabase’). SQL defines an SQL 
query. 

When placed as the definition of an index variable, DBQuery() will 
be evaluated as soon as the definition is complete. When it is 
evaluated, the actual query is performed. The resulting result table is 
cached inside Analytica, to subsequently be accessed by DBTable() 
or DBLabels(). 

DBQuery()returns a sequence 1..n, where n is the number of records 
(rows) in the result table.

DBQuery() should appear only once in a definition, and if it is 
embedded in an expression, the expression must return a list with n 
elements.

DBQuery() processes the sql statement in read-only mode, so that 
the data source cannot be altered as a result of executing this 
statement. To alter the data source, use DBWrite().
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DBTable( dbIndex, column )
DBTable( dbIndex, columnList )
DBTable( dbIndex, columnIndex )

DBTable() is used to get at the data within a result table. The first 
argument, dbIndex, must be the name of a variable (normally an index) 
in your Analytica model that is defined with a DBQuery() statement. 
If the second argument, column, is a string, it identifies the name of a 
column label in the result table, in which case DBTable() returns a 
1-D array (indexed by dbIndex) with the data for that column.   If the 
second argument is a list of strings (the columnList form), then 
DBTable() returns a 2-D table with records indexed by dbIndex, and 
columns implicitly indexed (i.e., self-indexed/null-indexed). If the 
second argument is the name of an Analytica variable (usually an 
index) whose value evaluates to a list of strings, those strings become 
the column headings for a 2-D table with columns indexed by 
columnIndex, and rows indexed by dbIndex. With this last form, 
columnIndex may be defined as DBLabels(dbIndex).

DbTableNames( connectionString, cat, sch, tab, typ)

Connects to an ODBC data source and returns catalog data for the data 
source. ConnectionString specifies a data source (e.g., 
’DSN=MyDatabase’). Cat (catalog names), sch (schema names), 
tab (table names), and typ (table types) may be patterns if your ODBC 
driver manager is ODBC 3 compliant. Use ‘%’ as a wildcard in ea
field to match zero or more characters. Underscore, ‘_’, matches 
character. Most drivers use backslash (‘\’) as an escape character
that the characters ‘%’, ‘_’, or ‘\’ as literals must be entered as ‘\%
‘\_’, or ‘\\’. Typ may be a comma-delimited list of table types. Your
data source and ODBC driver may or may not support this call to 
varying degrees.

Examples

To get all valid catalog names in My db:

DBTableNames(‘DSN=My db’,’%’,’’,’’,’’)

To get all valid schemas in My db:

DBTableNames(‘DSN=My db’,’’,’%’,’’,’’)

To get all valid table names in My db:
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DbTableNames(‘DSN=My db’,’’,’’,’%’,’’)

To get all valid table types:

DbTableNames(‘DSN=My db’,’’,’’,’’,’%’)

DBWrite( connectionString, sql )

This function is identical to DBQuery()  except that the query is 
processed in read-write mode, making it possible to store data in the 
data source from within Analytica. 

SqlDriverInfo( driverName )

Returns a list of attribute-value pairs for the specified driver. If 
driverName=''  (an empty string), returns a list of the names of the 
drivers. Note: driverName must be a string — it cannot be a list of 
strings or an index that is defined as a list of strings. This stateme
would not normally be used in a model, but may be helpful in 
understanding the SQL drivers that are available.

Protecting intellectual property

Note: These features are available only from Analytica Enterprise.

When you are ready to let others use the models you have created
may want to protect your hard work either by preventing the end-u
from changing your model, or by limiting the end-user’s access to
selected definitions. Analytica Enterprise provides features for this
purpose.

Using these features to protect intellectual property involves these
steps:

1. Hide selected definitions.

2. Backup your master model file (and any linked submodules) to 
a safe place.

3. Save a protected (obfuscated) copy of your model.

Note: “Obfuscated” refers to the fact that the model file is scrambl
into a non-human-readable form.

4. Distribute the “obfuscated” copy to your end-users.
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The third step permanently locks your model so that hidden definitions 
can never again be viewed in that copy. It is therefore recommended 
that you save a protected copy of your model, and leave your original 
model as a master (unprotected) copy. Until the model is stored in an 
“obfuscated” form (step #3), an end-user is not prevented from 
unhiding your definitions, or from viewing them by other means (e.
by loading the Analytica model file into a text editor).

Warning: An obfuscated model file cannot be un-obfuscated, even by 
the original author. If it is locked as Browse-only, it can 
never again be edited. If definitions are hidden, they can 
never again be viewed or edited. Always place a master 
copy of your model (and any submodules) in a safe place 
before making an obfuscated copy!

Hiding Definitions

By hiding your definitions, you are essentially hiding the algorithm
and data in your Analytica model from the eyes of your end-user.

When a definition is hidden, the definition attribute displays as:

[Definition is Hidden]

However, the variable can still be evaluated and its result viewed.

Note: Variables associated with input nodes are always visible.

Inheritance of Definition Hiding

Whether a definition is hidden or not is determined through an 
inheritance over the module hierarchy. Using this inheritance, you c
easily hide individual definitions or all definitions within a given 
model or module (and its submodules). You can also exclude sele
nodes or modules from being hidden. For example, you can speci
that the definitions for all variables in module A or any of its 
submodules are to be hidden, except for those in submodule B. 
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As an example, consider the module hierarchy shown above. A flag to 
hide definitions is set for module Mo1 and variable Va4. A flag to 
unhide definitions is set for module Mo3. With these settings, all 
variables under Mo1, except those under Mo3, have hidden 
definitions. Thus, the definition of Va3 is visible, while the definitions 
for Va1, Va2, and Va4 are all hidden. 

Hiding and Unhiding Definitions

To hide all definitions within a model or a module, bring the module 
window to the front and click in the diagram background so that no 
nodes are selected. To hide a single definition, select the variable
node (only a single node should be selected when toggling the hid
unhide status). Then examine the Object menu.

Checkmarks next to Hide Definition(s) and Unhide Definition(s) 
indicate the cloaking status for the current module or selected nod
no checkmarks appear, the module or node inherits its cloaking sta
from its parent module. If a checkmark appears next to Hide 
Definition(s), then the definition for this variable, or for all variables
within the selected module, are hidden. If a checkmark appears ne
Unhide Definition(s), then the cloaking status of the current node’s
parent is overridden so that definitions under the current node are
be visible. To toggle the cloaking status, simple select Hide 
Definition(s) or Unhide Definition(s) as appropriate.

Remember that the definitions of variables with associated input no
are always visible regardless of cloaking status.

Mo3Mo2

Mo4

Mo1

Va1

Va2 Va3

Va4

(hide)

(hide)

(unhide)
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After you have selected the desired cloaking status, you can browse 
your model to verify that your definitions are hidden or visible as 
desired. However, until you lock these setting in place by saving your 
file in an obfuscated format, your end-user may still be able to view 
your definitions, for example, by toggling the cloaking status, or by 
viewing your model file in a text editor.

The Hide Definition(s) and Unhide Definition(s) menu options are 
disabled in the following circumstances:

• If the current model (or any of its linked submodules) has been 
loaded from an obfuscated model file. 
In this case, you cannot toggle the cloaking status since obfusca
has locked it in place.

• If more than one node is selected. 

Saving an Obfuscated Copy of Your Model

There are two main reasons you might wish to create an obfuscat
model file. The first is to lock the cloaking status of definitions so th
an end-user cannot unhide or otherwise gain access to your proprie
definitions (see the previous section). The second reason is to 
permanently lock your model into a browse-only mode so end-use
cannot edit the model (see the next section). 

When you decide to save an obfuscated copy of your model, you 
should do so with extreme caution since obfuscation is irreversible
This point cannot be emphasized enough. Obfuscation protects y
intellectual property from the eyes of others, but if you replace the
master copy of your model with an obfuscated one, you will find 
obfuscation to be equally effective in protecting your intellectual 
property from your own eyes! We recommend always placing a master 
copy of your model and all its linked submodules in a safe place before 
making an obfuscated copy. In this case, it is better to be safe than 
sorry.
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When you are ready to save an obfuscated copy of your model, select 
Save a Copy In... from the File menu. Enter a filename that is 
different than the filename of your master copy, and mark the Lock 
and obfuscate the copy checkbox at the bottom of the dialog and 
press the Save button.

To protect you from accidentally obfuscating your master copy, these 
checkboxes appear only on the Save a Copy In... dialog.

Saving a Browse-Only Copy

You may wish to distribute a copy of your model to others, without 
allowing them to edit your model. This is accomplished by saving a 
browse-only copy. The end-users will be able to change variables with 
associated input nodes, but will not be able to change other variables 
in the model or add or delete variables. The user will not be able to 
leave browse mode while the model is loaded.

If your end-user has only the Analytica Browser, which can be freely 
distributed, you do not need to create a browse-only copy. However, 
if your end-user obtains a registration number (either a licensed copy 
of Analytica or a trial registration number), they will be able to make 
changes unless you have given them a browse-only copy.
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If your model uses Enterprise database functionality, and you wish to 
share this model with others who have a non-enterprise version of 
Analytica, you must save the copy you give them as browse-only. 
Otherwise, the database functions cannot be evaluated by these users.

To save a browse-only copy, select Save a Copy In... from the File 
menu, enter a file name that is different from the name of your master 
copy, and check the Save as a browse-only model checkbox at the 
bottom of the dialog. 

Warning: The browse-only flag cannot be reset and browse-only 
models are obfuscated. Take extreme care to ensure that 
you have placed a master copy of your model in a safe 
place before saving a browse-only copy. In general, you 
should take the same precautions emphasized in the section 
“ Saving an Obfuscated Copy of Your Model” above.

Obfuscation and Linked Submodules

If you plan on distributing an obfuscated version of your model, it is 
preferable to embed submodules rather than linking submodule files 
into your model. In so doing, you minimize the chances of accidentally 
obfuscating a submodule file, or of leaving a submodule file 
unobfuscated. This only a recommendation and not a requirement.

If you do have linked submodules, their files are not obfuscated when 
you save your main model using Save a Copy In.... To obfuscate these 
files, open the object window for each submodule, and with the 
window in the foreground, select Save a Copy In.... Notice that the 
module name will appear in the title bar of the dialog. From there, the 
obfuscation option can be selected. Again, take extreme caution to 
avoid replacing your master copy. To ensure that the links between file 
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name are maintained in your copy, you will need to use the same file 
name as the original linked file name, but you will want to store the 
copies in a new directory, keeping the relative paths the same.

When any obfuscated model file is loaded into Analytica, even if it is 
a sub-module, Analytica will treat the entire model as if it has been 
obfuscated. If any module file is browse-only, the entire-model will be 
browse-only. If any submodule is dirtied and saved at that point, it will 
be saved in an obfuscated form.

Warning: Never import an obfuscated submodule into your master 
model. Doing so could cause your master model to become 
obfuscated next time it is saved.
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In this Appendix

This appendix describes all the pull-down 
menus you can access from the Analytica 
menu bar.



File menu

The File menu contains commands to open, create, and save files, as 
well as to import and export them. In addition, the printing and Exit 
commands are in this menu.

New Model

Starts a new model.

Open Model 

Opens an existing, previously saved model.

Add Module

Adds a filed module or filed library to the active model.

Close 

Closes the active window.
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Close Model 

Closes the active model.

Save 

Saves the active model to a file, and saves each changed linked module 
and linked library to its own file. If the model has never been saved 
before, prompts for a file name and folder.

Save As

Saves the active model, filed module, or filed library as a new file. 
Prompts for a file name and folder.

Save A Copy In

Saves a copy of the active model, filed module, or filed library into a 
new file, leaving the active file name for future saves. Prompts for a 
file name and folder. 

Import 

Imports the contents of a text or data file into the selected variable 
definition. See “Importing and exporting” on page 376.

Export 

Exports the contents of the selected field or cells into a file. See 
“Importing and exporting” on page 376.

Print Setup 

Displays a dialog box for selecting paper size, orientation, and sca
options for printing.

Print Preview

Displays a view showing where page breaks will occur before the
current window is printed. 
440 Analytica User Guide



ile 

es 
Print 

Displays a dialog box for selecting the printer, number of copies you 
want to print, and other printing options.

Print Report

Displays a dialog box for printing multiple diagrams, object windows, 
and result windows at the same time. See “Printing” on page 31.

Recent files

The four most recently opened Analytica models are listed on the F
menu. Selecting one loads the corresponding model into memory.

Exit

Quits the Analytica application. Confirms if you wish to save chang
to the current model.

Edit menu

The Edit menu contains commands to manipulate objects, text or 
graphics, and display the Preferences dialog. 

Undo 

Undoes your last action.
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Cut 

Cuts the selected text, nodes, graph, or table cells into the clipboard 
temporarily for pasting.

Copy

Copies the selected text, nodes, graph, or table cells into the clipboard 
temporarily for pasting. See “Copying and pasting” on page 365.

Paste 

Pastes the contents of the clipboard at the insertion point or repla
the current selection. See “Copying and pasting” on page 365.

Paste Special...

Brings up a dialog for selecting the format of data to OLE link into a
edit table.

Clear

Deletes the selected text or node(s).

Select All

Selects all text, nodes, or table cells.

Duplicate Nodes

Duplicates the selected nodes. See “Duplicating nodes” on page 6

Copy Diagram/Table

When a Result table or Edit Table is active, this command is Copy 
Table, which copies the entire multidimensional object as a 
tab-delimited list of tables. When a Diagram window is active, this
menu command is Copy Diagram, which copies a picture of the 
diagram without copying the objects they represent. See “Copying 
pasting” on page 365.
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Insert Rows

Inserts an item in a list, or a row in a table, by copying the current item, 
or row. If a column in a table is selected, this command changes to 
Insert Columns. See “Editing a table” on page 195.

Delete Rows

Deletes the selected item or items in a list, or rows in a table. If a 
column in a table is selected, this command changes to Delete 
Columns. See “Editing a table” on page 195.

Preferences 

Displays the Preferences dialog box to examine or change variou
options. See “Preferences dialog box” on page 80.

OLE Links...

Brings up a dialog that allows properties to be changed for OLE lin
from external applications into your model. Used to change links fro
Manual to Automatic, to update manual links, or to open an extern
application that is serving a link.

Object menu

The Object menu contains commands that find and create Analytic
objects and display their attributes. 
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Find 

Displays a dialog box to find an object by its identifier or title. See 
“Finding variables” on page 388.

Find Next 

Finds the next object that partially matches the previously defined t
string. See “Finding variables” on page 388.

Find Selection 

Finds an object by its identifier that matches the currently selected
text. See “Finding variables” on page 388.

Make Alias 

Creates an alias for the selected object. See “Creating alias nodes
page 74.

Make Importance 

Creates an Index and General variable for the selected variable to
compute the uncertainty importance (rank correlation) contribution
of its inputs. See “Importance analysis” on page 343.

Make Input Node

Creates an input node as an alias of the selected object. See “Us
input nodes” on page 151.

Make Output Node

Creates an output node as an alias of the selected object. See “U
output nodes” on page 154.

Show By Identifier 

Shows variables by their identifier in the current diagram, Edit Tab
Result window, or Outline view. 
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Show With Values 

Shows the mid values of the variable and all its inputs. See “Show
mid values” on page 29 and “The Outline window” on page 386.

Attributes

Opens the Attribute dialog box to set the visibility of attributes and
define new attributes. See “Managing attributes” on page 390.

Hide Definition(s)

(Analytica Enterprise only) Marks the currently selected node or 
module as hidden. The definitions for all variables contained withi
the selected node will be private.

Unhide Definition(s)

(Analytica Enterprise only) Unhides the currently selected node or
module. This overrides any settings in parent modules to hide 
definitions.
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Definition menu

The Definition menu contains commands for editing variable 
definitions. It lists Analytica’s built-in function libraries, as well as 
any user libraries that are currently open. 

Edit Definition

Opens the appropriate view for editing the definition of the selecte
variable. If the variable is defined as a distribution or sequence, th
Object Finder opens. If it is defined as a table or probability table,
Edit Table window opens. Otherwise, an Object window or Attribu
panel opens, depending on the Edit attributes setting in the Prefere
dialog box. See “Preferences dialog box” on page 80.

Edit Time 

Opens the Object window for the Time system variable. See “The 
Time index” on page 349.

Paste Identifier

Opens the Object Finder dialog box for examining functions and 
variable identifiers, entering function parameters, and pasting the
into definitions. See “Object Finder dialog box” on page 143.

Show Invalid Variables

Displays a window listing all variables with invalid or missing 
definitions. See “Invalid Variables” on page 393.

List of libraries you’ve created in, or added 
to, the current model
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Math 

Displays a list of the mathematical functions in the Math library. See 
“Math functions” on page 213.

Array

Displays a list of functions for creating and transforming arrays in t
Array library. See Chapter 12, “Function Reference”.

Abs() Logten()
Arctan() Mod()
Ceil() Radians()
Cos() Round()
Degrees() Sin()
Exp() Sqr()
Factorial() Sqrt()
Floor() Tan()
Ln()

Area() Normalize()
Array() Product()
Average() Rank()
Choice() Sequence()
Concat() Size()
Cumproduct() Slice()
Cumulate() Sortindex()
Determtable() Split()
Integrate() Subscript()
Join() Subset()
Max() Sum()
MdArrayToTable() Table()
MdTable() Uncumulate()
Min() Unique()
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Distribution 

Displays a list of functions for creating probability distributions in the 
Distribution library. See Chapter 14, “Using Continuous Probabilit
Distributions” and Chapter 15, “Using Discrete Probability”.

Special 

Displays a list of unusual or less commonly used functions in the 
Special library.

Statistical 

Displays a list of statistical functions in the Statistical library. See 
“Statistical functions” on page 327.

Bernoulli() Lognormal()
Beta() Normal()
Certain() Probdist()
Chancedist() Probtable()
Cumdist() Triangular()
Fractiles() Truncate()
Gamma() Uniform()

Argmax() Isnumber()
Attrib of ... Istext()
Cubicinterp() Isundef()
Decompose() Linearinterp()
Determinant() Stepinterp()
Dydx() Stringlength()
Dynamic() Stringreplace()
Elasticity() Subindex()
For...Do Substring()
Ident[I=....] Transpose()
Ident[time-...] Truncate()
IndexNames() Using...Do
Invert() WhatIf()
Isnan() WhatIfAll()

Correlation() Probbands()
Frequency() Rankcorrel()
Getfract() Sample()
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Operators 

Displays a list of arithmetic, comparison, logical, and conditional 
operators in the Operators library. See “Operators” on page 166. 

System Variables 

Displays a list of system variables that you can use in definitions (
the next section).

Advanced Math

Displays a list of advanced and specialized mathematical and 
statistical functions. See “Advanced math functions” on page 260.

Kurtosis() Sdeviation()
Mean() Skewness()
Mid() Statistics()
Probability() Variance()

(- ) <> 
+ ≠ 
- >= 
* > 
/ Not 
÷ Or 
^ And 
< If Then Else
<= Ifall Then Else
= Ifonly Then Else

Arccos() ErfInv()
Arcsin() GammaFn()
Arctan2() GammaI()
BetaFn() GammaIInv()
BetaI() Lgamma()
Combinations() Permutations()
Cosh() Regression()
CumNormal() Sinh()
CumNormalInv() Tanh()
Erf()
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Database

Appears only in Analytica Enterprise. Contains a list of functions for 
accessing ODBC-compliant databases. See “Database functions” on 
page 427.

Financial

Displays a list of financial functions. See “Financial Functions” on
page 253.

your libraries

Any libraries that you have defined or added to the model are liste
the bottom of the Definition menu, each with a submenu that lists th
functions contained in the library. See Chapter 20, “Building 
Functions and Libraries”.

System variables submenu

The system variables submenu lists the Analytica variables and 
constants that can be used in variable definitions. 

DbLabels() DbTableNames()
DbQuery() DbWrite()
DbTable() SqlDriverInfo()

Cumipmt Pmt()
Cumprinc() Ppmt()
Fv() Pv()
Ipmt() Rate()
Irr() Xirr()
Nper() Xnpv()
Npv()
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AnalyticaPlatform

In Analytica for Windows, this is ‘Windows’. From Analytica for 
Macintosh, this is ‘Macintosh’, and from the Analytica Decision 
Engine this is ‘ADE’. 

AnalyticaVersion

An integer encoding the current build number of Analytica being ru
In terms of the major version number, minor version number, and s
minor version number, it is equal to 

For example, Analytica 2.0 subminor version 1 returns the value 
20001.

False

The logical (Boolean) constant that evaluates numerically to zero.

Pi

The ratio of circumference to the diameter of a circle.

Run

The index for uncertainty sampling, defined as 
Sequence(1,Samplesize). 

Samplesize

The number of sample iterations for probabilistic simulation. See 
“Uncertainty Setup dialog box” on page 284.

Time

The index variable identifying the dimension for dynamic simulatio
(the Dynamic() function). See “The Time index” on page 349.

True

The logical (Boolean) constant that evaluates numerically to nonz

10K Major⋅ 100 Minor⋅ SubMinor+ +
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Result menu

The Result menu contains commands for opening Result windows, 
changing the appearance of graphs and tables, and setting uncertainty 
options. 

Show Result

Opens a Result window for the selected object. See “The Result 
window” on page 37.

Mid Value

Displays the deterministic value, holding most uncertain variables
their median value. See “Uncertainty view options” on page 44.

Mean Value

Displays the mean of the uncertain value. See “Uncertainty view 
options” on page 44.

Statistics

Displays the statistics of the uncertain value in a table as set in th
Uncertainty Setup dialog box. See “Uncertainty view options” on 
page 44.

Check mark indicates the
default or current
uncertainty view
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Probability Bands

Shows probability bands as set in the Uncertainty Setup dialog box. 
See “Uncertainty view options” on page 44.

Probability Density

Displays a probability density graph for an uncertain value. For a 
discrete probability distribution, Probability Mass replaces this 
command. See “Uncertainty view options” on page 44.

Cumulative Probability

Displays a cumulative probability graph representing the probabili
that a variable's value is less than or equal to each possible (uncer
value. See “Uncertainty view options” on page 44.

Sample

Displays a table of the values determined for each uncertainty sam
iteration. See “Uncertainty view options” on page 44.

Graph Setup

Displays a dialog box to specify the graphing tool, graph frame, an
graph style. See “Graph Setup dialog box” on page 121.

Number Format

Displays a dialog box to set the number format for displays of resu
See “Number Format dialog box” on page 127.

Uncertainty Options

Displays a dialog box to specify the uncertainty sample size and 
sampling method and to set options for statistics, probability band
probability density, and cumulative probability. See “Uncertainty 
Setup dialog box” on page 284.
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Diagram menu

The Diagram menu contains commands for changing the display of 
the diagram, including nodes, arrows, and fonts. 

Set Diagram Style 

Displays a dialog box to set default arrow displays, node size, and 
font. See “Diagram Style dialog box” on page 111.

Set Node Style 

Displays a dialog box to set arrow display and font for specific nod
See “Node Style dialog box” on page 113.

Show Color Palette

Displays a palette to set the color of the diagram background or o
selected nodes. See “Changing background or node colors” on 
page 110.

Align Selection To Grid 

Aligns selected node(s) to the diagram grid. See “Aligning to the gr
on page 68.

Adjust Size 

Adjusts the selected node’s size to match the default node size, o
fit the title label. See “Default node size” on page 113.
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Move Into Parent 

Moves the selected object from the current diagram to its parent 
diagram. See “Examining an influence diagram window” on page

Resize Centered

If checked, when you resize a node, the node’s center stays unmo
If unchecked, when you resize a node by dragging a corner handle
opposite handle stays unmoved. See “Align nodes horizontally or 
vertically” on page 106.

Set Diagram Size

(Obsolete) Displays a dialog box to set the number of diagram pag
See “Changing the size of the diagram” on page 115.

Snap to Grid

Turns alignment to the diagram grid on or off in edit mode. See 
“Aligning to the grid” on page 68.

Edit Icon 

Opens a window to edit the icon for the selected node. See “Addin
icons to nodes” on page 158.

Window menu

The Window menu contains commands for bringing windows to th
front, and for opening special windows. 
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Bring to Front 

Displays a list of the current windows; select one to display on top.

Show Memory Usage

Displays a window showing memory usage. See Appendix C, 
“Memory”.

Show Page Breaks 

Shows page breaks for the currently active diagram.

Cascade

Rearranges the open Analytica windows. All windows are resized
be a standard size. The first window is placed at the upper left cor
of the main Analytica window, with each subsequent window offse
slightly below and to the right.

Tile Horizontally

Rearranges the open Analytica windows. Windows are resized an
repositioned to tile the main Analytica window area horizontally.

Tile Vertically

Rearranges the open Analytica windows. Windows are resized an
repositioned to tile the main Analytica window area vertically.

Help menu

The Help menu allows you to access to Analytica’s online help 
system. 
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Help Topics

Displays Analytica help topics in standard Windows format.

Analytica on the Web

Opens your default web browser to the Analytica product home page 
at: http://www.lumina.com/software/aboutanalytica.html

ADE on the Web

Opens your default web browser to the Analytica Decision Engine 
product home page at: http://www.lumina.com/software/ADEW.html. 
The Analytica Decision Engine (ADE) is an ActiveX automation 
server that allows you to embed the core computational engine of 
Analytica in your custom-built applications or web-server backends. 
ADE is a separate product from Analytica, and is sold by Lumina 
Decision Systems, Inc.

About Analytica

Displays useful information such as the application’s version numb
your license registration number, and contact information.

Right mouse button menus

Many of common commands found on the Analytica application me
are also available from a right mouse button pop-up menu.
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The above pop-up appears when you depress the right mouse button 
with the mouse above a node in a diagram window while in edit mode. 
A slightly different set of options appear if you are in browse mode, or 
if you depress the right mouse button while the mouse is over the 
diagram background.

There are only two menu items that are appear only on the right mouse 
button menu:

Bring to Front

Brings the selected object(s) to the front of the drawing order so that 
if the object(s) overlap any other elements, the object will be visible.

Send to Back

Sends the selected object(s) to the back of the drawing order so that 
the selected object(s) are drawn behind any overlapping elements.
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In this Appendix

This appendix contains the specifications 
for Analytica.



Hardware and software

Objects

Uncertainty

Numbers and Arrays

CPUs supported 486 and higher (Pentium 
recommended)

System Software Windows 95, 98 or NT 4

Memory requirements 16MB (24 MB+ recommended)

Application size Approximately 6 MB

Typical model file size 20K (small)–200K (large)

Number of system objects 525

Maximum user-defined objects 14830

Probability methods Random Latin HyperCube
Median Latin HyperCube
Monte Carlo

Maximum sample size 32000

Random sampling methods SANE
Minimal Standard
L’Ecuyer
Knuth

Number precision 15 significant digits for 
floating-point numbers
9 digits for integers

Maximum elements 
in a dimension

32000

Maximum dimensions 
in an array

15
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Memory



In this Appendix

This appendix shows you how to allocate 
and monitor memory usage in Analytica.



Memory usage

The Memory Usage window displays the amount of memory available 
on your system, as well as the memory currently in use by all 
applications, including Windows itself. The memory available on your 
system is the sum of all physical memory installed on your system and 
the swapfile on your hard disk, which is used to complement the 
physical memory.

To display the Memory Usage window, select Show Memory Usage 
from the Window menu.

Analytica Note:  This window appears automatically when Analytica 
runs low on memory. 

If you require additional memory to run your model at a given sample 
size, you can take several steps to increase the amount of memory 
available to Analytica:

1. Close other open applications.

All applications require a segment of memory to operate, and this 
reduces the memory available to Analytica.

2. Increase the size of your computer’s swapfile.  

Under Windows 95, the swapfile size is dynamically handled by the 
system by default, and is limited only by the free space available on 
the hard disk where the swapfile resides. You can manually change 
swapfile settings in the Memory control panel.

Number of user-defined variables and other objects

Current sample size (reduce it if you
are having memory problems); see
“Uncertainty Sample” on page 285

Shows proportion of 
available memory 
currently used

High-water mark indicates peak 
memory used
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Under Windows NT, the minimum swapfile size is set through the 
Hardware control panel. If your hard disk is full or nearly full, you 
will need to free space on your hard disk, or select a different hard 
disk to hold your swapfile, in order to provide more memory for 
Analytica computations.

3. Finally, consider adding more physical memory to your 
computer.

Memory message on opening a model

When you save a model, the number of megabytes of peak memory 
used during the session is also saved. When you open the model, the 
saved peak memory is compared to the amount of memory allocated 
to Analytica. If the saved peak memory exceeds 95% of Analytica
memory allocation, a message will recommend either reducing the
sample size (see “Uncertainty Setup dialog box” on page 284) or 
changing the application memory size (see next section).
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In this Chapter

This appendix shows you how to select an 
appropriate sample size.
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Each probabilistic value is simulated by computing a random sample 
of values from the actual probability distribution. 

You can control the sampling method and sample size by using the 
Uncertainty Setup dialog box (see “Uncertainty Setup dialog box” 
page 284). This appendix briefly discusses how to select a sample

Choosing an appropriate sample size

There is a clear trade-off for using a larger sample size in calculat
an uncertainty variable. When you set the sample size to a large va
the result is less noisy, but it takes a longer time to compute the 
distribution. For an initial probabilistic calculation, a sample size of 
to 50 is usually adequate.

How should you choose the sample size m? It depends both on the cost
of each model run, and what you want the results for. An advantag
the Monte Carlo method is that you can apply many standard statist
techniques to estimate the precision of estimates of the output 
distribution. This is because the generated sample of values for e
output variable is a random sample from the true probability 
distribution for that variable. 

Selecting the sample size: uncertainty about the mean

First, suppose you are primarily interested in the precision of the m
of your output variable y. Assume you have a random sample of m 
output values generated by Monte Carlo simulation:

(1)

You can estimate the mean and standard deviation of y using in the 
following equations: 

(2)

(3)

This leads to the following confidence interval with confidence α, 
where c is the deviation for the unit normal enclosing probability α:

y1 y2 y3 …ym, , ,( )

y
yi
m
----

i 1=

m

∑=

s
2 yi y–( )2

m 1–( )
--------------------

i 1=

m

∑=
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Suppose you wish to obtain an estimate of the mean of y with an α 
confidence interval smaller than w units wide. What sample size do 
you need? You need to make sure that: 

(5)

or, rearranging the inequality,

(6)

To use this, first make a small Monte Carlo run with, say, 10 values to 

get an initial estimate of the variance of y—that is, s2. You can then 
use Equation (6) to estimate how many samples will reduce the 
confidence interval to the requisite width w. 

For example, suppose you wish to obtain a 95% confidence interv
for the mean that is less than 20 units wide. Suppose your initial 
sample of 10 gives s = 40. The deviation c enclosing a probability of 
95% for a unit normal is about 2. Substituting these numbers into 
Equation (6), you get:

(7)

So, to get the required precision for the mean, you should set the
sample size to about 64. 

Estimating confidence intervals for fractiles 

Another criterion for selecting sample size is the precision of the 
estimate of the median and other fractiles, or more generally, the 
precision of the estimated cumulative distribution. Assume that th
sample m values of y are relabeled so that they are in increasing ord

and c is the deviation enclosing probability α of the unit normal. Then 
the following pair of sample values constitutes the confidence 
interval:

y c
s

m
--------– y c

s

m
--------+, 

 

w 2c
s

m
-------->

m
2cs
w

-------- 
  2

>

m
2 2× 40×

20
------------------------ 

  2
> 8

2
64= =

y1 y2 …ym≤ ≤

yi yk( , )
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(8)

(9)

Suppose you want to achieve sufficient precision such that the α 
confidence interval for the pth fractile  is given by , where 

 is an estimate of , and  is an estimate of . In 

other words, you want α confidence of  being between the sample 

values used as estimates of the ( )th and ( )th fractiles. 

What sample size do you need? Ignoring the rounding, you have 
approximately

, (10)

Thus, 

(11)

From Equations (8) and (9) above, you have 

(12)

Equating the two expressions for , you obtain

(13)

(14)

For example, suppose you want to be 95% confident that the estimated 
fractile Y.90 is between the estimated fractiles Y.85 and Y.95. So you 

have , and . Substituting the numbers into Equation 

(14), you get:

(15)

On the other hand, suppose you want the credible interval for the least 
precise estimated percentile (the 50th percentile) to have a 95% 
confidence interval of plus or minus one estimated percentile. Then, 

i mp c mp 1 p–( )–=

k mp c mp 1 p–( )+=

Yp yi yk( , )

yi Yp ∆p– yk Yp ∆p+
Yp

p ∆p– p ∆p+

i m p ∆p–( )= k m p ∆p+( )=

k i– 2m∆p=

k i– 2c mp 1 p–( )=

k i–

2m∆p 2c mp 1 p–( )=

m p 1 p–( ) c
∆p
------- 

  2
=

∆p 0.05= c 2≈

m 0.90
·

1 0.90–( )× 2 0.05⁄( )2× 144= =
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Note that these results are completely independent of the shape of the 
distribution. If you find this an appropriate way to state your 
requirements for the precision of the estimated distribution, you can 
determine the sample size before doing any runs to see what sort of 
distribution it may be.

m 0.5 1 0.5–( )× 2 0.01⁄( )2× 10 000,= =
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In this Appendix

This appendix describes the types of error 
messages you may see when you run 
Analytica.
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There are several types of error messages in Analytica. Many 
messages are designed to inform you that something in the model 
needs to be corrected; some messages indicate that Analytica cannot 
continue or complete your request. Each error message begins with its 
message type, one of: warning, lexical, syntax, evaluation, system, 
and fatal errors. 

In general, Analytica allows you to continue working on your model 
unless it cannot proceed until a problem has been corrected. When you 
are editing a variable definition, you can request an error message by 
pressing Alt-Enter or by clicking on the definition Warning icon( ).

Warning

A warning indicates that there is a possible problem. For example: 

A warning is reported during result evaluation to inform you that 
continuing may yield unexpected results.

You can suppress evaluation warnings for all variables by disabling 
the Show result warnings preference (see “Preferences dialog box
on page 80). When Show result warnings is unchecked, any warning
conditions encountered during result evaluation will be ignored.

If an identifier in a module that you are adding to a model has a na
conflict with an identifier in the model, you will see a warning simila
to the following: 

Warning: 

Log of non-positive number.

Warning: 

Can’t declare Variable Location because the Identifier
is already in use as Attribute Location.

Declare using the Identifier Location1? 
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Lexical error

A lexical error occurs when a component of an expression was 
expected and is missing or is invalid. For example, if you enter a 
number with an invalid number suffix, you may get a message similar 
to the following: 

Syntax error

A syntax error occurs when an expression contains a syntax mistake. 
Analytica often reports the mistake together with the fragment of the 
expression that contained the error. For example: 

The following are two common syntax errors:

expecting “,”

Indicates a comma is missing, or there are too few parameters to a 
function.

expecting “)”

Indicates there are too many parameters to a function.

Lexical error while checking:

2sdf
^

Invalid exponent code. 

Syntax error while checking:

2 + + 3
^

Expression expected.
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If you attempt to change the identifier for a variable, and the new 
identifier is assigned to another node, you will see a message similar 
to the following:

Evaluation error

An evaluation error occurs when there is a problem while evaluating a 
variable, user-defined function, or system function. You are asked if 
you want to edit the definition of the variable currently being 
evaluated:

If a system function expects a specific kind of argument, an error 
message similar to the following is displayed:

This message indicates that an argument passed to the function is of a 
different type or cannot be handled by that function. You may need to 
redefine a variable being used as an argument to the function, or 
change an expression being passed as an argument.

Syntax error: 

The Identifier “Location” is already in use.

Error during evaluation of Ch1.

Do you want to edit the Definition of Ch1?

Evaluation error: 

First argument of Sysfunction Argmax must be 
a table.
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Invalid number

If a calculation such as division by zero is performed, a warning is 
displayed with an option to continue calculating. Three possible error 
codes may be returned as a result of an invalid calculation:

These can be detected in expressions using “X=INF”, Isnan(X), or 
Isundef(X)

System error

If you see this message type, please contact Lumina Decision 
System’s technical support department (see “For Technical Suppo
on page 492) to report the error.

Out of memory error

Indicates that Analytica has used up all available memory and can
complete the current command. If this occurs, first save your mod
Before attempting to evaluate again, close some windows, use a 
smaller sample size, or expand the memory available to Analytica (
Appendix C, “Memory“).

Code Meaning

INF Infinity.

NAN Invalid argument, such as Sqrt(-1), or
Invalid division, such as 0/0.

Undefined

(blank)

Displays as a blank cell if the result is a table,
or shows the Compute button otherwise. 
Results from certain functions, such as 
SubIndex(), when a result is not available.
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In this Appendix

This appendix lists all the identifiers 
reserved for use by Analytica.



You cannot use the following terms as identifiers. If you attempt to assign one as an identifier, 
Analytica appends a number to the new identifier to keep it distinct from the existing term.

Reserved Words
Abbreviation
Abs
Activate
Activex
Alias
Aliases
All
Allshow
Allwarnings
Analyticaplatform
Analyticaversion
And
Any
Append
Arccos
Arcsin
Arctan
Arctan2
Area
Argmax
Array
Arrayt
Arraytype
Asc
Ascending
Askattribute
Askpause
Attribget
Attribute
Att__barorigin
Att__cloakdefn
Att__customformat
Att__diagramprintsca
Att__graphprintscali
Att__objectprintscal
Att__outlineprintsca
Att__tableprintscali
Att__totalsindex
Author

Average
Balloonhelp
Baroverlap
Bernoulli
Beta
Betafn
Betai
Bigbrother
Browsemodeon
Button
Bye
Cdf
Cdfresol
Cdfsteps
Ceil
Certain
Chance
Chancedist
Chancevar
Chartlibrary
Chartname
Check
Checking
Choice
Chr
Cicn
Class
Clipboard
Clock
Close
Closegraph
Color
Combinations
Command
Comment
Concat
Constant
Contains
Context

Correlation
Cos
Cosh
Cubicinterp
Cumdist
Cumipmt
Cumnormal
Cumnormalinv
Cumprinc
Cumproduct
Cumulate
D2
D3
Date
Dblabels
Dbquery
Dbtable
Dbtablenames
Dbwrite
Ddeexecute
Ddeinitiate
Ddeterminate
Decision
Decompose
Defaultsize
Definition
Defnstate
Degrees
Delete
Delimiter
Depth
Derived
Description
Determ
Determinant
Determt
Determtable
Determtype
Developeron

Diagram
Diagramcolor
Diagstate
Displayinputs
Displayoutputs
Distresol
Distribsize
Diststeps
Do
Domain
Dotproduct
Dydx
Dynamic
Dynamicvalue
Dyninputs
Dynoutputs
Each
Edit
Editor
Edittable
Elasticity
Else
End
Endphoto
Endrecord
Endupdate
Erf
Erfinv
Evaldynamic
Evalindex
Evaluate
Every
Exp
Export
Expr
Factorial
False
Field
Fileinfo

Fixedcheck
Fixeddef
Flip
Floor
Fontstyle
For
Forlocal
Form
Formnode
Fractiles
Frame
Frameauto
Frequency
Fullscreen
Function
Functionof
Fv
Gamma
Gammafn
Gammai
Gammaiinv
Getfract
Getresource
Geturl
Graph
Graphsetup
Graphtool
Graphvar
Graphwindows
Grid
Heapsize
Help
Hypertalk
Iacquit
Icon
Idensubscript
Identifier
Identpred
If
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If0
Ifall
Ifonly
Ifpos
Import
Imports
In
Include
Includexzero
Includeyzero
Includezzero
Index
Indexnames
Indext
Indextype
Indexvals
Inf
Inobjs
Inputs
Integrate
Invert
Ipmt
Irr
Isin
Isnan
Isnumber
Istext
Isundef
It
Iterate
Join
Keyoff
Keyword
Kurtosis
Laser
Laserheight
Laserp
Laserwidth
Lasterror
Launch
Levels
Lgamma
Library
Linear
Linearinterp
Linestyle
Linkedreform
Linklibrary
Linkmodule

List
Ln
Localvar
Location
Lognormal
Logten
Macscribe
Makesticky
Manual
Map
Mapvar
Max
Mdarraytotable
Mdtable
Mean
Mesh
Mid
Min
Mod
Modauthor
Mode
Model
Module
Moniker
Morehelp
Move
Namebyoid
Namesize
Naming
Nan
Need
Neededby
Needs
News
No
Nodecolor
Nodefont
Nodeinfo
Nodelocation
Nodesize
None
Normal
Normalize
Normal_fracs
Not
Nper
Npv
Numberformat
Numberwidth

Numeric
Obfuscated
Object
Objective
Objectswithtimings
Odbc4anaversion
Of
Oidof
Oleautorecompute
Olegraph
Open
Openfile
Or
Origcontains
Original
Orphans
Output
Outputs
Pagesetup
Pan
Parameters
Paramnames
Paramtypes
Path
Pausephoto
Pauserecord
Pdf
Pdfvalue
Permutations
Photo
Pi
Pict
Picture
Plotheight
Plotwidth
Pluginfunction
Pluginlibrary
Pmt
Positive
Ppmt
Printtable
Prob
Probability
Probbands
Probdist
Probindex
Probtable
Probvalue
Product

Profile
Profileexpr
Project
Publisher
Publishoneval
Put
Pv
Q_infromrec
Q_makerect
Q_squareinterp
Radians
Randomseed
Randomtype
Range
Rank
Rankcorrel
Rate
Readfile
Readurl
Record
Rectangular
Reform
Reformdef
Reformval
Regression
Rename
Repeat
Request
Result
Resumephoto
Resumerecord
Role
Rotation
Round
Samp
Sample
Samplesize
Sampletype
Save
Saveauthor
Savedate
Saveformat
Saveoptions
Savevalues
Scalar
Scales
Scatter
Schedulepublish
Scoping

Screenheight
Screenwidth
Scribe
Script
Sdeviation
Section
Self
Send
Sequence
Setpath
Show
Showhier
Showkey
Showundef
Sin
Sinh
Size
Skewness
Slice
Slide
Slidep
Softwareversion
Sortindex
Split
Sqldriverinfo
Sqr
Sqrt
Statistics
Statslabels
Statsselect
Stepinterp
Sticky
Stringlength
Stringlowercase
Stringmixedcase
Stringreplace
Stringuppercase
Subindex
Subscriber
Subscript
Subset
Substring
Sum
Swapenterreturn
Symbolsize
Sysfunction
Sysvar
Table
Tabletype
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Tabwidth
Tan
Tanh
Terminaltype
Text
Textype
Then
Ticks
Tilt
Time
Timingwithchildren
Timingwithoutchildre
Title
To
Transpose
Trash
Tree
Triangular
True
Truncate
Tutorial
Typechecking
Uncumulate
Undef
Undefined
Unevaluated
Uniform
Unique
Units
Update
Updatelink
Usecheck
Usetable
Using
Usinglocal
Value
Valuestate
Valuevar
Variable
Variance
Varlist
Vartype
Vector
Verbosity
Version
View
Warnings
Warnonnonindexedop
Webhelper

What
Whatif
Whatifall
Why
Whyall
Windows
Windstate
With
Xintervals
Xirr
Xmaximum
Xminimum
Xnpv
Xyexpr
Yes
Yintervals
Ymaximum
Yminimum
Zmaximum
Zminimum
__advmath_
__financial_
__odbc4analytica_
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In this Appendix

This appendix lists books and papers that 
are referred to in this manual or that are 
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Morgan, M. Granger and Henrion, Max. Uncertainty: A Guide to 
Dealing with Uncertainty in Quantitative Risk and Policy Analysis, 
Cambridge University Press (1990,1998).

Written by the original authors of Analytica, this text provides 
extensive background on how to represent and analyze uncertainty 
in quantitative models. It includes chapters on:

• Building good policy models

• Categorizing types and sources of uncertainty

• How people make judgments under uncertainty

• Encoding expert judgment in the form of probability distribution

• Choosing a computational method for propagating uncertainty
a model

• Analyzing uncertainty in very large models

• Displaying and communicating uncertainty

• How to tell if representing uncertainty could make a significan
difference to your conclusions, or “the value of knowing how 
little you know”

We recommend the second edition, published 1998, which conta
a full chapter on Analytica (Chapter 10). If you have the first 
edition (1990), we recommend that you ignore Chapter 10, whic
describes the precursor of Analytica and is quite out of date!

Clemen, Robert T. Making Hard Decisions: An Introduction to 
Decision Analysis. Duxbury Press (1991).

Howard, R., and Matheson, J. Influence Diagrams. In Readings on the 
Principles and Applications of Decision Analysis, eds. R. Howard and 
J. Matheson. pp. 721-762. Menlo Park, Calif.: Strategic Decisions
Group (1981).

Keeney, R. Value–Focused Thinking: A Path to Creative Decision 
Making, Cambridge, MA: Harvard University Press (1992).

Knuth, D.E. Seminumerical Algorithms, 2nd ed., vol. 2 of The Art o
Computer Programming, Reading, MA: Addison-Wesley (1981).

L’Ecuyer, P. Communications of the ACM, 31, 742-774 (1988).

Park, S.K., and K.W. Miller. Communications of the ACM, 
31, 1192-1201 (1988).
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Calif.: Morgan Kaufmann (1988).
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How to Contact 
Us



In this Appendix

This appendix contains information on 
how to contact the publisher of Analytica.



If you have any questions or comments about Analytica, or just want 
to keep up to date on changes to Analytica, please contact us.

For Sales or Customer Service

By mail 

Lumina Decision Systems, Inc.
59 N. Santa Cruz Ave., Suite Q
Los Gatos, CA 95030
USA

By electronic mail

info@lumina.com

By phone

(877) 658-6462 = 1-877-6-LUMINA Toll free, US only

or

(408) 354-1841

By fax

(408) 354-9562

Web Site

For the latest information about Analytica, please visit our Web Site 
located at 

http://www.lumina.com

Technical Support information →
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For Technical Support

By mail

Lumina Decision Systems, Inc.
59 N. Santa Cruz Ave., Suite Q
Los Gatos, CA 95030
USA

By electronic mail

support@lumina.com

By phone

(408) 354-1841

By fax

(408) 354-9562
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In this Glossary

A compilation of terms specific to 
Analytica as well as statistical terms 
used in this manual.



Glossary

e 
 

ADE

See Analytica Decision Engine.

Alias

A node in a diagram that refers to a variable or other node located 
somewhere else, usually in another module. An alias permits you to 
display a variable in more than one module. An alias node is 
distinguished by having its title in italics.

Analytica Browser

A free version of Analytica that allows a user to evaluate and view 
results, and change input fields; however, from Analytica Browser a 
user cannot enter edit mode or otherwise change the content of a 
model. Copies of Analytica without a valid registration number run as 
the Analytica Browser.

Analytica Decision Engine

A product sold by Lumina Decision Systems, Inc., separate from 
Analytica. With the Analytica Decision Engine (ADE), you embed the 
Analytica computation engine in your web-server backend or in your 
custom applications built in Visual Basic, C++, Microsoft Office, or 
any language supporting ActiveX Automation or COM.

Analytica Enterprise

A version of Analytica for users who intend to share data or models 
with others in their organization. Analytica Enterprise contains all 
features of Analytica Pro as well as functions for accessing ODBC 
databases and features for protecting your intellectual property.

Analytica Pro / Professional version

The standard fully-functional version of Analytica. Analytica Pro 
provides all the features and functionality required to create, edit, and 
evaluate models. 

Analytica Trial

A fully-functional, but expiring, version of Analytica. Analytica Trial 
can be downloaded from the Lumina web site (www.lumina.com) for 
those wishing to “test drive” the product. Analytica Trial contains th
complete functionality of Analytica Pro. After expiration, Analytica
Trial converts to Analytica Browser.
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Array

A collection of values that can be viewed as one or more tables. An 
array has one or more dimensions; each dimension is identified by an 
index.

Array Abstraction

See Intelligent Array Abstraction.

Arrow

An arrow or influence from one variable node to another indicates that 
the origin node affects (influences) the destination node. If the nodes 
depict variables, the origin variable usually appears in the definition 
of the destination variable.

Arrow tool

The Arrow tool, or Influence Arrow tool, is in the shape of a 
left-to-right pointing arrow cursor. The Arrow tool is used to draw 
arrows connecting variables to create relations between them.

Attribute

A property or descriptor of an object, such as its title, description, 
definition, value, or inputs.

Attribute panel

An auxiliary window pane that you can open below a diagram or 
outline window. Use the Attribute panel to rapidly examine one 
attribute at a time of any variable in the model, by selecting the 
variable and then the attribute from a popup menu.

Author

An attribute recording the names of the person or people who created 
the model, or other object.

Behavior analysis

Model behavior analysis is a type of sensitivity analysis in which you 
specify a set of alternative values for one or more inputs and examine 
the effect on selected model output variables. It is also known as 
parametric analysis.
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Browse-only models

Analytica Enterprise users can save a copy of their model in a browse-
only form. When a browse-only model is loaded into any version of 
Analytica, the user cannot enter edit mode, and therefore can only 
make changes to variables with input nodes. Browse-only models are 
also obfuscated.

Browse tool

The Browse tool is in the shape of a hand. With the Browse tool, you 
can examine the diagram but cannot make any changes, except to 
change the values in input nodes.

Chance variable

A Chance variable is uncertain and cannot be directly controlled by the 
decision maker. Usually, it is defined by a probability distribution. A 
Chance variable is depicted as an oval node.

Check

The check attribute contains an expression that checks the validity of 
the value of a variable. It displays a message when the variable’s value 
is out of specified bounds.

Class

The type of Analytica object: decision, chance, objective, or index 
variable; function; module; library; form; model.

Cloaking

See definition hiding.

Conditional dependency

A Chance variable a is conditionally dependent on another variable b 
if the probability of a value of a depends on the value of b. If a is 
defined by a probability table, b may be an index of its probability 
table.

Constant

A variable whose value is not probabilistic, and does not depend on 
other variables, such as the number of minutes in an hour.
Analytica User Guide 497



Glossary

Continuous distribution

A probability distribution defined for a continuous variable—that is, 
for a real-valued variable. Example continuous distributions are beta, 
normal, and uniform. Compare to discrete distribution.

Continuous variable

A variable whose value is a real number—that is, one of an infinite 
number of possible values. Its range can be bounded (for example, 
between 0 and 1) or unbounded. Compare to discrete variable.

Created

The date and time at which the model was first created. This model 
attribute is entered automatically, and is not user-modifiable.

Cumulative probability distribution

A representation of a probability distribution that plots the cumulative 
probability that the actual value of the uncertain variable x will be less 
than or equal to each possible value of x. The cumulative probability 
distribution is a display option in the Uncertainty View popup menu.

Cyclic dependency

A cyclic dependency occurs when a variable depends on itself directly 
or indirectly so that the arrows form a directed circular path. The only 
cyclic dependencies allowed in Analytica are in variables using the 
Dynamic() function that contain a time lag on the cycle.

Decision variable

A variable that the decision maker can control directly. Decision 
variables are represented by rectangular nodes.

Definition

A formula that defines how to compute a variable’s value. It can be a 
simple number, a mathematical expression, a list of values, a table, or 
a probability distribution. In text format, it is limited in length to 
32,000 characters.

Definition Hiding

A feature in Analytica Enterprise for protecting your intellectual 
property when distributing models you have created to others. 
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Definition hiding controls whether the end-user of your model can 
view the definitions of selected nodes.

Description

Text explaining what the node represents in the real system being 
modeled. It is limited in length to 32,000 characters.

Deterministic table

A deterministic function that gives the value of a variable x 
conditional on the values of its input variables. The input must all be 
discrete variables. The table is indexed by each of its inputs, and gives 
the value of x that corresponds to each combination of values of its 
inputs.

Deterministic value

A variable’s deterministic value, or mid value, is a calculation of the 
variable’s value assuming all uncertain inputs are fixed at their median 
values.

Deterministic (determ) variable

A variable that is a deterministic function of its inputs. Its definition 
does not contain a probability distribution. The value of a 
deterministic variable can be probabilistic if one or more of its inputs 
are uncertain. A deterministic variable is displayed as a double oval. 
You can also use a general variable (rounded rectangle) to depict a 
deterministic variable.

Determtable

See deterministic table.

Diagram

See influence diagram.

Dimension

An array has one or more dimensions. Each dimension is identified by 
an index variable. When an array is shown as a table, the row header 
(vertical) and column headers(horizontal) give the two dimensions of 
the table.
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Discrete distribution

A probability distribution over a finite number of possible values. 
Example discrete distributions are Bernoulli and the Probtable 
function. Compare to continuous distribution.

Discrete variable

A variable whose value is one of a finite number of possible values. 
Examples are the number of days in a month (28, 29, 30, or 31), or a 
Boolean variable with possible values True and False. A variable 
that is defined as a list or list of labels is discrete. Compare to 
continuous variable.

Domain

The possible outcomes of a variable. The Domain has a type as well as 
value. The possible types are List of labels, List of numbers, or 
Continuous; the default type is Continuous, except for variables 
defined with the Choice(), Probtable(), and Determtable() 
functions.

Dynamic variable

A variable that depends on the system variable Time and is defined by 
the Dynamic() function. A dynamic variable can depend on itself at 
a previous time period, directly or indirectly, through other dynamic 
variables.

Edit Table

A definition that is a table is also called an Edit Table because it can 
be edited.

Edit tool

The Edit tool is in the shape of the normal mouse pointer cursor. The 
Edit tool is used to create a new model or to change an existing model. 
It allows you to move, resize, and edit nodes, and exposes the Arrow 
tool and node palette.

Excel Graph

The graphing engine of Microsoft Excel®. Users who have Excel 
installed on their computers can take advantage of Excel Graph to 
graph results. 
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Expression

A formula that can contain numbers, variables, functions, 
distributions, and operators, such as 0.5, a-b, or Min(x), combined 
according to the Analytica language syntax. The definition of a 
variable must contain an expression.

Expression type

The Expression popup menu, which appears above the definition field, 
allows you to change the definition of a variable to one of several 
different kinds of expressions. Expression types include expression, 
list (of expressions or numbers), list of labels (text values), table, 
probability table, and distribution. Any definition, regardless of 
expression type, can be viewed as an expression.

File Info

The name of the file and folders in which the model was last saved. 

Filed library

A library whose contents are saved in a file separate from the model 
that contains it. A filed library can be shared among several models 
without making a copy for each model.

Filed module

A module whose contents are saved in a file separate from the model 
that contains it. A filed module can be shared among several models 
without making a copy for each model.

Fractile

The median is the 0.5 fractile. More generally, there is probability p 
that the value is less than or equal to the p fractile. Quantile is a 
synonym for fractile. (Fractal is something different!) Compare to 
percentile.

General variable

A variable that can be certain or probabilistic. It is often convenient to 
define a variable as a general variable without worrying about what 
particular kind of variable it is. A general variable is depicted by a 
rounded rectangle node.
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Identifier

A short name for a variable used in mathematical expressions in 
definitions. An identifier must start with a letter, have no more than 20 
characters, and contain only letters, numbers, and ‘_’ (underscore, 
used instead of a space). Each identifier in a model must be unique. 
Compare to title.

Importance analysis

Importance analysis lets you determine how much effect the 
uncertainty of one or more input variables has on the uncertainty of an 
output variable. Analytica defines importance as the rank order 
correlation between the sample of output values and the sample for 
each uncertain input. It is a robust measure of the uncertain 
contribution because it is insensitive to extreme values and skewed 
distributions. 

Unlike commonly used deterministic measures of sensitivity, this rank 
order correlation averages over the entire joint probability 
distribution. Therefore, it works well even for models where the 
sensitivity to one input depends strongly on the value of another.

Index

An index of an array identifies a dimension of that array. An index is 
usually a variable defined as a list, list of labels, or sequence. An index 
is often, but not always, a variable with a node class of Index.

Indexes

Plural of index. Indicates a set of index variables that define the 
dimensions of a table (in an Edit Table or value).

Index selection area

The top portion of a Result window, containing a description of the 
result and other information about the dimensions of the result.

Index variable

A class of variable, defined as a list, list of labels, or sequence, that 
identifies the dimensions of an array—for example, in an Edit Table. 
An Index variable is depicted as a parallelogram node. Variables of 
other classes whose definition or domain consist of list, list of labels, 
or sequence can also be used to identify the dimensions of an array, 
and are sometimes referred to as index variables.
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Influence arrow

See arrow.

Influence diagram

An intuitive graphical view of the structure of a model, consisting of 
nodes and arrows. Influence diagrams provide a clear visual way to 
express uncertain knowledge about the state of the world, decisions, 
objectives, and their interrelationships.

Innermost dimension

The dimension of an array that varies most rapidly in the Table() 
function. The innermost dimension is the last index listed in a 
Table() or Array() function. Compare to outermost dimension.

Input

A variable that appears in the definition of the selected variable. See 
also output.

Input arrowhead

An arrowhead pointing into a node, indicating that the node has one or 
more inputs from outside its module. Click on the arrowhead for a 
popup menu of the input variables.

Inputs

A list of the variables or functions on which this variable or function 
depends. The inputs are determined by the arrows drawn to and the 
variables or functions referred to in this variable’s or function’s 
definition or check attribute. See also outputs.

Intelligent Array Abstraction™

A powerful key feature of the Analytica Engine that automatically 
propagates and manages the dimensionality of multidimensional 
arrays within models.

Key

In a results graph, the key shows the value of the key index variable 
that corresponds to each curve, indicated by pattern or color.
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Kurtosis

A measure of the peakedness of a distribution. A distribution with long 
thin tails has a positive kurtosis. A distribution with short tails and 
high shoulders, such as the uniform distribution, has a negative 
kurtosis. A normal distribution has zero kurtosis.

Last Saved

The date and time at which the model was last saved. This model 
attribute is entered automatically, and is not user-modifiable. If the 
model is new, this field remains empty until the model is first saved.

Library

A model component that typically contains a collection of 
user-defined functions and/or variables to be shared. 

List

A type of expression available in the Expression popup menu 
consisting of an ordered set of numbers or expressions. A list is often 
used to define Index and Decision variables.

List of labels

A type of expression available in the Expression popup menu 
consisting of an ordered set of text items. A list of labels is often used 
to define Index and Decision variables.

Matrix

A two-dimensional array of numbers with indexes of equal length.

Mean 

The average of the population, weighted by the probability mass or 
density for each value. The mean is also called the expected value. The 
mean is the center of gravity of the probability density function. 

Median

The value that divides the range of possible values of a quantity into 
two equally probable parts. Thus, there is 0.5 probability that the 
uncertain quantity is less than or equal to the median, and 0.5 
probability that it is greater than the median.
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Mid value

The result of evaluating a variable deterministically, holding 
probability distributions at their median value. Analytica calculates 
the mid value of a variable by using the mid value of each input. The 
mid value is a measure of central value, computed very quickly 
compared to uncertainty values. Compare probvalue.

Mode

The most probable value of the quantity. The mode is at the highest 
peak of the probability density function. On the cumulative probability 
distribution, the mode is at the steepest slope, at the point of inflection.

Model

A module, or a hierarchy of linked and/or embedded modules and 
libraries, on which you work during an Analytica session; the main, or 
root, module at the top of the module hierarchy. Between sessions, a 
model is stored in an Analytica document file. 

Module

A collection of related nodes, typically including variables, functions, 
and other modules, organized as a separate influence diagram. A 
module is depicted in a diagram as a node with a thick outline. 

Module hierarchy

A model can contain several modules, each one containing details of 
the model. Each module can contain further modules, containing still 
more detail. This module hierarchy is organized as a tree with the 
model at the top. You can view the hierarchical structure in the Outline 
window.

Multimodal distribution

A probability distribution that has more than one mode.

Node

A shape, such as a rectangle, oval, or hexagon, that represents an 
object in an influence diagram. Different node shapes are used to 
represent different types of variables.
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Obfuscated

Saved in a non-human-readable (i.e, encrypted) form. Obfuscation 
provides a mechanism for protecting intellectual property. Analytica 
Enterprise users can distribute obfuscated copies of their models to 
their end-users. In Analytica, obfuscation also has the effect of making 
settings for definition hiding and/or browse-only mode permanent.

Object

A variable, function, or module in an Analytica model. Each object is 
depicted as a node in an influence diagram and is described by a set of 
attributes. See also class, node, attribute, and influence diagram.

Object Finder

A dialog box used to browse and edit the functions and variables 
available in a model. 

Object window

A view of the detailed information about a node. The Object window 
shows the visible attributes, such as a node’s type, identifier, and 
description.

Objective variable

A variable that evaluates the overall desirability of possible outcomes. 
The objective can be measured as cost, value, or utility. A purpose of 
most decision models is to find the decision or decisions that optimize 
the objective—for example, minimizing cost or maximizing expected 
utility. An objective variable is represented by a hexagonal node.

OLE Linking

A standard in the Windows operating system for sharing data between 
applications.

Operator

A symbol, such as a plus sign (+), that represents a computational 
process or action such as addition or comparison. 

Outermost dimension

The dimension of an array that varies least rapidly in the Table() 
function. The outermost dimension is the first index listed in a 
Table() or Array() function. Compare to innermost dimension.
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Outline window

A view of a model that lists the objects it contains as a hierarchical 
outline.

Output

A variable whose definition refers to the selected variable. See also 
input.

Output Arrowhead

An arrowhead pointing out of a node, indicating that the node has one 
or more outputs outside its module. Click on the arrowhead for a 
popup menu of the output variables.

Outputs

A list of the variables or functions that depend on this variable or 
function. The outputs are determined by the arrows drawn from this 
variable or function and the variables or functions in whose definition 
or check attribute this variable or function appears. See also inputs.

Parameters

The arguments of a function.

Parametric analysis

See behavior analysis.

Parent diagram

The diagram for the module that contains this object. 

Percentile

The median is the fiftieth percentile (also written as 50%ile). More 
generally, there is probability p that the value is less than or equal to 
the pth percentile. Compare to fractile. 

Probabilistic variable

A variable that is uncertain, and is described by a probability 
distribution. A probabilistic variable is evaluated using simulation; its 
result is an array of sample values indexed by Run.
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Probability bands

Probability bands are a way to display the uncertainty in a value by 
showing percentiles from its distribution—for example, the 5%, 25%, 
50%, 75%, and 95% percentiles. On a graph, these often appear as 
bands around the median (50%) line. Probability bands are also 
referred to as credible intervals. 

Probability density function

A representation of a probability distribution that plots the probability 
density against the value of the variable. The probability density at 
each value of X is the relative probability that X will be at or near that 
value. The probability density function can be displayed for 
continuous, but not discrete variables. It is a display option in the 
Uncertainty View popup menu. Compare to Probability mass 
function, which is used with discrete variables.

Probability distribution

A probability distribution describes the relative likelihood of a 
variable having different possible values.

Probability mass function

A probability mass function is a representation of a probability 
distribution for a discrete variable as a bar graph, showing the 
probability that the variable will take each possible value. The 
probability mass function can be displayed for discrete, but not 
continuous variables. It is a display option in the Uncertainty mode 
View menu. Compare to Probability density function, which is used 
with continuous variables.

Probability table

A table for specifying a discrete probability distribution for a Chance 
variable. In a probability table, you specify the numerical probability 
for each value in the domain of the variable. If the variable depends on 
(that is, is conditioned by) other discrete variables, each of these 
conditioning variables gives an additional dimension to the table, so 
you can specify the probability distribution conditional on the value of 
each conditioning variable.

Probtable

See probability table.
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Probvalue

The probabilistic value of a variable, represented as a random sample 
of values from the probability distribution for the variable. The 
probvalue for a variable is based on the probvalue for the inputs to the 
variable. See also probabilistic variable and compare to mid value.

Reducing function

A function that operates on an array over one of its indexes. The result 
of a reducing function has that dimension removed, and hence has one 
fewer dimension.

Remote variable

A variable in another module, not shown in the active diagram. 
Typically a remote variable is an input or output of a node in the active 
diagram.

Result view

A window that shows the value of a variable as a table or graph.

Sample

An array of values selected at random from the underlying probability 
distribution for a quantity. Analytica represents uncertainty about a 
quantity as a sample, and estimates statistics, probability density 
function, and other representations of a probability distribution from 
the sample.

Sampling method

A method used to generate a random sample from the probability 
distributions in a model (for example, Monte Carlo and Latin 
hypercube).

Scalar

A value that is a single number.

Scatter plot

A graph that plots the samples of two probabilistic variables against 
each other.
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Self

A keyword used in two different ways:

• Refers to the index of a table that is indexed by itself. Self refers 
to the alternative values of the variable defined by the table. 

• Refers to the variable itself, as a substitute for the variable’s 
identifier, in a Check attribute expression or a Dynamic 
expression.

Sensitivity analysis

A method to identify and compare the effects of various input 
variables to a model on a selected output. Example methods for 
sensitivity analysis are importance analysis and model behavior 
analysis.

Skewness

A measure of the asymmetry of the distribution. A positively skewed 
distribution has a thicker upper tail than lower tail, while a negatively 
skewed distribution has a thicker lower tail than upper tail. A normal 
distribution has a skewness of zero.

Slice

A slice of an array is an element or subarray selected along a specified 
dimension. A slice has one less dimension than the array from which 
it is sliced.

Standard deviation

The square root of the variance. The standard deviation of an 
uncertainty distribution reflects the amount of spread or dispersion in 
the distribution.

Suffix

Numbers such as 10K, 123M, or 1.23u are in suffix notation. The 
suffix letter denotes a power of ten; for example, K, M, and u denote 

103, 106, and 10-6, respectively.

Symmetrical distribution

A distribution, such as a normal distribution, that is symmetrical about 
its mean.
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System function

A function available in the Analytica modeling language. See also 
User-defined function.

System variable

A variable that is part of the Analytica modeling language, such as 
Samplesize or Time. 

Table

A two-dimensional view of an array. The array can have more than 
two dimensions, but only two can be seen at one time. In the Result 
window, click on the Table button to select the table view of an array-
valued result.

Tail

The upper and lower tails of a probability distribution contain the 
extreme high and low quantity, respectively. Typically, the lower and 
upper tails include the lower and upper ten percent of the probability, 
respectively.

Title

The full name of an Analytica object. A variable’s or module’s title is 
displayed in its node, in window titles, and in object lists. It is limited 
to 255 characters. It can contain any characters, including spaces and 
punctuation. Compare to identifier.

Uncertain value

See Probvalue.

Units

The units of measurement for a variable. Units are used to annotate 
tables and graphs; they are not used in any calculation.

User-defined function

A function that the user defines to augment the functions provided as 
part of the Analytica modeling language.

Value 

See mid value.
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Variable

An object that has a value, which may be text, a number, or an array.

Variance

A measure of the uncertainty or dispersion of a distribution. The wider 
the distribution, the greater its variance.
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A comprehensive index designed to 
give you quick access to the 
information in this manual.



Index
(scoping) operator 168

Symbols
- (subtraction) operator 166, 199
< (less than) operator 167
¦ (not equal) operator 167
* (multiplication) operator 166, 199
+ (addition) operator 166, 199
/ (division) operator 166, 199
<= (less than or equal to) operator 167
= (equal) operator 167
> (greater than) operator 167
>= (greater than or equal to) operator 167
^ (exponential) operator 166, 199

A
Abs() function 213
Accept button 138, 197
ActiveX automation server, See Analytica Decision Engine
Add Module command 396, 439
Add Module dialog box 395
Adding text to diagrams 160
ADE 495
ADE on the Web command 457
Adjust Size command 104, 454
Adjusting node Z-order 68
Advanced Math command 449
Advanced Math library 449
aliases 74, 495

creating 71, 74
modifying 77

Align Selection to Grid command 68, 106, 454
Analytica browser 495
Analytica Decision Engine 457, 495
Analytica Enterprise 495
Analytica Pro 495
Analytica Trial 495
AnalyticaPlatform system variable 451
AnalyticaVersion system variable 451
Arccos() function 260
Arcsin() function 261
Arctan() function 213
Arctan2() function 261
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Area() function 224
Argmax() function 225
arithmetic operations 166, 199
Array abstraction 503
Array command 447
Array library 170, 447
Array() function 218, 219, 221
arrays 175–205, 496

arithmetic operations on 199
changing index of 221
conventions for 197
defining 219
functions that create 216
operating on 180–185, 198–204, 209–212
referencing an element of 235, 236, 237

Arraytype qualifier 407
Arrow tool 69, 496
Arrow tool button 18
arrows 21, 496

and nodes 69
arranging 105
automatically drawn 71, 140
between modules 72
bold 397
changes to model when created 71
creating 70
deleting 70
drawing 69–71
drawing between 2 modules 76
dynamic 112, 359
hiding 106, 112, 114
removing 70
showing 112, 114
small arrow head 70
to and from indexes 179

Ascending qualifier 407
Attrib Of Ident function 392
Attribute panel 27, 496

resizing 28
Attribute popup menu 27
attributes 390–392, 496

creating new 391
displaying 147, 391
editing 77
in a definition 392
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of functions 28, 390, 405
of modules 28, 390
of variables 28, 390
renaming 392
user-created 390

Attributes command 147, 391, 445
Attributes dialog box 147, 391, 392
Author 390, 496
Auto recompute outgoing OLE links 83, 370
Average() function 225

B
behavior analysis 53, 496
Bernoulli() function 317
Beta() distribution function 295
BetaFn() function 261
BetaI() function 261
bevel, displaying 115
Binomial distribution function 323
Boolean number format 128
Boolean operators 167
Boolean values 166
Boolean variables 276
border, displaying 114
Bring to Front 68
Bring to Front command 456, 458
Browse 497
Browse mode 19, 151
Browse tool 19, 497
Browse tool button 19
Browser version 495

C
Cancel button 197
cancel button 138
Cascade command 456
Ceil() function 213
cells 190, 196

adding 196
copying 196
deleting 191, 196
editing 196
inserting 190
pasting 196

Certain() function 318
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Chance variables 23, 497
Chancedist() function 319
Change identifier 81
Check 82, 146, 390, 497
check value bounds 82
check variable class 82
Choice option 153
Choice() function 234

Change in Analytica 2.0 7
Class 23, 78, 390, 497
Class popup menu 78
Clear command 442
Close command 439
Close Model command 16, 440
color

in influence diagrams 109
of input and output node 156

color palette 110
column index 39
columns 196
Combinations() function 262
Comments in definitions 137
comparing results 49
comparison operators 167, 200
computation time 469
Concat() function 241
conditional dependencies 316, 497
conditional deterministic table 320
conditional operators 168, 201
conditional probability tables 314
confidence intervals 469, 470
constants 24, 497
Context qualifier 407
continuous distributions 276, 498
continuous variable 498
conventions

for array examples 197
terminological 10
typographic 10

Copy command 68, 197, 365–366, 442
Copy Diagram/Table/Object command 366, 442
Correlation() function 328
Cos() function 213
Cosh() function 262
Created 390, 498
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Cubicinterp() function 239
Cumdist() distribution function 296
Cumipmt() function 254
CumNormal() function 262
CumNormalInv() function 262
Cumprinc() function 254
Cumproduct() function 230
Cumulate() function 230
Cumulative Probability command 47, 453
cumulative probability distributions 498
Cumulative Probability options 291
currency symbols 128
Curve fitting, see Regression function 264
Cut command 68, 442
cyclic dependencies 72, 498

D
Data source 417
Database command 450
Database library 416, 427, 450
Database query 415
Date number format 128
DBLabels() function 416–421, 427
DBQuery () function 427
DBQuery() function 416–425, 427
DBTable() function 416–423, 428
DBTableNames() function 428
DBWrite() function 423–426, 429
Decimal number format 163
decimal points 128
decision 315
Decision variables 23, 88, 104, 498
Decompose function 246
default view 40
Definition 390, 406, 498

editing 135–145
incomplete 393, 446

Definition button 17
Definition hiding 430, 498
Definition menu 145, 446
Degrees() function 214
Delete Columns command 196, 443
Delete Rows command 191, 196, 443
dependencies 18

conditional 316
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cyclic 72
with the Dynamic() function 358

Description 390, 406, 499
Determ variables 24, 499
Determinant() function 247
deterministic conditional tables 320–323, 499

defining 320
deterministic value 499
deterministic variables, see Determ variables
Determtable() function 320, 322
determtables, see deterministic conditional tables
DetermType qualifier 407
diagram

adding graphics 159
changing size 115
see also Diagram window

Diagram menu 454
Diagram Style dialog box 111
Diagram window 17, 21, 26

background color 110
customizing 111
maximum number of 401
printing 31
resizing 28

diagrams, see influence diagrams
dimensions 177–179, 185, 499

adding to a probability table 315
adding to an array 197
innermost 211, 212
outermost 211
removing from an array 194, 197

discrete probability distributions 276, 500
creating 311
with label values 314

discrete variables 500
Distribution command 448
Distribution library 448
distribution, defining a variable as 279
domain 153, 311, 313, 314, 316, 390, 500
Domain Service Name 417
dot product 248
DSN 417
Duplicate Nodes command 68, 442
Dydx() function 337
dynamic arrows 359
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showing or hiding 112

dynamic models 105
dynamic simulation 349–361
dynamic variables 500
Dynamic() function 350–361

E
Edit Definition command 135, 446
Edit Icon command 158, 455
Edit menu 441
Edit Table 500
Edit Table window 179, 195, 365

opening 195
Edit Time command 349, 446
Edit tool 500
Edit tool button 18
Elasticity() function 338
Enterprise version 413–435, 495
Erf() function 263
ErfInv() function 263
error factor 300
error messages, see errors
errors 475–478
evaluation errors 477
Excel graph 500
Exit command 16, 441
Exp() function 214
Exponent number format 127, 163
Exponential distribution 298
Exponential() distribution function 305
Export command 377, 440
export data format 378
Exporting data 363–381
Expr keyword 72
Expr qualifier 407
Expression popup menu 141, 192
expression types 141, 501
expressions 161–216, 501

syntax of 169

F
Factorial() function 214
False system variable 166, 451
fatal errors 478
File Info 390, 501
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File menu 439
filed libraries 393, 501
Filed Library class 79
Filed Module class 79
filed modules 393, 501
fill color, displaying 114
Financial functions 253
Find command 388, 444
Find dialog box 388
Find Next command 389, 444
Find Selection command 389, 444
Fixed Point number format 127
Floor() function 214
fonts

in graphs 126
in nodes 113

For...Do... function 267
Form class 79
form modules 156
fractiles 470, 501
Fractiles() distribution function 297
frame 160
Frequency() function 329
FunctionOf() 72, 395
functions 24, 450

attributes of 405
creating 405–410

Fv() function 255

G
Gamma() distribution function 298
GammaFn() function 263
GammaI() function 263
GammaIInv() function 264
general variable 23, 501
Generalized linear regression 264
Geometric distribution function 324
Getfract() function 330
Graph Setup command 121, 453
Graph Setup dialog box 121
Graph View button 42
graphs

background grid 125
displaying 42
exporting 366
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fonts 126
formatting 121
frames around 125
line style 125
origin 124
printing 31
ranges for 44
scatter 341
styles 44
tick marks 125
X-Y 339

grid 68

H-K
hardware specifications 461
Help 390
Hide Definition(s) command 445
Hypergeometric() distribution function 324
Icon window 158
icons 158
Ident(I=U) function 235
Ident(Time-n) function 351
identifiers 138, 390, 405, 502

changing 81
naming 477

If...then...else... operator 168, 202
Changes in Analytica 2.0 7

Ifall...then...else... operator 203, 205
Ifonly...then...else operator 203
Import command 376, 440
import data format 378
importance analysis 343, 502
Importing data 363–381
Index button 197
index selection area 39, 502
index variables, see indexes
indexes 24, 177–179, 185, 192, 502

adding to a probability table 315
adding to an array 197
changing on arrays 221
column 39
creating 185, 193
interchanging 39
key 39
removing from an array 194, 197
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row 39
selecting for tables 197
showing or hiding arrows 112, 179
x-axis 39

Indexes dialog box 193
IndexNames() function 243
IndexType qualifier 407
INF 164
infinity 164
influence arrows, see arrows
influence diagrams 21, 89, 503

copying 366
editing 64–68
guidelines for 101–117

innermost dimension 211, 212, 503
input arrowhead 22, 503
input nodes 19, 151–157
inputs 390, 503

displaying arrows 114
examining 26
remote 22

Inputs popup menu 22, 136
Insert Columns command 196, 443
Insert Rows command 191, 196, 443
Integer number format 128, 163
Integrate() function 231
Intelligent Array Abstraction 503
interpolation functions 238
Invert() function 247
Ipmt() function 255
Irr() function 256
Isnan() function 266
Isnumber() function 266
Istext() function 266
Isundef() function 266
iteration 270
Join() function 226, 252
key 124, 503
key icon 27
key index 39
Knuth random number generator 289
kurtosis 504
Kurtosis() function 330
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L
L’Ecuyer random number generator 288
labels, displaying 114
Last Saved 390, 504
lexical errors 476
Lgamma() function 264
libraries 504

adding to a model 395
creating 410
filed 393
removing from a model 395
using 410

Library class 79
Library popup menu 144
linear regression 264
Linearinterp() function 239
list of labels 189, 504
lists 152, 186–191, 504

creating 54, 186
editing 190

Ln() function 214
logical operators 167, 200
logical values 166
logical variables 276
Logistic distribution function 305
Lognormal() distribution function 300
Logten() function 215
Logtriangular distribution function 306
Loguniform() distribution function 306

M
Make Alias command 74, 444
Make Importance command 344, 444
Make Input Node command 152, 444
Make Output Node command 155, 444
Math command 447
math functions 198, 213
Math library 447
matrices 504
matrix functions 246–248
Matrix multiplication 248
Max() function 226
MDArrayToTable() function 424
MDArrayToTable() function 249
MDTable() function 250
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mean 504
Mean Value command 45, 452
Mean() function 331
median 504
Median Latin Hypercube sampling method 286
memory

Memory Usage window 465
requirements 461
usage 456

menus 437–456
mid value 29, 505
Mid Value command 45, 452
Mid() function 332
Min() function 227
Minimal Standard random number generator 288
Mod() function 215
mode 277, 505
Model class 79
models

building 85
changes when an arrow is created 71
changes when an arrow is removed 71
closing 16
combining 397
creating 63
defined 15
defining 64
documentation 94
dynamic 72, 105
editing 65–78, 389
expansion 95
integrated 397
modular 398
navigating 386
opening 15
saving 63, 395
switching 16
testing 91

Module class 79
module hierarchy 385, 505

organizing 108
modules 23, 505

attributes of 28
filed 393
showing or hiding arrows 112
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Monte Carlo sampling method 288
Move Into Parent command 455
multidimensional array 177
multimodal distribution 505

N
naming errors 477
NAN 165
natural cubic spline 239
New Model command 439
Node Style dialog box 77, 113
nodes 505

adding icons 158, 159
aligning 68, 106
and arrows 69
arranging 104
changing size 67
color 110
creating 66
customizing 113
default size 113
deleting 67
deselecting 25
displaying arrows to/from 114
duplicating 68
editing title 66
fill colors 114
grouping related 108
in fonts 113
labels 102, 114
moving 67
selecting 24, 66
size 103
text node type 160
types 23
undefined 82, 117
visual grouping 111
Z-order 68

Normal() distribution function 301
Normalize() function 232
Nper() function 256
Npv() function 257
Number Format command 127, 453
number formats 127, 163
Numeric qualifier 407
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O
Obfuscated 506
Object button 17
Object Finder dialog box 143, 506
Object menu 443
Object window 17, 22, 25, 81, 506

maximum number of 401
opening 25
printing 31

Objective variables 23, 88, 104, 506
objects 506
ODBC 415
OLE Linking 506

Activating other application 375
Auto recompute outgoing OLE links 83, 370
Automatic vs. Manual updating 369, 375
Changing file locations 375
Linking data from Analytica 366–371
Linking data into Analytica 371–375
Motivations for 5
Number formatting 370
OLE Links... command 443
Open Source button 375
Paste Special... dialog 373
Terminating links 375
Uses 5

OLE Links... command 443
Open Database Connectivity 415
Open Model command 16, 439
Open Source button on OLE Links... dialog 375
operators 506
Operators command 449
Operators library 449
order of precedence 169
outermost dimension 211, 506
Outline button 17
Outline window 17, 386, 507

printing 31
output arrowhead 507
output nodes 20, 154
outputs 390, 507

displaying arrows 114
examining 26
remote 22
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P
page breaks 456
Page Setup command 440
palette

node 64
tool 17

Parameters 390, 406, 507
parametric analysis 53
parent diagram 22, 26, 507
Parent Diagram button 17, 22
Parenthesis matching 137
Partial name-space scoping 168
Paste command 68, 197, 365, 442
Paste Identifier command 143, 446
Paste Special... command 442
Percent number format 128
percentile 330, 507
Permutations() function 264
Pi system variable 451
picture nodes 159
Pmt() function 257
Poisson() 324
popup menu

creating 153
using 20

Positive qualifier 407
Ppmt() function 258
precedence, order of 169
precision 461
Preferences command 80, 402, 443
Preferences dialog box 18, 80, 148, 385, 402
Preview window 31
Print command 377, 441
Print Preview Command 31
Print Preview command 440
Print Report command 33, 441
Print Setup... Command 31
Print... Command 31
Printing 31
Prob qualifier 407
Prob Table button 312
probability bands 508

setting 290
Probability Bands command 46, 453
Probability Density command 46, 453
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probability density function 508
Probability Density option 291
probability distribution functions 295–305
probability distributions 295–306, 508

beta 295
choosing 275–279
computing 282
continuous 276
discrete 276, 311
lognormal 300
normal 301
triangular 303
truncating 306
uniform 304

Probability Mass command 46, 453
probability mass function 508
Probability Table command 311
probability tables 311–316, 508

conditional 314
Probability() function 332
Probbands() function 332
Probdist() function 302
Probtable() function 314
probtables, see  probability tables
Probvalue 390, 509
Product() function 227
Professional version 495
Pv() function 258

Q
quantile 330
Query 416, 420

R
Radians() function 215
Random Latin Hypercube sampling method 287
random number generators

Knuth 289
L’Ecuyer 288
Minimal Standard 288

random number methods 288
random seed 289
Rank() function 233
Rankcorrel() function 333
Rate() function 258
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Recent files 441
Recomputing results 41
reducing functions 223–229, 509
Regression() function 264
remote

inputs 22
outputs 22
variables 22

resampling 361
Resize Centered command 67, 106, 455
Result button 17, 30, 38
Result command 37
Result menu 452
Result Tool palette 38
result view 509

see also Result window 509
Result window 17, 37–40

default view 40, 82
graph view 43
maximum number of 80, 401
opening 37
table view 41

results
comparing 49
printing 31
recomputing 41
viewing 23, 37–49

Round() function 215
row index 39
Run system variable 194, 283, 333, 451

S
Samp qualifier 408
sample 509
Sample command 48, 453
sample size

selecting 469
setting 285

Sample() function 333
Samplesize system variable 286, 333, 451
sampling methods 509

Median Latin Hypercube 286
Monte Carlo 288
Random Latin Hypercube 287
selecting 286
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Save a Copy In command 395, 440
Save As command 63, 395, 440
Save command 63, 395, 440
Save obfuscated copy 432
scalar 177, 509
Scalar qualifier 408
Scaling printouts 32
scatter plots 341, 509
scenario analysis 53
Scoping operator 168
screen captures 116
Sdeviation() function 334
Select All command 106, 442
Self 148, 193, 312, 350, 510
Send to Back command 68, 458
sensitivity analysis 336–338, 510
Sequence option 187
Sequence() function 217
Set Diagram Size command 116, 455
Set Diagram Style... command 112, 454
Set Node Style command 113, 454
shells, stand alone 400
Show By Identifier command 138, 444
Show Color Palette command 110, 454
Show Invalid Variables command 393, 446
Show Memory Usage command 456, 465
Show module hierarchy 83
show module hierarchy 385
Show Page Breaks command 32, 456
Show Result command 452
Show result warnings 83
Show undefined 82
Show With Values command 30, 388, 445
Sin() function 215
Sinh() function 265
size box 29
Size() function 243
skewed distributions 278
skewness 510
Skewness() function 334
slice 510
Slice() function 236
Snap to Grid command 68, 455
software specifications 461
Sortindex() function 243
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Special command 448
Special library 170, 448
specifications 461
Split() function 252
SQL 415
Sqr() function 215
Sqrt() function 216
standard deviation 510
Standard Query Language 415
Statistical command 448
Statistical library 448
Statistics command 46, 452
Statistics() function 335
Statistics, setting 290
Stepinterp () function 240
string, see text values
Stringlength() function 252
Stringreplace function 252
Subindex() function 228
Subscript function 237
Subset() function 244
Substring() function 253
Suffix number format 127, 163
suffixes 510
Sum() function 229
symmetrical distributions 278, 510
syntax errors 476
system functions 511
system variables 511
System Variables submenu 449

T
table lookup 240
Table View button 38, 41
Table() function 218, 221
tables 175–205, 511

creating 191–194, 219
deterministic conditional 320–323
displaying 41
editing 195–197
printing 31
saving 197
selecting cells 195
selecting indexes for 197

tails 511
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Tan() function 216
Tanh() function 266
text values 165
TextTable keyword 378
thousands separators 128
Tile Horizontally command 456
Tile Vertically command 456
Time system variable 194, 349, 351–355, 451
Title 25, 102, 390, 406, 511

editing 66, 77, 79
transforming functions 229–234
Transpose() function 248
Trial version 495
Triangular() distribution function 303
True system variable 166, 451
Truncate() distribution function 306

U
uncertainty factor 300
Uncertainty Options command 284
Uncertainty Sample option 285
Uncertainty Setup command 453
Uncertainty Setup dialog box 284
Uncertainty View popup menu 38, 44
Uncumulate() function 233

Changes in Analytica 2.0 7
undefined nodes 82
Undo command 78, 441
Unhide Definition(s) command 445
Uniform() distribution function 304
Unique() function 245
Units 390, 406, 511
Use Return to enter data 83
user libraries 410, 446
user-defined functions 405–412, 511

libraries of 410
parameter qualifiers 407

Using 130
Using...Do... function 270

V
values 390

checking bounds 82, 146–148
deterministic 499
showing 29
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uncertain 511

variables 23
attributes of 28
automatic renaming 81
class checking 82
classes 23
finding 388
influencing each other 21
invalid 393
public 397
remote 22, 509
showing dependencies among 69
types 23

variance 512
Variance() function 335

W
Warning icon 139, 475
warnings, see errors
Weibull() distribution function 306
what-if analysis 53
Whatif() function 338
Window menu 455, 456
windows

managing 401
numbers of 80
see also Diagram window, Object window, Outline window

Windows system software 461
WriteTableSql() function 426

X
x-axis index 39
Xirr() function 259
Xnpv() function 260
XY button 339, 342
X-Y results 339

Z
Z-order. See Nodes, Z-order
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Analytica Windows and Dialogs

Diagram Window: Inputs and Outputs

Diagram Window: 
Influence Diagram

Result Window—Graph View

Object Window
Object Finder

Result Window—Table View

Diagram Style Dialog
Node Style Dialog

Graph Setup Dialog

Uncertainty Setup Dialog

Number Format Dialog

Find Dialog

Preferences Dialog

Attributes Dialog Outline Window



Analytica Quick Reference

The Tool Bar

Numerical Formats (Output)

Numerical Prefixes and Suffixes (Input)

Analytica Note:  If fixed point is selected, numbers larger than 109 display in exponent format.

Format Description Example

Suffix the default (see the following table) 12.35K

Exponent scientific exponential 1.235e04

Fixed Point fixed decimal point 12345.68

Integer fixed point with no decimals 12346

Percent percentage 1234568%

Date text date 12 Jan 93

Boolean true or false True

Power 
of 10

Suffix Prefix Power 
of 10

Suffix Prefix

3 K Kilo -2 % percent

6 M Mega or Million -3 m milli

 9 G Giga -6 µ micro (mu)

 12 T Tera or Trillion -9 n nano

15 Q Quad -12 p pico

-15 f femto
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	The Attribute popup menu
	Changing the panel size
	Closing the Attribute panel

	Showing mid values
	Array values
	Values of inputs

	Printing
	Previewing Page Breaks Before Printing
	Scaling Printouts
	Print multiple windows
	Print Outline (All Objects)
	Print Outline (Modules Only)
	Chapter 2
	Viewing Results




	The Result window
	Opening a Result window
	The Result tool palette
	Index selection area
	Index navigation buttons
	The default view
	Recomputing results

	Viewing a result as a table
	Displaying a table
	Display of values
	One dimension
	Two dimensions
	Three or more dimensions

	Formatting numbers
	1. Select the row(s), column(s), or cell that you wish to format.
	2. Choose Number Format from the Result menu or press Ctrl�B.


	Viewing a result as a graph
	Displaying a graph
	Display of values
	One dimension
	Two or more dimensions

	Changing graph ranges and styles

	Uncertainty view options
	Mid Value
	Mean Value
	Statistics
	Probability Bands
	Probability Density or Probability Mass
	Cumulative Probability
	Sample

	Comparing results
	Chapter 3
	Analyzing Model Behavior


	Varying input parameters
	Which inputs to vary
	How many values to assign
	Creating a list
	1. Select the variable by clicking on its node in the influence diagram.
	2. Display the variable's definition by clicking on the Definition button in the tools palette.
	3. Click on the Expressions popup menu above the definition and select the List option. (Do not s...
	4. A dialog box asks for confirmation. Click on “OK”.
	5. Select the element by clicking on it.
	6. Type in the lowest value for the variable.
	7. Press Enter and type in the next value.
	8. Repeat step 7 until you have all the values you want.

	How many inputs to vary

	Analyzing model behavior results
	1. Select the variable you wish to view by clicking on its node in the diagram.
	2. View the result by clicking on the result button in the tool palette. The result displays as a...
	Understanding unexpected behavior
	Understanding model behavior
	Chapter 4
	Creating and Editing a Model



	Creating and saving a model
	Creating a new model
	Saving a model

	The model Object window
	Creating and editing nodes in a diagram
	Creating a node
	Editing a node title
	Selecting nodes
	Working with nodes
	Moving a node
	Moving a node into a module
	Changing the size of a node
	Deleting a node
	Copying and pasting nodes
	Duplicating nodes

	Aligning to the grid
	Adjusting node Z-order

	Drawing arrows in a diagram window
	Arrow tool
	Arrows and nodes
	Arrow from variable node to variable node
	Arrow from variable node to module node
	Arrow from module node to variable node
	Arrow from module node to module node
	Double-headed arrow between module nodes
	Small arrowhead to the right or left of a variable node

	Creating and removing arrows
	1. Drag from the origin node (it becomes highlighted) to the destination node (which also becomes...
	2. When you release the mouse button, the arrow is drawn.

	Model changes when creating an arrow
	Arrow between two variable nodes
	Arrow between a variable node and a module node
	Arrow between two module nodes

	Model changes when deleting an arrow
	Cyclic dependency

	Drawing arrows between variables in different modules
	Drawing arrows across windows
	1. Open both module Diagram windows and bring to the top the module Diagram window containing the...
	2. Position the Diagram windows so the variable Mortgage loan amount is exposed in the window und...
	3. Draw an arrow from the origin variable (Buying price) to the second variable (Mortgage loan am...
	Result

	Moving, drawing, and moving back
	1. Select Mortgage loan amount, then choose Move Into Parent from the Diagram menu to move the va...
	2. Draw an arrow from Buying price to Mortgage loan amount.
	3. Move Mortgage loan amount back into its module by dragging it onto the Cost to Buy module node.

	Indirectly drawing an arrow

	Creating alias nodes
	Use the Make Alias command
	Draw arrow between variable and module
	Example:

	Draw arrow between two modules

	Using an alias node
	Modifying an alias node

	Editing an attribute of a node
	1. If in the attribute panel, select the attribute in the attribute popup menu.
	2. Click in the attribute field. If a gray outline appears around the attribute and the cursor is...
	3. Edit the attribute using the standard text-editing methods.
	Attribute changes
	Cancel and Undo

	Changing the class of a node
	Model
	Module
	Filed Module
	Library
	Filed Library
	Form

	Preferences dialog box
	Windows of each kind
	One only
	Any number
	Result windows

	Change Identifier
	When title changes
	Ask before renaming

	Opens
	Object window
	Diagram attribute panel

	Default result view
	Checkboxes
	Check variable class
	Check value bounds
	Show undefined
	Show module hierarchy
	Show result warnings
	Use Return to enter data
	Auto recompute outgoing OLE links
	Chapter 5
	Building Effective Models




	Creating a model
	Identify the objectives
	Identify the decisions
	Link the decisions to the objectives
	Move from the qualitative to the quantitative
	Keep it simple
	Reuse and adapt existing models
	Aim for clarity and insight

	Testing and debugging a model
	Test as you build
	Test the model against reality
	Test the model against other models
	Have other people review your model
	Test model behavior and sensitivities
	Celebrate and learn from unexpected behavior
	Document the model as you build it

	Expanding your model
	Extend the model by stages
	Identify ways to improve the model
	Discover what parts are important to guide expansion
	Simplify where possible
	Chapter 6
	Creating Lucid Influence Diagrams



	Guidelines for creating lucid and elegant diagrams
	Use clear, meaningful node titles
	Use consistent node sizes
	1. Select the nodes to resize.
	2. Resize one of the selected nodes by dragging one of its handles. All the other selected nodes ...

	Use small and large nodes sparingly
	Arrange nodes from left to right (or top to bottom)
	Tolerate spaghetti at first…
	…reorganize later
	Align nodes horizontally or vertically
	1. Select all nodes in the diagram with the Select All (Ctrl-A) command from the Edit menu.
	2. Select Align Selection To Grid from the Diagram menu.

	Hide less important arrows
	Keep diagrams compact

	Organizing a module hierarchy
	Group related nodes in the same diagram
	Use 5 to 15 nodes per diagram

	Color in influence diagrams
	Use colors judiciously
	Background color
	Node colors
	Changing background or node colors
	Grouping nodes by color

	Diagram Style dialog box
	Show arrows to/from
	Indexes
	Functions
	Modules
	Dynamic

	Default node size
	Font Style

	Node Style dialog box
	Changing the node style
	1. Select one or more nodes.
	2. Choose Set Node Style... from the Diagram menu.

	Display
	Input arrows
	Output arrows
	Label
	Border
	Fill color
	Bevel

	Font Style

	Changing the size of the diagram
	1. Drag a node into the region beyond the current diagram extent.
	1. Bring the diagram window to the front.
	2. Select Set Diagram Size... from the Diagram menu.
	3. Specify the size diagram you want.
	4. Click on Set.

	Taking screenshots of diagrams
	Use Browse mode
	Switch off cross-hatching
	Diagram colors
	Use a common level of reduction
	Chapter 7
	Formatting Graphs and Tables



	Graph Setup dialog box
	Setup option popup menu
	Buttons
	Set Default
	Cancel


	Selecting the Graphing Tool
	Analytica® (built-in)
	Excel Chart®

	Graph Frame setup option
	Value entry boxes
	Number of intervals between tick marks
	Minimum/maximum value

	Checkboxes
	Choose axis ranges automatically
	Display Key
	Include 0


	Graph Style setup option
	Grid
	Frame
	Tick Marks
	None
	Bottom and Left Only
	All Sides
	Show Numbers/Labels

	Line Style
	Line graph
	Line and data markers
	Data markers (dots)
	Data markers only
	Bar chart
	Overlap
	Origin
	Histogram
	Symbol Size

	Font Style

	Number Format dialog box
	1. Open a Result window.
	2. If the Result window is a table, select a row, column, or cell.
	3. Choose Number Format from the Result menu or Ctrl-B to display the Number Format dialog box.
	Formats
	Options
	Currency
	Decimal digits
	Number of digits
	Date formats
	Thousands separators

	Using multiple formats in a single result table
	1. Create a separate variable for each column (or row) of the report. Set the number format for e...
	2. Create a node to represent the report. Define the node to be a list. In each cell of the list,...
	3. Display the result as a table.


	Using Excel Graph with Analytica
	Switching a Result Graph to an Excel Graph
	1. Double click on the graph.
	2. When the ‘Graph Setup’ box appears, select ‘Excel Graph’ from the Setup option pulldown menu.
	3. Click on the ‘Excel Chart’ icon and click the Apply button.

	Important Notes about Using Excel Graph
	Formatting Settings
	Excel Graph as Default will Increase Model File Size
	Three-Dimensional Graphing
	Keeping Excel Open
	Chapter 8
	Creating and Editing Definitions




	Creating or editing a definition
	1. Select the definition.
	2. Edit it by typing, by deleting, or by using the standard text editing operators—that is, Copy ...
	Special editing key combinations
	Comments in definitions
	Identifiers
	Functions
	Syntax check

	How a valid definition may change the diagram
	Cross-hatching disappears
	Arrow updating

	The Expression popup menu
	Expression
	List
	List of Labels
	Sequence
	Table
	Probability table
	Distribution
	Choice
	Other

	Object Finder dialog box
	Pasting from a library in the Definition menu
	1. Have the cursor at the point you want to insert a function or expression.
	2. From the Definition menu, select the library and then the function or expression.
	3. The function or expression is pasted into the definition.
	4. Replace all parameters with input identifiers or expressions. Each parameter is enclosed in <<...

	Checking the validity of a variable’s values
	1. Display the Check attribute.
	2. Define checks for variables.
	Displaying the Check attribute
	1. Select Attributes from the Object menu to open the Attributes dialog box. See “Managing attrib...
	2. Scroll down the Attribute list and find Check.
	3. Click on Check once to select it, and a second time to add a check mark next to it. The check ...
	4. Click on the OK button.

	Defining the check
	Triggering a check
	If a check fails
	Disabling value checking
	Chapter 9
	Creating Models to be Used by Others



	Using input nodes
	Input field
	Input popup menu
	List
	Edit table
	Probability distribution
	Creating an input node
	1. Select the variable.
	2. Select Make Input Node from the Object menu. The input node will appear in the same diagram ne...
	3. Move the input node to the location you want.
	4. Adjust the size of the node.


	Creating a popup menu
	Creating a menu from a list
	1. Show the definition of the variable as a list, either in the attribute view or the object window.
	2. Press the Expression popup menu and select the Choice option. Press OK to “Replace current def...
	3. The object finder dialog displays with parameter I=Self and n=0. Press OK.

	Creating a new definition

	Using output nodes
	Creating an output node
	1. In a diagram window, select the node of the variable from which you wish to create an output n...
	2. Select Make Output Node from the Object menu. The output node will appear in the diagram next ...
	3. Move the output node to the location you want.
	4. Adjust the size of the node.


	Resizing controls
	Changing display style
	Using form modules
	1. Make sure you are in a diagram window with the Edit tool selected.
	2. Drag the module icon off the node palette and position it in the diagram.
	3. Type in a title for the module—for example, Inputs.
	4. Open the attribute view at the bottom of the diagram window.
	5. From the attribute popup menu, select Class. A popup menu of available classes displays.
	6. Select Form from the popup menu of classes.
	Creating input and output nodes in a form module
	1. Adjust the diagram(s) on your screen so the form node and the source variables for the input o...
	2. In the tool palette, click on the arrow button ().
	3. For input nodes, draw an arrow from the form node to each variable. Analytica creates an input...
	4. For output nodes, select the variables and draw arrows from the variables to the form node. An...
	5. When you have finished creating input and output nodes, double-click on the form node to open ...
	6. In the tool palette, click on the edit button ().
	7. Rearrange and resize the input and output nodes for clarity. It is usually clearest to put the...


	Adding icons to nodes
	Opening the Icon window
	1. Make sure that the Edit tool is selected.
	2. Select the node that you wish to illustrate.
	3. Choose Edit Icon from the Diagram menu to open the Icon window.

	Drawing or editing an icon

	Adding graphics, frames, and text to a diagram
	Adding graphics
	1. Copy (Ctrl-C) the graphic to the clipboard from within a graphics application.
	2. Make sure that the Edit tool is selected in Analytica.
	3. Select the node or the diagram window where you want the graphic to appear.
	4. Paste (Ctrl-V) the graphic from the clipboard.

	Adding a frame
	Adding text

	Numbers
	Range
	Numbers out of range
	INF (infinity)
	Precision

	Text values
	Boolean or logical values
	Operators
	Arithmetic operators
	Comparison operators
	Logical operators
	If �b Then �u Else v

	Scoping operator (::)
	Example

	Operator binding precedence
	Examples


	Functions
	Library Organization
	Chapter 10
	Using Expressions

	Chapter 11
	Modeling with Arrays and Tables



	Introduction to Arrays
	What is an array?
	What is an index?
	Index variables in a diagram
	Viewing an array as an Edit table
	Example (continued from above)

	Two sources of array value

	Operations on arrays
	Operation on a scalar and an array
	Example (continued)

	Operation on two arrays with the same indexes
	Example (continued)

	Operation on a one- and two-dimensional array
	Example (continued)

	Summing over an index variable
	Example (continued)

	Operation on arrays with different dimensions
	Example (continued)

	General rule for operations on arrays

	Creating an index
	1. Select the Edit tool () and have the Diagram window active.
	2. Drag the parallelogram shape () from the node palette to the diagram.
	3. Give the new index a descriptive title.
	4. Define the index as a list, list of labels, or sequence (see below).
	Creating a list
	1. Press the Expression popup menu above the definition field and select List (for numbers) or Li...
	2. Select the element by clicking on it.
	3. Type in a number or expression (for List) or text (for List of Labels).
	4. Press Enter and type in the next value.
	5. Repeat step 4 until you have entered all the values you want.

	Autofilling a list
	Autofilling a list of labels
	Creating a list with the Sequence option

	List vs. List of Labels
	List View
	Expression View
	List (of numbers)
	List of labels
	List view
	Expression view

	Mixing numbers and text
	List view
	Expression view
	List view
	Expression view


	Editing a list
	Inserting cells
	Deleting cells
	Navigating a list

	Creating an array with an Edit table
	1. Press the Expression popup menu above the definition field and select Table.
	2. The Indexes dialog box displays for selecting the table’s indexes (dimensions).
	3. Select a variable from the Indexes list and click on the move button (), or double-click on th...
	4. Click on OK to create the table and open the Edit Table window for editing the table’s values ...
	Indexes dialog box
	Preview
	All variables checkbox
	Selected indexes
	new index

	Creating a new index
	1. Select new index from the variables list in the Indexes dialog box.
	2. Enter a title for the index.
	3. Click on the Create button.
	4. To make the new index an index of the table, click on the button.

	Removing an index
	1. Select the index from the Selected Indexes list.
	2. Click on the button.

	System index variables Run and Time

	Editing a table
	The Edit Table window
	Selecting cells
	Select a single cell
	Select multiple cells

	Editing a cell
	Adding and deleting cells
	1. Select the row (or column) before which you wish to insert a new one.
	2. Choose Insert Rows (or Insert Columns) from the Edit menu.
	1. Select the row (or column) you wish to delete.
	2. Choose Delete Rows (or Delete Columns) from the Edit menu.

	Copying and pasting cells
	1. Select the cell or region.
	2. Choose Copy from the Edit menu (Ctrl-C).
	3. Paste the item(s) into another cell or region by selecting Paste from the Edit menu (Ctrl-V). ...

	Adding or removing indexes
	Saving the table

	Calculating with arrays
	Conventions for array examples
	Scalar functions
	Arithmetic operations

	Comparison and logical operations
	Conditional operators
	If B Then U Else V
	Examples
	Avoiding Evaluation

	Ifonly B Then U Else V
	When to use
	Examples:

	Ifall B Then U Else V
	When to use
	Examples:


	Overview
	Examples
	Array Abstraction
	Relating indexes to values

	Math functions
	Abs ( X )
	Arctan ( X )
	Ceil(X)
	Cos ( X )
	Degrees( R )
	Exp ( X )
	Factorial ( X )
	Floor(X)
	Ln ( X )
	Logten ( X )
	Mod( X, Y )
	Radians( D )
	Round ( X )
	Sin ( X )
	Sqr ( X )
	Sqrt ( X )
	Tan( X )

	Functions that create lists
	[ u1, u2, u3, … um ]
	Examples

	Sequence ( Start, End, Stepsize )
	Library
	Examples


	Functions that create arrays
	Array( I1, I2, … In, A)
	Library
	Example 1
	Example 2
	Example 3
	Example 4

	Table ( I1, I2, … In ) (�u1, u2, u3, … um )
	Library
	Example 1
	Example 2
	Example 3


	Array-reducing functions
	Examples
	Area ( R, I, X1, X2 )
	Library
	Example

	Argmax ( R, I )
	Library
	Example

	Average ( X, I )
	Library
	Examples

	Join(A, I, separator,finalSeparator)
	Max ( X, I )
	Library
	Examples

	Min ( X, I )
	Library
	Examples

	Product ( X, I )
	Library
	Examples

	Subindex ( A, U, I )
	Library
	Examples

	Sum ( X, I )
	Library
	Examples


	Transforming functions
	Example
	Cumproduct ( X, I )
	Library
	Example

	Cumulate ( X, I )
	Library
	Example

	Integrate ( R, I )
	Library
	Example

	Normalize ( R, I )
	Library
	Example

	Rank ( X, I )
	Library
	Examples

	Uncumulate ( X, I, firstElement)
	Library
	Example


	Functions that select part of an array
	Choice ( I, n, inclAll)
	Library
	Examples

	Ident [I = U ]
	Library
	Examples

	Slice ( U, I, N )
	Library
	Examples

	Subscript ( U1, I, U2 )
	Library
	Examples


	Interpolation functions
	Cubicinterp ( D, R, X, I)
	Library
	Example

	Linearinterp ( D, R, X, I)
	Library
	Example

	Stepinterp ( D, A, X, I)
	Library
	Examples


	Other array functions
	Concat ( A1, A2, I, J, K )
	Library
	Examples

	IndexNames(A)
	Library
	Example

	Size ( U )
	Library
	Examples

	Sortindex ( D, I )
	Library
	Examples

	Subset ( D )
	When to use:
	Library
	Example

	Unique(A,I)
	When to use:
	Library
	Example


	Matrix functions
	Decompose ( C, I, J )
	Library
	Example

	Determinant ( C, I, J )
	Library
	Example

	Invert ( C, I, J )
	Library
	Example

	Transpose ( C, I, J )
	Library
	Example

	Dot product of two matrices
	Example


	Array flattening functions
	MDArrayToTable(A, I, L)
	Library
	Example

	MDTable(T,Rows,Cols,Vars,conglomFn,missingval)
	Library
	Example


	Text Functions
	Join(A, I, separator,finalSeparator)
	Split(S, separator)
	Example

	Stringlength(Text)
	Example

	Stringreplace(Text,pattern,s,all)
	Example

	Substring(Text,M,N)
	Example


	Financial Functions
	Parameters:
	Cumipmt( Rate, Nper, Pv, StartPeriod, EndPeriod, Type )
	Example

	Cumprinc( Rate, Nper, Pv, Start_period, End_Period, Type )
	Example

	Fv( Rate, Nper, Pmt, Pv, Type )
	Examples

	Ipmt( Rate, per, Nper, Pv, Fv, Type )
	Example

	Irr( Values, I, Guess )
	Example

	Nper( Rate, Pmt, Pv, Fv, Type )
	Example

	Npv( DiscountRate, Values, I )
	Example

	Pmt( Rate, Nper, Pv, Fv, Type )
	Example

	Ppmt( Rate, Per, NPer, Pv, Fv, Type )
	Example

	Pv( Rate, Nper, Pmt, Fv, Type )
	Example

	Rate( NPer, Pmt, Pv, Fv, Type, Guess )
	Example

	Xirr( Values, Dates, I, Guess )
	Example

	Xnpv( Rate, Values, Dates, I )
	Example


	Advanced math functions
	Arccos(X)
	Arcsin(X)
	Arctan2( Y, X )
	BetaFn( A, B )
	BetaI( X, A, B )
	Combinations( k, n )
	Cosh(X)
	CumNormal( X, mean, stddev )
	CumNormalInv( Y, mean, stddev )
	Erf( X )
	ErfInv( Y )
	GammaFn( X )
	GammaI( X, A, B )
	GammaIInv( Y,A,B )
	Lgamma( X )
	Permutations( k,n )
	Regression( Y,B,I,K )
	Example 1
	Example 2

	Sinh( X )
	Tanh( X )

	Datatype Functions
	Isnan(X)
	Isnumber(X)
	Istext(X)
	Isundef(X)

	Control functions
	For Temp:= I Do Expr
	Library
	Examples

	Using Temp := X Do Expr
	Library
	Examples
	Chapter 12
	Function Reference

	Chapter 13
	Expressing Uncertainty




	Choosing an appropriate distribution
	Is the quantity discrete or continuous?
	Does the quantity have bounds?
	How many modes does it have?
	Is the quantity symmetric or skewed?
	A standard or custom distribution?

	Defining a variable as a distribution
	1. Click on the Expression popup menu above the definition field and select Distribution.
	2. Select the distribution you wish to use.
	3. Enter the values for the parameters. You can use an expression or refer to other variables by ...
	4. Click on OK to accept the distribution.
	Entering a distribution as an expression
	1. Set the cursor in the definition field and type in the distribution name and parameters, e.g.
	2. Press Alt-enter or click on the button.


	Including a distribution in a definition
	1. Set the insertion point where you wish to enter the distribution in the definition field or ed...
	2. Enter the distribution in any of the following ways:
	3. Type in missing parameters, or replace parameters enclosed as <<x>>.

	Overview of built-in probability distributions
	Probabilistic Calculation
	Example
	Example

	Uncertainty Setup dialog box
	Uncertainty Sample
	Sample size
	Sampling method
	Simple Monte Carlo
	Median Latin hypercube (the default method)
	Random Latin hypercube

	Choosing a sampling method
	Random number method
	Minimal Standard (the default method)
	L’Ecuyer
	Knuth

	Random seed
	Reset once
	Statistics option
	Probability Bands option
	Probability Density and Cumulative Probability options
	Samples per plot point
	Equal probability steps
	Equal X axis steps
	Chapter 14
	Using Continuous Probability Distributions



	Continuous distribution functions
	Beta ( X, Y, lower, upper )
	When to use
	Library
	Examples

	Cumdist ( P, R, I )
	Library
	Example

	Fractiles ( L )
	Library
	Example

	Gamma( A,B )
	When to use
	Library
	Examples

	Lognormal ( median, gsdev�)
	When to use
	Library
	Examples

	Normal ( mean, stddev )
	When to use
	Library
	Example

	Probdist ( P, R, I )
	Library
	Example

	Triangular ( min, mode, max )
	When to use
	Library
	Example

	Uniform ( min, max )
	When to use
	Library
	Example


	Continuous Distribution Library
	Exponential( R )
	Logistic( mean, scale)
	Logtriangular( min, mode, max )
	Loguniform( lower, upper )
	Weibull( scale, shape )

	Truncating Distributions
	Truncate ( Dist, X )
	Library:
	Examples:
	Chapter 15
	Using Discrete Probability




	Using a probability table
	Creating a probability table
	1. Determine the variable’s domain—the list of possible outcomes.
	2. Select the variable and open one of the following:
	3. Click on the Expression popup menu above the definition field and select Probability Table.
	4. The Indexes dialog box opens to confirm your choices for the indexes of the table. Only variab...
	5. Click on the OK button. An Edit Table window appears.
	6. Enter the possible outcomes (the domain) in the first column. If the outcomes are numeric, the...
	7. Enter the probability of each possible outcome in the second column. (The probabilities should...
	Example

	Editing the domain
	Changing the domain type
	Expression view of probability table
	Probtable ( I1, I2, … In ) ( p1, p2, p3, … pm )
	Example

	Using labels in a probability table
	Adding dimensions to a probability table
	1. Open the Edit Table window by clicking on the ProbTable button.
	2. Click on the Indexes () button to open the Indexes dialog box.
	3. Click in the All variables checkbox above the left hand list.
	4. Move the desired variables to add them as indexes.
	5. Click on the OK button to accept the changes.

	Creating a conditional dependency
	1. Open the Edit Table window by clicking on the ProbTable button.
	2. Click on the Indexes () button. Other variables that are defined as probability tables appear ...
	3. Move the variables you wish to be conditionally dependent, to add them as indexes.
	4. Click on the OK button to accept the changes.


	Other discrete distribution functions
	1. Select the variable and open the Attribute panel of the Diagram window (see see “The Attribute...
	2. Select the Domain attribute from the popup menu.
	3. The domain type popup menu shows the default of Continuous. Select either List of numbers or L...
	4. Analytica displays a list containing one element. Enter the domain values like any list (see “...
	Bernoulli ( P )
	Library
	Example

	Certain ( U )
	Library
	When to use
	Example

	Chancedist ( P, A, I )
	When to use
	Library
	Example


	Using a deterministic conditional table
	Creating a determtable
	1. Determine the variable’s domain—the list of possible outcomes.
	2. Press the Expression popup menu above the definition field and select Other.
	3. Select Array from the Library popup menu and select Determtable from the function list.
	4. Click on the Indexes button to specify discrete probability variables as inputs. The Indexes d...
	5. Click on OK to accept the indexes and open an Edit Table window.
	6. Enter the outcomes corresponding to each outcome of your discrete inputs.

	Expression view of a determtable
	Determtable( I1, I2, … In ) (�r1, r2, r3, … rm )
	Example


	Discrete Distribution Library
	Binomal(n, p)
	Geometric( p )
	Hypergeometric( n, d, m)
	Poisson( R )
	Chapter 16
	Analyzing Uncertainty and Sensitivity



	Statistical functions
	Correlation ( X, Y )
	Library
	Example
	Example

	Frequency ( X, I )
	Library
	Example (Continuous)
	Example (Discrete)

	Getfract ( X, P )
	Library
	Examples

	Kurtosis ( X )
	Library
	Example

	Mean ( X )
	Library
	Examples

	Mid ( X )
	Library
	Example

	Probability( B )
	Library
	Example

	Probbands ( X )
	Library
	Example

	Rankcorrel ( X, Y )
	Library
	Example

	Sample ( X )
	Library
	When to use
	Example

	Sdeviation ( X )
	Library
	Example

	Skewness ( X )
	Library
	Example

	Statistics ( X )
	Library
	Example

	Variance ( X )
	Library
	Example


	Sensitivity analysis functions
	Examples
	Dydx ( Y, X )
	Library
	Examples

	Elasticity ( Y, X )
	Library
	Examples

	Whatif ( Ident, Tempval, X )
	Library
	Example

	WhatIfAll(Ident, varlist, X)
	Example


	X-Y results
	1. Open a Result window for the y- (vertical axis) variable.
	2. Click on the XY button located in the top right corner of the window to open the Object Finder...
	3. In the Object Finder, select the x- (horizontal axis) variable
	Example

	Scatter plots
	1. Open a Result window for Y.
	2. Click on the XY button located in the top right corner of the window to open the Object Finder...
	3. In the Object Finder, select the X variable.
	4. In the Uncertainty View popup menu (at the top left of the Result window), select the Sample v...
	Example

	Importance analysis
	Importance analysis defined
	Creating an importance variable
	1. Be sure you are in Edit mode. Select an output variable’s node (usually your model’s objective...
	2. Select Make Importance from the Object menu.

	Example
	Editing importance variables
	Chapter 17
	Modeling Changes over Time



	The Time index
	Using the Dynamic function
	Dynamic ( initial1, initial2..., initialn, Expr )
	Library
	When to use
	Example

	Ident [ Time�-�k ]
	Library


	More about the Time index
	Reference to earlier time
	Defining time
	Time as a sequence
	Example

	Time as a list (numeric)
	Example

	Time as a list of labels (text)
	Example


	Using Time in a model
	1. Open the Object window for Time by selecting Edit Time from the Definition menu.
	2. Select Make Alias from the Object menu (see “Using an alias node” on page 76).


	Initial values for Dynamic
	Using arrays in Dynamic
	Example

	Dependencies with Dynamic
	Example
	Dynamic dependency arrows
	1. Select Set Diagram Style... from the Diagram menu to open the Diagram Style dialog box (see “D...
	2. Click in the Dynamic checkbox to show dynamic arrows (or uncheck it to hide the arrows).
	3. Click OK to accept the change.

	Expressions inside dynamic loops

	Uncertainty and Dynamic
	Example
	Resampling
	Chapter 18
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	Copying and pasting
	Pasting data from a spreadsheet
	1. Select a group of cells in a spreadsheet.
	2. Select Copy from that program's Edit menu, to copy the data to the clipboard.
	3. Bring the Analytica model to the front and open the Edit Table window you want to paste the da...
	4. Select a top-left cell or the same number of cells that you originally copied.
	5. Select Paste from the Edit menu (Ctrl-V).

	Pasting data from another program
	Copying a diagram
	1. Select the group of nodes you wish to copy.
	2. Select Copy from the Edit menu (Ctrl-C). The objects that the nodes represent, as well as a pi...

	Copying an edit table or result table
	1. Open the window containing the table.
	2. Select cells and choose Copy from the Edit menu (Ctrl-C).

	Copying a result graph
	1. Open the Result window containing the graph.
	2. Select Copy from the Edit (Ctrl-C) menu to copy a PICT representation of the graph.


	Linking Analytica results to other applications
	Linking procedure
	1. In the Analytica Result window, select the cells you want to link and choose ‘Copy’ from the ‘...
	2. From Excel, select the cells where you would like the Analytica data linked.
	3. From Excel’s ‘Edit’ menu, choose ‘Paste Special…’
	4. The ‘Paste Special’ dialog box will appear.
	5. In this box, choose the option ‘Paste link’ as ‘Text’ and click the ‘OK’ button.

	Detailed example of linking Analytica results
	Important notes about linking to Analytica results
	Changing file locations
	Automatic vs. manual updating
	1. On Word’s edit menu, select ‘Links…’
	2. In the ‘Links’ box that appears select the link(s) you’re interested in adjusting.
	3. Click on the radio button labeled ‘manual’ and click the ‘OK’ button.

	Number formatting
	Refreshing links when Analytica model is not running
	1. A new instance of Analytica will launched,
	2. The model will be automatically loaded,
	3. The nodes upon which the links are dependent will be evaluated,
	4. The links will become reactivated, and
	5. The linked data will be updated.



	Linking data from other applications into Analytica
	Linking procedure
	1. In Excel, select the cells you want to link to Analytica and choose ‘Copy’ from the ‘Edit’ menu.
	2. In Analytica, make the Edit table where you want the Excel data linked the front most window.
	3. From the ‘Edit’ or the right mouse button pop-up menu, choose ‘Paste Special…’ and the ‘Paste ...
	4. It will already be set for ‘Paste link’ as ‘Text’ (see figure 5), so just click ‘OK’.

	Example of linking a table into Analytica
	Important notes about linking into Analytica edit tables
	Changing file locations
	Automatic vs. manual updating
	1. On Analytica’s ‘Edit’ menu, select ‘OLE Links…’
	2. In the ‘Edit Analytica Links’ box that appears select the link(s).
	3. Click on the radio button labeled ‘manual’ and click the ‘OK’ button.

	Terminating links
	Activating other application


	Importing and exporting
	Importing a definition
	1. Select the definition field of the variable in either the Object window or Attribute panel def...
	2. Select Import... from the File menu. A dialog box prompts you for the file name from which to ...

	Importing into an edit table
	1. Open the window containing the table.
	2. Select cells and choose Import… from the File menu.

	Exporting
	1. Select the variable to be exported from and open either the Object window, definition in the A...
	2. Select the definition field, list cell(s), or table cell(s) for exporting.
	3. Select Export from the File menu. A dialog box prompts you for the file name to export to.


	Printing to a file
	1. Select Print from the File menu.
	2. Select Print to File and press Enter or click on OK.
	3. Enter the name of the file and the format for the file in the dialog box that appears.

	Edit Table data import/export format
	One-dimensional array
	Example

	Two-dimensional array
	Example

	Three-dimensional array
	Example:

	Number Format
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	Show module hierarchy preference
	The Outline window
	Opening the Outline window
	Opening details from an outline
	Expanding and contracting the outline
	Viewing and editing attributes
	1. Select the node by clicking on it.
	2. Choose the attribute to examine from the Attribute popup menu (see “The Attribute popup menu” ...

	Viewing values

	Finding variables
	Find dialog box
	1. Select Find... (Ctrl-F) from the Object menu.
	2. Choose the attribute to search by: Identifier or Title.
	3. In the text field, enter the identifier or title for the Analytica object for which you want t...
	4. Click on the Find button to initiate the search.


	Managing attributes
	Attributes dialog box
	Class popup menu
	Attribute list

	Displaying optional attributes
	Creating new attributes
	1. Select new attribute from the attribute list to show the new attribute Title field and the Cre...
	2. Enter the title for the new attribute in the Title field. The title can contain a maximum of 1...
	3. Click on the Create button to define the new attribute.

	Renaming an attribute
	1. Select it in the attribute list. The Title field and the Rename button appear.
	2. Edit the name of the attribute in the Title field.
	3. Click on the Rename button.

	Referring to the value of an attribute
	Attrib Of Ident
	Library
	Example



	Invalid Variables
	Using filed modules and libraries
	Creating a filed module or library
	1. Create a module by dragging the module icon from the node palette onto the diagram, and give i...
	2. Create functions and/or variables in the module, or create them elsewhere and move them into t...
	3. Change the class of the module to Module () or Library () (see “Changing the class of a node” ...
	4. The Save As dialog box appears. Give the filed module or library a name and save it.
	5. If you want the original model to load the new filed module or library the next time it is ope...

	Locking a filed module or library
	1. Close the filed module or library, or close Analytica.
	2. In Windows Explorer, select the filed module or library.
	3. Select Properties from the File menu.
	4. Check the Read-only checkbox.
	5. Close the Properties window.

	Adding a module or library to a model
	Removing a module or library from a model
	Saving changes

	Add Module dialog box
	Embed a copy
	Link to original
	Merge contents (overwrite)

	Combining models into an integrated model
	Define public variables
	Create a modular model
	1. Create or open the model that will be the top level of the hierarchy. This is the model to whi...
	2. Using Add Module (see “Add Module dialog box” on page 395), add in the submodels. Be sure to c...
	3. Save the entire integrated model, using the Save command.

	Identical identifiers
	Redundant nodes
	Stand alone shells
	1. Open the integrated model and evaluate all nodes that feed inputs to Mod1.
	2. Use the Export command (see “Importing and exporting” on page 376) to save the value of each f...
	3. Close the integrated model.
	4. Create a new model, to be the stand alone shell.
	5. Use Add Module to add the public variables module.
	6. For each input node, create a node containing an Edit Table, using the identifier and dimensio...
	7. Use the Import command (see “Importing and exporting” on page 376) to load the appropriate dat...
	8. Use Add Module to add Mod1 into the stand alone shell.
	9. To include output nodes at the top level of the hierarchy, create nodes there and define them ...
	10. Save the shell.

	Cautions in combining models
	Identifiers
	Created attributes
	Location of linked modules and libraries


	Managing windows
	Overriding the limits on the number of windows
	Chapter 20
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	Creating a function
	1. Make sure the Edit tool is selected and you can see the node palette (see page 65).
	2. Drag the Function node icon from the node palette into the Diagram area.
	3. Title the node, and double-click on it to open its Object window.
	4. Enter the new function’s attributes (described in the next section).

	Attributes of a function
	Identifier
	Title
	Units
	Parameters
	Description
	Definition

	Parameter qualifiers
	Function parameter type qualifiers
	ArrayType
	Ascending
	Context, Expr
	DetermType
	IndexType
	Numeric
	Positive
	Prob
	Samp
	Scalar

	Syntax
	Examples:


	Example function
	Parameters
	Definition
	Sample usage

	Libraries
	Creating a library
	1. Create a module by dragging the module icon from the node palette onto the diagram, and give i...
	2. Change the class of the module to library or filed library (see “Changing the class of a node”...
	3. Create functions and/or variables in the new library or create them elsewhere in the model and...

	Adding a filed library to a model
	Using a library
	Example
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	Accessing external databases
	Overview of ODBC in Analytica
	Identifying the data source
	Configuring a DSN
	1. Select the ODBC icon from the Windows Control Panel.
	2. Select the “User DSN”, “System DSN”, or “File DSN” tab depending on your needs. Most likely, y...
	3. Select the driver. For example, if your database is a Microsoft Access database, select “Micro...
	4. You will be led through a series of dialogs specific to the driver you selected. These will in...

	Specifying an SQL query
	Retrieving an SQL result table
	1. Create an index node. Name it RecordIndex, and specify its definition as:
	2. Create a second index node, and name it Labels. Specify its definition as:
	3. Create a variable node, name it Result Table, and specify its definition as:


	Separating columns in a model
	1. Create an index node. Name it Record Index, and specify its definition as:
	2. Create a variable node named Make, and give it the definition:
	3. Create a variable node named Year, and give it the definition:
	4. Create a variable called CarModel, and give it the definition:
	DBWrite: Writing to a database
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	Creating a button to initiate the write operation
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	4. Distribute the “obfuscated” copy to your end-users.
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